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This chapter includes:
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T OO oo L 36
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Troubleshooting and Limitations ............ ..o i 89

Topology Query Language (TQL) Overview

Topology Query Language (TQL) is a language and tool for discovering, organizing, and managing
IT infrastructure data. It enables you to create TQL queries that retrieve business service data from
the RTSM. TQL queries also help you display the data in a visual representation that facilitates data
monitoring and managing.

This section includes the following topics:

Topology Query Language
TQL extends the standard SQL language by adding two important capabilities:
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e TQL enables you to draw conceptual relationships between configuration items (Cls), which
represent their actual interdependencies. Using predefined operators, the different types of
interconnections (relationships) that exist between Cls can be established, and consequently
the infrastructure design and performance are more accurately represented. This representation
serves as a basis and a model for the discovery, arrangement, query, and management of
complex infrastructures.

o TQL includes a graphical aspect, consisting of visual symbols and syntax, that represents the
resources and their interconnections. This visualization of an IT infrastructure simplifies the
understanding, monitoring, and managing of the IT business operations.

The Roles of TQL

TQL plays several roles:

o Builds a business service model that defines and delineates the interconnection between IT
assets that function together as business services. The business service model guides the
discovery and identification of these business services, from the ever-increasing number and
complexity of infrastructure resources. After the resources that comprise the business services
are discovered, the business service model structures the way they are organized and managed
inthe RTSM.

o Constantly searches the RTSM for changes that occur in the state of managed resources.
When such changes are detected, the relevant subsystems are informed and updated.

o Creates queries that retrieve business service data from the RTSM, and displays the datain a
visual representation that facilitates data monitoring and managing.

Creating TQL Queries in the RTSM Managers

The following managers enable you to create TQL queries that retrieve specific data from the RTSM
and to display that data:

« Impact Analysis Manager. An Impact rule simulates how infrastructure changes can impact
your system and enables you to determine the true origin of a problem and its business impact.
During rule creation, you define the base TQL query type, which can be a new query or an
existing query. For details, see "Impact Analysis Manager" on page 331.

o Enrichment Manager. An Enrichment rule enables enlarging the RTSM, deleting Cl instances
from the RTSM, or updating the attributes of a Cl that already exists in the RTSM. During rule
creation, you define the base TQL query type, which can be a new query or an existing query.
For details, see "Enrichment Manager" on page 382.

¢ Modeling Studio. You can build a new TQL query using the TQL Query Editor or you can build a
new query while defining a new view, template, or perspective using the Pattern View Editor.
You can also define the topology report settings for any view in the Pattern View Editor. For
details, see "Modeling Studio" on page 228.
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Viewing TQL Query Resulits

You view the resulting data in a visual representation in IT Universe Manager. The queries define
the structure of the resulting topology map. The view displays only those Cls and relationships that

meet the query definition. You can also view the results of a query by clicking the Preview
button in the toolbar to open a preview display identical to IT Universe Manager. For more details
about IT Universe Manager, see "IT Universe Manager" on page 176.

TQL Query Types and Priorities

When you define a TQL query, you define the type of the TQL query in the Type field of the Query
Definition Properties dialog box. The following query types are available:

o View. TQL queries used as the basis for pattern views.

o Integration. TQL queries used for integrations.

o Discovery. TQL queries used as the basis for DFM patterns.
o Template. TQL queries used as the basis for templates.

o Perspective. TQL queries used as the basis for perspectives.

« Impact Analysis. TQL queries used as the basis for Impact rules. This is the default type for
queries created in Impact Analysis Manager.

o Enrichment. TQL queries used as the basis for Enrichment rules. This is the default type for
queries created in Enrichment Manager.

You cannot change the type of an existing TQL query if it has dependencies (such as views,
templates, and so on).

If a query imported though an integration is not assigned a type, it is considered a hidden query and
does not appear in the query list in the Modeling Studio. To display hidden queries in the query list,
change the setting for hidden queries under General in the User Preferences dialog box. For details,
see "User Preferences Dialog Box" on page 88.

You can also set the priority level of a TQL query, which determines how often the query is rerun
automatically to include updated information. The following priorities are available:

o Low. The TQL query is refreshed every 2 minutes.

Medium. The TQL query is refreshed every 30 seconds.

High. The TQL query is refreshed every 10 seconds.

o Express. The TQL query is refreshed continuously.
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¢ Not Active. The TQL query is inactive.
Note: The above refresh times are average values.

If you set the priority of a TQL query to Not Active, the query becomes inactive and is not run
automatically, however it can be used for manually building a view.

Base Queries

You can select a base query fora TQL query in the Query Definition Properties dialog box. In this
case, the base query is first applied to the entire IT Universe, generating results. The new query is
then applied to that subset of the universe, further refining the results. Selecting a base query
enables you to filter the query results more finely and generate results more quickly in certain
cases.

The base query you select must be both active and persistent for your new query to be active. If the
base query is not active and persistent, the new query is automatically assigned a priority of Not
Active.

Compound Relationship

A compound relationship represents a path in the topological graph. You use a compound
relationship to define the allowed steps in the path between the source and the target Cls.

Each row represents one of the allowed steps in the path leading from the source ClI to the target CI
in the topology map.

Source | Relationship | Target
IpSubnet Membership % Mode
% Mode Containment @ IpAddress

For an example of a compound definition, see "Define a Compound Relationship — Scenario" on
page 24. For details on defining compound relationships, see "Add/Edit Compound Relationship
Dialog Box" on page 43.

Join Relationship

A join relationship is a logical connection that represents the relationship between two Cls (and
which appears only in the topology map containing the TQL query results). It does not exist in the
RTSM. A join relationship is created by defining an attribute for each query node, whose values are
used for comparison.

The TQL results retrieve all Cls whose attribute values meet the conditions defined in the join
definition.

For example, you can create a join definition that links all node Cls connected to IP Address Cls
whose Created By attribute values are equal (see the example below).

Hode | Operator | IpAddress
Created By Egual Created By
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Each join definition represents one condition defined for the join relationship.
Note: You can define multiple conditions.

For an example of a join definition, see "Define a Join Relationship — Scenario" on page 27. For
details on defining join relationships, see "Add/Edit Join Relationship Dialog Box" on page 47.

Query Node Conditions

You can add conditions to the query nodes and relationships of a TQL query in the Query Node
Properties dialog box. The conditions filter the query results by retrieving only Cls and relationships
that match the conditions defined in the query. There are several types of conditions you can define:
o Attributes. Conditions based on CI property values.

Cardinality. Conditions based on the number of related query nodes.

o Qualifiers. Conditions based on Cl type qualifiers.

Element type. Conditions based on Cl subtypes. See below for details.

Identity. Conditions based on Cl element IDs.

Each one has a separate tab in the dialog box. For details, see "Query Node/Relationship
Properties Dialog Box" on page 68.

Element Type Conditions

The Element type conditions enable you to specify the subtypes of a query node that should appear
in the query results. There are two options for defining this condition:

« Simple Type Condition. The simple type condition enables you to either include all subtypes
of the selected query node in the query results, or to exclude all of them.

o Complex Type Condition. The complex type condition enables you to select the specific
subtypes of the query node to be included in the query results. For details, see "Complex Type
Condition" on the next page.

Element Layout

You can specify the attributes to include in the query results for each query node or relationship in a
TQL query in the Element Layout tab of the Query Node Properties dialog box. Select the Select
attributes for layout radio button and then select a CIT or relationship in the CIT pane. If you
select Specific Attributes for the Attributes condition, only the attributes you move to the Specific
Attributes pane are included in the query results for that element. If you select All for the Attributes
condition, all of the available attributes are included in the query results for that element. In this
case, you can select Exclude specific attributes and move selected attributes to the Excluded
Attributes pane.

There is also an option to select attributes by qualifiers. If you select qualifiers in the Attributes
with the following qualifiers field, all attributes that have the selected qualifiers are included in
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the query results for that element, in addition to the attributes selected in the Specific Attributes
pane. In this case too, you can exclude selected attributes by moving them to the Excluded
Attributes pane.

By default, the attribute settings you select for a CIT are automatically applied to its descendant
CITs in the query results, however the settings are not visible in the Element Layout tab of the
dialog box. For example, if you select specific attributes to be included for the Database CIT, the
same attributes are included for the Oracle CIT (a child CIT of Database), but if you select Oracle
in the CIT pane, the Attributes condition displayed is None (the default condition).

You can then make attributes condition selection for the child CITs themselves. If the parent CIT
has All selected as the attributes condition, then the Specific Attributes option is disabled for the
child CITs. If the parent CIT has Specific Attributes selected as the attributes condition, you can
select All or Specific Attributes for the child CIT. If you select Specific Attributes, you can add
more attributes by moving them to the Specific Attributes pane. These are included in the query
results along with the attributes inherited from the parent CIT's setting. Similarly, you can select
attributes from the parent CIT's setting to exclude for the child CIT, by moving them to the
Excluded Attributes pane. If the parent CIT has qualifiers selected to determine the attribute
selection, these are also inherited by the child CIT. If you select additional qualifiers to filter the
child CIT's attribute selection, the combined set of selected qualifiers is used to filter the attribute
selection for the child CIT.

When you change the type of a query node or relationship using the Change Query
Node/Relationship Type dialog box, the attributes selection for that element is lost.

Note: The layout selection is not visible in the query results in the user interface. To view the
query results with the selected attributes, access the JMX console, select TQL services, and
invoke the calculateTqlAdHoc method.

Complex Type Condition

The complex type condition enables you to select the specific subtypes of the query node to be
included in the query results. A Cl type tree appears with all the subtypes of the selected query
node. By default, instances of all the displayed subtypes are included in the query results. For each
subtype, you can select Exclude <subtype> from the query which excludes instances of that
subtype from the query results. If you select the Apply this condition recursively on all
subtypes check box, instances of the subtype and all of its descendants are excluded from the
results.

If you select a subtype from the tree and you select Include <subtype> in the query without
selecting the Apply this condition recursively on all subtypes check box, only instances of the
specified subtype are included, but not instances of its descendants.

For both the Include and Exclude options, there is a further selection in the Conditions pane. If you
select By CI type, all instances of the specified subtype are then included or excluded from the
results. If you select By qualifiers and then select qualifiers from the popup list, only the instances
of the selected subtype with the selected qualifiers are included or excluded from the query results.

For example, suppose CIT_B and CIT_C are subtypes of CIT_A, and CIT_A and CIT_B have
qualifier Q1. The following are some of the possible configurations of options:

HP Business Service Management (9.24) Page 20 of 416



Modeling Guide
Chapter 1: Topology Query Language

o Select Exclude for CIT_A and all of its descendants. No CITs are included.
o Select Exclude for CIT_A without its descendants. Only CIT_B and CIT_C are included.

o Select Exclude for CIT_A and all of its descendants with qualifier Q1. Only CIT_C is
included.

Note:

= lItis possible to apply the Exclude option to the root of the tree (that is, the Cl type of the
original query node). If the Apply this condition recursively on all subtypes check box
is selected, no Cls are included in the results. If the check box is not selected, instances
of the root CI type are excluded, but instances of its descendants are included.

= The Element Type Conditions feature is only available in the Modeling Studio. If you define
a complex type condition in the Modeling Studio, and then modify the TQL query in
Enrichment Manager or Impact Analysis Manager, the condition may be overwritten and
will no longer be in effect. If the complex condition is equivalent to a simple condition, you
can edit the TQL query from the Qualifier tab of Enrichment Manager or Impact Analysis
Manager.

= If you want to define a qualifier condition on a query node as using the functionality of
previous UCMDB versions, select Customize subtypes and select the root query node in
the Cl types tree. Then select the Include option, select By qualifiers, and select the
required qualifiers. Similarly, when accessing a TQL query with qualifier conditions defined
in a previous UCMDB version or in Enrichment Manager or Impact Analysis Manager, the
condition appears in the Customize subtypes section of the Element Type tab, using the
Include and By qualifiers options.

= Itis sometimes possible to define an attribute condition (using the Cl Type attribute) that
generates the same results as a complex type condition. However, the complex type
condition ensures better performance. In such cases, the RTSM automatically optimizes
the query calculation by substituting an equivalent complex type condition for the simple
one. If the query is active,you will see the complex conditions in the TQL definition the next
time you open it.

For details on defining a complex type condition, see " Define a Complex Type Condition -
Scenario" on page 28.

Subgraph Definition

A subgraph definition enables you to create a graph that represents additional TQL query data
related to a specific Cl. The DFM job searches for the results from both the TQL query and the
subgraph definitions. The query recursively retrieves all related Cls for a defined depth matching the
definition of the subgraph. For details on defining subgraph definitions, see "Subgraph Definition
Dialog Box" on page 86.

In the graph, you can define the relationship that is connected to a specific query node. For
example, if one of the query nodes is of type node, you can specify different relationships for
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Windows, router, and IP Address. You can also define attribute conditions for query nodes. For
details, see "Subgraph Condition Definition Dialog Box" on page 85.

DFM jobs retrieve data that meets the criteria defined in the subgraph.

For an example of a subgraph definition, see "Create a Subgraph Definition — Scenario" on page 29.

The ALLOW_VOLATILITY Qualifier

This qualifier is used to mark attributes that enable minor deviations to their value. For example,
there is probably no need to report a small disk size change (from 8.00008 to 8.00009 GB).

When updating an attribute that is marked with this qualifier, HP Business Service Management
checks the new value against the old value. This check is performed on the server as part of the
record update. If the difference between the two values is lower that the allowed deviation, an
update is not performed (the action is considered a false update).

This qualifier must contain one of the following data items that hold the allowed deviation:

o ALLOWED_DEVIATION_FIX. The type of deviation is the same as the attribute type for
numeric attributes, and the integer type for date attributes. Deviation is measured by a fixed
value, of the same unit as the attribute value. (For date attributes, the deviation is measured in
seconds.)

o ALLOWED_DEVIATION_PERCENT. Deviation is measured by percentage. For date values,
the percentage is checked against the millisecond date representation. This data item type is
always integer, and the value range is 0 to 100.

To deactivate the qualifier:

Access the Infrastructure Settings Manager (Admin > Platform > Setup and Maintenance >
Infrastructure Settings). Locate the Allow Volatility option. Change the value to False.

Define a TQL Query

This task describes how to create a TQL query in the Modeling Studio.

Note: You can also create a TQL query during the procedure for creating Impact rules,
Enrichment rules, Views, Templates, and Perspectives.

This task includes the following steps:

"Create a TQL Query" below

"Add Query Nodes and Relationships to the Query" on the next page

o "Set the Query Properties" on the next page

1. Create a TQL Query
In the Modeling Studio, select New > Query to open the TQL Query Editor. For details, see
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"TQL Query Editor" on page 301.

2. Add Query Nodes and Relationships to the Query

Add the TQL query nodes and relationships that define the query. The TQL query nodes
represent the CITs, as defined in the Cl Type Manager, and the relationships represent the
connections between them. Relationships are defined one at a time for each pair of TQL query
nodes in the query. For details, see "Add Query Nodes and Relationships to a TQL Query"
below.

Note: You can also define a self-relationship from a query node to itself.

3. Set the Query Properties

Click the Query Definition Properties 5 button to open the Query Definition Properties
dialog box. Set the query type, scope, priority, and other properties. For details, see
"Query/View Definition Properties Dialog Box" on page 290.

Example of a TQL Query Definition:

The direction of the relationship indicates which query node is dependent on the other. The
following example displays two nodes, an IP Service Endpoint, and a Client Port, which
are linked to one another via a client/server connection. The TQL query results must
comply with the direction of the arrows.

ay |
i =
Windows +
i #ini
: ' tainment_1
IComposition_1 I -
| Composition —
| 1
; | lll
v IpAddress :
e I [pAddress_1
2 B ClientServer ¥
IpServiceEndpaint 3L
Client Port

Note: A TQL query is subject to certain validation restrictions. For details, see
"Troubleshooting and Limitations" on page 89.

Add Query Nodes and Relationships to a TQL Query

This section explains how to add query nodes and relationships to a TQL query. It is relevant for
Impact Analysis Manager, Enrichment Manager, and the Modeling Studio.
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Note: For TQL queries to be valid, they must comply with certain restrictions. For details, see
"Troubleshooting and Limitations" on page 89.

To add query nodes and relationships to a TQL query:

1. InImpact Analysis Manager or Enrichment manager, select the required query from the tree in

the left pane or click the New * button to create one.

In the Modeling Studio, select the Resources tab in the left pane, select Queries as the
Resource type, and select the required query from the tree or click New > Query to create a new
one.

2. InImpact Analysis Manager or Enrichment manager, click and drag one or more required TQL
query nodes from the tree displayed in the CI Type Selector, onto the editing pane. In the
Modeling Studio, select the Cl Types tab in the left pane and drag the required TQL query
nodes from the tree onto the editing pane. These are the TQL query nodes that are included in
the query.

If you want the query to run over federated Cls also, right-click a query node and select Set
Integration Points. In the Select Integration Points dialog box, select the integration points for
the external data sources to use. For details, see "Select Integration Points Dialog Box" on
page 295.

3. To add a relationship between two query nodes, do one of the following:

= Select the required TQL query nodes by holding down CTRL and clicking the TQL query
nodes, right-click and select Add Relationship. The Add Relationship dialog box opens.
Select the required relationship. For details, see "Add/Edit Relationship Dialog Box" on page
50.

= Click the Create Relationship [% icon and draw a line between the required query nodes.
The Select Relationship Type dialog box opens. Select the required relationship type. For
details, see "Select Relationship Type Dialog Box" on page 84.

4. Click OK. The selected query nodes are linked by the relationship you have selected.

Define a Compound Relationship - Scenario

This section describes how to define the allowed steps that form a compound relationship between
an IP Subnet Cl and an IP Address CI.

Note: To reach the required result, you must implement each one of the following steps.

To define a compound relationship between a IP Subnet Cl and an IP Address ClI:
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1. Create a TQL query of type view and drag the following query nodes onto the editing pane:
= |P Subnet
= |P Address

2. Right-click the IP Subnet and IP Address query nodes and select Add Compound
Relationship to open the Add Compound Relationship dialog box.

3. Clickthe Add * button. In Enrichment Manager and Impact Analysis Manager, the Add
Triplet dialog box opens. In the Modeling Studio, a row is added to the table. Make the following
selections:
= From the Source list, select IP Subnet.

From the Target list, select Node.

= From the Relationship list, select Membership.

Select the required Relationship direction.

In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.

4. Click the Add * button again and make the following selections:
= From the Source list, select Node.
s From the Target list, select IP Address.
= From the Relationship list, select Containment.

Select the required Relationship direction.

In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.

The following shows an example of compound definitions following the changes:

Source | Relationship | Target
IpSubnet Mermbership % MNode
% Mode Cortainment IE IpAddress

5. Click OK to save your changes.

The TQL query in the editing pane now looks like this:

Trp ) Mitual- Compound =
il < =

[pAddress IpSubnet
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6. Create aview based on your TQL query and save it.
7. Goto the required view in IT Universe Manager to view the results. If you did not select the
Show full path between source and target Cls option, then the results display the names of

the relationships that link the Cls as Virtual-Compound rather than the actual names of the
relationships. See the illustration below:

@

Wirtla

192.1658.168.0

Yirtual - Compo
urnd
Compo

p]
Yirtual - Compo

W W

192168.01 1659658183 1921631651

You can double-click the Virtual - Compound relationship in IT Universe Manager to open the
Link Map, which displays the Cls and relationships that comprise the allowed steps used to link
the IP Subnet and IP Address Cls.

=

192 165.165.0

Membership

L
%

labrmlccmls

Containment

¥

In the example above, the 192.168.168.0 (IP Subnet) Cl is linked to the 192.168.0.1 (IP
Address) Cl through the labm1cecm15 (Node) Cl.
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If you selected the Show full path between source and target Cls option, then the results in
IT Universe Manager display the actual names of the relationships that link the Cls and the full
path between the source and target Cls. See the illustration below:

192.168.168.0

Membership

¥

%

[abmlcomla

Containment
Contaikment

Containment

W W

1921681681 16.59.68183  192168.01

Define a Join Relationship - Scenario

This section explains how to define a join relationship that links Node Cls to IP Address Cls
whose Created by attribute values are equal.

Note: To reach the required result, you must implement each one of the following steps.

To define a join relationship that links all IP Address and Node Cls whose Created by
attribute values are equal:

1. Create a TQL query and drag the following query nodes from the CI Type Selector onto the
editing pane:

= Node
= |P Address

2. Select the Node and IP Address query nodes and right-click to open the Add Join
Relationship dialog box.

3. Click the Add * button to add a row to the table and do the following:
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= Inthe Node Attribute box, select Created by.
= Inthe Operator box, select Equal.
= Inthe IP Address Attribute box, select Created by.

In Enrichment Manager and Impact Analysis Manager, you make these selections in the Join
Relationship Condition dialog box.

The Join Definition area now looks like this.

Hode | Operator IpAddress
Created By Eqqual Created By

4. Click OK to save your changes.

The TQL query in the editing pane now looks like this:

(I

Mode

Wirtual - Join

————

=

IpAddress

Define a Complex Type Condition - Scenario

This section describes how to define a complex type condition in the Query Node Properties dialog
box. In this example, you add subtype conditions to a Node query node in a TQL query.

To define a complex type condition:
1. Create a TQL query and drag a query node of type Node onto the editing pane.

2. Right click the query node and select Query Node Properties. The Query Node Properties
dialog box opens.

3. Select the Element Type tab and select Customize subtypes.
4. Inthe Cl Types pane, select Computer, and in the Conditions pane, select Exclude

<Computer> from the query. Select the Apply this condition recursively on all subtypes
of <Computer> check box. This excludes all Cls of type Computer and its descendants in the
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8.

query results.

In the CI Types pane, select Unix, and in the Conditions pane, select Include <Unix> in the
query. This includes all Unix Cls in the query results.

Inthe CI Types pane, select IBM Frame, and in the Conditions pane, select Include <IBM
Frame> in the query. Then select By qualifiers and select the CONTAINER qualifier. This
includes all IBM Frame Cls with the CONTAINER qualifier in the query results.

In the Cl Types pane, select Firewall, and in the Conditions pane, select Exclude <Firewall>
from the query. Select By qualifiers and select the HIDDEN_CLASS and MAJOR_APP
qualifiers. This excludes all Firewall Cls with the HIDDEN_CLASS and MAJOR_APP
qualifiers from the query results.

Click OK to save your conditions and exit the dialog box.

Create a Subgraph Definition - Scenario

This section describes how to create a subgraph definition. In this example, the TQL query results
retrieve all Cls that are connected to a Business Service Cl by a Containment relationshipup to a
depth of 3.

Note: To reach the required result, you must implement each one of the following steps.

To create this sample subgraph definition:

1.

2.

Create a TQL query and drag a query node of type Business Service onto the editing pane.

Right-click the Business Service query node and select Subgraph Definition to open the
Subgraph Definition dialog box.

Click the Add * button. In Enrichment Manager and Impact Analysis Manager, the Add
Triplet dialog box opens. In the Modeling Studio, a row is added to the table. Make the following
selections:

= From the Source drop-down list, select Managed Object.

= From the Target drop-down list, select Managed Object.

= From the Relationship drop-down list, select Containment.

= Set the direction of the relationship as left to right.

In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.
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The Subgraph Definition dialog box now looks like this.

Source | Relationship | Target Relationship Direction
Managed Object Containmert Managed Object =

4. Setthe Depth settingto 3.
5. Click OK in the Subgraph Definition dialog box.

Go to the required view in IT Universe Manager to view the results.

Containment

|

@
111

Containment

222
Containment

Containtnent

Ar AF
13444831120 gec-smelesh
efaultDomain

The results show the Business Service Cl aaa and all of the Cls linked to it in succession by
Containment relationships down to three levels.

Shortcut Menu Options

This section includes a list of TQL query shortcut menu options (listed alphabetically):
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Ul Element (A-Z) Description

Add Calculated Enables you to create a calculated relationship.
Relationship
o Fordetails on how to create a calculated relationship, see "Triplets
Page" on page 369.

o For details about Impact Modeling, see "Impact Modeling" on page 94.

Add Compound Enables you to define the connection between two query nodes using a
Relationship compound relationship.

For details, see "Add/Edit Compound Relationship Dialog Box" on page

43.
Add Join Enables you to define join relationships. You create them by defining an
Relationship attribute for each query node. These query node values are used for

comparison during federation.

For details, see "Add/Edit Join Relationship Dialog Box" on page 47.

Add Related Query Displays the Add Related Query Node Wizard which enables you to build
Node Wizard a TQL query. For details, see "Add Related Query Node Wizard" on page
52.

Add Relationship = Enables you to create a relationship for your query nodes by selecting it
from a predefined list. Displays the Add Relationship dialog box.

For details, see "Add/Edit Relationship Dialog Box" on page 50.

Note: In Enrichment Manager, this option adds an Enrichment
relationship to the rule when working in Enrichment mode. Applicable for
regular and Enrichment query nodes. For details, see "Enrichment

Manager" on page 382. Added relationships are denoted by an added E|
indicator.

Add to Hierarchy Adds the selected query node to the hierarchy as a separate query node.
Note: Only relevant for the Modeling Studio.

Add to Model Designates the selected query node as output for the pattern-based
Output model.

Note: Only relevant for pattern-based models in the Modeling Studio.

Change Query Displays the Change Query Node Type dialog box. Enables you to

Node/Relationship = change the ClI type of the query node after you have created it. For

Type details, see "Change Query Node/Relationship Type Dialog Box" on page
256.

Note: Only relevant for the Modeling Studio.
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Ul Element (A-2) Description

Clear Available by right-clicking a query node or relationship when working in
Enrichment mode in the Enrichment Manager. Clears the query
node/relationship's Enrichment rule definition. For details, see
"Enrichment Manager" on page 382.

Appears only if you have updated or deleted a query node/relationship
using an Enrichment rule.

Note: Only relevant for Enrichment Manager.

Copy/Paste Copy/paste an existing TQL query node/relationship in the same query or
into another TQL query.

The copied TQL query node/relationship includes all TQL definitions.

You can copy and paste relationships provided that the TQL query nodes
to which the relationships are connected are also selected. A relationship
on its own cannot be copied without its connecting TQL query nodes.

You can select multiple TQL query nodes/relationships as well.

Note: The Copy and Paste options are only available in the Modeling
Studio. The Paste option is available only after using the Copy option to
copy an existing TQL query node/relationship.

Define Impacted Define which query node in the TQL query is the trigger Impact Analysis
query node and which query nodes are impacted by the changes that
occur in the system. For details, see "Impacted Query Nodes Dialog
Box" on page 342.

Note: Only relevant for Impact Analysis Manager.
Delete Deletes the selected query node/relationship/Cl.

Note: This option is not available for calculated relationships.

Delete Available by right-clicking a query node or relationship when working in
Relationship/Query Enrichment mode.
Node

Creates a specific Enrichment rule that is designed to delete
Cls/relationships from the RTSM. Applicable to regular query nodes and
relationships only. You can use this option, for example, for removing
unnecessary data from the RTSM. For details, see "Enrichment
Manager" on page 382.

Deleted query nodes and relationships are denoted by a removed E
indicator.

Note: Only relevant for Enrichment Manager.
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Ul Element (A-2) Description

Edit Relationship Displays the Refine Relationship Type dialog box. For details, see
"Refine Query Node Type Dialog Box" on page 83.

Note:
¢ Not relevant in the Modeling Studio.

o This option appears only when the selected relationship has

descendants.
Hide Element in When this option is selected, a Hidden in Query Results indicator &
Query Results appears to the right of the selected TQL query node in the editing pane.

Any query results pertaining to that TQL query node are not displayed in
the topology map. This can be useful when certain relationships or TQL
query nodes are required to build the query but are not needed in the

results. At least one query node must be visible for the view to be valid.

Note: Only relevant for the Modeling Studio.

Query Displays the Query Node/Relationship Properties dialog box, enabling
Node/Relationship | you to define the attribute conditions for the selected TQL query
Properties node/relationship. For details, see "Query Node/Relationship Properties

Dialog Box" on page 68.
Note: This option is not available for calculated relationships.

Refine Query Node Displays the Refine Query Node Type dialog box. Enables you to change
Type the ClI type of the query node after you have created it. For details, see
"Refine Query Node Type Dialog Box" on page 83.

Note: This option only appears if a child of the CI type exists. Only
relevant for Impact Analysis Manager and Enrichment Manager.

Remove Subgraph Only appears if you have defined a subgraph definition. For details, see
"Subgraph Definition Dialog Box" on page 86.

Reset Impacted Removes the Define Impacted definition applied to that query node. For
details on the Define Impacted definition, see "Impacted Query Nodes
Dialog Box" on page 342.

Note: Only relevant for Impact Analysis Manager.

Reset Inner Redraws a self-referential relationship in the Topology map as a square
Relationship for ease of viewing.

Note: Only relevant for self-referential relationships that are not square.

Select All Selects all query nodes and relationships in the TQL query.
Note: Only relevant for the Modeling Studio.
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Ul Element (A-2) Description

Set As Contact Designates the selected query node as a contact query node for the
Query Node perspective.

Note: Only relevant for perspectives in the Modeling Studio.

Set Integration Opens the Select Integration Points dialog box which enables you to
Points select the required data sources for a TQL query node.

Note: Only relevant for the Modeling Studio.

Show Element in When this option is selected, the results pertaining to the TQL query node
Query Results are displayed in the topology map.

Note: Only relevant for the Modeling Studio.

Show Element Displays the Element Instances dialog box which displays all the
instances instances found for each query node in a table. For details, see "Element
Instances Dialog Box" on page 61.

Show Node Opens the Template Parameter Values dialog box, which enables you to
Parameters set the values of the query node's parameters.

Note: Only relevant for template-based views in the Modeling Studio.

Subgraph Displays the Subgraph Definition dialog box, where you can create a

Definition graph that represents additional TQL query data related to a specific
query node. For details, see "Subgraph Definition Dialog Box" on page
86.

Update Use an Enrichment rule to update the value of Cl attributes in the RTSM,

Relationship/Query or to add data to attributes that currently do not have values. Opens the

Node Query Node Definition - Attributes dialog box. For details, see "Query

Node/Relationship Definition Dialog Box" on page 400. This is applicable
for both regular and Enrichment query nodes.

Updated query nodes are denoted by an updated L-"| indicator.

Note: Only relevant for Enrichment Manager.

Attribute Operator Definitions

This section contains a list of operators used to define attribute conditions in various dialog boxes,
such as the Subgraph Condition dialog box, Impact Rules Definition dialog box, or the Query
Node/Relationship Properties dialog box.

Operator Description

Changed (Displayed only when you select an attribute of type Date.) Displays only the
during instances that changed during the period specified in the Value box.
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Operator Description

Equal Checks whether the attribute value is equal to the value specified in the Value
box.

Equal Checks whether the attribute value is equal to the value specified in the Value box

ignore regardless of the case.

case

Greater Checks whether the attribute value is greater than the value specified in the Value
box.

Note: When comparing attributes of type string, the comparison is based on the
ASCII values of the string characters.

Greater Checks whether the attribute value is greater than or equal to the value specified
than or in the Value box.

equal

In Displays only the instances where this attribute value equals one of the selected

values. For example, for Cls that have a Change state that equals P1an and New,
select the operator In from the Operator list and select both Plan and New from
the Value box.

Is null Checks whether the attribute value is null.
Less Checks whether the attribute value is less than the value specified in the Value
box.

Note: When comparing attributes of type string, the comparison is based on the
ASCII values of the string characters.

Less than Checks whether the attribute value is less than or equal to the value specified in
or equal the Value box.

Like Uses a wildcard (%). Use Like when you are not sure of the complete name for
which you are searching.

Like ignore Uses a wildcard (%). Use Like ignore case when you are not sure of the
case complete name for which you are searching. The case of the string is ignored.

Not equal Checks whether the attribute value is not equal to the value specified in the Value
box.

Unchanged (Displayed when you select a date type attribute.) Displays only the instances
during that did not change during the period specified in the Value box.

Note:

o Forthe Not equal operator, query results do not include data from the Cl instances that are
not assigned a value. For example, a system contains three nodes: Node1 is assigned the
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value A, Node2 is assigned the value B, and Node3 is not assigned a value. If you create a
query to retrieve all nodes that are Not equal to A, the results of your query include Node2
only, because Node3 is not assigned a value.

e HP Business Service Management supports both Microsoft SQL Server and Oracle Server
databases. Microsoft SQL Server is not case sensitive by default (unlike Oracle database
which is case sensitive). Consequently, if you are using Microsoft SQL Server, the Equal
operator retrieves the same query results as the Equal ignore case operator. For example,
if you select the attribute City, the operator Equal, and type NEW YORK in the Value
comparison box, case differences are ignored and query results include NEW YORK,
New York and new york.

TQL Logs

This section contains definitions for TQL parameter log files.

This section includes the following topics:

o "Pattern Log" below

o "Pattern Statistics Log" on page 38

o "Audit Short/Detailed Log (TQL Perspective)" on page 38
o "Incremental Statistics Log" on page 39

o "Incremental Splitter Log" on page 40

¢ "Incremental Detailed Log" on page 40

Pattern Log

The log name is cmdb.pattern.log.

Log File Description
Purpose Information about the lifecycle of a TQL query that is handled and calculated in
the RTSM.

Only TQL queries stored in the RTSM are included. Information about ad hoc
TQL queries is not included.

Information Not available.
Level
Error Level Not available.
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Log File Description

Debug Level Possible actions performed on each TQL query include:

o Status changes. Each TQL query has an internal state during its lifecycle.
For example, all inactive queries are always in the INACTIVE state. Active
queries begin in the NEW state. When they are first calculated, they move
tothe IN_CALC state. When a query is removed, it moves to the WAIT _
FOR_DELETE state until it is removed completely.

o Model changes. Whenever a change occurs in the CMDB model, the TQL
determines if it is relevant to its results. If so, it calculates the required
change in the query results. The log displays the number of changes
processed by this TQL.

¢ Query changes. When the TQL is modified, the log indicates that the query
was modified and displays its new priority.

Basic Check if a TQL query has the same status for a long time:

Troubleshooting
e new —the query is in lazy loading

e inactive

« calculation — the calculation may have failed but the scheduler was not
informed

You can also view the number of notifications that a TQL query received.

Examples of typical log entries:
The TQL query named TQL1 is added and is in NEW state:

2011-01-25 07:44:48,763 DEBUG - TQL1 [NEW] State change NEW ==
NEW

TQL1 is asked to be calculated and is moved to IN CALCULATION state:

2011-01-25 07:44:48,763 DEBUG - TQL1 [NEW]  State change  NEW  -->
IN_CALC

The calculation finishes and moves to IDLE state (waits for changes):

2011-01-25 07:44:48,778 DEBUG - TQL1 [IN CALC]  State change  IN_CALC
- IDLE

Changes took place in the model (total of 5 changes):

2011-01-25 07:44:49,544 DEBUG - TQL1 [IDLE] Model Change Recieved 5 mo
del changes.
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Moving to a state that checks whether these change are relevant for this TQL query:

2011-01-25 07:44:49,544 DEBUG - TQL1 [IDLE]  State change  IDLE  -->
IN_IMMEDIATE_1

The pattern is changed. The new priority is medium:

2011-01-25 07:45:39,647 DEBUG - TQL1 [IDLE] Pattern change New priorit
y MED_PRIORITY

Pattern Statistics Log

The log name is cmdb.pattern.statistics.log.

Log File Description

Purpose General calculation data for each TQL query, updated at predefined
intervals.

Information Level The following information is given for each TQL query:
e nName

e average, minimum, and maximum calculation times
e number of calculations
¢ last calculation time

o result size

Error Level Not available.
Debug Level Not available.
Basic o Verify that a specific TQL query was updated.

Troubleshooting
o Evaluate a TQL query's calculation time.

o Evaluate a TQL query's result size.
Audit Short/Detailed Log (TQL Perspective)
The log name is cmdb.audit.short.log.

Log File Description

Purpose RTSM state changes, Cl Type changes, and TQL query results.
You can use this log to follow the results of TQL queries.

Information Level Not available.

HP Business Service Management (9.24) Page 38 of 416



Modeling Guide
Chapter 1: Topology Query Language

Log File Description
Error Level Not available.
Debug Level ¢ Final calculation for TQL queries is logged.

o If the final TQL query calculation is unchanged from the previous
calculation, this is noted.

¢ If the final TQL query calculation is changed from the previous
calculation, results of the Cls and relationships are recorded in the
detailed log. The number of Cls and relationships are recorded in the
short log.

Basic Troubleshooting

Use this log to verify which notifications are published by the TQL
query subsystem.

o Check the section at the end of each result. This section includes
added, removed, and updated Cls and relationships.

o Track the CIT changes and see if the query results also change. You
can thus correlate the CIT changes to the results of the query
calculations.

Incremental Statistics Log

The log name is cmdb.incremental.statistics.log.

Log File Description

Purpose Traces the calculation procedure, full orincremental, of every query.
Information Not available.

Level

Error Level Not available.

Debug Level o Gives the date, time, query name, and whether an incremental statistic

calculation was performed (yes/no).

o If anincremental statistic calculation was not performed, states the reason,
the number of subcalculations (relevant for incremental calculations only),
and the complete calculation time.

Basic Monitors the calculation process.

Troubleshooting . ) . ey s
If a specific query calculation takes a long time, check if it is a full or

incremental calculation:
o If full, check whether a full calculation is necessary.

¢ If incremental, check how many subcalculations have been performed.
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Incremental Splitter Log

The log name is cmdb.incremental.splitter.log.

Log File Description

Purpose Monitors the incremental splitter result made during an incremental
calculation.

Information Not available.

Level

Error Level Not available.

Debug Level Gives the set of query node numbers of each query graph created by the

incremental splitter.

Basic If the TQL result calculated by the incremental calculator is wrong, verify that
Troubleshooting = the splitter result is correct.

Incremental Detailed Log

The log name is cmdb.incremental.detailed.log.

Log File Description

Purpose Monitors the incremental calculation process.

Information Not available.

Level

Error Level Not available.

Debug Level Each incremental subcalculation entry includes the following:

o the trigger query node
o the number of elements classified to the trigger query node

o Wwhether the subcalculation step is driven by new elements added to the
model or by existing elements

¢ the calculated query graph

Basic Follows the basic steps of an incremental calculation.
Troubleshooting

Topology Query Language User Interface

This section includes (in alphabetical order):
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o "Add/Edit Calculated Relationship Dialog Box" below

o "Add/Edit Compound Relationship Dialog Box" on page 43
o "Add/Edit Join Relationship Dialog Box" on page 47

« "Add/Edit Relationship Dialog Box" on page 50

o "Add Related Query Node Wizard" on page 52

o "Add Triplet Dialog Box" on page 58

o "Conditions Preview Dialog Box" on page 61

o "Element Instances Dialog Box" on page 61

o "Element Layout Preview Dialog Box" on page 65

o "Filter Cl Instances Dialog Box" on page 65

« "Join Relationship Condition Dialog Box" on page 66

o "Layout Settings Dialog Box" on page 67

o "Query Node/Relationship Properties Dialog Box" on page 68
+ "Refine Query Node Type Dialog Box" on page 83

o "Select Relationship Type Dialog Box" on page 84

o "Subgraph Condition Definition Dialog Box" on page 85

o "Subgraph Definition Dialog Box" on page 86

o "User Preferences Dialog Box" on page 88

Add/Edit Calculated Relationship Dialog Box

This dialog box enables you to define the connection between two query nodes using a calculated
relationship from the CI Type model.
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To To access in Enrichment Manager, Impact Analysis Manager, and the Modeling
access Studio:

Right-click the required query node in the editing pane in Enrichment Manager,
Impact Analysis Manager, or the Modeling Studio and select Add Calculated
Relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Add Calculated Relationship option.

To access in Adapter Management in Data Flow Management (DFM):

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query button £ tothe right
of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Calculated Relationship.

Relevant
tasks

"Define an Impact Rule — Workflow" on page 331

¢ "Define an Enrichment Rule — Scenario" on page 384

o "Define a TQL Query" on page 22

¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
e "Create a Pattern View" on page 244

e "Create a Template" on page 245

e "Create a Perspective" on page 246

See also

"Impact Modeling" on page 94

e "Cl Type Relationships" on page 350

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

B Click Expand All to expand all the folders in the tree.
B Click Collapse All to collapse all the folders in the tree.
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Ul Element

(A-2) Description

Tree View Click Tree View to select the display format of the calculated relationship tree.
F The following options are available:

o Display label
e Class name

e Legacy class name

<Calculated | Select the calculated relationship that defines the connection between two query
relationship  nodes.
tree>

Relationship The direction of the relationship that indicates which query node is dependent on
Direction the other.

Relationship The name of the calculated relationship.
Name

Relationship Select an option to define how to handle relationships between identical query
Restrictions nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.

Note: This list appears only when you select one query node or two identical
query nodes.

o Allow All Relationships. All relationships appear in the query results.

o Allow Self Relationships Only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

¢ Allow Non Self Relationships Only. Self-relationships do not appear in the
query results.

Add/Edit Compound Relationship Dialog Box

This dialog box enables you to define the connection between two query nodes using a compound
relationship.

HP Business Service Management (9.24) Page 43 of 416



Modeling Guide
Chapter 1: Topology Query Language

To access  Toaccess in Enrichment Manager, Impact Analysis Manager, and the Modeling
Studio:

Right-click the required query nodes in the editing pane in Enrichment Manager,
Impact Analysis Manager, or the Modeling Studio and select Add Compound
Relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Add Compound Relationship option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the & Edit Input Query button to the
right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Compound

Relationship.
Important You can create as many compound definitions as necessary.
information
Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
¢ "Define an Enrichment Rule — Scenario" on page 384
o "Define a TQL Query" on page 22
¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
o "Create a Pattern View" on page 244
e "Create a Template" on page 245
o "Create a Perspective" on page 246
See also e "Compound Relationship" on page 18

o "Define a Compound Relationship — Scenario" on page 24

User interface elements are described below:

Ul Element (A-
Z) Description
< Add a compound definition.

In Impact Analysis Manager and Enrichment Manager, it opens the Add Triplet
dialog box. In the Modeling Studio, it enters a default compound definition in
the table. Click the Edit buttons to edit the definition components.
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Ul Element (A-
Z)

b4
&

Max steps

Min steps

Relationship

Relationship
Direction

Relationship
Name

Relationship
Restrictions

Description

Delete the selected compound definition.

Edit the selected compound definition.

In Impact Analysis Manager and Enrichment Manager, it opens the Add Triplet
dialog box. In the Modeling Studio, it opens the Compound Relationship
Condition Definition dialog box.

The longest path allowed between the two Cls in the RTSM to be included in
the discovery process.

Default is: 5

The shortest path allowed between the two Cls in the RTSM to be included in
the discovery process.

Default is: 1
The relationship connecting the two query nodes.

The direction of the relationship that indicates which query node is dependent
on the other.

The name of the compound relationship.

Select an option to define how to handle relationships between identical query
nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.

Note: This list appears only when you select one query node or two identical
query nodes.

o Allow All Relationships. All relationships appear in the query results.

o Allow Self Relationships only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

o Allow Non Self Relationships only. Self-relationships do not appearin
the query results.
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Ul Element (A-

Z) Description

Show element = Select Show element in query results to include query results relating to a
in query join or compound relationship. By default, this option is selected. When the
results check box is cleared, a Hidden in Query Results indicator & appears to the

left of the relationship's name in the editing pane, denoting that any query
results pertaining to the relationship are not displayed in the topology map.

(

MHode

Yirtual - Jain

-Q—E—lr

E

pAddress

Show full path ' If you select this option, then the query results display the actual names of the

between relationships that link the Cls and the full path between the source and target
source and Cls.

target Cls

Source The required source query node.
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Ul Element (A-

Z) Description

Stop at first Select this option if you want the system to stop looking for TQL query results
compound once it reaches the first target in the path.

level

In the following sample compound link definition, Depth is defined as 10 and
Stop at first compound level is selected.

The TQL query results include the Target 1, Target 3, and Target 4 because
they are all at level 1 (the first Cl found in the path). Target 2 is not included in
the TQL results because it is at level 2 (the second CI found in the path).

Target The required target query node.

Add/Edit Join Relationship Dialog Box

This dialog box enables you to define join relationships.

To access  Toaccess in Enrichment Manager, Impact Analysis Manager, and the Modeling
Studio:

Right-click the required query nodes in the editing pane in Enrichment Manager,
Impact Analysis Manager, or the Modeling Studio and select Add Join
Relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Add Join Relationship option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the < Edit Input Query button to the
right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Join Relationship.
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Important = When you access the dialog box from the Modeling Studio, you select the

information = attributes and operator within the dialog box itself. When you access the dialog
box from Impact Analysis Manager or Enrichment Manager, you select the
attributes and operator from the Join Relationship Condition dialog box.

Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
¢ "Define an Enrichment Rule — Scenario" on page 384
o "Define a TQL Query" on page 22
¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
o "Create a Pattern View" on page 244

e "Create a Template" on page 245

o "Create a Perspective" on page 246

See also ¢ "Join Relationship" on page 18

¢ "Define a Join Relationship — Scenario" on page 27

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description
i Define ajoin definition. In Impact Analysis Manager and Enrichment Manager, it
opens the Join Relationship Condition dialog box. In the Modeling Studio, it adds
the selected attributes and operator to the list.
% Delete the selected join definition.
o3 Edit the join definition. Opens the Join Relationship Condition dialog box.
Note: This option is not relevant in the Modeling Studio.
<Query Select an attribute for the <end_1> query node.
node1 . L . . . .
Attribute> Note: This option is only available in the Modeling Studio.
box
<Query Select an attribute for the <end_2> query node.
node2

Attribute> Note: This option is only available in the Modeling Studio.

box
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Ul Element
(A-2) Description
<Selected A selected query node. The first attribute applies to <end_1>.
query
node1>
column
<Selected A selected query node. The second attribute applies to <end_2>.
query
node2>
column
And All join definitions are linked by the And operator.
Note: This is not relevant in the Modeling Studio.
Operator Select an operator. For details on the available operators, see "Join Relationship
box Condition Dialog Box" on page 66.
Note: This option is only available in the Modeling Studio.
Operator The operator selected in the Join Relationship Condition dialog box. For details
column about operator definitions, see "Attribute Operator Definitions" on page 34.

Relationship The direction of the relationship that indicates which query node is dependent on
Direction the other.

Relationship The name of the join relationship.
Name

Relationship Select an option to define how to handle relationships between identical query
Restrictions nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.

Note: This list appears only when you select one query node or two identical
query nodes.

o Allow All Relationships. All relationships appear in the query results.

o Allow Self Relationships only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

o Allow Non Self Relationships only. Self-relationships do not appear in the
query results.
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Ul Element

(A-2) Description

Show Select Show relationship in query results to include query results relatingto a
relationship | join or compound relationship. By default, this option is selected. When the

in query check box is cleared, a Hidden in Query Results indicator & appears to the left
results of the relationship's name in the editing pane. Any query results pertaining to the

relationship are not displayed in the topology map.

(

Mode

Yirtual - Jain

=

IpAddress

Add/Edit Relationship Dialog Box

This dialog box enables you to define the connection between two query nodes in a TQL query.

To access  Toaccess in Enrichment Manager, Impact Analysis Manager, and the Modeling
Studio, do one of the following:

¢ Right-click the required query node in the editing pane in Enrichment Manager,

Impact Analysis Manager, or the Modeling Studio and select Add
Relationship.

¢ Click the Create Relationship [% icon and draw a line between the required
query nodes. The Select Relationship Type dialog box opens. Select Regular
Relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Add Relationship option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the ¢ Edit Input Query button to the
right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Relationship.
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Important | This option does not appear when two selected query nodes (or a single selected
information = query node) do not have a valid relationship between them.

Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
¢ "Define an Enrichment Rule — Scenario" on page 384
o "Define a TQL Query" on page 22
¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
e "Create a Pattern View" on page 244

e "Create a Template" on page 245

e "Create a Perspective" on page 246

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

B Click Expand All to expand all the folders in the relationship tree.
B Click Collapse All to collapse all the folders in the relationship tree.

Tree View |Z]  Click Tree View to select the display format of the relationship tree. The
following options are available:

o Display label
e Class name

e Legacy class name

<Relationship Select the relationship that defines the connection between two query nodes.
tree>

Relationship = The direction of the relationship that indicates which query node is dependent
Direction on the other.

Relationship = The name of the relationship.
Name
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Ul Element
(A-2) Description

Relationship = Select an option to define how to handle relationships between identical query
Restrictions nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.

Note: This list appears only when you select one query node or two identical
query nodes.

o Allow All Relationships. All relationships appear in the query results.

« Allow Self Relationships only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

¢ Allow Non Self Relationships only. Self-relationships do not appear in
the query results.

Add Related Query Node Wizard

This wizard enables you to build a TQL query.

To access | Toaccess in Enrichment Manager, Impact Analysis Manager, and the Modeling
Studio:

In the editing pane, right-click the required query node and select Add Related
Query Node.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Add Related Query Node option.

To access in Discovery Control Panel in DFM:
1. Select ajobinthe Discovery Modules pane.

2. Select a Trigger Query in the Properties tab. Click the Open the Query Editor
¢ putton to open the Trigger Query Editor.

3. Right-click the required query node and select Add Related Query Node
Wizard.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the & Edit Input Query button to the
right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Related Query Node
Wizard.
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Important
information

Relevant
tasks

Wizard
map

See also

If the TQL query is empty, drag the required TQL query nodes on to the editing
pane from the tree displayed in the Cl Type Selector or the Cl Types tab of the left
pane.

¢ "Define an Impact Rule — Workflow" on page 331

¢ "Define an Enrichment Rule — Scenario" on page 384

o "Define a TQL Query" on page 22

¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
e "Create a Pattern View" on page 244

e "Create a Template" on page 245

o "Create a Perspective" on page 246
The Add Related Query Node Wizard contains:

"Related Query Node Type Page" > "Relationship Type Page" > "Related Query
Node Properties Page" > "Related Query Node Instances Page"

"Topology Query Language (TQL) Overview" on page 15

Related Query Node Type Page

This wizard page enables you to add a query node to the TQL query.

Important
information

Wizard
map

If the TQL query is empty, drag the required TQL query node on to the editing pane
from the tree displayed in the Configuration Item Types pane.

For general information on the Add Related Query Node Wizard, see "Add Related
Query Node Wizard" on the previous page.

The "Add Related Query Node Wizard" contains:

"Related Query Node Type Page" > "Relationship Type Page" > "Related
Query Node Properties Page" > "Related Query Node Instances Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Element
(A-Z)

B

B

Description

Click Expand All to expand all the folders in the tree.

Click Collapse All to collapse all the folders in the tree.

HP Business Service Management (9.24) Page 53 of 416



Modeling Guide
Chapter 1: Topology Query Language

ul
Element
(A-Z) Description
Tree View Click Tree View to select the display format of the Cl type tree. The following
2 options are available:
o Display label

e Class name
e Legacy class name

Note: This feature is only available in the Modeling Studio.

<query Define the relationship cardinality. For details, see "Query Node/Relationship
node> is | Properties Dialog Box" on page 68.
required

o Select the <query node> is required check box for each query node to include
a minimum of one instance of the query node at the other end of the relationship
in the query results. Selecting the check box gives the relationship a cardinality
value of 1..*.

e Clearthe <query node> is required check box to give the relationship a
cardinality value of 0..*.

<TQL Select the required query node. The query node you select appears in the Element
Query name box.

Node o . : . .
hierarchy This list only includes the query nodes of the Cl type that have valid relationships to
tree> the selected (source) query node.

To the right of each query node, the number of Cl instances that exist in the RTSM
for that Cl type is displayed. The number of instances is only updated after you
close the Add Related Query Node Wizard and open it again.

Note: The first query node in the hierarchy tree is selected by default.

Element  (Optional) Contains the name of the selected query node. By default, the Cl type is
name assigned as the element's name.

You can rename a TQL query node in the Element name box giving it a unique
label. This can be helpful when there is more than one query node of the same CI
type in the TQL query.

Show Select this check box to display only the CITs of which there are instances in the
only CITs RTSM. If this box is not selected, the tree includes all CITs with a valid link to the
with source query node.

instances

Note: The Show only CITs with instances check box is selected by default.
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Relationship Type Page

This wizard page enables you to add a relationship to a TQL query.

Wizard The "Add Related Query Node Wizard" contains:

map

"Related Query Node Type Page" > "Relationship Type Page" > "Related Query
Node Properties Page" > "Related Query Node Instances Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
Tree View B Click Tree Vi.ew to select. the display format of the Relationship tree. The
following options are available:
o Display label
o Class name
e Legacy class name
Note: This feature is only available in the Modeling Studio.
<TQL Query Select the required relationship.
Relationship

hierarchy tree>

Relationship Select the required relationship direction. The direction indicates which query
Direction node is dependent on the other.

Relationship The name of the relationship.

Name Note: This feature is only available in the Modeling Studio.

Relationship Select an option to define how to handle relationships between identical query

Restrictions

nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.

Note: This feature is only available in the Modeling Studio.

Relationship A valid relationship that defines the connection between the selected query

Type nodes. The box displays the relationship you selected in the relationship
hierarchy tree.
Note: This feature is only available in Enrichment Manager and Impact
Analysis Manager.

Show only Display only the relationships of which there are instances in the RTSM. If

relationships
with instances
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this box is not selected, the tree includes all valid relationships between the
selected query nodes.
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Related Query Node Properties Page

This wizard page enables you to create an expression that restricts the number of query nodes that
appear in the query by adding an attribute condition to a query node or relationship.

Important

When you access the wizard from the Modeling Studio, this wizard page has three

information tabs: Attribute, Element Type, and Element Layout. The Attribute tab includes

Wizard
map

the elements described below. For details on the Element Type tab, see
"Element Type Tab" on page 75. For details on the Element Layout tab, see
"Element Layout Tab" on page 77.

The "Add Related Query Node Wizard" contains:

"Related Query Node Type Page" > "Relationship Type Page" > "Related Query
Node Properties Page" > "Related Query Node Instances Page"

User interface elements are described below:

Ul
Element
(A-Z)

=n

1t

W
ot

And/Or

Attribute
name

Brackets
€ )

Criteria

Include
subtypes

Description

Add an attribute condition.

Delete an attribute condition.
Move a selected row up.

Move a selected row down.

View the condition definition.

Click inside the And/Or field and select either And or Or to link multiple conditions.

Choose an attribute from the list.

Click inside the Brackets box to display a list of brackets you can use to build more
complex, logical statements.

Contains the attribute condition definition as defined in the Element Instances Dialog
Box.

Display both the selected Cl and its children in the topology map.

Note: This check box is only available in the Enrichment Manager and Impact
Analysis Manager.
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ul

Element

(A-Z) Description

NOT Select NOT if you want the condition statement to do the opposite of what is defined.

Note: If you select NOT, query results do not include data from the Cl instances that
were not assigned a value. For example, your system contains three nodes: Node1
is assigned the value A, Node2 is assigned the value B and Node3 is not assigned a
value. You create a query to retrieve all nodes that are equal to A and select NOT;
the results of your query only include Node2 because Node3 is not assigned a value.

Operator = Select the required operator. For details, see "Attribute Operator Definitions" on page
34,

Show Select Show element in query results to display the selected TQL query node in
element  the editing pane. When the check box is cleared, a Hidden in Query Results

in query indicator & appears to the right of the selected TQL query node in the editing pane.
results

iy
IpAddres

antainment

% Membership @

Windows @
[pEumet

Any query results pertaining to that TQL query node are not displayed in the topology
map. This can be useful when certain relationships or TQL query nodes are required
to build the query but are not needed in the results. For example, Windows are
connected to the network by defining specific IP Addresses, but in any query results
you may want to view the IP Address elements only and not the Windows elements.

Value Enter or select the value of the attribute. The Value options vary according to the
attribute type you select.

Related Query Node Instances Page

This wizard page displays all the instances found for the selected TQL query node in a table.
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Important = The columns displayed in the report vary according to the Cl type selected.

information . . , .
By default, only columns corresponding to attributes that have been defined with

the Asset Data, Change Monitored, and Comparable attribute qualifiers in the
Cl Type Manager are displayed as columns in the dialog box. For details, see
"Attributes Page" on page 365.

If required, you can click the Display Hidden Columns button to display the
attributes that are defined as Visible but not Static. For details on Static attributes,
see "Attributes Page" on page 365.

Note: For information on the elements included in the Related Query Node
Instances page, see "Element Instances Dialog Box" on page 61.

Wizard The "Add Related Query Node Wizard" contains:

ma
P "Related Query Node Type Page" > "Relationship Type Page" > "Related Query

Node Properties Page" > "Related Query Node Instances Page"

Add Triplet Dialog Box

This dialog box enables you to define the allowed steps in a path in the topology graph leading from
the source Cl to the target Cl when creating a subgraph definition, a compound relationship, or a
calculated relationship.

Toaccess  , |nthe Add Compound Relationship dialog box, click the Add ¥ button. For
details, see "Add/Edit Compound Relationship Dialog Box" on page 43.

¢ Inthe Subgraph Definition dialog box, click + Add. For details, see
"Subgraph Definition Dialog Box" on page 86.

¢ InCl Type Manager, select Calculated Relationships from the drop-down list
in the Cl Types pane. In the editing pane, select the Triplets page and then

click ¥ Add.

Important Select the query nodes and relationships to be included in the topology graph.

information e .
Important: The Condition fields are displayed only when you access the Add

Triplet dialog box from the Subgraph Definition dialog box.
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Relevant
tasks

See also

¢ "Define an Impact Rule — Workflow" on page 331

¢ "Define an Enrichment Rule — Scenario" on page 384

o "Define a TQL Query" on page 22

¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
o "Create a Pattern View" on page 244

e "Create a Template" on page 245

o "Create a Perspective" on page 246

¢ "Compound Relationship" on page 18
¢ "Define a Compound Relationship — Scenario" on page 24

e " Subgraph Definition" on page 21

User interface elements are described below:

Ul Element
(A-Z)

&

Relationship

Relationship
Direction

Source

Target

Description

Define attribute conditions for the source and target query nodes you selected.
When the Add Triplet dialog box is opened from the Subgraph Definition dialog
box, it opens the Subgraph Condition Definition dialog box. When the Add Triplet
dialog box is opened from the Add Compound Relationship dialog box, it opens
the Compound Relationship Condition Definition dialog box.

The Condition button is enabled only after you select a query node from the
Source or Target lists.

Note: You cannot define attribute conditions for the source and target query
nodes in the Cl Type Manager.

Select an available relationship connecting the two query nodes. The list of
available relationships appears only after defining both query nodes.

Select the required direction. Setting different relationship directions can achieve
different query results. For an example, see "Setting Different Relationship
Directions for Compound Definitions" on the next page.

Note: The Relationship list remains empty until you have selected a source and
target.

Select the required source query node.

Select the required target query node.
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Setting Different Relationship Directions for Compound Definitions

You can achieve different TQL results by setting different relationship directions. For example, in
your business world, as illustrated below, you want to create a compound relationship that
connects between a query node of the CIT a and a query node of the CIT b. Depth is defined at 5
(for details, see "Depth" on page 88).

In the Add Triplet dialog box, you can create compound definitions to link query nodes a and b using
different relationship directions.

Compound Relationship

Definition Source Target Relationship Direction

#1 query node | query node ¢ = <relationship> source --> target
a

#2 query node | query node | <relationship> source --> target
c b

#3 query node | query node | <relationship> source <--target
c b

o Compound definitions 1 and 2 result in the following query:

Compound definitions 1 and 2
al = bl

o Compound definitions 1 and 3 result in the following query:
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Compound definitions 1 and 3
ail = b2

o Compound definitions 1, 2, and 3 result in the following query:

Conditions Preview Dialog Box

This dialog box displays the conditions selected when selecting a complex type condition in the
Element Type tab of the Query Node Properties dialog box.

To access Click the Preview button 54| from the Element Type tab of the Query Node
Properties dialog box.

User interface elements are described below:

Ul Element (A-2) Description

Cl Type Displays the subtypes for which you defined conditions.

Condition Displays the icon of the selected condition, as defined in the Legend.
Filter by Specifies the selected condition (by Cl type or by qualifier, and by

which qualifiers).

Element Instances Dialog Box

This dialog box displays all of the Cl instances found for the selected TQL query node in a table.
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To access  To access in Enrichment Manager, Impact Analysis Manager, and the
Modeling Studio:

In the editing pane, right-click the required query node and select Show Element
Instances.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Show Element Instances option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query button & tothe
right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Show Element’s Instances.

To access in Integration Studio:

Create an integration point based on a discovery jython adapter. In the Trigger CI
Instance menu, choose Select Existing CI.

Important The columns in the table display the attributes of the selected Cl type. The
information  attributes displayed vary according to the Cl type selected.

By default, only columns corresponding to attributes that have been defined with
the Asset Data, Change Monitored, and Comparable attribute qualifiers in the
CIT Manager are displayed as columns in the dialog box. For details, see
"Attributes Page" on page 365.

Relevant "Define an Impact Rule — Workflow" on page 331
tasks "Define an Enrichment Rule — Scenario" on page 384
"Define a TQL Query" on page 22
"Create a Pattern View" on page 244
"Create a Template" on page 245
"Create a Perspective" on page 246

"Work with Population Jobs" in the Data Flow Management Guide

"Work with Data Push Jobs" in the Data Flow Management Guide
User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2) Description

Show Cl instances of: | Metwork *.  Specify the CIT you want displayed in the table. The table
also includes the children of the selected CIT.
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Ul Element (A-Z) Description
% Click to delete the selected ClI.
S Click Show CI Properties to open the Configuration Item
Properties dialog box for the selected ClI.
|%| Click to refresh the list of Cl instances.
T Filters the Cl instances you want to display for the selected

query node. Opens the Filter Cl Instances dialog box.

Clears the filter definitions you created in the Filter Cl
Instances dialog box.

|@| Enables you to select the columns to be displayed. For
details, see "Select Columns Dialog Box" on page 412.

=t Enables you to set the sort order of the Cl instances. For
details, see "Sort Column Content Dialog Box" on page 413.

Q Click Find to display the Find toolbar.

B2 Click Send Mail to send the table data in an email.
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Ul Element (A-2) Description
# Choose the export format for the table data. The available
options are:

o Excel. The table data is formatted as an .xIs (Excel) file
that can be displayed in a spreadsheet.

o PDF. Thetable data is exported in PDF format.

Note: When exporting to PDF, select a reasonable
number of columns to display to ensure that the report is
legible.

e CSV. The table data is formatted as a comma-separated
values (CSV) text file that can be displayed in a
spreadsheet.

Note: For the CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. In Windows, to verify or modify the list
separator value, open Regional Options from the Control
Panel, and on the Numbers tab ensure that the comma is
defined as the List Separator value.

o XML. The table data is formatted as an XML file that can
be opened in a text or XML editor.

Tip: To extract HTML code from the report:
= Save thefileas HTML
= Open the file in an HTML editor

= Copy the relevant table into the target file

Rows per page Select the number of rows to be displayed on each page. You
can also manually enter value for the number of rows per
page.

K < | 3 of 16528 | ENE Click to navigate through the results page by page or to jump
to the first or last page.

<Element Instances> The Cl instances found for the selected TQL query node. You
can double-click an instance to open the Configuration Item
Properties dialog box for that ClI.

<Element instances shortcut = For details, see "IT Universe Manager Shortcut Menu" on

menu> page 211.
Display Label The name of the Cl instance as it appears in the topology
map.
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Element Layout Preview Dialog Box

This dialog box displays the attributes selected in the Element Layout tab of the Query Node
Properties dialog box to be included in the query results for the selected element.

To access Click the Preview button [“4] from the Element Layout tab of the Query Node

Properties dialog box.
User interface elements are described below:

Ul Element (A-2) Description

Attributes Mode Displays the Attributes condition selected in the Element Layout tab of
the Query Node Properties dialog box.

Cl Type Displays the CIT of the selected query node or relationship.

Excluded Attributes Displays the attributes appearing in the Excluded Attributes pane in
the Element Layout tab of the Query Node Properties dialog box.

Qualifier Marked Displays the qualifiers selected in the Element Layout tab of the Query
Attributes Node Properties dialog box.

Specific Attributes Displays the attributes appearing in the Specific Attributes pane in the
Element Layout tab of the Query Node Properties dialog box.

Filter Cl Instances Dialog Box

This dialog box enables you to reduce the number of Cl instances to be displayed in a list by
selecting a condition and a value for a specific Cl.

To access  Click the Filter T button in the Element Instances dialog box.

Important A description of the filter condition you defined appears above the table columns in
information = the Element Instances dialog box. For example, the following illustration shows

that a filter condition was created to display only Cl instances whose Cl type is
Windows.

Filter: Cl Type[Equal rt];

Dizgplay Lakel Cl Type
WIMEPUKRD Winclows
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Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
¢ "Define an Enrichment Rule — Scenario" on page 384
o "Define a TQL Query" on page 22
¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
o "Create a Pattern View" on page 244

e "Create a Template" on page 245

o "Create a Perspective" on page 246

User interface elements are described below:

Ul Element (A-

Z) Description

Attribute Displays all the attributes of the CI type to which the CI belongs.

Condition Select the required operator. For details, see "Attribute Operator Definitions"
on page 34.

NOT Select tofilter the results by the negation of a condition and value.

Value Select or enter the required value.

Join Relationship Condition Dialog Box

This dialog box enables you to define the connection between two query nodes using a join
relationship.

To access In Enrichment Manager or Impact Analysis Manager, click the Add ' button

in the Add Join Relationship dialog box.

Relevant tasks e "Define an Impact Rule —Workflow" on page 331
o "Define an Enrichment Rule — Scenario" on page 384
¢ "Define a TQL Query" on page 22

¢ "Implement a Discovery Adapter" in the RTSM Developer Reference
Guide.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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ul
Element
(A-Z) Description

<Selected A selected query node. The first attribute applies to <end_1>.
query

node1>

<Selected A selected query node. The second attribute applies to <end_2>.
query

node2>

Operator = Select one of the following operators:
o Equal. The system checks whether two selected attributes are equal.
o Not equal. The system checks whether two selected attributes are not equal.

¢ Sub string. The system checks whether the value of the first attribute is a
substring of the value of the second attribute.

o Sub string ignore case. The system checks whether the value of the first
attribute is a substring of the value of the second attribute regardless of the
string's case.

Important: When using the operator Not equal, ensure that both sides of the join
relationship have a limited result size. It is recommended to define more specific
conditions so as not to overload the system with large results.

Layout Settings Dialog Box

This dialog box enables you to determine which attributes are used in the calculation of the TQL
query when using the UCMDB API. For details, see "RTSM (HP Universal CMDB) Web Service
API" in the RTSM Developer Reference Guide.

To access | Click Advanced layout settings in the Query Node/Relationship Properties
dialog box in Enrichment Manager or Impact Analysis Manager.

Important Since this option is only relevant when querying the CMDB API, the query results
information  in the user interface are not impacted by the attributes you select in this dialog
box.
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Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
¢ "Define an Enrichment Rule — Scenario" on page 384
o "Define a TQL Query" on page 22
¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
o "Create a Pattern View" on page 244

e "Create a Template" on page 245

o "Create a Perspective" on page 246

User interface elements are described below:

Ul Element (A-Z) Description
Attribute name The name of the attribute.

Calculate Select this check box to include the attribute in the query's calculation.

Query Node/Relationship Properties Dialog Box

This dialog box enables you to define the attribute conditions for the selected TQL query
node/relationship.

To To access in Enrichment Manager, Impact Analysis Manager, and the Modeling
access Studio:

In the editing pane, right-click the required query node and select Query
Node/Relationship Properties.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Query Node Properties option.

To access in DFM:

1. Toaccess from the Adapter Definition tab, select an adapter. Click the ¢ Edit
Input Query button to the right of the Input Query box to open the Input Query
Editor.

2. Right-click the required query node/relationship and select Query Node
Properties or Relationship Properties.
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Relevant
tasks

¢ "Define an Impact Rule — Workflow" on page 331

¢ "Define an Enrichment Rule — Scenario" on page 384

o "Define a TQL Query" on page 22

¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
¢ "Create a Pattern View" on page 244

e "Create a Template" on page 245

e "Create a Perspective" on page 246

User interface elements are described below:

Ul
Element
(A-Z)

Element
name

Element

type

Include
subtypes

Query
Result

Description

(Optional) The Element name box contains the name of the selected query
node/relationship. By default, the Cl type is assigned as the element's name. You
can rename a TQL query node in the Element name box giving it a unique label. This
can be helpful when there is more than one query node of the same ClI type in the
TQL query.

Displays the Cl type of the selected query node. If you want to change the query
node type to a child of the original type, select a subtype from the drop-down list.

Note:

o If you have already defined a complex type condition for the query node, the
condition is lost when you change the query node type.

o This feature is only available in the Modeling Studio.
Select to display both the selected Cl and its children in the topology map.

Note: This feature is only available in Enrichment Manager and Impact Analysis
Manager.

Click Query Result to display a topology map of the TQL query showing the number
of instances of each query node/relationship.

Note: This feature is only available in the Modeling Studio.
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ul

Element

(A-Z) Description

Show Select Show element in query results to display the selected TQL query node in

element  the editing pane. When this option is cleared, a Hidden in Query Results indicator
in query [ appears to the right of the selected TQL query node in the editing pane.

results
[pAddres
ontainment
(&2 | Membership .
. =
Windows m
[Etrmet
Any query results pertaining to that TQL query node are not displayed in the topology
map. This can be useful when certain relationships or TQL query nodes are required
to build the query but are not needed in the results. For example, Windows are
connected to the IP Subnet by defining specific IP Addresses, but in any query
results you may want to view the IP Address elements only and not the Windows
elements.
Attribute Tab

This area enables you to create an expression defining conditions that restrict the number of query
nodes that appear in the query. You can add an attribute condition to a query node or relationship
and filter the query results.

To access Click the Attribute tab in the Query Node/Relationship Properties dialog
box.

Important This tab is not available for calculated relationships.

information
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Relevant tasks ¢ "Define an Impact Rule — Workflow" on page 331
¢ "Define an Enrichment Rule — Scenario" on page 384
o "Define a TQL Query" on page 22

¢ "Implement a Discovery Adapter" in the RTSM Developer Reference
Guide

e "Create a Pattern View" on page 244
e "Create a Template" on page 245

e "Create a Perspective" on page 246

User interface elements are described below:

Ul Element
(A-2) Description
gp Add the attribute condition you have defined.
% Delete an attribute definition.
1t Move a selected row up.
1L Move a selected row down.
=% Display the criteria in a popup dialog box.
Advanced Opens the Layout Settings dialog box which enables you to determine which
layout attributes are used in the calculation of the TQL query when querying the
settings RTSM using third-party or custom tools.
Note: This feature appears only in Enrichment Manager and Impact Analysis
Manager.
And/Or Click inside the And/Or field and select either And or Or to link multiple
conditions.
Attribute Select an attribute from the drop-down list.
name
Note: When you select one of the following attribute types: float, double, or
long, the In operator is not available.
Brackets Click inside the Brackets box to display a list of brackets you can use to build
() more complex, logical statements.
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Ul Element
(A-2) Description
Criteria Contains the attribute condition definition as defined in the Element Instances

dialog box.
Default Value @ For parameterized attributes, enter a default value for the parameter.

Not Select NOT if you want the condition statement to do the opposite of what is
defined.

Note: If you select NOT, query results do not include data from the CI
instances that were not assigned a value. For example, your system contains
three nodes: Node1 is assigned the value A, Node2 is assigned the value B
and Node3 is not assigned a value. You create a query to retrieve all nodes that
are equal to A and select NOT; the results of your query only include Node2
because Node3 is not assigned a value.

Operator Select the required operator. For details, see "Attribute Operator Definitions" on
page 34.

Note: When you select one of the following attribute types: float, double, or
long, the In operator is not available.

Parameterized Select Yes to define a parameterized value for the attribute. Select No to
define a fixed value for the attribute.

Note: This feature is only available in the Modeling Studio.

Parameter If you are defining a parameterized value for the attribute, you must enter the
Name parameter name.

Note: This feature is only available in the Modeling Studio.

Value Enter or select the value of the attribute. The Value options vary according to
the attribute type you select.

Note: You can paste a copied value into the window by pressing CTRL+V on
the keyboard.

Cardinality Tab

In this area, you can define a relationship cardinality, which enables you to define how many ClI
instances you expect to have at the end of a relationship in your query result.

To access  Click the Cardinality tab in the Query Node Properties dialog box.
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Important Select the required relationship to which the selected query node is attached.
information = Then define the lower and upper limits for including the query node at the other end
of the relationship in the query results.

You can define relationship conditions that enable the relationship's connecting
query node to be included in the TQL query results by creating an expression
defining that condition. For an example, see "Example of a Relationship
Condition" on the next page.

Note: This tab only appears when a query node is selected.

Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
¢ "Define an Enrichment Rule — Scenario" on page 384
o "Define a TQL Query" on page 22
o "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
e "Create a Pattern View" on page 244

e "Create a Template" on page 245

o "Create a Perspective" on page 246

User interface elements are described below:

Ul Element (A-Z) Description

Add the cardinality definition you have defined.
Delete a cardinality definition from the Cardinality area.
Move a selected row up.

Move a selected row down.

Display the criteria in a popup dialog box.

Note: Only relevant for the Modeling Studio.

Inserts 0 in the Min box and * in the Max box.

4p

®

1+

Lr

(%

p—— Inserts 1 in the Min box and * in the Max box.
h_

hd

Note: Only relevant for the Modeling Studio.

And/Or Click inside the And/Or field and select either And or Or to link multiple
conditions.
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Ul Element (A-Z)

Brackets ( 2

Criteria

Max

Min

Query Node

Not

Description

Click inside the Brackets box to display a list of brackets you can use to
build more complex, logical statements.

Contains the cardinality condition definition as defined in the Element
Instances Dialog Box.

Enter the value that defines the upper limits for including the query node
at the other end of the relationship in the query results.

Note: You can use an asterisk (*) in the Max box to represent an infinite
value.

Enter the value that defines the lower limits for including the query node
at the other end of the relationship in the query results.

For example, if <end_1> is IpAddress and <end_2> is Windows,
entering 1 in the Min box and asterisk (*) in the Max box instructs the
system to retrieve only those IP Addresses that are connected to at
least one Windows operating system. (The asterisk indicates an infinite
value.) Entering 3 in the Min box and asterisk (*) in the Max box
instructs the system to retrieve only those Windows operating systems
that are connected to at least three IP Addresses.

Select the required relationship to which the selected query node is
attached. The list contains all the relationships that are linked to the
selected query node.

Select NOT if you want the condition statement to do the opposite of
what is defined.

Note: If you select NOT, query results do not include data from the Cl
instances that were not assigned a value. For example, your system
contains three nodes: Node1 is assigned the value A, Node2 is
assigned the value B and Node3 is not assigned a value. You create a
query to retrieve all nodes that are equal to A and select NOT; the
results of your query only include Node2 because Node3 is not assigned
avalue.

Example of a Relationship Condition

The example of relationship conditions is based on the following TQL query:
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A
[pAddres

ontainment

| Membership __
] 7

o =

o]
IpsSubnet

In the Relationship Cardinality dialog box, the following relationship conditions are defined for the
query:

o Containment —Min: 2, Max: 4
¢ Membership —Min: 1, Max: *

Using the OR operator, the definitions appear in the Cardinality section, as follows:

Mot | ( | Criteria . ) | Andior
Containment (Mode, IpAddress) : 2.4 OR
Membership (pSubnet, Mode): 1.*

e [Containment (Node, IP Address)] OR [Membership (IP Subnet, Node)] means that
the node must either have between two and four IP Addresses OR be a member of the IP
Subnet.

Using the AND operator, the definitions appear in the Cardinality section, as follows:

wotr | ( | Criteria ') | Angior
Containment (Mode, lpAddress): 2.4 ARD
Membership (pSubnet, Mode) . 1.*

e [Containment (Node, IP Address)] AND [Membership (IP Subnet, Node)] means that
the node must have between two and four IP Addresses AND also be a member of the IP

Subnet.
Element Type Tab
This area enables you to specify subtype conditions for the selected query node or relationship.
To access Click the Element Type tab in the Query Node/Relationship Properties
dialog box.
Important This tab is only available in the Modeling Studio.
information

This tab is not available for calculated relationships.
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Relevant tasks o "Define a TQL Query" on page 22
e "Create a Pattern View" on page 244
e "Create a Template" on page 245
o "Create a Perspective" on page 246

¢ "Define a Complex Type Condition - Scenario" on page 28

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Legend> Indicates the icons displayed next to the subtypes based on the
selected conditions:

o @ Includethe subtype without its descendants.
o ¥ Include the subtype with its descendants.

o ™ Excludethe subtype without its descendants.

. W Exclude the subtype with its descendants.
Cl When Customize subtypes is selected, the Cl Types pane displays a
Types/Relationships tree with all subtypes of the selected Cl type (for relationships, the
pane Relationships pane displays a tree with all subtypes of the selected

relationship). After selecting conditions in Conditions pane, click the
Preview button to open the Conditions Preview dialog box.

Conditions pane For details, see "Conditions Pane" below.

Customize subtypes Select Customize subtypes to set a complex type condition. Select the
required subtypes from the tree in the CI Types/Relationships pane and
select conditions for them in the Conditions pane, as described below.

Element type Select Element type to set a simple type condition. If you want to
include all subtypes of the selected Cl type, select the Include
subtypes check box. If you do not want to include all subtypes, clear
the check box.

Conditions Pane

HP Business Service Management (9.24) Page 76 of 416



Modeling Guide
Chapter 1: Topology Query Language

Ul Element (A-Z) Description

Apply this condition = Select this check box to apply the specified condition for the selected Cl
recursively on all type to all of that Cl type's descendants, recursively.

subtypes of

<selected CI type>

By ClI types Select By Cl types to include or exclude all instances of the selected
Cl type in the query results.

By qualifiers Select By qualifiers to include or exclude instances of the selected ClI
type with specific qualifiers in the query results. A popup appears with a
list of qualifiers. Select the required qualifiers for the selected subtype.
For details on the qualifiers, see "Qualifier Tab" on page 79.

Condition Select a condition for the selected ClI type. The following options are
available:

¢ None. No condition is selected for this Cl type. Instances of this ClI
type and all its descendants are included in the query results, unless
a parent Cl type of this Cl type was selected for exclusion and the
Apply recursively check box was selected.

¢ Include <selected subtype> in the query. Includes instances of
the selected Cl type in the query results (according to the condition
selected). An example of a situation where this option is relevant is
where a parent of the Cl type was selected to be excluded and the
Apply recursively check box was selected. You can select certain
subtypes to be included, so the query results exclude all subtypes of
the parent Cl type except for the specified ones.

o Exclude <selected subtype> from the query. Excludes instances
of the selected CI type from the query results (according to the
condition selected).

Element Layout Tab

This area enables you to select the attribute values returmned in the query results for the selected
query node or relationship.

To access  Click the Element Layout tab in the Query Node/Relationship Properties dialog
box.

HP Business Service Management (9.24) Page 77 of 416



Modeling Guide
Chapter 1: Topology Query Language

Important = When you make a selection of the attributes to include in the query results fora
information  particular CIT, the selection also applies to all of its descendant CITs. You can
manually exclude specific attributes for descendant CITs in the Conditions pane.

This option is only relevant when querying the CMDB API. The query results in
the user interface are not impacted by the attributes you select in this dialog box.

This tab is only available in the Modeling Studio.
This tab is not available for calculated relationships.

Relevant o "Define a TQL Query" on page 22
tasks
o "Create a Pattern View" on page 244
e "Create a Template" on page 245

o "Create a Perspective" on page 246

¢ "Define a Complex Type Condition - Scenario" on page 28

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Legend> Indicates the icons displayed next to the subtypes based on the
selected attributes condition:

« @ Include all attributes for this subtype.

o % Include only the selected attributes for this subtype.

Cl When Select attributes for layout is selected, the Cl Types pane
Types/Relationships displays a tree with all subtypes of the selected Cl type (for
pane relationships, the Relationships pane displays a tree with all subtypes of

the selected relationship). After selecting conditions in Conditions pane,
click the Preview button to open the Element Layout Preview dialog

box.
Conditions pane For details, see "Conditions Pane" below.
No attributes If you select No attributes, no attribute values are returned in the query

results for the selected query node or relationship.

Select attributes for  If you select Select attributes for layout, you can select the attributes
layout to be included in the query results for the selected query node or
relationship.

Conditions Pane

HP Business Service Management (9.24) Page 78 of 416



Modeling Guide
Chapter 1: Topology Query Language

Ul Element (A-Z) Description

Attributes condition = Select one of the following options:

¢ None. No attributes are included in the query results for the selected
element.

o All. All attributes defined for the selected element are included in the
query results.

o Specific Attributes. Only the selected attributes are included in the
query results for the selected element.

Attributes with the You can include attributes with specific qualifiers. Click the ellipsis
following qualifiers | button to open a dialog box with the available qualifiers and select the
required qualifiers.

Note: This feature only appears when you select Specific Attributes
for the Attributes condition.

Available Attributes Displays all of the available attributes for the selected element.

Excluded Attributes = When All is selected as the Attributes condition, you can exclude
selected attributes by moving them into the Excluded Attributes pane.

When Specific Attributes is selected as the Attributes condition for a
CIT that has inherited an attribute selection from its parent CIT, you can
exclude specific attributes from the selection by moving them to the
Excluded Attributes pane.

Alternatively, if you select attributes with selected qualifiers fora CIT,
you can exclude some attributes from that selection by moving then to
the Excluded Attributes pane.

You can move attributes into and out of the pane using the arrow

buttons.
Exclude Specific Select this check box to enable the Available Attributes and Excluded
Attributes Attributes panes and the arrow buttons.

Note: This feature only appears when you select All for the Attributes
condition.

Specific Attributes Displays the attributes to be included in the query results for the
selected element. Move attributes into and out of the pane using the
arrow buttons.

Note: This feature only appears when you select Specific Attributes
for the Attributes condition.

Qualifier Tab

This area enables you to define qualifier conditions for the selected query node or relationship. For
example, you can use a qualifier to define a CIT as abstract, meaning you cannot create instances
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fromit.

To access Click the Qualifier tab in the Query Node/Relationship Properties dialog
box.

Important By default, multiple selection links the conditions with the OR operator.

information . . . . .
Note: This tab is only available in the Enrichment Manager and Impact
Analysis Manager.

Relevant tasks ¢ "Define an Impact Rule — Workflow" on page 331

¢ "Define an Enrichment Rule — Scenario" on page 384
¢ "Define a TQL Query" on page 22

o "Implement a Discovery Adapter" in the RTSM Developer Reference
Guide

o "Create a Pattern View" on page 244
e "Create a Template" on page 245

o "Create a Perspective" on page 246

User interface elements are described below:

Ul Element (A-

Z) Description

ABSTRACT_ You cannot create instances of this CIT.
CLASS
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Ul Element (A-
Z)

ALLOW _
VOLATILITY

BLE_LINK_
CLASS

CALCULATED_
LINK

CONTAINER

HIDDEN_
CLASS

ID_CLASS_
NAME_
OVERRIDE

Description

Used to mark attributes that enable minor deviations to their value. For
example, there is probably no need to report a small disk size change (from
8.00008 to 8.00009 GB).

By default, ALLOW_VOLATILITY is enabled for the following numeric or
date attributes only:

o CIT: Node

= MemorySize

= SwapMemorySize

These attributes also include comparable and static qualifiers.

o CIT: Host

= HostlLastBootTime
o CIT:CPU

= CpuClockSpeed
o CIT: Filesystem

n Disk_size

For details of this qualifier's attributes and the procedure for activating and
deactivating this feature, see " The ALLOW_VOLATILITY Qualifier" on page
22,

A relationship that has been assigned this qualifier is loaded by an online BLE
engine TQL and becomes part of the Dashboard status calculations.

This qualifier is assigned to calculated relationships
This qualifier is assigned to relationships that signify a containment
relationship, such as Membership, Composition, Containment.

Instances of this CIT do not appear anywhere in the application.

Indicates that the class ID is calculated based on another class.
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Ul Element (A-
Z)

ITU_HIDDEN_
CLASS

MAJOR_APP

MODELING_
ENABLED

NETWORK_
DEVICES

Negate
Qualifiers

RANDOM_

GENERATED_

ID_CLASS

READ_ONLY_
CLASS

RECURSIVE_
DELETE

TRACK_LINK_

CHANGES

Identity Tab

Description

Instances of this CIT do not appear in the topology map application.

Cl types that are assigned this qualifier appear in the Application Breakdown
overview report.

Enables a CIT to act as a model in Modeling Studio. For details, see
"Business Cl Models" on page 235.

A qualifier common to all the Cl types that represent a network device. It can
be used for TQL queries related to network devices and serves as a
replacement for Cl types in a query.

If this check box is selected, then the element is included in the query results
only if it has no qualifier in the list of selected qualifiers.

Indicates that the RTSM ID of the Cls is randomly generated rather than
being based on the key attributes of the class.

This CIT cannot be edited.

Relevant for relationships. When the Cl at one end of a relationship is
deleted, the system checks the Cl at the other end of the relationship. If it is
not related to any other Cls, it is also deleted.

Changes that occur in the specified relationship appear in Change reports.

This area enables you to filter the TQL query results according to the element ID of the instances
found for the selected TQL query node.

To access

Important
information

Click the Identity tab in the Query Node Properties dialog box.

Move the required element from the Optional identities pane on the left to the
Selected identities pane on the right to define what you want included in the TQL

query results using the left and right arrows.

Note: This tab only appears when a query node is selected.
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Relevant ¢ "Define an Impact Rule — Workflow" on page 331

tasks
¢ "Define an Enrichment Rule — Scenario" on page 384

o "Define a TQL Query" on page 22

¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
e "Create a Pattern View" on page 244

e "Create a Template" on page 245

o "Create a Perspective" on page 246

The following elements are included (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Toolbar> For descriptions of the toolbar buttons, see "Element Instances Dialog
Box" on page 61.

Optional identities Displays all the instances found for the selected TQL query node.
pane

Selected identities = Displays the elements that are used to define what should be included in
pane the TQL query results.

Refine Query Node Type Dialog Box

This dialog box enables you to change the Cl type of a TQL query node after you have created a
TQL query.

To access In Impact Analysis Manager or Enrichment Manager, right-click the required query
node and select Refine Query Node Type.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Refine Query Node Type option.

Important You can change the Cl type to a type from one of the CI type's children, if one
information  exists. If no such Cl type exists, this option does not appear.
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Relevant .
tasks

"Define an Impact Rule — Workflow" on page 331

"Define an Enrichment Rule — Scenario" on page 384

"Define a TQL Query" on page 22

"Implement a Discovery Adapter" in the RTSM Developer Reference Guide
"Create a Pattern View" on page 244

"Create a Template" on page 245

"Create a Perspective" on page 246

Select Relationship Type Dialog Box

This dialog box enables you to select the type of TQL relationship to be created.

To access In the editing pane of Impact Analysis Manager, Enrichment Manager, and the

Modeling Studio, click the Create Relationship I} button in the toolbar and
draw a line between two query nodes. The Select Relationship Type dialog box
opens automatically.

Important Select one of the following relationship types:

information

Relevant .
tasks

Regular Relationship. For details, see "Add/Edit Relationship Dialog Box"
on page 50.

Join Relationship. For details, see "Add/Edit Join Relationship Dialog Box"
on page 47.

Compound Relationship. For details, see "Add/Edit Compound
Relationship Dialog Box" on page 43.

Calculated Relationship. For details, see "Add/Edit Calculated Relationship
Dialog Box" on page 41.

"Define an Impact Rule — Workflow" on page 331

"Define an Enrichment Rule — Scenario" on page 384

"Define a TQL Query" on page 22

"Implement a Discovery Adapter" in the RTSM Developer Reference Guide
"Create a Pattern View" on page 244

"Create a Template" on page 245

"Create a Perspective" on page 246
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Subgraph Condition Definition Dialog Box

This dialog box enables you to create conditions that restrict the number of query nodes that appear
in the query.

To access In Impact Analysis Manager and Enrichment Manager, click Condition £ inthe

Add Triplet dialog box.

In the Modeling Studio, click Condition ¢ inthe Subgraph Definition dialog box.

Important Contains the following tabs:
information
o Attribute. Enables you to define attribute conditions for query nodes and
relationships. See a description of the elements in the Attribute tab in the table
below.

¢ Qualifiers (for Enrichment Manager and Impact Analysis Manager). Enables
you to define qualifier conditions for the selected query node or relationship.
For details, see "Qualifier Tab" on page 79.

o Element Type (for the Modeling Studio). Enables you to define subtype

conditions for the selected query node or relationship. For details, see
"Element Type Tab" on page 75.

Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
¢ "Define an Enrichment Rule — Scenario" on page 384
o "Define a TQL Query" on page 22
¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
o "Create a Pattern View" on page 244

e "Create a Template" on page 245

o "Create a Perspective" on page 246

User interface elements are described below:

Ul Element

(A-2) Description

< Add the subgraph condition definition.
iy Delete the subgraph condition definition.
i+ Move a selected row up.
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Ul Element
(A-Z)

W

Advanced
layout
settings

And/Or

Attribute
name

Brackets
(]

Criteria
Element

Name

Not

Operator

Value

Description

Move a selected row down.

View the subgraph condition definition.

Opens the Layout Settings dialog box which enables you to determine which
attributes are used in the calculation when querying the RTSM using third-party
or custom tools.

Note: This option is only relevant when accessing the dialog box from the
Modeling Studio.

Click inside the And/Or field and select either And or Or to link multiple
conditions.

Choose an attribute from the list.

Click inside the Brackets box to display a list of brackets you can use to build
more complex, logical statements.

Contains the attribute condition definition as defined in the Element Instances
Dialog Box.

Contains the CIT selected from the Source and Target lists.

Select NOT if you want the condition statement to do the opposite of what is
defined.

Note: If you select NOT, query results do not include data from the CI
instances that were not assigned a value. For example, let us assume that your
system contains three nodes. Node1 is assigned the value A, Node2 is
assigned the value B and Node3 is not assigned a value. If you create a query
in which you want to retrieve all nodes that are equal to A and you select NOT,
the results of your query only include Node2 because Node3 is not assigned a
value.

Select the required operator. For details, see "Attribute Operator Definitions" on
page 34.

Enter or select the value of the attribute. The Value options vary according to
the attribute type you select.

Subgraph Definition Dialog Box

This dialog box enables you to create a graph that represents additional TQL query data related to a

specific CI.
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To access To access in Enrichment Manager, Impact Analysis Manager, and the Modeling
Studio:

In the editing pane, right-click the required query node and select Subgraph
Definition.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Subgraph Definition option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the ¢ Edit Input Query button to the
right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Subgraph Definition.

Important The following icon is displayed next to the query node for which you define a
information | subgraph:

il

i
Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
o "Define an Enrichment Rule — Scenario" on page 384
¢ "Define a TQL Query" on page 22
o "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
o "Create a Pattern View" on page 244
o "Create a Template" on page 245
o "Create a Perspective" on page 246
See also o " Subgraph Definition" on page 21

o "Create a Subgraph Definition — Scenario" on page 29

User interface elements are described below:

Ul Element
(A-2) Description
s Add a subgraph definition. In Enrichment Manager and Impact Analysis

Manager, click to open the Add Triplet dialog box. In the Modeling Studio, click to
add a row to the table.
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Ul Element

(A-2) Description

¢ Delete a subgraph definition.

W Edit a subgraph definition. In Impact Analysis Manager and Enrichment
Manager, click to open the Edit Triplet dialog box. In the Modeling Studio, click to
open the Subgraph Condition Definition dialog box.

Depth A number that represents the longest path (that is, the maximum connecting
query nodes) allowed between two Cls in the RTSM that should be included in
the DFM process.

Default: 5

Element A green asterisk appears next to either the source, relationship, or target in the

condition subgraph definition if an attribute condition has been defined for one of them in

exists the Subgraph Condition Definition dialog box. For details, see "Subgraph

Condition Definition Dialog Box" on page 85.
Relationship The relationship selected connecting the source to the target query node.

Relationship The direction of the relationship selected, indicating which query node is

Direction dependent on the other.
Source The required source query node selected.
Target The required target query node selected.

User Preferences Dialog Box

This dialog box enables you to reset system preferences.

To access | Select Tools > User Preferences or click the Configure User Preferences
button e in the Status Bar.

Important | All the preferences you select (such as whether to display certain wizard pages or
information = warning message preferences) are stored in the system. This dialog box enables
you to reset those preferences.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element
(A-2) Description

<Left pane> Select the preferences page to edit. The following options are available:

o Wizard Preferences. Enables you to define whether to hide or display
certain wizard pages.

« Optional Messages Preferences. Enables you to define whether to hide or
display certain messages.

« Discovery Preferences. Enables you to define:
= Whether to hide or display certain Discovery warning messages
= The required default external editor (such as Notepad)
= Whether to use Basic or Advanced Discovery mode

o General. Enables you to define general application preferences.

<Preferences The list of warning messages and their user-selected preferences.

list>
Filter by Enter a search word to filter the list of options.
Reset All Click toreset all the preferences to their default values.

Reset Page Click toreset the selected preference to its default value.

Troubleshooting and Limitations

This section describes troubleshooting and limitations for Topology Query Language.

o If you get an error while working with views in the Modeling managers, when adding Cls to the
CMDB, or when updating existing Cls, and the error log indicates that objects are missing in the
database, access the JMX console and run the following methods under service = DAL
services:
= rebuildModelViews

= rebuildModelDBSchemaAndViews

o If youreceive the message Active query quota is exceeded when saving the first enrichment
rule in a new BSM installation, you can either increase your model capacity level from small to
medium or large (depending on your resources), or manually deactivate TQLs which you do not
need. You can manually deactivate TQLs using the JMX Console, or by editing the TQL
definitions from the GUI.

o For TQL queries to be valid, they must comply with certain restrictions.
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Understanding Validation Restrictions

For Impact Analysis, Discovery, and Enrichment TQL query types to be valid, they must comply
with the following restrictions:

= Unique Names. TQL query elements must have unique names.

= Self Relationships. A TQL query must not contain self relationships, that is, a relationship
must not lead from a query node to itself, as the following example illustrates:

Route

~ Containment |mL—4_|
W
IpAddrass
Mode

= Cyclic Graph. The TQL query structure cannot be a closed circle, as shown in the following

example:
mMananed Relationship
Cantainment
Configurationltermn
IpAddress 'a
Membership
oute

Ipﬁddresaj

= Separate Query Nodes and Groups. All the TQL query nodes must be linked to one
another, that is, the TQL query cannot contain separate query nodes or groups, as the
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following example illustrates:

= —

Containment C':""”F'!Ilaltn:un

|
¥

AI_-T.-.‘:J o
ATl Port Bridge

Impact Analysis TQL Query Validation

Impact Analysis TQL queries must also comply with the following restrictions:

= Number of query nodes. An Impact Analysis TQL query must consist of at least two query
nodes.

= Trigger and affected query nodes must be connected. There must be a path of
relationships from the triggered query node to the affected query nodes.

= Selecting query nodes to function as Impact Analysis triggers. When selecting query
nodes to function as Impact Analysis triggers, the query nodes must comply with the
following restrictions:

o You can select more than one query node as a trigger. However, you cannot define a query
node both as affected and as a trigger.

o If aquery node has a relationship whose minimum limit is O (meaning that one of its ends
does not necessarily have a query node linked to it), the query node that is linked to its
other end cannot be a root cause query node (because it may or may not exist in the TQL
query). For details about minimum limits, see "Cardinality Tab" on page 72. For example,
Configuration Item cannot be either a root cause or affected query node because it is
connected to the query node with a Min limit of o.
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Cardinality: Containment (Mode, lp&ddress) : 1..* AND
[ | Composition (Maode, Configurationttem) : 0..*

o
| Mode
r - .
.—"-‘ )
Lt fainment
“’- .
(;prﬂpusnmn ) .
" AL
Configurationitern IpAddress

cardinality: Composition (Mode, Configurationttem) : 1..* Cardinality: Containment (Mode, [pAddress) 1.

Note: A query node that is hidden cannot be a root cause or an affected query node.

= The connection between trigger and affected query nodes. The trigger query node and
affected query nodes you define must be connected by a path of relationships from the
triggered query node to the affected query nodes.

Enrichment TQL Query Validation

Enrichment TQL queries must comply with the following restriction:

= Required elements. You cannot perform Enrichment on a non-required query node, that is, a
query node that does not necessarily appear in the TQL query results.

Example 1. In this example, the TQL query results can be either A and B or A and C.
Therefore, you cannot add an Enrichment query node to query nodes B or C because they are
not required elements. You can add an Enrichment query node to query node A because it
always appears in the TQL query results. For details on how to add Enrichment query nodes
and relationships, see "Add Enrichment Query Nodes and Relationships to an Enrichment
TQL Query" on page 388.

HP Business Service Management (9.24) Page 92 of 416



Modeling Guide
Chapter 1: Topology Query Language

'

!
;énrichrnent relationship

Example 2. In this example, both A and B are required elements that always appear in the
TQL query results. Only C is not a required element because it has a cardinality of 0.
Therefore, you cannot add an Enrichment query node to it.

)
Ervichment relationstip
!
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Impact Modeling Overview

The impact model enables you to determine the direction of the propagation of the IT infrastructure
Cls in your business world. The direction of the impact is not always the same direction as the
physical relationships taken from the CI Type model.

The impact model uses the impact layer to change the propagation direction. The impact layer is
used in the applications where propagation occurs. You change the direction of the impact using the
impact layer, regardless of the direction of the physical relationships.

All KPI propagation is affected by the impact model. For details on KPI propagation in Service
Health, see "Propagation Rules" in the BSM User Guide. For details on KPI propagation in Service
Level Management, see "Propagation Rules" in the BSM User Guide.

Impact Layer

The impact layer changes the direction of the impact. The impact layer separates the impact
direction from the CI Type model, creating an independent layer on top of the Cl Type model. This
means that components affected by the impact model are no longer relying on the physical
relationships as defined in the Cl Type model. As a result, the impact direction is no longer
necessarily identical to the direction of the physical relationships in the Cl Type model.

Impact Rules

The impact layer consists of impact rules. The impact rules are defined in the Cl Type Manager. For
details, see "Triplets Page" on page 369.

An impact rule is defined by one or more triplets. Each triplet is defined by the following
components:

e One source Cl type

e Onetarget Cl type
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o A physical relationship type (for example, Containment) that links the two CI types

o The required impact direction. The direction of the impact can be identical to or opposite from the
direction of the physical relationship between the source and target Cls.

BSM implements the impact layer by creating calculated relationships that are defined by impact
rules. Once one of the triplets fulfills the impact rule condition, BSM automatically creates the
calculated relationship based on the triplet definition.

Since calculated relationships are defined by physical relationships from within the class model,
their lifetime is determined by the lifetime of the physical relationships defined in the impact rule.
When the physical relationship in the class model is removed, the corresponding calculated
relationship is removed from all view results as well.

Note: If you create a new ClI type or relationship in the Cl Type Manager, you need to define
the required triplets. For example, to enable the impact model to properly affect KPI
propagation. If the triplets are not defined, the required KPIs are not included in the Dashboard
views and SLA agreements.

You can use calculated relationships to create TQL queries just like any other relationship in the Cl
Type model. This enables you to base Enrichment rules, Impact rules, and views on calculated
relationships. Calculated relationships affect the results of all TQLs that use that calculated
relationships since calculated relationships are part of the class model.

Example of an Impact Rule Definition:

@J Web Service Link {:? Running Software =

Propagation Reversal

The following example illustrates a scenario in which propagation is reversed.
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| {Calculated relationship -
Containment ‘same direction as physical

e

Calculated relationship -

T Same direction as physical r
- Contalnment
Calculated
redationship —
C:Jr'l.‘-‘.inrﬂ:;}r'l dIrEEIE;;TE;:EHE

Monitored By

Based on the impact rules defined in the Cl Type Manager, the impact is propagating from the
Business2 Cl to Business1, the same direction as the physical relationship that is connecting the
Running Software Cl to Business2.

According to the direction of the physical relationship between the Running Software Cl and the
Node, the Running Software Cl should impact the Node.

But based on the following impact rule, a calculated relationship is automatically created and BSM
reverses the impact of the propagation.

% Mode Lirk u Running Software =

The impact is now propagated from the Node to the Running Software.

Calculated Relationship Types

There is one out-of-the-box calculated relationship called Impacted By. Impacted By contains two
subtypes, each one representing a different type of dependency relationship (complete dependency
vs. potential dependency.)

« Impacted by (Directly). Represents the fact that one Cl that is linked to another Cl using an

Impacted By (Directly) relationship is part of that Cl. You use an Impacted By (Directly)
relationship for those Cls that you want to see in your model. The ownership of the two Cls may
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be the same, but this is not always the case.

« Impacted By (Potentially). Represents the fact that one Cl consumes the products of another.
Cls that are linked by an Impacted By (Potentially) relationship are not part of that model, but are
listed as related Cls. For details, see "Model Editor" on page 267.

Creating Views Based on the Impact Model

As a best practice, you should use Modeling Studio to create a view of calculated relationships
based on a model. Modeling Studio enables you to create perspective based views that use
calculated relationships instead of physical relationships. For details, see "Modeling Studio" on
page 228.

For details on how to create and edit models, see "Model Editor" on page 267.

Note: For an in-depth description of the Impact Modeling Solution, see "Best Practices for
Modeling" on page 168.
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Generate a Direct Link - Overview

Direct Links enables you to create a URL that guides another user to a specific target view or Cl in
BSM.

You can create a URL that:

o Opens a specific BSM view or Cl directly in BSM. This enables users to retrieve information
from BSM without being located in the BSM context.

Note: To open a specific view or Cl directly in BSM, use the Open in context links option.
For details, see "Select Command Page" on page 102.

« Enables integration with BSM:
= If you create a URL using the Embedded links option, the URL takes you first to the BSM

login page. After you enter your login name and password, the target page opens in your
browser.

Note: To open the target page in your browser, use the Embedded links option. For
details, see "Select Command Page" on page 102.

When you create a URL, you can:

o Send the URL to an email recipient

e Copy the URL to the clipboard

o Test the URL to ensure that the target application page can be found

The user to whom you are sending the URL must have an account with sufficient privileges to open

the target page. You must apply the appropriate viewing and editing permissions to the users and
user groups that want to access the target view. You set permissions in Admin > Platform >
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U

sers and Permissions, select a user or a group and select Permissions. For details, see "How

to Assign Permissions" in the BSM Platform Administration Guide.

Note: You can use Link to this Page function to open a target BSM page in your browser.
While the Link to this Page function enables you to access another application page in BSM,
it does not enable you to access a specific Cl or view. For details, see "Linking to a Specific
Page" in the BSM Platform Administration Guide.

Generate a Direct Link - Scenario

This scenario describes how to generate a direct link to email the URL of a specific Cl to another
person.

Jane Harrison is a senior engineer in the ABC Software company. She has encountered a
problematic Cl in a view she has created. She wants to inform Henry Jones, who is working with
the same view through HP ServiceCenter, about the problematic Cl. Since the view Jane has
created contains many hundreds of Cls, she decides to email Henry the URL of the Cl so that he
does not have to spend a lot of time searching for that specific Cl.

In IT Universe Manager, Jane selects Generate Direct Link from the Edit menu. In the Select

C
N

ommand page, she selects Open in context links and then the Show view option, and clicks
ext.

Inthe Direct Link Parameters — Show View page, she selects the view she created, the
problematic Cl, and View topology as the mode in which Henry should open the CI. When the

u

RL is created, she emails Henry the link to the problematic CI.

For details, see "Generate Direct Link Wizard" on page 101.

Create a Direct Link to a Template with Parameter

Va

lues

This task describes how to create a direct link to a template by including the parameter values in the

u

1.

RL.

Create a Direct Link to a Template

In IT Universe Manager, select Edit >Generate Direct Link to run the Generate Direct Link
wizard. On the Select Command page, select Embedded links. Select Show view topology
from the list of options. On the Direct Link Parameters page, select the required template from
the drop-down list.

2. Editthe URL

When the wizard finishes, click Copy URL and paste the URL into a text editor such as
Notepad.

Append the following text to the end of the URL:
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&params=[parameterl=valuel,parameter2=value2]

where parameterl and parameter2 are the parameter names for the selected template and
valuel and value2 are the values you want to enter for the parameters.

Note: Any special characters must be entered using the URL encoding. In the above
example, the URL encoding for the [ character is %5B, the URL encoding for the ]
character is %5D, and the URL encoding for the comma is %2C. Thus, the actual text to
enteris:

&params=%5Bparameterl=valuel%2Cparameter2=value2%5D

3. Paste the URL into a Browser

Paste the URL into a browser. BSM opens to the selected template with the parameters
assigned the specified values.

Encrypt the Password of a Direct Link Using the JMX
Console

This task describes how to encrypt the password contained within a direct link using the JMX
console.

To encrypt the password of a direct link using the JMX console:

1. Launch your Web browser and enter the following address: http://<server_name>:<port
number>/jmx-console, where <server_name> is the name of the machine on which HP
Universal CMDB is installed.

2. Under UCMDB-UI, locate UCMDB Integration.

3. Under encryptString, enter your password in the Value box.

4. Click Invoke to view the encrypted string.

Generate a Direct Link User Interface

This section includes:
e "Generate Direct Link Dialog Box" below

e "Generate Direct Link Wizard" on the next page

Generate Direct Link Dialog Box

This dialog box enables you to create a URL to send to users so that they can access BSM.
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To From the Admin > RTSM Administration > Modeling main menu, select Edit >
access Generate Direct Link. After you configure the Direct Link parameters in the
"Generate Direct Link Wizard" below, click Finish in the Finish page.

Alternatively, click the Generate Direct Link to View button == in the CI Selector
toolbarin IT Universe Manager.

Relevant | " Generate a Direct Link — Scenario" on page 99
tasks

User interface elements are described below:

Ul Element
(A-Z) Description

Advanced Enables you to build a direct link and choose specific elements such as views or
Cls, for the end user to access. For details, see "Generate Direct Link Wizard"
below.

Note: This feature is only relevant when accessing the Generate Direct Link
dialog box from the Cl Selector toolbar in IT Universe Manager.

Copy URL  Copies the URL to the clipboard.

Description = Describes the parameters that are included in the URL. For details on selecting
the parameters, see "Select Command Page" on the next page.

Link URL The created URL that accesses the specified BSM function.
Mail URL Opens an email containing the URL of the link.

Test URL Checks the URL to ensure that the specified application page can be found.

Generate Direct Link Wizard

This wizard enables you to create a URL that guides another user to a specific target view or Cl in
BSM.

To access  From theAdmin > RTSM Administration > Modeling main menu, select Edit
> Generate Direct Link.

Important By default, this wizard is set to display a Welcome page. You can choose not to
information = display the Welcome page by selecting the Do not show this page again check

box.
Relevant " Generate a Direct Link — Scenario" on page 99
tasks
Wizard The Generate Direct Link wizard contains:
map

"Select Command Page" (<Open in context links options> and <Embedded links
options>) > "Finish Page"
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Select Command Page
This wizard page enables you to select the required parameters that must be added to the URL.
You can create two types of links:

e Open in context links. Creates a URL that opens a specific view or Cl directly in BSM without
having to be in the BSM context:

o Embedded links. Creates a URL that enables you to embed an RTSM applet into external
applications.

Important By default, this wizard is set to display a Welcome page. You can choose not to
information = display the Welcome page by selecting the Do not show this page again

check box.

Wizard The Generate Direct Link wizard contains:

map "Select Command Page" (<Open in context links options> and <Embedded
links options>) > "Finish Page"

See also "Generate Direct Link Wizard" on the previous page

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

<Left A graphic illustration of the selected command.
pane>

Cll Grid Creates a URL that displays all the Cl instances found in the RTSM for a selected
Cl type and its children. For details, see "Direct Link Parameters — Cll Grid Page"
on page 106.

Note: Available when you select the Embedded links option.

Cl Selector Creates a URL that embeds the ClI Selector displaying the Cls of a selected view,
into external applications. For details, see "Direct Link Parameters — C| Selector
Page" on page 104.

Note: Available when you select the Embedded links option.

Cl Type Creates a URL that embeds the ClI type selector into external applications. For
Selector details, see "Direct Link Parameters — Cl Type Selector Page" on page 105.

Note: Available when you select the Embedded links option.

Description A description of the selected command.
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Ul Element
(A-Z)

Impact Map

Model
Editor

Query
Editor

Related Cls

Report
Viewer

Report
Viewer -
Saved
Report

Show ClI
properties

Show view

Show view
topology

HP Business Service Management (9.24)

Description

Creates a URL that embeds an impact map into an external application. For
details, see "Direct Link Parameters — Impact Map Page" on page 106.

Note: Available when you select the Embedded links option.

Creates a URL that embeds the Model Editor into an external application,
highlighting the selected Cls in the Cl Selector in the Model Editor. For details,
see "Direct Link Parameters — Model Editor" on page 107.

Note: Available when you select the Embedded links option.

Creates a URL that embeds the Model Editor into an external application,
displaying the selected TQL query. For details, see "Direct Link Parameters —
Query Editor" on page 108.

Note: Available when you select the Embedded links option.

Creates a URL that opens a topology map displaying the selected Cl and its
immediate neighbors within the selected view. For details, see "Direct Link
Parameters — Related Cls Page" on page 109.

Note: Available when you select the Embedded links option.

Creates a URL that opens a specific report. For details, see "Direct Link
Parameters — Report Viewer Page" on page 110.

Note: Available when you select the Embedded links option.

Creates a URL that opens a saved topology or custom report. For details, see
"Direct Link Parameters — Report Viewer — Saved Report Page" on page 110.

Note: Available when you select the Embedded links option.

Creates a URL that displays a Cl's properties. For details, see "Direct Link
Parameters — Show CI Properties Page" on page 111.

Note: Available when you select the Embedded links option.

Creates a URL that displays the selected view and optionally preselects a query
node in it. For details, see "Direct Link Parameters — Show View Page" on page
113.

Note: Available when you select the Open in context links option.

Creates a URL that displays the topology map of the selected view and embeds it

in an external application. For details, see "Direct Link Parameters — Show View
Topology Page" on page 111.

Note: Available when you select the Embedded links option.
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Ul Element
(A-Z)

Start in
mode

Steps

View Editor

Views
Selector

Description

Creates a URL that opens BSM at the selected page. For details, see "Direct Link
Parameters — Start in Mode Page" on page 114.

Note: Available when you select the Open in context links option.
The current step in the procedure.

Creates a URL that opens a specific view in the Pattern View Editor in Modeling
Studio. For details, see "Direct Link Parameters — View Editor Page" on page 112.

Note: Available when you select the Embedded links option.

Creates a URL that embeds the View Selector in an external application, enabling
you to select and display a view in that application. For details, see "Direct Link
Parameters — Views Selector Page" on page 112.

Note: Available when you select the Embedded links option.

Direct Link Parameters — Cl Selector Page

This wizard page enables you to create a URL that embeds the CI Selector displaying the Cls of a
selected view, into external applications.

Wizard map

Important
information

"Select Command Page" (Embedded links > Cl Selector) > "Finish Page"

o For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 101.

o Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

User interface elements are described below:

Ul Element (A-2) Description

Allow multi Allow single or multiple selection of Cls.

selection

Selected view Select the required view from which you want to select the required

Cls.

o Click %2 to open the View Selector dialog box. Select the view you
want to appear in the Cl Selector.

e Click %% to delete the selected view.
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Direct Link Parameters — Cl Type Selector Page

This wizard page enables you to create a URL to a hierarchical tree or list of selected Cl types,
which can be embedded into an external application.

Important o Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

¢ Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > Cl Type selector) > "Finish Page"

User interface elements are described below:

Ul Element (A-Z) Description
Cl type selector View the selected Cl types in either a hierarchical tree or list.
mode

Invisible CITs (tree Select the Cl types you do not want to appear in the tree.
only)

e Click € to open the Cl Type Selector dialog box. Select the Cl
types you want to appear in the tree.
« Click # to delete the selected Cl types.
Root Cl Type (tree Select the Cl type you want to use as the root Cl type in a hierarchical

only) tree.

e Click ¢ to open the Cl Type Selector dialog box. Select the Cl
type you want to use as the root Cl type in the tree.

« Click % to delete the selected Cl type. The default is
Configuration Item.

Selection mode Allow single or multiple selection of Cl types.
Unselectable CITs Select the Cl types which cannot be selected in the tree.
(tree only)

e Click ¢ to open the Cl Type Selector dialog box. Select the Cl
types which cannot be selected in the tree.

« Click % to delete the selected Cl types.
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Ul Element (A-2) Description
Visible CITs (list Select the Cl types which you want to appear in the Cl type list.
only)

e Click € to open the Cl Type Selector dialog box. Select the Cl
types which you want to appear in the Cl type list.

« Click # to delete the selected CI types.

Note: If you choose to view the CITs in a list, then you are required to
select at least one Cl type.

Direct Link Parameters — Cll Grid Page

This wizard page enables you to display all of the Cl instances found in the RTSM for selected Cl
type, and its children.

Important o For general information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

¢ Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > CllI Grid) > "Finish Page"

See also "Element Instances Dialog Box" on page 61
User interface elements are described below:

Ul Element (A-Z) Description
Class type Select the required Cl type.
e Click %%l to select the required Cl type.

e Click ® to clear the box.

Direct Link Parameters — Impact Map Page

This wizard page enables you to run an Impact Analysis rule defined in Impact Analysis Manager.
The URL you create enables you to embed a topology map showing a simulation of all the Cls that
are affected by the selected trigger Cl for the selected severity and state. For details, see "Run
Impact Analysis Dialog Box" on page 221.
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Important ¢ Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

¢ Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > Impact map) > "Finish Page

See also "IT Universe Manager" on page 176
User interface elements are described below:

ul
Element
(A-Z) Description

Filter by Select the Cl types you do not want to appear in the impact analysis results.
Cl types

e Click %% to select the required Cl types.

« Click # to delete the selected Cl types.

Rule Enables you to define where you can run Impact Analysis rules.
bundle

Severity = Select the required severity from the drop-down list.

Note: The severity list was defined for the state in the System Type Manager. For
details, see "System Type Manager" on page 351.

For example, you can create an Impact rule in the Impact Analysis Manager (see the
"Impact Rules Definition Dialog Box" on page 342, that defines the severity of the
trigger query node as other than No Change. If you select a severity other than No
Change, for example, Plan, the condition is met and the simulated changes in the
system are triggered.

For details, see "Run Impact Analysis Dialog Box" on page 221.
Trigger
Cls e Click =% to select the Cls that are used as the triggers in an impact map. These
Cls represent the simulated changes to be made to the system. Opens the ClI

Selector dialog box. For details on how to use the Cl Selector pane, see "Cl
Selector" on page 126.

o Click # to delete the selected Cls.

Direct Link Parameters — Model Editor

This wizard page enables you to embed the Model Editor into an external application, highlighting
the selected Cls in the Cl Selector in the Model Editor.
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Important ¢ Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

¢ Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > Model Editor) > "Finish Page"

See also "Business Cl Models" on page 235
User interface elements are described below:

Ul Element (A-Z) Description

Model name Select the model you want to display in the Model Editor.

e Click %% to open the Select Model dialog box. Select the model you
want to appear in the Model Editor.

e Click # to delete the selected model.

Selected Cl in Select the Cls you want to appear highlighted in the Cl Selector in the
search Model Editor.

e Click %% to open the Cl Selector.

e Click ® to delete the selected Cls.

Direct Link Parameters — Query Editor

This wizard page enables you to embed the Model Editor into an external application, displaying the
selected TQL query.

Important o Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

¢ Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > Query Editor) > "Finish Page"

See also "Business Cl Models" on page 235

User interface elements are described below:
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Ul Element (A-Z) Description

Query name Select the model you want to display in the Model Editor.

e Click =21 to open the Select Query dialog box. Select the query you
want to appear in the Model Editor.

e Click ® to delete the selected query.

Direct Link Parameters — Related Cls Page

This wizard page enables you to embed into an external application, a topology map that displays a
specific Cl, and all the Cls that are linked to it by a distance of no more than one relationship.

Important o Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

o Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > Related Cls) > "Finish Page"
User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

Cls Select the Cl type you want to appear in the topology map.

e Click %%l to select the required Cl types. Opens the Cl Selector dialog
box.

e Click ® to delete the value in the Cls box.

Filter by CI Restrict the results of the topology map to related Cls of one or more Cl
types types.

e Click %2l to select the required Cl types.

« Click % to delete the value in the Filter by CI types box.

Restrict to view  Restrict the results of the topology map to related Cls from a specific view.

e Click %2l to select the required view. Opens the View Selector dialog
box.

e Click K to delete the selected view in the Restrict results to view box.
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Direct Link Parameters — Report Viewer Page

This wizard page enables you to create a URL that opens a specific report.

Important o Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

o Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > Report Viewer) > "Finish Page"

User interface elements are described below:

Ul Element
(A-Z) Description

Report type = Select the required report type. For information about the different report types,
see "Reports" on page 309.

Direct Link Parameters — Report Viewer — Saved Report
Page
This wizard page enables you to create a URL that opens a saved topology or custom report.

Important o Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

o Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > Report Viewer - Saved Report) >
"Finish Page"

User interface elements are described below:

Ul Element (A-Z) Description

Report Select the required saved report.

e Click %% to open the Select Report dialog box. Select the required
topology or custom report.

e Click X to delete the selected report.

For information about saved reports, see "Reports” on page 309.
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Direct Link Parameters — Show CI Properties Page

This wizard page enables you to view basic information for an existing Cl.

Important o Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

o Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > Show CI properties) > "Finish
Page"

See also "Configuration Item Properties Dialog Box" on page 200
User interface elements are described below:

Ul Element (A-Z) Description

Source Cl object ID = Select the required CI.

o Click £ toselect the source Cl and retrieve its object ID. Opens
the Select Source Cl dialog box. For details, see "Cl Selector" on

page 126.

« Click #£ to delete the value in the Source CI object ID box.

Direct Link Parameters — Show View Topology Page

This wizard page enables you to display the topology map of the selected view and embed it in an
external application.

Important o Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

¢ Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > Show view topology) > "Finish
Page"

User interface elements are described below:
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Ul Element (A-2) Description

Show topology of
view e Click =% to select the required view to be opened by the URL.

Opens the View Selector dialog box.

« Click % to delete the selected view in the Show topology of view
box.

Direct Link Parameters — View Editor Page

This wizard page enables you to create a URL that opens a specific view in the Pattern View Editor
in Modeling Studio.

Important o Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

¢ Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > View Editor) > "Finish Page"

See also "Building a Business View" on page 229
User interface elements are described below:

Ul Element (A-Z) Description

View name
e Click **! to select the required view to be opened by the URL.

Opens the View Selector dialog box.

o Click b4 to delete the selected view in the View name box.

Direct Link Parameters — Views Selector Page

This wizard page enables you to embed into an external application, the View Selector, that enables
you to select, and display a view in that application.

Important o Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

o Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Embedded links > Views Selector) > "Finish Page"

See also "Building a Business View" on page 229
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Direct Link Parameters — Show View Page

This wizard page enables you to create a URL to a specific view and optionally select a specific
query node in that view. When the view opens, the Cl you chose is selected in the view. The view
opens in IT Universe Manager.

Important ¢ Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

¢ Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Open in context links > Show view) > "Finish Page"

User interface elements are described below:

Ul Element (A-
Z) Description
<Left pane> A graphic illustration of the selected option.

Advanced pane @ Hide ordisplay the Advanced pane in IT Universe Manager.
(visibility)

Select Cl from (Optional) Click to select a Cl and retrieve its object ID. When the view
view result opens, the Cl you chose is selected in the view.

e Click ¢ tochoose the Cl you want selected in the target view and
retrieve its object ID. Opens the Select Cl dialog box. For details, see "Cl
Selector" on page 126.

« Click % to delete the object ID for the selected Cl in the Select Cl from
view result box.

Selected View The target view to be opened by the URL.

e Click ¢ toselect the target view to be opened by the URL. Opens the
Select View dialog box.

o Click ® to delete the selected view in the Selected view box.
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Ul Element (A-
Z) Description
View mode The view options are:

¢ View Topology. Displays an entire layer within a view.

« Related in View. Displays the selected Cl and its immediate neighbors
within the current view.

¢ Related in CMDB. Displays the selected Cl and its immediate neighbors
in the RTSM.

Direct Link Parameters — Start in Mode Page

This wizard page enables you to start the RTSM application at the selected page, for example, in
the Modeling Studio page.

Important o Forgeneral information about the Generate Direct Link wizard, see
information "Generate Direct Link Wizard" on page 101.

o Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 100.

Wizard map "Select Command Page" (Open in context links > Start in mode page) >
"Finish Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Left pane> A graphic illustration of the selected mode.

Initial mode Starts the RTSM application in the selected mode.
Finish Page

This is the final page of the Generate Direct Link wizard. Click Finish to close the wizard and
create a URL. Opens the Generate Direct Link dialog box.

Important For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 101.
Wizard map "Select Command Page" (<Open in context links options> and <Embedded

links options>) > "Finish Page"
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This chapter includes:

Using the Direct Link Functionality to Embed RTSM Applets ... ... .. ... 115
RTSM Applet Tag — OVervieW .o 115

Direct Link Operation Flow

Note: This chapter is relevant to integration developers only.

Using the Direct Link Functionality to Embed RTSM
Applets

You can directly embed RTSM applets into external applications using a direct link. A direct link is a
URL that you create using the Direct Links wizard. For details, see "Generate Direct Link Wizard"
on page 101.

You can embed RTSM applets in the following ways:

« Usingthe URL itself to display RTSM content in an external application. For example, you can
create a URL in the Direct Links wizard to display the properties of a certain Cl. The login page
opens if you are not already logged into BSM or if Lightweight Single Sign-On Authentication
Support (LW-SSQ) is not enabled for BSM.

Note: Using the URL to enable the integration requires opening the link in an IFrame or a
new window. This does not allow you to manage the resulting RTSM applet using
Javascript due to cross-site scripting issues. For example, if you use a URL that displays
the properties of a specific Cl using the object ID, you cannot use the same URL to display
the properties of another ClI.

o Using the RTSM applet tag to embed the RTSM applet in an external application. This enables
integration developers to display a part of the BSM user interface as part of their own application.
In addition, this enables interaction with the embedded BSM user interface using Javascript.

RTSM Applet Tag - Overview

The RTSM Applet tag creates the environment needed for the RTSM applet to run (HTML,
Javascript, and server session parameters). The code behind the tag can log into the BSM serverin
one of the following cases:
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o The login parameters are specified and the user is not already logged in (or if Lightweight Single
Sign-On Authentication Support (LW-SSO) is not enabled for BSM).

¢ The clear session parameteris true.

Once a user session is established, the tag continues to write the required applet environment
(HTML and Javascript code) to the result of the JSP processor. The resulting HTML page includes
the required Javascript code to load the RTSM applet from the specified server. On error, the
specified error string is printed to the page. This string can be customized using the
userErrorMessage parameter and may include HTML elements and HTML wrapped Javascript
code to initiate error handling scenarios.

Example of the Usage of an RTSM Applet Tag

<ucmdb:ucmdb_applet
serverConnectionString="http://labm3maml7.devlab.ad:8080"
serverType="UCMDB"
directLinkParameters="initViewName=NetworkTopology"
userName="user-name"

userPassword="password"

customerId="1"

encoded="false"

printDebuglLogs="true"

userErrorMessage="This is your general error"
navigation="false"

clearSessionCookies="false"
command="ShowCISelector"/>

Caution: You retrieve the directLinkParameters from the URL created in the Direct Links
wizard. Insert the values for each parameter in the tag as displayed. If the URL contains values
for parameters not displayed above, copy them into the directLinkParameters line of the tag.
For details on how to create a direct link, see "Generate Direct Link Wizard" on page 101.

The RTSM applet tag is located at <BSM>\odb\deploy\ucmdb-ui\WEB-INF\tags\ucmdb_
applet.tag on the Gateway Server machine.

You can copy the RTSM applet tag to an external application server. The RTSM applet tag requests
the login data from the BSM server provided that:

o The external application server can communicate with JSP tags.

o The BSM serveris accessible to the external application server and to the browser.

Direct Link Operation Flow

This section describes different scenarios in which direct links are used to embed RTSM applets
into external machines.

This section includes the flow descriptions:
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¢ "Regular Login" below
¢ "An Embedded RTSM Applet Using a Direct Link URL" on the next page

¢ "An Embedded RTSM Applet Using an RTSM Applet Tag" on page 119

Regular Login
This flow describes a regular login to the BSM server. It serves as a base reference for the direct
link flows.
HP Business
Service
Management/HP
Universal CMDB
Browser server
1
2 -

-—

. 1 —

o)}
Y

JV -

1. The user enters the direct link URL (into the browser) to log into the BSM server.
2. The browser sends the login request to the BSM server.
3. The server checks the user credentials and creates a user session if required.

4. The server returns the requested first page of BSM.
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Note: This can be any page. For this flow, we assume that it is the Admin > RTSM

Administration > Modeling page in which the RTSM applet is loaded.

5. The browser loads the Java virtual machine (JVM) with the code base location parameter
(which instructs the JVM from where to load the RTSM applet files) as the BSM server.

6. RTSM applet files (jars) and data are transferred between the BSM server and the JVM loaded

in the browser.

At this point, the RTSM applet is loaded and regards BSM as the server with which it should

communicate.

An Embedded RTSM Applet Using a Direct Link URL

This flow shows how to use the direct link to open an RTSM applet (opened to a specified context)

in a new browser frame.

[ CO—

HP Business
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Management/HP
External Universal CMDB
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1. The external application has a page that needs to show the RTSM applet.

2. The returned page includes a directive to open the direct link in an IFrame or new browser

window.
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3. The browser opens a new frame (IFrame or new window) with the direct link as the frame URL.

4. The new frame sends the direct link to the BSM server.

5. Ifthe useris not already logged into BSM, or if Lightweight Single Sign-On Authentication
Support (LW-SSO) is not enabled for BSM, BSM displays the login page and waits for the user
to enter credentials and click the login button.

6. The user session is created, if required.

7. The BSM server returns a page that includes the directive to load the RTSM applet.

8. The browser processes the page. When the browser encounters the directive to load the
RTSM applet, it starts the JVM. The browser then passes the needed parameters to the JVM,
including the BSM server location as "code base."

9. RTSM applet files (jars) and data are transferred between the BSM server and the JVM loaded
in the browser.

Caution: The BSM server must be accessible from the browser machine.

An Embedded RTSM Applet Using an RTSM Applet Tag

This flow shows how to use the RTSM applet tag in conjunction with direct links to embed the
RTSM applet (opened to a specified context) in an external application page.
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1. The RTSM applet tag is included in the processed JSP in the external application.

2. The RTSM applet tag uses the parameters given to it to create an HTTP/HTTPS connection to
the BSM server and requests the applet HTML snippet code.

3. Ifthe useris not already logged in, the parameters from the RTSM applet tag are used (see the
tag itself for reference information regarding this step). If login fails, the RTSM applet tag
returns an error message, either the preset one or the one specified in the RTSM applet tag
parameters.

4. The BSM server returns the HTML snippet code (with embedded Javascript) that loads the
RTSM applet. The external application can now incorporate this snippet code into the page,
and send the page to the browser.

5. The external application sends the complete page that includes the HTML snippet code to the
browser.

6. The browser processes the page. When the browser encounters the HTML snippet code that
loads the RTSM applet, the JVM is started. The browser then passes the needed parameters
to the JVM, including the BSM server location as "code base".

7. RTSM applet files (jars) and data are transferred between the BSM server and the JVM loaded
in the browser.
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Caution: The BSM server must be accessible from both the browser machine as well as
the external application machine.
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This chapter includes:

Cl Selector OVEIVIEW . ... ... 122
Display a View in Browse Mode ... . 122
SearchforClsinSearchMode ... ... ... . 123
Modify Cl Selector Display Options ... ... 124
Cl Selector UserInterface ... ... ... . L 124
Troubleshooting and Limitations .. ... ... . 135

Cl Selector Overview

Note: The Cl Selector was known as View Explorer in earlier versions of BSM.

The CI Selector presents the elements of the IT universe model in BSM through the medium of
views. BSM displays the Cl Selector in the left pane of IT Universe Manager and the Modeling
Studio.

When you select a view in the Cl Selector, the configuration items (Cls) contained in the view are
displayed in a hierarchical tree format according to the relationships defined between the Cls. A
view may be empty if no Cls were found matching the TQL query. For details on views, see "View
Formats" on page 229.

You can use the Cl Selector to select views and to locate Cls. You can select a view and browse
through the list of Cls, or you can search for a specific Cl by name or by Cl type. You can also save
the search criteria for future use.

For information on the components of the Cl Selector, see " Cl Selector User Interface” on page
124.

Display a View in Browse Mode

When the Cl Selector is set to Browse mode, you can display the contents of a selected view. For
details on the Cl Selector user interface in Browse mode, see "Cl| Selector" on page 126.

1. Prerequisites

In the CI Selector pane, select Browse Views mode.

2. Select a View to Display

Click the ellipsis button **/ to open the View Selector dialog box and select the view you want
to display. The name of the selected view is shown in the View box. The Cls in the view
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appear in the Cl tree in the lower part of the CI Selector pane. The view remains selected when
you move to other applications in BSM.

Search for Cls in Search Mode

The CI Selector search tool enables you to locate a specific Cl. The search is executed on the
entire RTSM. For details on the Cl Selector search tool user interface, see "Cl Selector" on page
126.

This task includes the following steps:

Prerequisites

In the CI Selector pane, select Search Cls mode and select the Simple tab.

Search by Cl Name

To search for Cls by name, enter a string in the CI Name box, representing the name of the CI, or
part of the name. The search returns all Cls that contain the entered string somewhere in their
names (within the boundaries of the other search criteria that you define).

Note: The search by Cl name option is not case sensitive.

Search by Configuration ltem Type

You can search for Cls using the CI Type box. This search returns Cls of the type specified in the
Cl Type box.

A

Click the ellipsis button
Cl Type box.

and select the required Cl type. You cannot manually enter a CIT in the

After defining a Cl in the CI Type box, HP Business Service Management remembers your
selection until you move to a different application, or until you define a different value.

Run the Search and Sort the Results

Run the search. The results appear in the lower part of the Cl Selector pane, showing the Cl name
and type for each entry. You can sort the search results by clicking the appropriate heading.

When you select the required Cl from the results list, the right pane displays details for the Cl you
selected, in the context in which you are working. To see a Cl in the context of its view, right-click
the Cl and select Locate CI in View. The CI Selector reverts to Browse mode and displays the
view that contains the Cl, with the Cl selected in the view tree.

When you select a Cl in the search results, the Cl appears in the topology map with its related Cls
inthe RTSM.

Optionally, save the search criteria by clicking the Save button and entering a name for the
search. For details, see "Save Search Criteria Dialog Box" on page 135.

Run an Advanced Search

You can select the Advanced tab for other search options. For details on the Cl Conditional
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search, see "Cl| Conditional Search Dialog Box" on the next page. For details on the Running
Software search, see "Running Software Search Dialog Box" on page 134.

Modify Cl Selector Display Options

You can modify the display options for the CI Selector. These options are configured in the
Infrastructure Settings Manager.

Caution: Modifying certain settings in the Infrastructure Settings Manager can adversely
affect the performance of BSM. Do not modify settings without first consulting HP Software
Support or your HP Professional Services representative

This task includes the following steps:

1. Prerequisites

Access the Infrastructure Settings Manager by selecting Admin > Platform > Setup and
Maintenance > Infrastructure Settings.

2. Modify Selected Settings

The following settings under RTSM - General properties can be modified:

= Immediate Children Count. Number of children immediately displayed when expanding
their parent's query node in the CI Selector.

= Maximal Children Count. Maximum number of children displayed under their parent's
query node in the Cl Selector.

= Maximal search results size. Maximum number of CMDB instances that can be returned
in one search operation.

= Recently Used Views List size. Maximal number of recently used views to store per user.

Cl Selector User Interface

This section includes (in alphabetical order):

¢ "CI Conditional Search Dialog Box" on the next page
o "CI Selector" on page 126

o "Organize Searches Dialog Box" on page 133

¢ "Running Software Search Dialog Box" on page 134

o "Save Search Criteria Dialog Box" on page 135
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CI Conditional Search Dialog Box

This dialog box enables you to search for Cls by attribute conditions, by related Cls, and by
attribute conditions of related Cls.

To In the CI Selector, select the Advanced tab in Search mode and click the ellipsis

access button next to Cl Conditional Search.

User interface elements are described below:

Ul Element

(A-Z) Description

= Click to add an attribute condition.
Click to delete a selected row.

1t Click to move a selected row up.

i Click to move a selected row down.

Click to display a preview of the attribute condition list.

Attribute Select an attribute from the drop-down list.

name
Note: If you select Display Label from the Attribute name list, the operator
Like ignore case does not appear in the Operator list since a Display Label
Like ignore case condition can be added using the Cl name/Related Cl Name.

Cl Name Enter a Cl name for which to search.

Cl Type
Click the ellipsis button =% to select a Cl type from the tree.

Integration If you want to run your search over federated Cls also, click the ellipsis button

Points

%1 to select the target integration points for the Cls.

Note: If you select a disconnected integration point for your search, an error
message appears when the search is run, asking if you want to see local search
results.

Operator Select an operator from the drop-down list.

Related CI Enter the name of arelated ClI for the search.

Name

Related CI

Type Click the ellipsis button ***! to select a Cl type from the tree for a search by
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Ul Element

(A-2) Description

Relationship

Type Click the ellipsis button ***I to select a relationship from the tree for a search by

related ClI.

Search by Select to run a search for Cls with the specified conditions.
Cl
conditions

Search by Select to run a search for Cls related to Cls with the specified conditions.
related CI

conditions Note: If you select Display Label from the Attribute name list, the operator

Like ignore case does not appear in the Operator list since a Display Label
Like ignore case condition can be added using the Cl name/Related Cl| Name.

Search by Select to run a search for Cls related to the specified Cls or Cl types.
related CI
criteria

Value Enter a value for the attribute condition.

Cl Selector

This feature enables you to select views and to locate Cls.

To access | Appears in the left pane of the IT Universe Manager page and the Modeling
Studio.

Important = The CI Selector consists of two functional formats: Browse Views mode and
information Search Cls mode.

¢ InBrowse Views mode, you can search for and display a view, and browse
through the view to locate a particular Cl. You can also perform operations on
the CI from a shortcut menu.

e InSearch Cls mode you can search for one or more Cls in the RTSM by name
orby Cl type.

Note: Many of the features of the Cl Selector are only relevant in the RTSM and
not in other BSM modules.

Relevant "Display a View in Browse Mode" on page 122

tasks
"Search for Cls in Search Mode" on page 123

Browse Views Mode

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-Z)

&

<P

1%

53

Ld

Description

Click to refresh the data content of the hierarchical tree structure
that may have been modified by other users.

Click Show Template Parameters to open the Template
Parameter Values dialog box, which enables you to edit the
parameters of the selected template.

Note: This button is only active when a template is selected.

Click Add selected Cls to model/view to add the selected Cls
to the current model or view.

Note: This button only appears in the Modeling Studio.

Click Add to model as related Cls to add the selected Cl to the
model as a related CI.

Note: This button is only active in the Model Editor of the
Modeling Studio.

Click Open selected model in a new tab to open the selected
model in the Model Editor.

Note: This button is only active when a model is selected in the
Modeling Studio.

Click Show models containing selected Cl to display a list of
models containing the selected CI.

Note: This button only appears in the Modeling Studio.

In IT Universe Manager, this represents Show View Definition,
which takes you directly to the view definition in the Modeling
Studio for the current view.

In the Modeling Studio, this represents Open selected view,
which opens the selected view in the Editor pane.

Click Show views containing selected Cl/model to display a
list of views containing the selected Cl or model.

Note: This button only appears in the Modeling Studio.

Click Generate view for selected model to open the Creating
New View dialog box which enables you to build a view based on
the selected model.

Note: This button is only active when a model is selected in the
Modeling Studio.
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Ul Element (A-Z) Description

(G Click Show Discovery and Changes Summary to rediscover
all the Cls in a selected view by manually starting the DFM jobs
that originally discovered them. For details, see "Show
Discovery Status and Changes Dialog Box" on page 224.

Note: This button only appears in IT Universe Manager.

== Click Generate Direct Link to View to create a direct link to the
view using the Direct Links wizard.

Note: This button only appears in IT Universe Manager.

# Choose the export format for the browse results. The available
options are:

o Excel. The table data is formatted as an .xIs (Excel) file that
can be displayed in a spreadsheet.

e PDF. The table data is exported in PDF format.

Note: When exporting to PDF, select a reasonable number of
columns to display to ensure that the report is legible.

o RTF. The table data is exported in Rich Text Format.

e CSV. The table data is formatted as a comma-separated
values (CSV) text file that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly,
the comma (,) must be defined as the list separator. In
Windows, to verify or modify the list separator value, open
Regional Options from the Control Panel, and on the Numbers
tab ensure that the comma is defined as the List Separator
value.

o XML. The table data is formatted as an XML file that can be
opened in a text or XML editor.

Tip: To extract HTML code from the report:
= Save the fileas HTML

= Open the file in an HTML editor

= Copy the relevant table into the target file
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Ul Element (A-Z)

[

<Cls>

<Tooltip>

Find

Description

Click the Snapshot button to work with snapshots. The following
options are available:

o Save Snapshot. Select to open the Save Snapshot dialog
box, which enables you to save a snapshot of the view. For
details, see "Save Snapshot Dialog Box" on page 223.

e Compare Snapshots. Select to run the Compare Snapshots
Report. For details, see "Compare Snapshots Report" on
page 319.

o Schedule Snapshot. Select to open the Schedule Job dialog
box. For details, see "Schedule Snapshot Dialog Box" on
page 327.

Note: This button only appears in IT Universe Manager.

Click View Based Report to display the topology report for the
selected view.

Note: This button only appears in IT Universe Manager.

Click Asset Report to open the Asset report for the selected
view. For details, see "Asset Report" on page 313.

Note: This button only appears in IT Universe Manager.

Click the ellipsis button to the right of the View box, to open the
View Selector dialog box. You can browse through the folder tree
to locate the view you want to display.

Enables you to move to the next or previous result of the search
for the string entered in the Find box.

The Cls contained in the currently selected view.

Hold the cursor over a Cl to display a tooltip with the relevant Cl
type.

Enter a Cl name or a portion of a Cl name in the Find box to
locate a Cl in the Cl tree.
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Ul Element (A-Z) Description

View The View box displays the currently selected view. To select a
view to display, click the down arrow on the right side of the View
box; this displays an abridged list of views, containing the most
recently accessed views. Click the arrow at the bottom of the list
to scroll through the entire list. The recently accessed views
appear at the top of the drop-down, above the dividing line. The
complete list of views appears below the line.

Alternatively, place the cursorin the list and begin typing the
view name. If the first few letters that you type match an existing
entry, BSM completes the view name. If the names of several
views begin with those letters, all matching views are displayed
in the list.

Note: If the selected view in the View box fails to load, the value
in the View box is set to the default (empty) selection.

Search Cls Mode

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description
{E Click Show Search Results in Table to open a separate pane

with a table of the Cls in the search results.

Note: This button only appears in IT Universe Manager.

> Click Add selected Cls to model/view to add the selected
Cls to the current model or view.

Note: This button only appears in the Modeling Studio.

@ Click Add to model as related Cls to add the selected Cl to
the model as a related CI.

Note: This button is only active in the Model Editor of the
Modeling Studio.

o Click Open selected model in a new tab to open the selected
model in the Model Editor.

Note: This button is only active when a model is selected in the
Modeling Studio.

£ Click Show models containing selected Cl to display a list of
the models containing the selected Cl.

Note: This button only appears in the Modeling Studio.
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Ul Element (A-Z) Description

e Click Show views containing selected Cl/model to display a
list of the views containing the selected Cl or model.

Note: This button only appears in the Modeling Studio.

L] Click Generate view for selected model to open the Creating
New View dialog box which enables you to build a view based
on the selected model.

Note: This button is only active when a model is selected in the
Modeling Studio.

# Choose the export format for the search results. The available
options are:

o Excel. The table data is formatted as an .xIs (Excel) file that
can be displayed in a spreadsheet.

e PDF. The table data is exported in PDF format.
Note: When exporting to PDF, select a reasonable number
of columns to display to ensure that the report is legible.

e RTF. The table data is exported in Rich Text Format.

e CSV. The table data is formatted as a comma-separated
values (CSV) text file that can be displayed in a
spreadsheet.

Note: For the CSV formatted table data to display correctly,
the comma (,) must be defined as the list separator. In
Windows, to verify or modify the list separator value, open
Regional Options from the Control Panel, and on the
Numbers tab ensure that the comma is defined as the List
Separator value.

o XML. The table data is formatted as an XML file that can be
opened in a text or XML editor.

Tip: To extract HTML code from the report:
= Savethe fileas HTML

= Open the file in an HTML editor

= Copy the relevant table into the target file

g Click to open the Organize Searches dialog box, where you can
edit or delete searches from the list of saved searches.
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Ul Element (A-Z)

Q,

@ @]

<Search results>

Advanced tab

Cl Name

Cl Type

Find

Searches

Description

Click to collapse or expand the search criteria area.

Click to run the search. The search results are displayed in the
lower part of the C| Selector pane.

Click to save the current search criteria for future use.

Enables you to move to the next or previous result of the search
for the string entered in the Find field.

After you run the search, the results are listed in the lower part
of the CI Selector pane. The results are shown in two columns:

¢ Name. Contains the name of the CI.
e CI Type. Contains the Cl type of the ClI.

If the Cl or view name is abbreviated, hold the pointer over the
entry to see the full name. You can sort the search results by
clicking the appropriate heading.

The following detailed search options are available:

¢ CI Conditional Search. Enables you to search for Cls by
attribute conditions, by related Cls, and by attribute
conditions of related Cls.

¢ Running Software Search. Enables you to search for hosts
by the applications running on them and for applications by
the host on which they are running.

CIT

For each of the searches, click the ellipsis button to open
the search dialog box. After running a search, click the Save

button to save the search for future use.

To search for a Cl by name, enter the name of the CI for which
to search.

To search for Cls by Cl type, click the ellipsis button to select a
ClI from the Select Configuration Item Type dialog box.

Enter a Cl name or a portion of a Cl name in the Find box to
locate a Cl in the search results.

Select a search from the drop-down list of saved searches.
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Ul Element (A-Z)

Description

Search results count The Search results count below the Find box displays the total

Simple tab

number of Cls found in the search.

The Simple tab includes the standard search functionality. Click
the Advanced tab for more detailed search options.

Shortcut Menu Options

Menu Item

<IT Universe
Manager
shortcut menu
options>

Add

Add to model as
related Cls

Generate view
for selected
model

Open selected
model in a new
tab

Show containing
models

Show containing
views

Description

The regular shortcut menu for the topology map in IT Universe Manager is
also available from the Cl Selector. For details on the menu options, see"IT
Universe Manager Shortcut Menu" on page 211.

Adds the selected ClI to the current model or view.
Note: This feature only appears in the Modeling Studio.
Adds the selected Cl as arelated CI to the current model.

Note: This feature only appears in the Modeling Studio.

Select to create a view based on the current model. The Creating New View
dialog box opens which enables you to select a perspective to apply.

Note: This feature only appears in the Modeling Studio.

Opens the selected model in a new tab in the Model Editor.

Note: This feature only appears in the Modeling Studio.

Select Show models containing selected CI to display alist of the
models containing the selected Cl.

Note: This option only appears in the Modeling Studio.

Select Show views containing selected Cl/model to display a list of the
views containing the selected CI or model.

Note: This option only appears in the Modeling Studio.

Organize Searches Dialog Box

This dialog box enables you to edit or delete searches from the list of saved searches.

To access

Click the Manage the list of saved searches button 5 in the ClI
Selector.

User interface elements are described below:
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ul
Element
(A-Z) Description
¥ Click to edit the selected search. For simple searches, the Cl Simple Search dialog
box opens, which enables you to edit the name and type of the CI. For Cl
Conditional searches, the Cl Conditional Search dialog box opens.
Y Click to delete the selected search.
P Click to expand the search tree.
B Click to collapse the search tree.

<Searches Displays all the saved searches in tree format.
tree>

Find Enter a search name or a portion of a search name in the Find box to locate it in the
list.

Find Next  Click to go to the next occurrence of the selected search phrase in the list.

Find Click to go to the previous occurrence of the selected search phrase in the list.
Previous

Running Software Search Dialog Box

This dialog box enables you to search for hosts by the applications running on them and for
applications by the host on which they are running.

To In the CI Selector, select the Advanced tab in Search mode and click the ellipsis
access button next to Running Software Search.

User interface elements are described below:

ul
Element
(A-2) Description

Host Enter the name of the node for which you are searching.
name

Running | Select a running software Cl from the drop-down list.

Software . . . . .
Note: The drop-down list may not display an accurate list of available running

software Cl types (only the option Any appears). In this event, perform the Host
name search only.

Search = Select RunningSoftware or Node.

for
Note: To search for a running software CI running on a specific node, enter a node

name, select the required running software Cl and search for it.
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Save Search Criteria Dialog Box

This dialog box enables you to save the current search criteria for future use.

To access . .
Click the Save button 'l from Search mode in the CI Selector.

User interface elements are described below:

Ul Element (A-

Z) Description

Existing Displays a list of existing searches in tree format.

Queries

Name Enter a name for the current search.

Find Enter a search name or a portion of a search name in the Find box to locate it
in the list.

Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find Previous Click to go to the previous occurrence of the selected search phrase in the list.

Troubleshooting and Limitations

This section describes troubleshooting and limitations for the Cl Selector.
Unavailable Views and Cls

The View list in the Cl Selector may not display all views in the RTSM, or it may not display the
contents of a view, for any of the following reasons:

o The View list includes only the views for which you have the necessary permissions. Similarly,
Search mode is only available if you have Cl Search permission. To set permissions, select
Admin > Platform > Users and Permissions, select a user or a group and select
Permissions. For more information, see "How to Assign Permissions" in the BSM Platform
Administration Guide.

o Views that are currently inactive appear in red in the View list, but they cannot be selected. InIT
Universe Manager, inactive views appear in faded text.

o Out-of-the-box views for which you do not have a license may appear in the View list, but these

views do not contain Cls. For information on the out-of-the-box views, see "Predefined Folders
and Views" on page 234.

Note: After deleting one or more query nodes from a TQL query, it can take time for changes
to be updated to the view; meanwhile, the removed Cls appear in the view. If you select one
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of these Cls before it is updated, an error message is displayed. Click the Refresh button to
update the view.
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This chapter includes:

Topology Map OVerview .. 137
Handling Large VieWs 137
Topology Map User Interface ... ... e 138

Topology Map Overview

The Topology Map provides a graphical display of a view. All the Cls in a given layer of the view are
represented by icons and the connecting lines represent relationships. You can select a Cl in the
Topology Map or in the Cl Selector in the left pane. You can also drill down in the Cl Selector to
display different layers of the view in the Topology Map.

The label of a Cl appears under the icon. You can set the maximum number of characters per line
and the maximum number of lines in a Cl label in the User Preferences dialog box under General.
For details, see "User Preferences Dialog Box" on page 88.

If a Cl icon appears with a downward arrow icon in the Topology Map, there is an additional CI layer
beneath it, created by the hierarchy set for the view. You can click the arrow to display the Cls
contained in the sublayer.

—

16.35.191.4

The topology map is automatically updated dynamically with changes in the IT Universe data, such
as new Cls discovered by the Data Flow Management process.

The toolbar and Main Menu above the Topology Map enable you to zoom in, change the layout of
the Topology Map, and print the Topology Map. Additional functionality is available from the
shortcut menu by right-clicking a Cl in the Topology Map or in the C| Selector.

Handling Large Views

The Topology Map cannot display a view with more than 900 Cls in a single layer. When you select
a view which contains a layer with more than this number of Cls, the Topology Map appears empty.
A layer with more than 900 Cls can be displayed in a table in Text mode.

To display large views in the Topology Map, use one of the following methods:

¢ Reduce the TQL query results by redefining the view in the Modeling Studio. For details, see
"Change Query Node/Relationship Type Dialog Box" on page 256.

o Define a different hierarchy for the view to redistribute the Cls among the view's layers. For
details on defining hierarchy, see "Setting the View Hierarchy" on page 230.
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o Reset the maximum number of Cls allowed in the configuration parameters. Select the Max
Object Count GUI for TS parameter under RTSM - Viewing Settings in the Infrastructure
Settings Manager. However, be aware that increasing the maximum number of Cls per layer
may significantly slow down the redrawing of the Topology Map.

To modify the setting, select Admin > Platform > Setup and Maintenance > Infrastructure
Settings > Foundations > RTSM. Locate Max Object Count GUI for TS and change the value
to the required number.

Topology Map User Interface
This section includes (in alphabetical order):
o "Export Map to Image Dialog Box" below
o "Layout Properties Dialog Box" on the next page
e "Main Menu" on page 154
¢ "Print Dialog Box" on page 155
o "Print Preview Dialog Box" on page 155
o "Print Setup Dialog Box" on page 156
e "Toolbar Options" on page 157

o "Topology Map Sidebar" on page 164

Export Map to Image Dialog Box
This dialog box enables you to save a topology map to a file.

To access From a topology map, select Operations > Export Map to Image.

Relevant tasks "Print and Save a Topology Map to File" on page 195
User interface elements are described below:

ul
Element
(A-2) Description

Actual Save the view so that the graph node sizes are at maximum.
Size

Current = Save the view as you see it on the topology map. For example, if you have used the
Zoom Interactive Zoom mode to decrease the view magnification, the graph nodes also
Level appear smaller in the saved view. For details, see "Interactive Zoom" on page 160.
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ul
Element
(A-Z) Description

Custom  Specify the size of the view you want to save in the Width and Height boxes.

File Specify the required file name and location (or click Browse to search for the file and
Name location).

Fitin Expand or shrink the view so that it fits in the pane.

Canvas

Image The quality of the printed map. Select High, Medium, or Low.

Quality

Selected Saves only the graph nodes/Cls and their relationships that you selected in the map.
Objects

Only

Type Select the required file format.

Visible | Saves only the part of the graph that appears in the pane.
Window
Only

Layout Properties Dialog Box

This dialog box enables you to customize the layout of a specific layer in a view, to achieve the
clearest presentation possible and to better understand and monitor the managed data.

To access | Select Layout >Layout Properties.

Important  You define the layout of a view's layers by assigning logical positions for the
information graph's nodes and relationships that appear in a layer. You customize the layer
layouts by modifying the default values.

You set layout definitions for a specific layer only. The definitions cannot be saved
for a different layer or a different view.

Parameter values are in pixels.

Global Tab

This area enables you to define global layout parameters.

To access Click the Global tab in the Layout Properties dialog box.

Important information = The Global tab enables you to define global settings for the layout.

User interface elements are described below:
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ul
Element
(A-2) Description

Drawing @ Select one of the following options for fitting the layout:
Fitting
o Fit to Canvas. Fit the layout to the canvas on the screen.

o Fit for Printing. Fit the layout to a page for printing.

¢ No Fitting. Do not change the layout.

Labeling = Select Perform Labeling to ensure that the labels appear when the layout is
redrawn. If this field is not selected, labels do not appear in the redrawn layout.

Style Select Apply Style Deeply to apply the layout selected to all nested layers of the
topology map.

All Styles Tab

To access  Click the All Styles tab in the Layout Properties dialog box.
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Important = The All Styles tab enables you to define general layout parameters for
information = disconnected graph nodes and connected components.

e A disconnected graph node is a node that is not connected to any other graph
node.

¢ Adisconnected component is a component that is not connected to any other
component. It contains a set of graph nodes that can be connected to each
other.

This illustrates a connected component with five graph nodes:

e

This illustrates a connected component with two graph nodes:

O—0O

This illustrates four disconnected components, each made up of a single,
disconnected graph node:

OO
O O

User interface elements are described below:
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Ul Element
(A-2) Description

Components | The spacing between the components in a disconnected graph consists of both
a constant value and a proportional value based on the sizes of the
components.

Select Detect Components to view the disconnected components. You can
specify that all components be laid out together or individually, regardless of the
other components. If the grouping for components is selected, each component
is laid out, and the resulting components are packed together.

When Detect Components is selected, enter values for the following settings:

o Constant Spacing. Set constant spacing (horizontal and vertical) around
each disconnected component.
Default value: 20

o Proportional Spacing. Set spacing (horizontal and vertical) that is
proportional to the size of the component around each disconnected
component.

Default value: 0.05

Disconnected The spacing between the graph nodes in a disconnected graph consists of both
Graph Nodes = a constant value and a proportional value based on the sizes of the graph
nodes.

Select Detect Disconnected Graph Nodes to view the disconnected graph
nodes. You can specify that disconnected graph nodes be grouped into one
component or laid out individually.

When Detect Disconnected Graph Nodes is selected, enter values for the
following settings:

o Constant Spacing. Set constant spacing (horizontal and vertical) around
each disconnected graph node.
Default value: 20

o Proportional Spacing. Set spacing (horizontal and vertical) that is
proportional to the size of the component around each disconnected graph
node.

Default value: 0.05

Margin Enter values for the right, left, top, and bottom margin spacing for the layout.
Spacing

Circular Tab

To access  To access: Click the Circular tab in the Layout Properties dialog box.
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Important = The Circular tab enables you to group a graph's nodes into groups or clusters
information = based on the grouping options you select. It is particularly suited for visualizing
ring and star network topologies, and for link analysis.

User interface elements are described below:

ul
Element
(A-2) Description

Clustering = Set the values for the following settings:

o Cluster Size Factor. Specifies the ratio between the average cluster size and
the number of clusters. The size of a cluster is defined as the sum of the
weights of all graph nodes in the cluster. You can assign a weight value to each
graph node.

e Min Number of Clusters. The minimum number of clusters in a layer.

e Max Number of Clusters. The maximum number of clusters in a layer.

Cluster Displays clusters either in a symmetric or circular layout style.
Layout i o
Style Select one of the following options:

o Symmetric. Displays clusters in a symmetric layout style.

D -D II

R - e

Circular. Displays clusters in a circular layout style.

4w
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ul
Element
(A-2) Description

Layout Adjusts the quality of the layout produced to fit your application's needs. The
Quality quality reflects the number of steps or the method used to produce the layout. For
example, high quality is sharper but takes more time to set the layout.

Select one of the following options:

o Draft. Produces faster results (faster than Medium and Proof).

e Medium. Produces aresult that is a combination of Draft and Proof, that is, it
produces a more accurate graph layout than Draft, but not as accurate as Proof.

¢ Proof. Produces a more refined result but takes more time.

Note: The differences between the speed and resulting layout of each quality
setting varies depending on the nature of the graph being laid out. You can try each
option to determine which works best for you.
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ul
Element
(A-2) Description

Spacing Sets the spacing around each graph node within the same cluster and between
clusters.

Enter values for the following settings:

o Between Graph Nodes. Sets the spacing around each graph node within the
same cluster. The larger the spacing, the more graph nodes there are on the
cluster boundary.

Default value: 50

This illustration shows smaller graph node spacing.

This illustration shows larger graph node spacing.

o Between Clusters. Sets the spacing between clusters.

Default value: 50

This illustration shows smaller cluster spacing.

TP

This illustration shows larger cluster spacing.

—

Hierarchical Tab

To access  Click the Hierarchical tab in the Layout Properties dialog box.

HP Business Service Management (9.24) Page 145 of 416



Modeling Guide
Chapter 6: Working with Topology Map

Important = The Hierarchical tab shows the precedence relationships that can represent

information = organizational or information management system dependencies, as well as
process models, software call graphs, and work flows. The hierarchical layout
emphasizes dependencies by placing the graph nodes at different levels.

User interface elements are described below:

Ul Element
(A-Z) Description

Backward  Specifies how backward relationships are displayed in the hierarchical layout.

Edges ) )
Select one of the following options:

¢ Minimize Backward Edges. Sets the number of backward relationships
displayed in a layer to a minimum.

o Optimize for Feedback Flow. Sets the number of backward relationships
displayed in alayer to a maximum. This mode is more appropriate for flow
charts.

Horizontal = Enables you to set the minimum horizontal distance between two neighboring
Spacing graph nodes at each level.

Enter values for the following settings:

o Between Graph Nodes. Sets a horizontal space around each graph node in
the layer.
Default value: 28

o Between Edges. This setting is available only when you select Routing >

Orthogonal. It sets a horizontal space between edges in the graph.
Default value: 12
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Ul Element

(A-2) Description

Layout Adjusts the quality of the layout produced to fit your application's needs. The
Quality quality reflects the number of steps or the method used to produce the layout. For

example, high quality is sharper but takes more time to set the layout.

Select one of the following options:

o Draft. Produces faster results (faster than Medium and Proof).

Draft

e Medium. Produces a result that is a combination of Draft and Proof, that is, it
produces a more accurate graph layout than Draft, but not as accurate as
Proof.

¢ Proof. Produces a more refined result but takes more time.

Note: The differences between the speed and resulting layout of each quality
setting varies depending on the nature of the graph being laid out. You can try each
option to determine which works best for you.
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Ul Element

(A-2) Description

Level Enables you to set the way graph nodes are vertically aligned.
Alignment

Select one of the following options:

e Top. This illustration shows that the top of the graph nodes at the same level of
the hierarchy are aligned.

e Center. This illustration shows that the center of the graph nodes at the same
level of the hierarchy are aligned.

e Bottom. This illustration shows that the bottom of the graph nodes at the same
level of the hierarchy are aligned.
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Ul Element
(A-2) Description

Orientation Enables you to set the orientation of the hierarchy.

Select one of the following options:

o Top to Bottom. The children are located above the parent.

o Left to Right. The children are located to the left of the parent.
e Bottom to Top. The children are located below the parent.

¢ Right to Left. The children are located to the right of the parent.

Orthogonal This setting is available only when you select Routing > Orthogonal. Maintain

Routing - the size of a graph node. Clear this option if you want the layout to increase the

Fix Node size of a graph node, if it is necessary to maintain the specified relationship

Sizes spacing, when more than one relationship is attached to the same side of the
graph node.

Polyline This setting is available only when you select Routing > Polyline. Polyline

Routing - routing routes edges (connecting lines) as one or more straight line segments with

Spacing arbitrary angles. Path nodes are added automatically to prevent the edges

Between (connecting lines) from overlapping.

Bends

Default Value: 12

Routing Select the type of routing for the layout. The available options are:
e Orthogonal

o Polyline

Undirected Edge direction is not used to build the levels of the hierarchical drawing.
Layout
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Ul Element

(A-2) Description

Variable Variable level spacing adjusts the spacing between pairs of neighboring levels

Level according to the density of edges between the levels.

Spacin

P 9 If the drawing's edges are orthogonally routed, this ensures the desired vertical

spacing between horizontal edges (in a top-to-bottom or bottom-to-top layout)
routed between levels.
If the routing is polyline, variable level spacing makes it easier to distinguish
among edges in very dense drawings.

Vertical Enables you to set the minimum vertical distance between two neighboring graph

Spacing nodes on different levels.

Enter values for the following settings:

o Between Graph Nodes. Sets a vertical space around each graph node in the
level.
Default value: 28

o Between Edges. This setting is available only when you select Routing >
Orthogonal. It sets a vertical space between edges in the graph.
Default value: 12
Orthogonal Tab

To access  To access: Click the Orthogonal tab in the Layout Properties dialog box.

Important The Orthogonal tab enables you to set orthogonal layout route relationships
information = horizontally and vertically. This results in relationships bending at 90-degree
angles only.

User interface elements are described below:

Ul

Element

(A-Z) Description

Fix Node Maintain the size of a graph node. Clear this option if you want the layout to

Sizes increase the size of a graph node if it is necessary to maintain the specified
relationship spacing when more than one relationship is attached to the same side
of the graph node.
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ul
Element
(A-2) Description

Horizontal Enables you to set the minimum horizontal distance between graph nodes.

Spacin
P 9 Select one of the following options:

o Between Graph Nodes. Set a horizontal space around each graph node in the
layer.

Default value: 20
o Between Edges. Set a horizontal space between elements in the layer.

Default value: 12

Layout Adjusts the quality of the layout produced to fit your application's needs. The
Quality quality reflects the number of steps or the method used to produce the layout. For
example, high quality is sharper but takes more time to set the layout.

Select one of the following options:
o Draft. Set the layout to draft quality.
e Medium. Set the layout to medium quality.

o Proof. Set the layout to proof quality.

Vertical Enables you to set the minimum vertical distance between graph nodes.

Spacin
P g Select one of the following options:

« Between Graph Nodes. Set a vertical space around each graph node in the
layer.

Default value: 100
o Between Edges. Set a vertical space between elements in the layer.

Default value: 20

Symmetric Tab

To access  Click the Symmetric tab in the Layout Properties dialog box.

Important The Symmetric tab displays a clear representation of complex networks. The
information symmetric layout emphasizes the symmetries that may occur in a graph.

User interface elements are described below:
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ul
Element
(A-2) Description

Layout = Adjusts the quality of the layout produced to fit your application's needs. The quality
Quality | reflects the number of steps or the method used to produce the layout. For example,
high quality is sharper but takes more time to set the layout.

Select one of the following options:

o Draft. Produces faster results (faster than Medium and Proof).

¢ Medium. Produces a result that is a combination of Draft and Proof, that is, it
produces a more accurate graph layout than Draft, but not as accurate as Proof.

e Proof. Produces a more refined result but takes more time.

Note: The differences between the speed and resulting layout of each quality setting
varies depending on the nature of the graph being laid out. You can try each option to
determine which works best for you.
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ul
Element
(A-2) Description
Spacing Allows you to set constant horizontal and vertical spacing around each graph node in
the layer. The value you specify is a guideline for the layout, so that it is possible that
the spacing for a particular pair of graph nodes might be different from the one you
specified. The larger the graph node spacing, the farther apart the graph nodes are
spaced in the final layout.
Default value: 50
The following figure illustrates smaller and larger spacing.
N, \"L._
/"’f f'-” H“'"‘x
-~ -~
D !
|| S
node spacing=75 node spacing=150
Routing Tab
To access Click the Routing tab in the Layout Properties dialog box.
Important The Routing tab enables you to produce drawings that leave graph nodes
information  essentially where they are, and reroute the lines orthogonally.

User interface elements are described below:

Ul
Element
(A-Z)

Fix Node
Positions

Fix Node
Sizes

HP Business Service Management (9.24)

Description

Maintain the position of all the graph nodes in the display. Clear this option for the
layout to move the graph nodes if it is necessary to improve the layout. The
movement is minimal, avoids overlaps, and minimizes bend points.

Maintain the size of a graph node. Clear this option if you want the layout to
increase the size of a graph node if it is necessary to maintain the specified
relationship spacing when more than one relationship is attached to the same side

of the graph node.
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ul
Element
(A-2) Description

Horizontal Enables you to set the minimum horizontal distance between graph nodes.

Spacin
P 9 Select one of the following options:

o Between Graph Nodes. Set a horizontal space around each graph node in the
layer.

Default value: 20
o Between Edges. Set a horizontal space between elements in the layer.

Default value: 12

Vertical Enables you to set the minimum vertical distance between graph nodes.

Spacin
pacing Select one of the following options:

o Between Graph Nodes. Set a vertical space around each graph node in the
layer.

Default value: 20
« Between Edges. Set a vertical space between elements in the layer.

Default value: 12

Main Menu

This feature contains the options for working with the topology map.

To access Located in the upper left portion of the screen.
Important The specific options contained within the Main Menu drop-downs are detailed
information in "Toolbar Options" on page 157.

User interface elements are described below:

Ul Element
(A-2) Description
Edit Contains selection options for the topology map.

Editor Item  Contains the topology map shortcut menu options for the current manager.
Note: This drop-down does not appear in Cl Type Manager.

Layout Contains options for changing the layout of the topology map.
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Ul Element
(A-2) Description

Operations | Contains options for printing or exporting the topology map.

Resources Contains the left pane shortcut menu options for the current manager.

Note: This drop-down does not appear in IT Universe Manager, and in Cl Type
Manager it is called Cl Types.

Tools Contains the User Preferences, Log Configuration, and Screen Capture tools.
View Enables you to hide or display the different panes of the module.
Print Dialog Box

This dialog box enables you to print the contents of the topology map.

To access  Select Operations > Print.

Important The results of printing a topology map is similar to a screen capture. Therefore,
information = before printing, it is recommended to:

o Define your print settings and arrange the contents of the topology map
according to your requirements. For details, see "Print Setup Dialog Box" on
the next page.

o Arrange the contents of the topology map for print. You can use the Layout
option and Layout Properties. For details about the layout options, see
"Layout Properties" on page 160. For details about layout properties, see
"Layout Properties Dialog Box" on page 139.

Relevant "Print and Save a Topology Map to File" on page 195
tasks

User interface elements are described below:

Ul Element (A-Z) Description
Number of copies Enter the number of copies you want to print.
Properties Define document properties as required.

Print Preview Dialog Box

This dialog box enables you to preview the content of the topology map before printing.

To access Select Operations > Print Preview.

Relevant tasks "Print and Save a Topology Map to File" on page 195
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User interface elements are described below:

Menu Item Description

& Print the map. For details, see "Print Dialog Box" on the previous page.
Zoom out to view the map.
Zoom in to focus on specific details of the map.

Fit the complete view in the pane.

Print Setup Dialog Box
This dialog box enables you to define the print settings for a topology map.

To access Select Operations > Print Setup.

Relevant tasks "Print and Save a Topology Map to File" on page 195
User interface elements are described below:

Ul Element
(A-2) Description

Actual Size | Print the view as it really is.
Color Set the text color.

Font Set the required font.

Page Setup = Set the printer settings.

Pages Divide the map into rows and columns and print each section separately. Enter
the number of columns and rows in the Page Columns and Page Rows boxes.

Position Select the position of the caption from the Position list.

Print Print the background behind the view.

Background

Print Print the map with a border. Click Color to select the required border color.
Border

Print Enter the caption in the text area and click Font to select the required custom
Caption font.

Print Crop Print the crop marks.
Marks
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Ul Element
(A-2) Description

Print Print the selected graph nodes and their relationships.
Current
Selection

Print Print the part of the view that appears in the pane.
Current
Window

Print Entire = Print the complete view.
Drawing

Print Page Print the page numbers.
Numbers

Zoom Level ' Print the view at the current zoom level.

Toolbar Options

The following table contains a description of each Topology Map toolbar option, organized
alphabetically.

Note: These toolbar options are relevant for RTSM applications.

Button Option Name Use This Option to...

S Additions Count Calculate the number of instances that are created as a result
of an Enrichment Rule. The number of TQL query node
instances and relationships that are created appear next to the
Enrichment query nodes/relationships, as seen in the figure
below.

(=
IpSubnet(d)

Membershipa)

e

+

|New NDdE{SHI

Note: This option appears in the toolbar in Enrichment Manager
only.
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Button Option Name

FEEL

I}
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Advanced Pane

Calculate Query
Result Count

Change Label

Length/Properties

Cl Types Tree

Create
Relationship

Delete Selected
Item(s)

Drag Map

Drill Down One
Layer

Enable/Disable
Related Cls
Retrieval

Use This Option to...

Toggle between hiding and displaying the Advanced Pane at
the bottom center of the screen.

To access: Select View > Advanced Pane.

Calculate the number of instances found for each TQL query
node/relationship.

Enter the maximum number of characters that the labels should
contain.

To access: In IT Universe Manager and the Modeling Studio,
select Layout > Change Label Properties. In the other
managers, select Layout > Change Label Length.

Toggle between hiding and displaying the CI Type Selector at
the right of the screen.

To access: Select View > Cl Types Tree.
Note: In the Modeling Studio, this option is called Cl Types.

In most managers, create a relationship between two existing
TQL query nodes. For details, see "Add Query Nodes and
Relationships to a TQL Query" on page 23.

In IT Universe Manager, create a relationship between existing
Cls. For details, see "Attaching Existing Cls" on page 184.

Delete a Cl from IT Universe Manager or a TQL query node
from Impact Analysis Manager or Enrichment Manager.

Drag the view.

To access: Open the drop-down menu in the Mode box or
select View > Drag Map. In IT Universe Manager and the
Modeling Studio, select Layout > Dragging Mode.

Move down one level in the topology map. This option is
enabled only if there is an additional Cl layer below it, created
by setting the hierarchy of the view. For details on setting the
hierarchy, see "Setting the View Hierarchy" on page 230.

Note: This option appears only in IT Universe Manager.

Toggle between disabling and enabling the redrawing of the
topology map with related Cls when selecting a new Cl in the
Cl Selector.

Note: This option appears only in IT Universe Manager in the
Related Cls tab.
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Button Option Name
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Entities Tree

Export Map to
Image

Fit to Window

Generate Direct
Link

Go Up One Layer

Hide All
Inheritance From
Map

Hide All Query
Node Labels

Hide All
Relationship
Labels

Use This Option to...

Toggle between hiding and displaying the manager specific
entities tree at the left of the screen.

To access: Select View > Entities Tree.

Note: In the Modeling Studio, each of the tabs of the Left pane
(Resources, Cl Types, Cl Selector) s listed as a separate
option.

Save the topology map to afile. For details, see "Export Map to
Image Dialog Box" on page 138.

To access: Select Operations > Export Map to Image.
Fit the complete map in the pane.

To access: Select Layout > Fit to Window.

Generate a direct link to a view or Cl.

To access: Select Edit > Generate Direct Link.

Move up one level in the topology map. This option is enabled
only if there is an additional Cl layer above it, created by setting
the hierarchy of the view. For details on setting the hierarchy,
see "Setting the View Hierarchy" on page 230.

Note: This option appears only in IT Universe Manager.

Toggle between showing and hiding Inheritance_f relationships
and their connecting query nodes.

To access: Select Layout > Hide All Inheritance From Map.

Note: This option is only active in the toolbar in Cl Type
Manager.

Toggle between showing or hiding the CI/CIT/query
node/pattern labels.

To access: Select Layout > Hide All Query Node Labels.

Note: This option is not available in IT Universe Manager and
the Modeling Studio.

Toggle between showing or hiding the relationship labels.
To access: Select Layout > Hide All Relationship Labels.

Note: This option is called Hide edges' labels in IT Universe
Manager and the Modeling Studio.
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Button Option Name

Hide All
Relationships

fie Hide/Show Get
Related Cls pane

Hide/Show Legend

Interactive Zoom

Layout Properties

Use This Option to...

Toggle between showing and hiding the relationships in the
displayed map.

To access: Select Layout > Hide All Relationships.

Note: This option is not available in IT Universe Manager and
the Modeling Studio.

Toggle between hiding and displaying the Get Related Cls
pane.

Note: This option appears only in IT Universe Manager in the
Related Cls tab.

Toggle between hiding and displaying the topology map legend.

Note: This option appears only in IT Universe Manager and the
Modeling Studio.

o Decrease the view magnification by clicking and pushing the
pointer upwards.

o Magnify the view by clicking and pulling the pointer
downwards.

To access: Open the drop-down menu in the Mode box or
select View > Interactive Zoom.

Note: This option is not available in IT Universe Manager and
the Modeling Studio.

Define the view's layer layout, by assigning positions for the
query nodes and relationships of the view. For details, see
"Layout Properties Dialog Box" on page 139.

To access: Select Layout > Layout Properties.
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Button Option Name Use This Option to...

Layout Select the layout display from the list. The options are:

o Hierarchical Layout. Enables you to display the
precedence relations in the topology map.

« SymmetricLayout. Enables you to display clear
representations of complex networks.

e Circular Layout. Groups a graph's nodes into groups or
clusters.

o Orthogonal Layout. Enables you to display views of
outstanding clarity that are achieved by employing only
horizontal and vertical edge routing.

e Manual Layout. Enables you to display the changes you
have made manually to the topology map.

For further details about each of the options, see "Layout
Properties Dialog Box" on page 139.

Note: These layout options are only relevant for Enrichment
Manager, CIT Manager, and Impact Analysis Manager.

Log Configuration = Open the Log Configuration dialog box.
To access: Select Tools > Log Configuration.

Map overview Open a small box with a copy of the topology map. This is
useful in large views when zooming in.

To access: Select Layout > Map Overview. In IT Universe
Manager and the Modeling Studio, select Layout > Show Map

Overview.
= Maximize Toggle between the regular display and a full-screen display of
Workspace/Restore the topology map.

Workspace
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Button Option Name Use This Option to...

Navigation Take the pointer to the next connected CI/CIT/TQL query node
in a clockwise direction.

o Left-click to move in a clockwise direction.

¢ Right-click to point to the next CI/CIT/query node/pattern in
a clockwise direction.

To access: Open the drop-down menu in the Mode box or
select View > Navigation.

Note:

e You can use this option only on CI/CIT/query
nodes/patterns that are connected by relationships.

¢ This option is not available in IT Universe Manager and the
Modeling Studio.

@ New CI Define a new unrelated Cl. For details, see "Working with Cls"
on page 179.
Note: This option appears in the toolbar in IT Universe Manager
only.

= New Related CI Define a new related Cl. For details, see "Working with Cls" on
page 179.
Note: This option appears in the toolbar in IT Universe Manager
only.

Place in Center Place the selected CI/CIT/query nodes/pattern in the center of

the map.

To access: Select Layout > Place in Center.

Note: This option is not available in IT Universe Manager and
the Modeling Studio.

Print Print the contents of the topology map. For details, see "Print
Dialog Box" on page 155.

To access: Select Operations > Print...
Print Preview Preview the contents of the map before printing.
To access: Select Operations > Print Preview.

Print Setup Define print settings for printing the topology map. For details,
see "Print Setup Dialog Box" on page 156.

To access: Select Operations > Print Setup...
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Button Option Name

HP Business Service Management (9.24)

Remove
Enrichment
Results

Screen Capture

Select

Select All

Select All Query
Nodes

Select Columns

Set Change
Timeframe

Show Candidates

for Deletion

Use This Option to...

Remove the instances created from an Enrichment rule from
the RTSM.

Note: This option appears in the toolbar in Enrichment Manager
only.

Take a snapshot of the screen using the Screen Capture tool.
To access: Select Tools > Screen Capture.

Select a CI/CIT/TQL query node or multiple Cls/CITs/TQL
query nodes.

To access: Open the drop-down menu in the Mode box or
select View > Select. In IT Universe Manager and the
Modeling Studio, select Layout > Selection Mode.

Select all the Cls and relationships in a selected layer.
To access: Select Edit > Select All.

Note: This option is not available in IT Universe Manager and
the Modeling Studio.

Select all the query nodes in a selected layer.
To access: Select Edit > Select All Query Nodes.

Note: This option is not available in IT Universe Manager and
the Modeling Studio.

Enables you to select the columns to be displayed. For details,
see "Select Columns Dialog Box" on page 412.

Note: This option is displayed in Text mode of IT Universe
Manager only.

Open the Change Timeframe dialog box, which enables you to
set the period for the display of added or changed Cl indicators.

Note: This option appears in the toolbar in IT Universe Manager
only.

Identify the Cls in the current view which are candidates for
deletion with the following icon A1

Note: This option appears in the toolbar in IT Universe Manager
only.
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Button Option Name Use This Option to...
) Show Schedule Display the scheduling information for the selected job. For
Info details, see "Discovery Scheduler Dialog Box" in the Data Flow

Management Guide.

Note: This option appears in the toolbar in the Dependency Map
tab of DFM. For details, see "Dependency Map Tab" in the
Data Flow Management Guide.

=4h Sort Column Enables you to set the order of the visible columns. For details,
Content see "Sort Column Content Dialog Box" on page 413.

Note: This option is displayed in Text mode of IT Universe
Manager only.

Straighten Straightens any selected relationship between two query nodes
that has angles.

To access: Select Layout > Straighten.

Note: This option is only available in Enrichment Manager and
Impact Analysis Manager.

User Preferences Opens the User Preferences dialog box which enables you to
reset warning message preferences. For details, see "User
Preferences Dialog Box" on page 88.

To access: Select Tools > User Preferences.

User Profile Opens the User Profile dialog box which displays the user
details for the user currently logged in.

To access: Select Tools > User Profile

Zoom In Zoom in on a specific section of the topology map by clicking
and drawing a selection rectangle around the part to magnify.
The area you select is displayed at the highest percentage that
fits in the topology map.

To access: Open the drop-down menu in the Mode box or
select View > Zoom In. In IT Universe Manager and the
Modeling Studio, select Layout > Zoom in.

Topology Map Sidebar

The following table contains a description of each Topology Map sidebar option. The Topology Map
sidebar appears in IT Universe Manager and the Modeling Studio.
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Button Option Name
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Move Layout
Toolbar to
Right/Left

Zoom In/Out

Selection Mode

Dragging Mode

Refresh to get an
optimal layout

Fit to Window

Hide Edges' Labels

Change label
properties

Show Map
Overview

Hierarchical Layout

Hierarchical Layout
with Orthogonal
Routing

Circular Layout
Orthogonal Layout

Symmetric Layout

Print

Use This Option to...

Move the sidebar to the right or left side of the screen.

Zoom in or out on the topology map.

Enable selection mode in the topology map.

Enable dragging mode in the topology map.

Refresh the topology map to optimize the layout.

Fit the complete map in the pane.

Hide the labels of all relationships.

Open the Map Label Properties dialog box which enables you to
set the maximum label length per line and maximum number of
lines per label.

Open a small box with a copy of the topology map. This is
useful in large views when zooming in.

Display the topology map in a layout displaying the precedence
relations.

Display the topology map in a layout displaying the precedence
relations using only horizontal and vertical edge routing.

Display the topology map in a layout that groups a graph's
nodes into groups or clusters.

Display the topology map in a layout using only horizontal and
vertical edge routing.

Display the topology map in a layout showing clear
representations of complex networks.

Print the topology map.
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Button Option Name Use This Option to...
f'_'f‘ Export Map to Save the topology map to afile.
Image
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This chapter includes:

Using Modeling Studio ... ... . 168
Models and Perspectives . ... 168
BUIlding MOEIS . .. ... 168
Model Dependencies on Other Cls inthe RTSM ... . .. 173
Modeling an Application with Running Software ... ... . .. ... 173
Creating Views Using the Modeling Studio ... . 174

Using Modeling Studio

The Modeling Studio is the RTSM module for building and modeling views for display in Service
Health. This document details the required flow to create Service Health views using the Modeling
Studio.

The motivation behind developing the Modeling Studio is to create a separation between the need to
change the RTSM content by creating Cls and relationships and the need to consume (view) the
RTSM content. In earlier versions, altering the RTSM content was part of the view creation
workflow. Hence, users were unintentionally changing the RTSM and influencing other users'
views. In the Modeling Studio, you build models and transform your content into views to be
consumed by BSM.

Models and Perspectives

A model is a Cl collection that represents a managed business entity such as an application,
business service, or line of business. A model is usually created by solution or application
architects who are familiar with the content and hierarchy of the model. The model content can
include system Cls (typically nodes), running software Cls (such as web servers, databases, and
J2EE servers), end user monitoring components (Business Process Monitor or Real User Monitor
applications), business processes, groups, and other existing models.

To generate a view from a model, a perspective needs to be applied. A perspective is a TQL-based
tool that enriches the model content by adding additional Cls, thus creating a view. The default
perspectives that are applied to create Service Health views add all descendent Cls that are related
by impact links down to the level of monitor Cls. There are other perspectives provided out of the
box that can be used to address additional use cases.

The resulting view shows the model content as it is monitored by BSM.

Building Models

The information required to define a model includes the CI content, the hierarchy, and the
dependencies upon additional Cls.
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BSM is configured with a predefined list of Cl types that represent your business entities. When
creating a new model using the Modeling Studio, the following list of valid models appears:

Select Cl Type

@ BuzinezzApplication
BusineszFunction

.;"_E_:; Business Service

@ BusinessTransactionFlow
(@] ciCallection

&:l Infrastructure Service

& organization

The model Cl types can be arranged in hierarchies to reflect the organization's specific needs. Here
is an example of a typical recommended model hierarchy:
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Line of Business

l

Unit

Business Service/Business

Business Process

Application

|

Groups (infra/End User)

Software Elements/
System Monitors

BPM/RUM

A model can be nested in any logical hierarchy, but it is best to create a hierarchy that starts from
high level business entities down to more specific model types.

Itis strongly recommended to build models in a way that allows them to be reused as components

of other models.

Building a model creates a contains link between the model and its Cls according to the defined

hierarchy.

The creation of a Cl which is a model Cl results in the creation of an empty model by default.

Therefore, if you want to create a model for a Cl that does not yet exist, you create a new model and
thus, a new CI. If you want to model an existing Cl for the first time, select the Cl in the CI Selector,
drag it onto the canvas and select Create a New Model.
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Preconfigured Models

BSM creates out-of-the-box models for applications monitored by Business Process Monitor and
Real User Monitor.

The Business Process Monitor model is of type business transaction flow and it contains business
transaction Cls.

¥l Banking® X -
13 wep [ERText) ' @ 0B X|& -G B | Qi
Name | Cl Type
= @ Banking BusinessApplication
B @ Credit cards BusinessTransactionFlow
@ trans_1 BusinessTransaction
@ trans_2 BusinessTransaction
@ tranz_3 BusineszTranzaction
@ trans_4 BusinessTransaction

The Real User Monitor model is of type application and contains the End User Management
Application related group and business process step Cls. The Real User Monitor model is also
impacted by the Real User Monitor Sessions monitor Cls, Real User Monitor Errors events Cls,
and Real User Monitor Informational events Cls, which are visible in the Related Cls pane.

CE Saving Account < -
Text Mode  w|EE o0 @) 7 =l fg - Gy - B -] QFind

[% Name | Cl Type
|E|- % Saving Account | Application
E— .ﬁ Business Processes End User Management Application Related Group
“_.! Show accounts list Business Process Step
:-' Select accournt Business Process Step
} Update profile Business Process Step
:-' Search by dates Business Process Step
:-' request check book Business Process Step
‘_.1 Account history Business Process Step

Properties Pelated Cls Watchpoints

Saving Account (Application) @ [*]

Fitter | <Show All= |v | by |

i cl Cl type | Relation type
> 7> Fum Info Events RUM Informational Events J Impacted By (Patentially)
> 25 Application Sessions RUM Sessions monitor ] Impacted By (Potertially)
> 7% Pum Errors RUM Errors events J Impacted By (Potertially)

Building Model Content

Create a model of the desired type and assign it a name. The new model appears as the top Cl in
the content pane of the Model Editor. Drag and drop Cls from the CI Selector into the content pane
to build the model content.

A model can contain system Cls, running software Cls, SiteScope groups, and other models (both
existing models and new ones created during the modeling process).

The only Cls that cannot be part of a model containment tree are monitors. Monitor Cls are added to
a model after you generate a view from the model using one of the monitor perspectives. You can
include monitors in view by dragging them into the Related Cls pane when a model Cl is selected in
the upper pane of the Model Editor. If you try to drop a monitor Cl into the upper pane, a message
appears prompting you to add the monitor Cl to the Related Cls pane.

The CI Selector pane offers two ways to search for a Cl (both model Cls and non-model Cls):
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o Browse Views

Use this option when you are familiar with a view that contains the Cl you are looking for. The
following out-of-the-box views can help you find commonly used Cls:

= End User Monitors view - contains business process groups and their content.
= System Monitors view - contains SiteScope groups hierarchy.

= System Software Monitoring view - contains running software Cls and the servers on which
they are deployed.

Inthe CI Selector, select Browse Views and begin entering the view name or use the view tree
to look for a Cl in a specific folder.

o Search Cls

If you know the ClI type you are looking for, select the Search Cls mode and use the quick
search dialog to locate the desired Cl. Use the Advanced Search option for Cls that do not
appear in the quick search mode.

The search result appears in the left pane. After the list of Cls is refreshed, you can drag and
drop Cls into the model content pane. It is possible to drag and drop multiple Cls in a single
selection.

Models can be placed in a hierarchical mode. During the process of building the content you can
insert new models and create groups.

Hierarchies between Cl types which are not models is not supported.

Grouping

In some cases, there is a need to divide the model into logical groups according to ownerships,
locations or any other custom representation.

In the following example the application contains two groups that represent data centers:

£ Bank One Data Centers* x| 4
I mep e ' @ LE LY X |G W W M -G - - QFn
Name | Cl Type
=3 C% Bank One Data Centers Business Service
EL'T'@ NY Data Center CiCollection
|: % 127001 DefaultDomain MNode
=] 10-END1 6 Windows
| [ LA Data Center CiCollection
@ ilogh89362eaf devlab.ad Windows
@ ilogb 8937 34wa devlab ad Windows
[E] LaBMIAPPO3 Windows
@ LAEM3AMINTOE Windows

For details on creating groups in a model, see "Model Editor" on page 267.
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Model Dependencies on Other Cls in the RTSM

Each model Cl in the model can be dependent on other Cls that exist in the RTSM but are not part
of the model itself. Examples of such Cls include shared resources such as database servers and
storage devices.

The model structure may vary between organizations according to policies and responsibilities in
the IT department. There are organizations where shared resources are considered to be part of the
application and are monitored as part of it, while in other organizations they are considered external
to the application. In the first case, shared resources are part of the model and appear in the content
pane, whereas in the second case they appear as related Cls (in the lower pane of the Model
Editor).

To create a dependency between a Cl in the model and another Cl in the RTSM, search fora Cl in
the left pane and drag it into the Related Cls tab. This operation creates a usage link in the RTSM.

In order to create a dependency relationship between two Cls, there must be a valid link in the
RTSM between the two Cl types. By default, all business Cls can be dependent on other business
Cls.

The following example shows an application that depends on a web server and Oracle software
elements:

G Credit cards®<
Fotvor w60 @ 2|8 6 A - Gy B -] QFne

Name Cl Type

=~ Credit cards Business Process Group
:.‘ Future debits Business Process Step
‘_.1 Select credit card Business Process Step
} Request data from Amex Business Process Step
:-' Request new credit card Business Process Step
:-' Last statement Business Process Step

Properties Pelated Cls ‘Watchpoints
<Show All> ¥ | by
Direction | cl Cltype | Relation type

i > 2 Microsoft IS Web Server (16.59.57.145) s J Depends On
i > % DB35 (labmZamdbl1) Oracle J Depends On
T

Filter

BSM offers a revised out-of-the-box impact model. The impact model describes the impact
relationships between ClI types. For example, a running software Cl is impacted by the node on
which it is deployed. In the Modeling Studio, when you include a running software Cl as part of a
model, the node on which it is deployed appears in the Related Cls tab, since the running software
is dependent on the server.

Modeling an Application with Running Software

Running software Cls are Cls that describe the implementation components of an application.
Examples include web servers such as |IS or Apache, application servers such as Webshpere or
Weblogic, and databases.

To build the implementation model of a three tier application using its running software Cls, create
an application model.
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You can use the Running Software search in the Advanced Search dialog or browse the System
Software Monitoring view to locate running software Cls. The names of the running software Cls
are formed by combining the running software ClI type with the server name, for example,
Microsoft IIS web server (Serverl).

Drag the relevant running software Cls into the modeling pane. The server on which the running
software was deployed as well as the monitor of the running software both appear automatically in
the Related Cls pane. This change derives from the new SiteScope monitoring model. In previous
versions, all monitors (of both hardware and software) were connected to the Server CI. The
SiteScope model was enhanced and now hardware monitors are connected to the server Cl, while
software monitors are connected to the running software Cls.

Creating Views Using the Modeling Studio

There are two methods of creating perspective-based views using the Modeling Studio. The first
option is to create a view based on a model (or on several models); the second one is to create a
view out of CI collection that is not a model.

A view based on a model is updated automatically when the model content is updated. For
example, a view was generated using a business process group model that initially contained five
business process steps. The business process group was then updated to include additional
business process steps. Those changes are automatically reflected in the view.

This option is the recommended one, since it creates a dynamic view.

In a view based both on models and individual Cls, the view content is updated according to
changes in the models.

Generating a View from a Model

After building a model and saving the model definition, select the top model and select Generate
view for selected model. In the dialog box that opens, select the desired perspective according to
the desired view content.

The recommended perspective is the Impact Perspective. It creates a view with all the Cls in the
model and for each Cl, it adds all the child Cls including the monitor Cls. Additional perspectives
that may be used for other purposes are described in "Predefined Folders and Views" on page 234.

If the selected model includes dependent Cls (which appear in the Related Cls tab), they are also
enriched by the perspective and become part of the view.

The Content Only perspective does not make any changes in the view, even for model Cls.

Hiding Irrelevant Cls from a View

The view result appears in the View Results pane. At this point, you may choose to hide Cls that
appear in the view.

Hiding Cls from a view does not change the status calculation of Cls in the view (the status
calculation is performed according to the RTSM hierarchy). For example, hiding two business
process steps from a business process group with five steps does not affect the business process
group status. If a hidden CI has a critical status and the remaining Cls are OK, the business
process group shows a critical status.
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For details on hiding Cls and restoring them to a view, see "Building a Perspective Based View" on
page 237.
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IT Universe Manager Overview

IT Universe Manager enables you to manage the content of your IT Universe model. The following
tasks represent the basic functionality of the application:

o Creating Cls without creating relationships. You can define new Cls that are added to the
RTSM individually, so that no new relationships are created. For details, see "Creating a Non-
Related CI" on page 180.

¢ Creating Cls with relationships for them. You can define new Cls and attach them to
existing Cls, so defining a new Cl and a new relationship in the RTSM. For details, see
"Creating a Related CI" on page 180.

o Adding existing Cls and creating relationships for them. You can attach Cls to an existing
Cl, so creating new relationships for existing Cls. For details, see "Attaching Existing Cls" on
page 184.

« Deleting Cls. You can delete Cls from the RTSM. For details, see "Deleting Cls" on page 180.

« Getting Impact Analysis results. You can run the Impact rules you defined for a view to
simulate how certain defined changes impact your system, and to discover the root causes of
the changes. For more information about Impact rules, see " Impact Analysis Manager
Overview" on page 331.
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Populating the IT Universe Model

The IT Universe model in the RTSM contains the Cls and relationships produced by the ClI-
generating tools that operate within BSM. Most Cls and relationships originate from one of the
following sources:

« Data Flow Management (DFM). Automatically creates Cls and relationships based on the
discovered IT resources and topology in your company's infrastructure. For details, see Data
Flow Management Overview in the Data Flow Management Guide.

o IT Universe Manager. Enables you to manually create Cls and relationships that represent
logical and physical elements of the business. For details, see "Working with Cls" on page 179.

« End User Management Administration and System Availability Management
Administration. Enables you to manually create relationships between the Cls for monitor
objects and Cls in the RTSM. For details, see "Integrating SiteScope Data with BSM's
Configuration Items" in the BSM User Guide.

« Enrichment Manager. Enables you to add Cls and relationships to the RTSM by receiving data
from the attributes of Enrichment query nodes as defined in the Enrichment TQL query. For
details, see "Enrichment Manager" on page 382.

Working with Views in IT Universe Manager

In IT Universe Manager, you analyze data at the view level. Views are subsets of the IT Universe,
containing only those Cls relating to a specific area of interest. All views are based on a pattern
which determines the content of the view.

o Pattern views and template-based views are built from a TQL (Topology Query Language) query
that defines the structure of the view. The view displays only those Cls and relationships that
satisfy the query definition.

o Perspective-based views are built manually, by selecting a group of Cls and applying
perspectives to them. A perspective is a pattern used to define which related Cls are included in
the view.

You build all views in the Modeling Studio, using the appropriate editor for each view type. For
information on the different view types and how they function, see "View Formats" on page 229.

Note: You must have Change permissions for a view to edit the view. If you do not have the
necessary permissions, contact your BSM Administrator.

Cls created by DFM are automatically added to each view where the Cls (and their relationships) fit
the TQL definition for the view. When you open a view in the Cl Selector, the TQL query for the view
queries the RTSM for Cls that match the defined pattern. If there are no matches (for example, in
the case of a view for a DFM process where the process has not yet run) then the view remains
empty.
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You can also include Cls from external data sources (federated Cls) in your view, by defining the
query to run over integration points for federated data sources. The federated Cls appear in the view
with an arrow icon indicating that they are from a federated source.

X

—

For details on federated data sources, see "Integration Studio Overview" in the Data Flow
Management Guide.

When you define a new Cl while working in any view in IT Universe Manager, the Cl (and any
associated relationship) is created in the RTSM. The Cl is added to your current view only if it
meets the view's TQL specifications.

If the created Cl and relationship do not meet the TQL requirements, then the Cl and relationship
are created in the RTSM but are not visible in the view. Similarly, if you attach an existing Cl toa Cl
in the view, and the new pattern does not meet the TQL requirements, then the attached Cls do not
appear in the view, but the relationship is still created.

Templates and Template-based Views

If you open a template in IT Universe Manager, it is displayed in the topology map like a pattern

view. Click the Show Template Parameters button *f? in the CI Selector toolbar to open the
Template Parameter Values dialog box, where you can change the values of the template
parameters and thereby affect the view results displayed in the topology map. You can try different
parameter values and see the resulting topology map, but you cannot save changes to the template
itself. To save the view results as a template-based view with the selected parameters, click the
Save As View button in the Template Parameter Values dialog box.

You can also create a direct link to a template in IT Universe Manager and insert the parameter
values directly into the URL. For details, see "Create a Direct Link to a Template with Parameter
Values" on page 99.

View Lifecycle

If you do not access a view from the CI Selector for a specified period of time, the view is cleared
out, to save memory in the system. It is not deleted from the RTSM; the view can be retrieved by
clicking on it. The default time period for clearing out unused views is one hour.

Note: Views defined as persistent are not cleared out and always remain in the memory.

Hidden Views

You can designate a view as a hidden view that does not appear in IT Universe Manager by defining
a bundle for hidden views and assigning the view to that bundle.

To designate a view as a hidden view:
1. Inthe Infrastructure Settings Manager, select Hidden Bundles Names in Cl Selector.
2. Enterthe name of the new bundle as the default value and save the setting.

3. Inthe Modeling Studio, open the relevant view and click the View Definition Properties
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button 5y in the toolbar.

4. Inthe View Definition Properties dialog box, select the hidden views bundle and assign the
view toit.

View Tree Structure

Views are organized in a hierarchical tree format in the left pane of IT Universe Manager, which is
known as the Cl Selector. The view name appears in the View box above the tree and acts as the
containing folder for the Cls in the view.

The first level of the Cl Selector tree consists of the query nodes for the root Cls. A root Cl is the
starting point for a view subtree. A view may contain any number of subtrees. Under the root Cls
come the branch Cls, expanding down to the leaf Cls as the last query nodes at the ends of each
branch.

The Cls at each level in a subtree are considered to be attached to the Cl on the branch directly
above. This attachment generally depicts a dependent relationship, so that the higher branch
(closer to the root Cl) represents a component of your business that depends on the Cls on the next
branch down (closer to the leaf Cls) in the business process. For example, an application depends
on the servers running the application.

The attachment between a higher and a lower query node is referred to as a parent-child
relationship. The parent CI may have many attached child Cls, and the child Cls pass operational
status to the parent. The status at each level is viewed in Service Health.

view: [End User Monitors view I BPM_Profilet - =

e Uty  Availability D¢y Ack B

B T End User Monitars view

BB e profile | Hierarc hy KPIs Business Impact Alerts Change
~
:-; cnnz Nam Performance Availability
# gocgle =T @4y @+
@49 @+
=T Qe Qeg
O LA

The tree topology is determined by the hierarchy defined for the view. In a pattern view, these are
defined for the specific view. In a template-based or a perspective-based view, the hierarchy is
defined as part of the template or perspective. For details on defining the hierarchy, see "Setting the
View Hierarchy" on page 230.

Working with Cls

In IT Universe Manager, you can create related and non-related Cls, delete Cls, edit the CI
properties, and remove out-of-date Cls using the aging mechanism.

This section includes the following topics:
o "Creating a Non-Related CI" on the next page

o "Creating a Related CI" on the next page
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e "Deleting Cls" below
o "Cl Properties" on the next page

+ "Removing Out of Date Cls Using the Aging Mechanism" on the next page

Creating a Non-Related CI

You can define a new Cl in IT Universe Manager by clicking the New CI button # in the toolbar.
The New CI dialog box opens, which enables you to define the properties for the new CI. The Cl is
created in the RTSM. For details, see "New Cl/New Related Cl Dialog Box" on page 217.

Note: The Cl is added to the view only if it meets the specifications of the pattern of the view,
template, or perspective.

A ClI created in this way is added as an independent entity without any relationship to any other
existing Cl in the RTSM.

Creating a Related ClI
You can define a new ClI to be added as a parent, child, or sibling of an existing CI.

To define a new related Cl:

1. Select the Cl in your view to which you want to attach the new CI.

2. Click the New Related CI button w in the toolbar.

3. Inthe New Related ClI dialog box, define the properties and relationship for the CI. For details,
see "New CI/New Related ClI Dialog Box" on page 217.

The Cl and relationship are created in the RTSM.

Note: The Cl and relationship are added to the view only if they meet the specifications of
the pattern of the view, template, or perspective.

Deleting Cls

You can delete a Cl by selecting Delete from CMDB from the shortcut menu in IT Universe
Manager. The Cl is deleted from the RTSM and from all views. If the CI has children, they are not
automatically deleted when you delete the parent CI. If you delete a Cl without first deleting the
relationship between the Cl and any child Cls that appear with the parent Cl in a view, the child Cls
are removed from the view.

If the child Cls do not appear in any other view, they remain in the RTSM without appearing in a
view. The child Cls might appear in the future in views where they meet the pattern requirements.

One exception to this rule is when the relationship between a child and parent Cl is a Composition
relationship; in that case, when the parent Cl is deleted, the contained Cl is also removed from the
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RTSM. For example, if a node Cl is the container for a child CPU ClI, then when the node Cl is
deleted, the CPU is also removed from the RTSM.

When you delete a Cl that was created by the DFM process, the Cl is restored the next time that
DFM runs (if the Cl is still valid), and it reappears in all relevant views.

Note: If an application, business transaction flow, business transaction, or location CI that has
a RUM or BPM configuration was removed from the RTSM, it is automatically restored by
EUM to ensure the stability of the EUM configuration. The restored Cl name comprises the Cl
ID number concatenated with _restored. In some cases, links to related Cls are not restored.

Cl Properties

In IT Universe Manager, you can edit the properties of a Cl. The CI properties are divided into
several categories which appear in the New CI dialog box:

o The general properties of a Cl are common to all Cls. Some general properties are defined
automatically during CI creation; others can only be defined manually in the New CI dialog box.

o CIT-specific properties are created as part of the CIT definition in the Cl Type Manager. The
values for the CIT-specific properties are taken from the Cls discovered during DFM. The values
can also be entered manually, when you manually create Cls to represent entities in your
infrastructure. For details, see "C| Type Manager" on page 348.

« Key properties can be general or CIT-specific properties, which must be assigned a value to
create an instance of the Cl type.

You can access the Configuration Item Properties dialog box to view the Cl properties from IT
Universe Manager by right-clicking the Cl and selecting Properties or by clicking the Properties tab
in the Advanced pane. You can also edit the CI properties if you have the necessary permissions
for editing Cls. For details on Cl properties, see "Configuration Item Properties Dialog Box" on page
200.

The CIT-specific properties are displayed in the Specific Properties section of the Configuration
Item Properties dialog box when you sort the properties using the Categorized button. Some
properties for the automatically created Cls can be edited, however, if the Cl is configured to Allow
Cl Update (in the General Properties), then DFM may override your changes when it updates the
CI. A description of the selected property can be found in the Description area at the bottom of the
Configuration Item Properties dialog box.

Some of the CIT-specific properties for DFM Cls are set by default to be monitored for changes.
When one of these properties has been modified, information on the change can be viewed in a ClI
change report, and in some cases, anicon is displayed in Service Health. For more information, see
CI Change Reports in the User Reports part of the BSM User Guide.

Removing Out of Date Cls Using the Aging Mechanism

If a Cl or relationship is not updated or refreshed over a period of time (for example, a Cl is not
rediscovered by DFM and no manual update occurs), an aging mechanism deletes the Cl from the
RTSM. For details, see "ClI Lifecycle and the Aging Mechanism" in the RTSM Administration
Guide.
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Note: The following actions that apply to Cls cannot be performed on federated Cls:
o Editing the CI properties

o Deleting the CI

o Creating a relationship to another ClI

o Viewing the Cl History

e Adding the Cl to a Discovery job

¢ Removing the CI from a Discovery job

Working with Relationships

Many of the relationships between Cls in the RTSM are created automatically, for example, by
DFM. In addition, you can create relationships manually in IT Universe Manager, Enrichment
Manager, Impact Analysis Manager, or the Modeling Studio. You can also create relationships in
System Availability Management and End User Management Administration.

This section includes the following topics:

¢ "Creating Relationships" below

o "Creating Hierarchical Relationships" on the next page
o "Attaching Existing Cls" on page 184

o "Setting the View Hierarchy" on page 184

¢ "Viewing Related Cls" on page 184

o "Deleting Relationships" on page 184

o "Inter-Layer Relationships" on page 185

Creating Relationships

You can create relationships in IT Universe Manager by right-clicking a Cl or multiple Cls in the CI
Selector pane or the Topology Map and selecting Relate to Cl from the shortcut menu. In the
Topology Map, you can define a relationship between two Cls in the view by drawing a line between

the two, using the Create Relationship button I from the toolbar. Either of these actions opens
the Insert Relationship dialog box. For details, see "Insert Relationship Dialog Box" on page 204.

You can create as many relationships as necessary between a Cl in the RTSM and other Cls. Each
new relationship exists as its own entity in the RTSM, and has its own properties that can be edited
in IT Universe Manager (as described in "Configuration Item Properties Dialog Box" on page 200).
You can also create more than one relationship between the same two Cls, when each relationship
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is based on a different relationship type. In the following example, host7 has both a Backbone and
a Talk relationship with switch3.

=

Talk
ackhone

&

switch3

hostr

Creating Hierarchical Relationships

By attaching one CI to another in IT Universe Manager or System Availability Management or End
User Management Administration you create a hierarchical relationship (parent-child) between
them, so that one Cl is influenced by the other.

Certain relationships defined in this way are restricted to the relationship type usage (if the
relationship is between two non-monitoring Cls), or the relationship type Monitored By (if the child
Clin the relationship is a monitor type Cl); however, other relationship types are used between
specific types of Cls. For example, if a relationship is defined between two node Cls, there are
several possible relationship types.

Select Relationzhip
Source Cl host0& (Mode)
Target Clis), hostO7

Relationship: | bl

I— Memkership
Dependency

3

Direction:

Define Relation

'— Backbone
=l

4 11 2

Note: When you attach a child Cl to a parent Cl, you are creating that relationship in the
RTSM. The child therefore impacts on the parent Cl in every view where the relationship
exists, and is displayed in every view where the child and relationship match the TQL query.

When performing status calculations, the Business Logic Engine only recognizes calculated
relationships. For details on calculated relationships, see "Impact Rules" on page 94
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Attaching Existing Cls

You can attach existing Cls using the Insert Relationship dialog box. The dialog box has two
modes:

o Selecting the Cls that you want to attach.
« Defining the relationship between the original Cl and the Cls to attach.

When selecting the Cls to attach, you can select multiple Cls from a view to attach to the original
Cl. However, all Cls that you want to attach in one operation must have the same relationship type.
For example, you cannot attach a Cl that uses the relationship usage in the same operation as a ClI
that uses the relationship Monitored By.

Note: SiteScope monitor Cls should not be attached to other Cls from within the RTSM. You
should only create links to SiteScope monitor Cls from within SiteScope.

Setting the View Hierarchy

After setting the query node and relationship definitions of a view, you can set a hierarchy for the
view. This enables you to define the organizational structure of Cls in the view by displaying
selected Cls at different levels. When no hierarchy is defined, the Topology Map or table displays
all Cls included in the query results on one level by default. For example, if the query results include
nodes and IP Subnets, both Cl types are displayed on the same level in the Topology Map or table.

Note: The maximum number of Cls that can be displayed in a single layer of the Topology Map
is 900. If a view contains a layer with more than 900 Cls, the view is not displayed in the
Topology Map until the hierarchy is changed. However, a layer with more than 900 Cls can be
displayed in a table in Text mode.

For details on setting the hierarchy, see "Setting the View Hierarchy" on page 230.

Viewing Related Cls

You can view all the Cls related to a selected Cl in the topology map. Select a Cl in a view and then
select the Related Cls tab. The Get Related Cls pane enables you to select the scope of the
display. If you select View, the topology map displays only the selected Cl and its related Cls in the
view (no matter where it is in the view hierarchy). If you select CMDB, it displays the selected Cl
and all of its related Cls in the RTSM. You can also filter the results from the Get Related Cls pane
by Cl type and apply perspectives to a Cl. For details, see "Get Related Cls Pane" on page 215.

You can also display Related Cls using the Get Related Cls from CMDB dialog box. For details,
see "Get Related Cls From CMDB Dialog Box" on page 204.

Deleting Relationships

The Topology Map shows only the relationships for the Cls that are part of the current view;
however, the same relationships may also be part of other views. When you delete a relationship in
IT Universe Manager, it is deleted from the RTSM and from all views.
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When a relationship is deleted, the Cl on the other end of the relationship may remain in the view, if
it still matches the pattern of the view. However, if the deleted relationship is a composition link, the
target Cl is deleted with it.

In a perspective-based view, you can remove the Cl completely from the view (without deleting it
from the RTSM), by hiding it from the view in the Perspective-based View Editor in the Modeling
Studio.

When you delete a relationship that was created by the DFM process, the relationship is restored
the next time that DFM runs (if the relationship is still valid), and it reappears in all relevant pattern
views.

It can take a few minutes to delete subtrees, or multiple Cls and relationships, from a view.

Inter-Layer Relationships

In certain circumstances, IT Universe Manager displays a relationship between Cls in a layer of a
view that does not reflect an actual relationship between the Cls in that layer, but rather a
relationship between Cls on deeper layers of the view. Such a relationship is known as an inter-
layer relationship.

For example, in the following view, two node Cls are related to each other with a dependency
relationship. Each is also related to an IP Subnet by a membership relationship and the view
hierarchy is defined such that the nodes are on the layer beneath the IP Subnet.

=

IpSubn
Mernbershin y mambarship_1
=), R
é Dependenty =
Mode_1 Mode

When you consume the view in IT Universe Manager, the relationship between the node Cls (which
are under different IP Subnets) is displayed in the higher layer of the view as a relationship between
the parent IP Subnets, even though the actual relationship only exists between the Cls in the lower
layer of the view. You can double-click the relationship to display the full path between the IP
Subnets.
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Another form of inter-layer relationship occurs when the same Cl appears under more than one
parent Cl of the same type in the layer above it. In such a case, the child Cl and its relationships are
duplicated in the view display, due to the hierarchy definition. The relationships of such child Cls
result in inter-layer relationships between the parent Cls. This type of inter-layer relationship is
known as a duplication metalink.

For example, in the following view, a single node CI appears under two IP Subnet Cls in the
hierarchy. The node and its children thus appear twice in the view - once under each IP Subnet.
Each node is effectively related to the child Cls of the node under the other IP Subnet, which
generates an inter-layer relationship between the two IP Subnets.
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Inter-layer relationships and duplication metalinks are displayed in gray in the topology map. IT
Universe Manager provides the following options for viewing inter-layer relationships:

o None. Hide all inter-layer relationships.
« Inter Layer. Display inter-layer relationships of the first type, but not duplication metalinks.
o Full. Display all inter-layer relationships, including duplication metalinks.

A tooltip for the inter-layer relationship displays the inner relationships which it represents. If there is
only one inner relationship, the relationship label displays that relationship type. If there are multiple
inner relationships, the label becomes Inter-layer and the tooltip displays alist of all the inner
relationships. If there are more than ten inner relationships, only the first ten are displayed, and a
note indicates that there are more inner relationships.

Create Cls and Relationships in the RTSM

This task describes how to create related and non-related Cls, as well as relationships between
Cls, inthe RTSM.
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Define a New Non-related CI

Click the New CI button ¥ in the toolbar. In the New ClI dialog box, select a Cl type from the tree
and define the properties for the new CI. For details, see "New Cl/New Related C| Dialog Box" on
page 217.

Define a New Related CI

Click the New Related CI button wl in the toolbar. In the New Related ClI dialog box, select a Cl
type from the tree and define the properties for the new Cl. On the Relationship page of the dialog
box, select the type of relationship and define its properties. For details, see "New CI/New Related
Cl Dialog Box" on page 217.

Attach Existing Cls

Select a Cl in aview. Right-click the Cl and select Relate to Cl. In the Insert Relationship dialog
box, select a target Cl. On the Relationship page of the dialog box, select the type of relationship
and define its properties. For details, see "Insert Relationship Dialog Box" on page 204.

View Related Cls

The following steps describe the options for viewing related Cls in IT Universe Manager.

Display Related Cls

InIT Universe Manager, select a Cl in the Topology map or the Cl Selector and select the Related

Cls tab. Click the Enable Related Cls Retrieval button ‘&2 . The selected Cl is displayed with its
related Cls. Select a different Cl or multiple Cls from the CI Selector, and the display changes
accordingly.

Note: You can display the Related Cls content in map mode or in text mode.

For details on the Get Related Cls user interface, see "Get Related Cls Pane" on page 215.

Select the Scope of the Display

Inthe Get Related Cls pane, select the scope of the related Cls display. Click the Show Related
Cls button. The display changes according to your selection.

Filter the Related Cls

In the Filter Related Cls by Cl Type section, select the Cl types to appear in the related Cls
display. Click the Filter Related Cls button. The filtered results appear in the tab. The scope
selected above still applies and the display is reduced according to your filter selection.

Apply Perspectives to a Cl
In the Apply Perspectives to Cl section, select the perspectives to apply to your selected Cl. Click
the Apply Perspectives button. The results are displayed in the tab.

Note: This feature is only relevant when CMDB is selected as the scope.
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Check Status of Application Discovery (Rediscover a
View)

You, the application owner or administrator, need to be kept informed of any problems to your
application. So, for example, you need to know that discovery is working correctly and that its
current configuration can connect to the application database. This section explains how to run the
rediscovery procedure that enables you to check the current status of the discovery of an
application.

Note:

o Set up and configuration is performed by the BSM administrator. For details, see
"Prerequisites" below.

o Rediscovery is performed by the application owner/administrator. For details, see "Access
the View" on the next page.

¢ You do not need any knowledge of Data Flow Management (DFM) to run this procedure.

o By default, you can run the rediscovery procedure on views that contain fewer than 10,000
Cls. For details on changing this number, see "Important information" on page 225.

This task includes the following steps:

1. Prerequisites

Note: This step is performed by the BSM administrator.

a. InDFM, create a module that contains the jobs that must discover the application. For
details, see "Discovery Control Panel — Advanced Mode Workflow" in the Data Flow
Management Guide.

b. Activate the module and all the jobs. The jobs must remain activated.

c. Verify that the module has run without errors. For details, see "Error Messages Overview"
and "Discovery Control Panel - Details Tab" in the Data Flow Management Guide.

d. Correct any errors in the application and confirm that DFM finds no errors during the next
run.

Caution: The application owner cannot rediscover a view if DFM is reporting errors.
You must set an error-free baseline.

e. Inthe Modeling Studio, define a view that includes the application Cl or Cls to be
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rediscovered. These are the Cls that are created when you activate the jobs that discover
the application. For details, see "Create a Pattern View" on page 244..

f. Notify the application owner of the name of the view.
2. Access the View

Note: This step is performed by the application owner/administrator.

InIT Universe Manager, access the view that includes the application Cls to be rediscovered.
For details, see "Search for Cls in Search Mode" on page 123.

3. View Results in the View
a. Check the complete application. Click the Show Discovery and Changes Summary

button EE& in the C| Selector toolbar. The Show Discovery Status and Changes of View
dialog box is displayed. The dialog box displays information about which jobs and trigger CI
discovered the Cls in the view, on the last occasion that DFM ran the discovery for the
jobs. For details, see "Show Discovery Status and Changes Dialog Box" on page 224.

To run the discovery, click the Rerun Discovery button. To view information about the jobs
and trigger Cls, use the links to drill down. For details, see "Error Messages Overview" in
the RTSM Developer Reference Guide.

b. Check specific components of your application. Select the component's Cl in the
Topology Map pane and display the Discovery tab in the Advanced pane. For details, see
"Show Discovery Status and Changes Dialog Box" on page 224.

Torediscover several Cls, press CTRL, select the Cls and display the Discovery tab.

To run the discovery, click the Rerun Discovery button.

4. Schedule the Rediscovery

You can schedule how often the rediscovery procedure should run. In the Job Definition
window, choose the Rerun Discovery on View action. For details, see "Job Definition Dialog

Box".

Retrieve Impact Analysis Results - Scenario

Impact Analysis Manager enables you to create an Impact rule that allows you to simulate the
impact certain infrastructure changes have on your system. The results of the Impact rule are
displayed in IT Universe Manager. The Impact Analysis results in this task describe how a change
in CPU operation impacts the node to which it is connected.

This task includes the following steps:
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o "Define an Impact Analysis TQL Query " below
¢ "Define an Impact Rule" below
o "Create a View in the Modeling Studio" on page 192

¢ "Get Impact Analysis Results" on page 192

1. Define an Impact Analysis TQL Query
To define an Impact Analysis TQL query, you need to create an Impact rule and then add the
TQL query nodes and relationships that define the query.

To create an Impact Analysis TQL query, select Admin > RTSM Administration >Modeling
> Impact Analysis Manager. For details about how to add query nodes and relationships to a
query, see "Add Query Nodes and Relationships to a TQL Query" on page 23.

Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a Composition
relationship.

[

=
=
o
m

Camposition

*--—--—-

Cpu

2. Define an Impact Rule

When you define an Impact rule, you must specify the required causal relationship between the
query nodes. Define one query node as the trigger, or the query node that represents the
changes you want to make to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger and select Define Impacted to
open the Impacted Query Nodes dialog box. Select the query node that you want the trigger
query node to impact and click Next. Then click the Add button to open the Impact Rules
Definition dialog box to set conditions for defining impacted query nodes. For details about how
to define an Impact rule, see "Impact Rules Definition Dialog Box" on page 342.

Note: The change state option in the Impact rule definition is no longer relevant for Impact
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Analysis. The only supported state is operation.

Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the conditions under
which the simulated change in the system is triggered. The Severity area defines the

severity of the impact on the impacted query node.

The Impact rule in this example states that when the CPU operation is not in the normal
state, the node is impacted. Since the severity is set to 100% of the trigger's severity, the
severity of the node is the same as the severity of the CPU, which is determined when

Impact Analysis is run.

g Impact Rules Definition

Description: |

|

I| ~Conditions
State: | operation
Operator: | Mot eqgual

Value comparison: | Marmal

() Pange 4

() Fixed severity:

(®) Severtty relative to trigger severity (%):

In the resulting TQL query, an upward arrow appears next to the query node defined as the
trigger query node and a downward arrow appears next to the query node defined as the

impacted query node.
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3. Create a View in the Modeling Studio

Go to the Modeling Studio and create a view matching the TQL query of the Impact rule you
defined. For details, see "Pattern View Editor" on page 280.

4. GetImpact Analysis Results

Select Admin > RTSM Administration > Modeling > IT Universe Manager and select the
required view in the Cl Selector. To get Impact Analysis results, you need to run the Impact
rule on a Cl instance in the topology map that is a trigger. Right-click a trigger Cl and select
Run Impact Analysis to open the Run Impact Analysis dialog box. For details on how to run
an Impact rule, see "Run Impact Analysis Dialog Box" on page 221.

Example for Getting Impact Analysis Results:

An Impact Analysis TQL query is created containing a CPU and node connected by a
Composition relationship. The CPU query node is defined as the trigger query node and
the query node of type node is defined as the impacted query node.

The following Impact rule is defined for the query.
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Impact Rules Definition

Dezcription: | |

[ Conditions

State: | operation | - |

Operator: | Mot equal |" |

Walue comparizon: | Mormal |" |

Scope

(®) lany
A
O Range Yo - o

) Fixed severity:
(®) Severtty relative to trigger severity (%):

oK Cancel |

Right-click a CPU Cl in the view, and select Run Impact Analysis to open the Run
Impact Analysis dialog box. Set the trigger severity to a value other than Normal.

g Run Impact Analysis

(= Run Impact Analysis
— Select the impact analysis trigger and the set of impact rules that will be executed

Trigger Severity

-8

Critical

Correlation Rules

(® |2l Impact Rules
O Only impact rules located in specified bundle

To see results, click one of the following:
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= Show in Views. This assigns a status to all the Cls in the view. Only the node ClI
connected to the CPU CI (whose severity was changed), becomes impacted. The
trigger Cl and the impacted CI turn orange because the trigger severity was set as
Major (7) on the scale in the Run Impact Analysis dialog box, which is assigned an

orange color.
(2],
WhlAMCIAT E6
Campasition
Ex
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Ex
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LABMZ2AMT 1
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= Show Map. A map appears in a separate window containing only the trigger CPU CI
and the node Cl it impacted. The relationship connecting the two Cls contains the name
of the Impact rule defined in Impact Analysis Manager.

Note: Optionally, you can create a URL that enables you to embed the map. For
details, see "Direct Link Parameters — Impact Map Page" on page 106.
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= Generate Report. Generates an Impact Analysis report that displays a list of Cls that
are impacted in the system as a result of the simulated changes. For details, see "Run
Impact Analysis Dialog Box" on page 221

Take a Snapshot of a View

You can take a snapshot of a view in IT Universe Manager, save it, and then compare snapshots of
the same view taken at different times using the Compare Snapshots Report. For details on how to
take a snapshot of a view, see "Save Snapshot Dialog Box" on page 223. For details on how to
view actual differences in the compared views, see "Compare Snapshots Report" on page 319.

Print and Save a Topology Map to File

You can print the content of any topology map and then save it to file. Before printing, it is
recommended to define your print settings and arrange the contents of the topology map according
to your requirements. For details on how to define print settings, see "Print Setup Dialog Box" on
page 156. For details on how to preview the content of the topology map before printing, see "Print
Preview Dialog Box" on page 155. For details on how to print the content of a topology map, see
"Print Dialog Box" on page 155. For details on how to save a topology map to file, see "Export Map
to Image Dialog Box" on page 138.

IT Universe Manager User Interface

This section includes (in alphabetical order):

o "Add Cls to Model Dialog Box" on the next page

"Add Cls to View Dialog Box" on the next page

"Change Timeframe Dialog Box" on page 197

o "Cl/Relationship History Dialog Box" on page 198
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o "Configuration Item Properties Dialog Box" on page 200

o "Get Related Cls From CMDB Dialog Box" on page 204

o "Insert Relationship Dialog Box" on page 204

o "IT Universe Manager Page" on page 208

o "New CI/New Related Cl Dialog Box" on page 217

o "RunImpact Analysis Dialog Box" on page 221

o "Save Snapshot Dialog Box" on page 223

o "Show Discovery Status and Changes Dialog Box" on page 224

e "Show Impact Pane" on page 225

Add ClIs to Model Dialog Box

This dialog box enables you to add selected Cls to a model.

To access  Select Admin > RTSM Administration > Modeling > IT Universe Manager.
Right click a Cl or multiple Cls in the Cl Selector and select Add Cls to Model.

Important | This feature is only relevant for instance based models. You cannot add selected
information = Cls to a pattern based model.

User interface elements are described below:

Ul Element (A-Z) Description

<Model tree> When Existing Model is selected, select a model from the tree.
Define New CI When New Model is selected, define the name and properties of the
Properties model.

Existing Model Select Existing Model to add the selected Cls to an existing model.
New Model Select New Model to add the selected Cls to a new model.

Select Cl Type When New Model is selected, select a Cl type for the model.

Add Cls to View Dialog Box

This dialog box enables you to add selected Cls to a perspective based view.

To Select Admin > RTSM Administration > Modeling > IT Universe Manager.Right
access click a Cl or multiple Cls in the Cl Selector and select Add Cls to View.

User interface elements are described below:
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Ul Element (A-
Z) Description
<View tree> When Existing View is selected, select a view from the tree.

Existing View  Select Existing View to add the selected Cls to an existing perspective

based view.
New View Select New View to add the selected Cls to a new perspective based view
View Name When New View is selected, edit the name of the view.

Change Timeframe Dialog Box

This dialog box enables you to display changes in the topology map and set the time frame for the
changes to display.

To access  Select Admin > RTSM Administration > Modeling > IT Universe Manager.

Click the Set Change Timeframe button in the main toolbar or the IT
Universe status bar.

Important When the change indicators are displayed in the topology map, a message
information appears in the IT Universe status bar Change Timeframe is Active.

To hide the indicators, open the dialog box and select Do not display changes,

or select the Reset Change Timeframe button @) inthe IT Universe status bar.

User interface elements are described below:

Ul Element (A-Z) Description
Display changes Select this option to display an indicator next to each Cl that was
according to the added or changed within the selected period as follows:

selected timeframe
e I Indicator for an added CI

o £ Indicator for a changed ClI

Select a time period from the drop-down list. If you select Custom,

L

click the ellipsis button to select the Date From and Date Until
fields. The changes to the Cls of the view within the selected period

are displayed in the map.

When the indicators are displayed, you can click the indicator to open
the CI History dialog box, which displays the history for the Cl over
the selected period.

Do not display Select this option to hide the change indicators.
changes

HP Business Service Management (9.24) Page 197 of 416



Modeling Guide

Chapter 8: IT Universe Manager

Cl/Relationship History Dialog Box

This dialog box displays alist of Cl or relationship attributes in which changes have occurred as
well as the differences between two configuration files.

To access

Important

o InIT Universe Manager, right-click the selected Cl or relationship in the ClI
Selector or the Topology Map and select Cl History.

o In Data Flow Management, in the Discovered by [Module or Job Name] Cls
dialog box, right-click a Cl and choose CI History.

Note: Cl and relationship history data is also available in the History tab of the
Advanced pane in IT Universe Manager.

Only attributes marked with the Change Monitored or Comparable qualifiers are

information = tracked in the CMDB History database. If you want an attribute to appear in the CI

history, select the Change Monitored or the Comparable qualifier for it in the
Attributes tab of the Cl Type Manager. For Cls, some attributes are designated as
Change Monitored by default. For relationships the attributes must be designated
manually in the Cl Type Manager.

In addition, to track history for a relationship, you must select the TRACK_LINK _
CHANGES qualifier for the relationship in the Qualifier tab of the Cl Type
Manager.

User interface elements are described below:

Ul
Element
(A-Z)

o

Q

Description

Click Refresh to refresh the data in the table.

View the difference between two history entries for the content of a configuration file.
This is relevant in the following situations:

e Select two history entries for the Document Content attribute for Cls of the type
Configuration Document to compare to each other.

¢ Select one history entry for the Document Content attribute for Cls of the type
Configuration Document to compare to the current content for that ClI.

Click the Show difference button to open the Visualdiff report, which displays a
comparison of the two entries. Text added to the second entry appears highlighted in
yellow. Text removed from the first entry appears highlighted in red. Differences
between the entries appear highlighted in green.
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ul
Element
(A-Z) Description

# Choose the export format for the table data. The available options are:

o Excel. The table data is formatted as an .xlIs (Excel) file that can be displayed in a
spreadsheet.

e PDF. The table data is exported in PDF format.

Note: When exporting to PDF, select a reasonable number of columns to display
to ensure that the report is legible.

¢ RTF. The table data is exported in Rich Text Format.

e CSV. The table data is formatted as a comma-separated values (CSV) text file
that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the comma (,) must
be defined as the list separator. In Windows, to verify or modify the list separator
value, open Regional Options from the Control Panel, and on the Numbers tab
ensure that the comma is defined as the List Separator value.

o XML. The table data is formatted as an XML file that can be opened in a text or
XML editor.

Tip: To extract HTML code from the report:
= Save the fileas HTML
= Open the file inan HTML editor

= Copy the relevant table into the target file
Attribute The name of the attribute.

Change The date when the last change occurred.
Date

Filter by | Filter the data in the table by one or more of the following filters:
o Time Range. Select the time period for which the CI history is displayed.
e Change Type. Select the type of changes displayed in the table.

o Attribute. Select the attribute types displayed in the table.

Modified  Indicates the cause of the change. For example, the field can contain the name of a
By userora DFM job.
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ul
Element
(A-Z) Description

New The new value of the attribute.
Value

Old The previous value of the attribute.
Value

Configuration Item Properties Dialog Box
This dialog box enables you to view and edit basic information for an existing CI or relationship.

To access  Select Admin > RTSM Administration > Modeling > IT Universe Manager
and use one of the following:

o Select aCl in the topology map or the Cl Selector. In the Advanced Pane,
select the Properties tab and click Edit.

¢ Right-click a Cl in the Cl Selector or the Topology map and select Properties.

Important The Configuration Item Properties dialog box contains two types of properties:
information
e General properties, which include general information about the Cl or
relationship. These properties are common to all CITs and are documented
below.

o CIT-specific properties, which include properties specific to that Cl. These
properties vary according to the type of CI or relationship and are not
documented except in the case of TransactionVision Monitor Cls. For details
about TV Monitor Cls, see "Transaction Configuration Page, Tracing Tab" in
the BSM User Guide.

When you sort the properties by category, the CIT-specific properties appear at
the top of the list and the general properties appear at the bottom.

You can view a description of the selected property in the Description Area at the
bottom of the dialog box. Click the Show/Hide Description Area button to
display the Description Area.

When accessing the Configuration Item Properties dialog box from within certain
applications, the fields are not editable.

Mandatory fields are denoted by an asterisk.

Note: HP Universal CMDB does not fully support surrogate pairs and combining
characters.

See also "Cl Lifecycle and the Aging Mechanism" in the RTSM Administration Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element
(A-2) Description
=) Click to display the properties by category.
B Click to display the properties alphabetically.
i Toggles between showing and hiding the description area at the bottom of the ClI

Properties dialog box.

£

Click Expand to expand the properties tree when the properties are displayed by
category.

e

Click Collapse to collapse the properties tree when the properties are displayed
by category.

{?_'1 Expart ~ Choose the export format for the table data. The available options are:

o Excel. The table data is formatted as an .xlIs (Excel)file that can be displayed
in a spreadsheet.

e PDF. The table data is exported in PDF format.
Note: When exporting to PDF, select a reasonable number of columns to
display to ensure that the report is legible.

e RTF. The table data is exported in Rich Text Format.

e CSV. The table datais formatted as a comma-separated values (CSV) text file
that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the comma (,) must
be defined as the list separator. In Windows, to verify or modify the list separator
value, open Regional Options from the Control Panel, and on the Numbers tab
ensure that the comma is defined as the List Separator value.

o XML. The table data is formatted as an XML file that can be opened in a text or
XML editor.

Tip: To extract HTML code from the report:
= Save the fileas HTML

= Open the file in an HTML editor

= Copy the relevant table into the target file
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Ul Element

(A-2) Description

<Quick Enter a string in the Quick filter box to filter the property names and values. Click
filter> the left end of the box to open the drop-down menu of filter options:

o Select All to search for the filter string in both property names and property
values. Select Name to search for the filter string in property names only.
Select Value to search for the filter string in property values only.

o Select Case sensitive to search for the filter string exactly as entered. Select
Case insensitive to ignore the case of the filter string.

o Select Use wild cards to use the wildcard symbol * in the filter string.

o Select Match from start to search for the filter string at the beginning of a
property name or value. Select Match exactly to search for the exact filter
string. Select Match anywhere to search for the filter string anywhere in the
properties.

Actual The number of days after which the CI or relationship is deleted.

Deletion

Period

Allow CI When selected, this option allows the DFM process to automatically update the

Update Cl or relationship properties with information that it discovers. If you change the
value of a property supplied by the DFM process, the value is overridden by the
discovered value.

When this option is cleared, the CI or relationship properties are not overridden by

the DFM process.

Apply Click Apply to save the changes made to the CI or relationship properties.
Cl Type The type of the Cl or relationship (read-only value). For information about CITs in

BSM, see "CI Type Manager" on page 348.

Created By The user name of the administrator who manually created the CI or relationship,
where applicable (read-only value).

Create The date and time when the ClI or relationship was created.

Time

Deletion The period after which the Cl becomes a candidate for deletion when the aging
Candidate = mechanism is enabled.

Period

Description A brief description of the CI or relationship.

Display The name of the Cl or relationship as it appears in the Cl Selector.
Label
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Ul Element
(A-Z)

Edit

Enable
Aging

Global Id

Last
Access
Time

Last
Modified
Time

Monitored
By

Name

Note

Description

In the Properties tab of the Advanced pane, you can view a Cl's properties but you
cannot edit them. Click Edit to open the Configuration Item Properties dialog box
where you can edit the properties.

If a Cl or relationship is not updated or refreshed over a period of time (for
example, a Cl is not rediscovered by DFM and no manual update occurs), an
aging mechanism deletes the Cl from the RTSM. For details, see "Cl Lifecycle
and the Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this CI or relationship.
False: the aging mechanism is disabled for this CI or relationship.

Note:
o If the aging mechanism is disabled in Aging Status, this field is ignored.
e This field is displayed for certain Cls only.

e The default value is determined by the default value of the Enable Aging
attribute for the CI type of the selected CI.

The internal ID of the ClI or relationship in the RTSM (read-only value).

The time that the Cl or relationship was last accessed, whether when being
updated or being discovered by DFM. This field is only displayed for certain Cls or
relationships.

This parameter is used by the aging mechanism. For details, see "Cl Lifecycle
and the Aging Mechanism" in the RTSM Administration Guide.

Note: By default, this property is updated every time the Cl is touched by a
running discovery job or integration. To prevent this property from being updated
by a discovery job or integration, go to the Data Flow Management module, and in
the Adapter Management > Adapter Configuration tab, clear the Update last
access time option. For more details, see "Adapter Configuration Tab" in the Data
Flow Management Guide.

The date and time when the ClI or relationship properties were last updated.

Indicates whether the Cl is monitored by a SiteScope monitor or an EMS
Integration monitor.

The name of the ClI or relationship.

Enables you to enter other information about the CI or relationship.
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Ul Element

(A-2) Description

Origin An ID for the source that automatically created the Cl or relationship, or the
application where the CI or relationship was created (read-only value).

Reset Click the Reset button to restore the original property settings of the Cl or

relationship.
Updated by The user name of the administrator who updated the CI or relationship properties.

User Label Enables you to define a display label for the Cl or relationship. If no value is
entered, the Cl name appears as the default label.

Shortcut Menu
Menu Item Description
Copy Property Copies the name and value of the selected property to the memory.

Name and Value

Get Related Cls From CMDB Dialog Box

This dialog box enables you to view the Cls related to a specified Cl in the RTSM in map or table
format.

To access | InIT Universe Manager, right-click the required Cl and select Get Related Cls.

Important | The Get Related Cls From CMDB dialog box is a standalone version of the

information Related Cls tab in IT Universe Manager. You can control the content of the
display using the features in the Get Related Cls pane. For details, see "Get
Related Cls Pane" on page 215.

You cannot select the scope of the related Cls displayed in the Get Related Cls
From CMDB dialog box. The scope is the entire CMDB.

Note: The text mode format includes the icons found in the Element Instances
dialog box. For details, see "Element Instances Dialog Box" on page 61.

Relevant "View Related Cls" on page 187
tasks

Insert Relationship Dialog Box
This dialog box enables you to attach Cls to the Cl you selected in the Cl Selector.

To access  InIT Universe Manager, right-click a Cl in the Topology Map or the Cl Selector,
and select Relate to CI.
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Important | To create arelationship between two Cls, select the source Cl in the Cl Selector

information = or the Topology Map and then select Relate to Cl from the shortcut menu. On the
first page of the dialog box (the CI Selection page), you select the target CI(s).
Then click Relationship, to select the relationship type on the second page of the
dialog box.

You can also create a relationship between two Cls graphically by clicking the

Create Relationship button [ in the toolbar and drawing a line between the two
Cls. In this case, a smaller version of the Insert Relationship dialog box opens,
which contains the following tabs:

o Select Relationship. Displays a tree with the available relationship types.
Select the required relationship.

Note: You can double-click the relationship you select to save using the
default properties.

« Relationship Properties. Displays the properties of the selected relationship.
You can edit the properties as described in "Define Relationship Properties
Pane" on the next page.

Relevant "Create Cls and Relationships in the RTSM" on page 186
tasks

See also e "Cl Selector" on page 126

¢ "Relationship Page" on the next page

User interface elements are described below:

Ul Element
(A-Z) Description
> Click to add the selected Cls in the left pane to the Target Cls pane.
'S Click to remove selected Cls from the Target Cls pane (this does not delete the

Cls from the RTSM).

Select target = Select a view to display in the view tree and select Cls to move to the Target Cls
Cls pane.

For details on the Select target Cls pane, see "C| Selector" on page 126.
Source CI The Cl you selected as the source ClI.

Target Cls Displays the Cls you have selected as target Cls for the relationship.
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Relationship Page

This page enables you to define the relationship to be created between the original Cl and the Cls
selected in the Cl Selection page of the dialog box.

To access  Click the Relationship button from the Insert Relationship dialog box.

Important = When defining multiple relationships, you can define different descriptions and
information = property values for each relationship. Skip the property definitions here and edit
each relationship individually after it is created.

User interface elements are described below:

Select Relationship Pane

Ul Element
(A-Z) Description
Direction Select the direction of the relationship.

For some relationship types (for example, Composition, or between a group CI
and a monitor Cl), only one direction is valid.

Relationship Define the type of relationship created between the original Cl and the Cls being
attached. Select an option from the list.

Source CI Displays the name of the Cl on the first end of the relationship. This is the CI that
you selected in the view.

Target CI Displays the name of the Cl on the second end of the relationship, that is
attached to the original Cl.

Define Relationship Properties Pane

Ul Element

(A-2) Description

Actual The period after which the relationship is deleted when the aging mechanism is

Deletion enabled.

Period

Allow CI When the value is set to true, the DFM process automatically updates the

Update relationship.

Created By The user name of the administrator who manually created the relationship, where
applicable.

Create The date and time when the relationship was created.

Time
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Ul Element

(A-2) Description

Deletion The number of days after which the relationship becomes a candidate for deletion.
Candidate

Period

Description A detailed description of the relationship.

Destination = Defined only for route links. Indicates the destination network address to which

Network this route is configured.

Address

Enable If a Cl or relationship is not updated or refreshed over a period of time (for
Aging example, a Cl is not rediscovered by DFM and no manual update occurs), an

aging mechanism deletes the Cl from the RTSM. For details, see "Cl Lifecycle
and the Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this Cl or relationship.
Default value: false. The default value for DFM Cls is true.

Note:
¢ If the aging mechanism is disabled, this field is ignored.

o This field is only displayed for certain Cls.

Last The time that the relationship was last accessed, whether when being updated or
Access being discovered by DFM. This field is only displayed for certain Cls.
Time

This parameter is used by the aging mechanism. For details, see "Cl Lifecycle
and the Aging Mechanism" in the RTSM Administration Guide.

Last The date and time when the relationship properties were last updated.

Modified

Time

Must When the value is set to true, the child Cl is dominant when the percentage rule is

used to calculate status for the parent CI. If the Cl has low status, the parent must
take the child Cl status, if necessary overriding the percentage rule calculation.
This is useful to give emphasis to an important Cl. For example, you might want
to define Must for a database Cl, so that status is critical all the way up the
subtree if the database falls, regardless of the status of the other Cls in the
subtree.

The must status defined for a relationship applies for that relationship only — it is
not used in any other relationships of the child Cl. For details, see "Understanding
the Percentage Rule" in the BSM User Guide.

Name A brief description of the relationship. If no value is entered, the relationship type
is used in place of the name.
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Ul Element

(A-2) Description

Note Enables you to enter other information about the relationship.

Origin An ID for the source that automatically created the relationship, or the application
where the relationship was created.

Updated The user name of the administrator who updated the Cl properties.

By

User Label = Enables you to define a display label for the relationship. If no value is entered, the
relationship name appears as the default label.

Weight When a weight value is entered, the child Cl is given more weight in percentage
calculations, when percentage rule is used to calculate status for the parent ClI.
For example, if a child Cl is given a weight of 3, then it has three times more
impact on the parent status calculation than its unweighted siblings.

The weight defined for a relationship applies for that relationship only — it is not
used in any other relationships the child Cl may have. For more details, see
"Understanding the Percentage Rule" in the BSM User Guide.

IT Universe Manager Page

This page enables you to define and manage the Cls and relationships in your views.

To access | Select Admin > RTSM Administration > Modeling > IT Universe Manager.

Important The IT Universe Manager page contains the following panes:

information
e ClI Selector. Displays the Cls of a selected view. You can select the view

from a drop—down list or search for a specific Cl. For details, see "Cl| Selector"
on page 126.

o Topology Map. Displays the Cls of a selected view in Map mode or Text
mode.

o Advanced Pane. Displays properties, history, and discovery for the selected
Cl orview.

o Get Related Cls. This pane can be accessed from the Related Cls tab of the
Topology Map. It controls the content of the display in the tab.

InIT Universe Manager, you can create new Cls, modify existing Cls, or delete
Cls. All of these actions have a direct effect on the entire IT Universe model. For
example, if you delete a Cl in your view, that Cl is deleted from the IT Universe
model and no longer appears in any view.
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Topology Map

This area displays the Cls of the currently selected view in graphical or table format. By default, the
Cls are displayed in graphical format.

To access  Select Admin > RTSM Administration > Modeling > IT Universe Manager.

Important You can customize the Topology Map shortcut menu to include other commands

information = (for example, ping, run a program, open a URL) from within Cl Type Manager. For
details, see "Create Configuration Item Type/Relationship/Calculated
Relationship Wizard" on page 363.

Note: For grouped Cls and the relationships between them, not all of the shortcut
menu options are active. Grouped Cls appear in parentheses in the Cl Selector
and in the Topology Map. You can double-click a link to a grouped Cl to open the
Link Map, which displays the individual Cls and relationships. Right-click a Cl or
relationship in the Link Map to display the regular shortcut menu. For details about
grouping Cls, see "Query Node Grouping Dialog Box" on page 290.

See also "Working with Topology Map" on page 137
User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

Click Map to display the selected layer of Cls in topology map
format.

128 Map Map mode
Note: If the selected layer of the view is too large to display in

topology map format, a message appears with a link to display the
layer in text format.

Click Text to display the attribute properties of the Cls in the

EH Text
Text mode selected layer in table format.

For details on some of the toolbar icons in Text Mode, see
"Element Instances Dialog Box" on page 61.

Show Clinstances of. | Network »  Specify the CIT you want displayed in the table. The table also
includes the children of the selected CIT.

Note: This option is displayed in Text mode only.

<Breadcrumbs> At the top of the topology map, the breadcrumbs indicate the
relevant query nodes in each layer of the view for the path to the
selected layer. The first item in the path is the Top Layer. When
you select a Cl from the layer below, the parent Cl forms the next
item in the breadcrumb path. You can click on any item in the path
to display that layer in the topology map.

<Cl type attributes> The columns appearing in Text mode represent the CIT attributes
of the selected Cls.
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Ul Element (A-Z)

<IT Universe Status Bar>

<Legend>

<Main Menu>

<Query Node>

<Relationship>

Description

The status bar below the topology map indicates the status of the
following processes:

o if Impact Analysis is active or not
o if Change Timeframe is active or not
o if Candidates for Deletion are shown or not

o the time of the last update of the data

Indicates the icons displayed next to Cls with any of the following
special statuses:

¢ Added. When Change Timeframe is active, indicates that the
Cl was added.

o Candidate for Deletion. Indicates that the Cl is a candidate for
deletion.

e Changed. When Change Timeframe is active, indicates that
the Cl was changed.

o External. Indicates that the Cl is a federated ClI.

o Impacted. When Impact Analysis is active, indicates an
impacted Cl.

o Impacted and Trigger. When Impact Analysis is active,
indicates a trigger Cl that is impacted.

¢ Note. Indicates that a note was added for the CI.

o Trigger. When Impact Analysis is active, indicates a trigger CI.
For details, see "Main Menu" on page 154.

The query nodes in the topology map represent Cls.

Hold the pointer over a query node to display its tooltip which
describes the type of the ClI.

The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip, which
describes the type of the relationship.

Note: When you select a calculated relationship, the Delete ®
button in the toolbar is disabled.
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Ul Element (A-Z) Description
<Toolbar> For details, see "Toolbar Options" on page 157.

Note: When accessing the Topology map via direct links, the
toolbar includes options from the Related Cls Map. For details, see
"Get Related Cls From CMDB Dialog Box" on page 204.

<Topology Map For details, see "Topology Map Sidebar" on page 164.
Sidebar>
Related Cls Click the Related Cls tab to display the interdependencies of the

selected Cl within the view or the entire RTSM. You can control the
scope of the display from the Get Related Cls pane.

View Results Click the View Results tab to display an entire layer within a view.

IT Universe Manager Shortcut Menu

The IT Universe Manager page includes the following elements (listed alphabetically) available by
right-clicking a CI or relationship in the ClI Selector pane or the Topology Map:
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Menu Item Description

Actions Select one of the following options:

« Add ClI to Discovery Job. Displays the Add CI to Discovery Job dialog
box, which enables you to manually invoke a DFM job for the selected Cl.
You can use this option to discover additional information about the CI
through one of the available DFM jobs.

¢ Remove CI from Discovery Job. Displays the Remove Cl from
Discovery Job dialog box, which enables you to manually remove a Cl
from the DFM job.

o Show Discovery status. Opens the Discovery Status dialog box for the
selected Cl.

e Open CI Credentials. Displays the Protocol Parameter dialog box,
which enables you to view the details of a previously-defined credential for
that CI. You cannot make any changes. This option is only relevant for Cls
that include a credentials property.

For details, see "Protocol Parameter Dialog Box" in the Data Flow
Management Guide.

o Edit Cl Credentials. Displays the Choose Credentials dialog box,
which enables you to choose another credentials set or edit the existing
credentials. This option is only relevant for Cls that include a credentials
property.

For details, see "Domain Credential References" in the Data Flow
Management Guide.

Add Cls to Adds selected Cls to a new or existing model.

Model

Add Cls to Adds selected Cls to a new or existing perspective based view.
View

Cl/Relationship Displays the Cl History dialog box. For details, see "Cl/Relationship History

History Dialog Box" on page 198.

Compare Cls Run a Compare Cls Report for the selected Cl. For details, see "Compare
Report Cls Report" on page 314.

Delete from Enables you to delete the selected Cl or relationship from the view and from
CMDB the RTSM.

Note: When you delete a parent Cl, the selected Cl and its children are
removed from the view, but only the selected Cl is removed from the
database.
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Menu Item Description

Get Related Cls = Opens the Get Related Cls from CMDB dialog box. For details, see "Get
Related Cls From CMDB Dialog Box" on page 204.

Label Select one of the following options:

o Edit Label. Opens the Edit Label dialog box which enables you to edit the
name of the ClI.

¢ Restore Default Label. Resets the Cl name to its default value from the
RTSM.

Note Select one of the following options:
o Add Note. Opens an editing box where you can add a note to the CI.

o Delete Note. Deletes all text saved in a note for the selected CI.

Properties Displays the Properties page for the selected Cl or relationship. For details,
see "Configuration Item Properties Dialog Box" on page 200.

Relate to CI Opens the Insert Relationship dialog box. For details, see "Insert
Relationship Dialog Box" on page 204.

Run Impact Enables you to run the Impact rule you defined in the Impact Analysis
Analysis Manager. Displays the Run Impact Analysis dialog box. For details, see
"Impact Analysis Manager" on page 331.

Note: You can only see Impact Analysis results if you defined an Impact rule
for that view in Impact Analysis Manager.

Show Appears only for compound relationships. Displays the Link Map for the
Compound selected relationship, which shows the Cls involved in the compound
Path relationship.
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Menu Item Description

Show Impact Enables you to select a Cl that is defined by an Impact rule as a root cause
Cl, and to display all the Cls that are impacted by it, and their statuses, in a
separate window.

This option appears only after the following has occurred:

¢ You defined an Impact rule for the selected view in Impact Analysis
Manager (for details, see "Impact Analysis Manager" on page 331).

e You clicked Show in Views in the Run Impact Analysis dialog box.
¢ Impact Analysis results appear in the Topology Map.

For example, suppose an Impact rule is defined (for an IP Address Cl) that
specifies that the rule impacts nodes, ports, and client-servers linked to the
IP Address.

By using the Show Impact option, you can display all Cls that are impacted
by the IP Address Cl.

Show Root This option enables you to retrieve root cause information for Cls that are

Cause impacted by a chain of Impact rules. The output of Show Root Cause
displays a logical map that describes a chain of trigger/impacted CITs that
impact the CI.

The root cause Cl is displayed in a separate window. If only one Impact rule
is defined for this Cl, the Impact Analysis window is directly displayed.

This option appears only after the following has occurred:

¢ You defined an Impact rule for the selected view in the Impact Analysis
Manager (for details see, "Impact Analysis Manager" on page 331).

¢ Youclicked Show in Views in the Run Impact Analysis dialog box.
o Impact Analysis results appear in the Topology Map.

A window is displayed containing the root cause Cl and all the other CITs in
the Impact rule chain.

To view the information about specific Cls that are triggered or impacted by
the Impact rule, double-click the relationship connecting the Cls. A map is
displayed.

Advanced Pane

User interface elements are described below:
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ul
Element
(A-2) Description

Discovery Displays the DFM run status for the selected Cls. For details, see "Show
tab Discovery Status and Changes Dialog Box" and "Discovery Control Panel - Details
Tab" in the Data Flow Management Guide.

History Displays the history for the selected ClI. For details, see "Cl/Relationship History
tab Dialog Box" on page 198.

Properties ' Displays the selected Cl's properties (the same properties that appear in the

tab Configuration Item Properties dialog box). You can view the properties in the
properties tab, but you must open the dialog box to edit the properties. For details,
see "Configuration Item Properties Dialog Box" on page 200.

Get Related Cls Pane

This pane enables you to control the different options for viewing related Cls for a selected ClI.

To access  Appears in the Related Cls tab of IT Universe Manager. If it is hidden, click the
Show Get Related Cls pane button “4 in the toolbar to display it.

Important You can control the display in the Related Cls tab with the following controls:

information
o Set the scope of the display
o Filter the related Cls by Cl type
o Apply perspectives to the selected Cl
Itis possible to display related Cls for several Cls at the same time. Use the CTRL
key to select multiple Cls at the same time in the CI Selector or the topology map.
Note: You can select to run the Get Related Cls search over integrated Cls also.
If the search results include Cls from a federated data source, they appear in the
topology map with an arrow icon, indicating that they are federated Cls However,
you cannot display related Cls of a federated CI.

Relevant "View Related Cls" on page 187

tasks

User interface elements are described below:

Ul Element
(A-2) Description
< Display the previous search results.
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Ul Element
(A-Z)

=)

&

Apply
perspectives
to Cl

Filter
Related Cls
by Cl Type

Description

Display the next search results.

When the button is selected, the related Cls are added to the current results.
When it is not selected, the current display content is cleared and only the new
related Cls are displayed.

If you want to include integrated Cls in your search results, click Select Target
Integration Points for related Cls and select the required integration points
from the popup dialog box.

Note: If you select a disconnected integration point for your search, an error
message appears when the search is run, asking if you want to see local search
results.

Select perspectives from the list to apply to the selected CI. Only perspectives
relevant to the selected Cl appear in the list. The selected Cl is used as content
for the selected perspectives and the view results are displayed.

Note:

o Application of perspectives is only relevant when CMDB is selected as the
scope. The feature is inactive when View is selected as the scope.

e The perspectives displayed in the Apply Perspectives to Cl list are filtered
according to the value set for the Enable perspective permission
enforcement on consumption functionality setting in General Settings in
Infrastructure Settings Manager.

» If the value is set to False, all the perspectives are displayed, regardless of
the View permissions the user is given in the Views tab in Security
Manager.

» If the value is set to True, the perspectives that are displayed are based on
the View permissions the user is given in the Views tab in Security
Manager.

The default for the Enable perspective permission enforcement on
consumption functionality setting is False.

Select the Cl types from the list to display in the related Cl results. Only the
selected Cl types appear in the displayed results.
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Ul Element
(A-Z)

Select
scope

Show
Related Cls

Description

Select the scope of the related Cls displayed:
o View. All related Cls in the selected view.
e CMBDB. All related Cls in the RTSM.

Note: This feature is not available in the Get Related Cls from CMDB dialog box
opened from the shortcut menu.

Click to display the related Cls according to your selection.

New CI/New Related CI Dialog Box

This dialog box enables you to define a new Cl or a new related Cl.

To access

Important
information

Relevant
tasks

See also

In IT Universe Manager, click the New Clicon @ in the toolbar to create a non-
related Cl. Select a Cl in the topology map and click the New Related Cl icon

ol to create a related ClI.

To define a new ClI, select the Cl type from the tree at the top of the dialog box.
The Cl types in the tree that are available to be instantiated appear in black. The
Cl types in faded text cannot be instantiated.

Edit the properties in the Define new CI properties area. The table below includes
the properties which are common to all Cls. In addition, there are other properties
specific to each CI.

If you are creating a related Cl, click the Relationship button to go to the
relationship mode of the dialog box. Select a relationship and edit its properties.

"Create Cls and Relationships in the RTSM" on page 186

e "CIl Selector" on page 126
e "Relationship Dialog Box" on page 219

o "Cl Lifecycle and the Aging Mechanism" in the RTSM Administration Guide

User interface elements are described below:
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Ul Element
(A-Z)

Actual
Deletion
Period

Allow CI
Update

Created By

Create Time

Deletion
Candidate
Period

Description

Display
Label

Enable
Aging

Is Candidate
For Deletion

HP Business Service Management (9.24)

Description

The period after which the Cl is deleted when the aging mechanism is enabled.

When the value is set to true, this option enables the DFM process to
automatically update the Cl properties with information that it discovers. If you
change the value of a property supplied by the DFM process, the value is
overridden by the discovered value.

When the value is set to false, the Cl properties are not overridden by the DFM
process.

The user name of the administrator who manually created the CI, where
applicable.

The date and time when the Cl was created.

The period after which the Cl becomes a candidate for deletion when the aging
mechanism is enabled.

A description of the CI.

The label that appears for the Cl in the topology map.

If a Cl or relationship is not updated or refreshed over a period of time (for
example, a Cl is not rediscovered by DFM and no manual update occurs), an
aging mechanism deletes the Cl from the RTSM. For details, see "Cl Lifecycle
and the Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this Cl.
False: the aging mechanism is disabled for this CI.

The default value is determined by the default value of the Enable Aging
attribute of the Cl type.

Note:
o If the aging mechanism is disabled in Aging Status, this field is ignored.
¢ This field is displayed for certain Cls only.

e You can change the default value for all new Cls of this type by editing the
default value of the Enable Aging attribute for this Cl type. For details, see
Enable and Run the Aging Mechanism in the RTSM Administration Guide.

Indicates if the Cl is a candidate for deletion.

Page 218 of 416



Modeling Guide
Chapter 8: IT Universe Manager

Ul Element
(A-2) Description

Last Access The time that the Cl was last accessed, whether when being updated or being
Time discovered by DFM. This field is displayed only for certain Cls.

This parameter is used by the aging mechanism. For details, see "Cl Lifecycle
and the Aging Mechanism" in the RTSM Administration Guide.

Last The date and time when the CI properties were last updated.

Modified

Time

Name The name of the ClI.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the ClI, or the application where

the Cl was created.

Relationship Forarelated Cl, click Relationship to go to the relationship mode of the dialog

box.
Select ClI Enables you to select the Cl type from the tree for the new CI. The Cl types that
Type are available for the selected ClI or view appear active in the Cl type tree. The

other Cl types appear in faded text and cannot be selected.

To limit the Cl type tree to Cl types from the current view, select Cl Types from
the current view on the right. To display all Cl types in the tree, select All Cl
Types.

Updated By The user name of the administrator who updated the CI properties.

User Label Enables you to define a display label for the CI. If no value is entered, the CI
name appears as the default label.

Relationship Dialog Box

This page enables you to define the relationship between the new Cl and the Cl selected in the
view, as well as the properties of the relationship.

To access Click the Relationship button from the New Related CI dialog box.
Important This page only appears for new related Cls.
information

User interface elements are described below:
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Ul Element

(A-2) Description

Allow CI When the value is set to true, the DFM process automatically updates the
Update relationship.

ClI Definition | Click Cl Definition to return to the CI properties mode of the dialog box.

Created By  The user name of the administrator who manually created the relationship, where
applicable.

Create Time The date and time when the relationship was created.

Description A description of the relationship.

Direction Select the relationship direction from the drop-down box.
Enable If a Cl or relationship is not updated or refreshed over a period of time (for
Aging example, a Cl is not rediscovered by DFM and no manual update occurs), an

aging mechanism deletes the Cl from the RTSM. For details, see "Cl Lifecycle
and the Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this relationship.
False: the aging mechanism is disabled for this relationship.

The default value is determined by the default value of the Enable Aging
attribute of the Cl type.

Note:
o If the aging mechanism is disabled, this field is ignored.
o This field is displayed for certain relationships only.

¢ You can change the default value for all new relationships of this type by
editing the default value of the Enable Aging attribute for this relationship
type. For details, see Enable and Run the Aging Mechanism in the RTSM
Administration Guide.

Last Access The time that the relationship was last accessed, whether when being updated or
Time being discovered by DFM. This field is only displayed for certain relationships.

This parameter is used by the aging mechanism. For details, see "Cl Lifecycle
and the Aging Mechanism" in the RTSM Administration Guide.
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Ul Element
(A-Z)

Must

Name

Network
Address

Note

Origin

Relationship

Source CI

Target CI

Updated By
Update Time
User Label

Weight

Description

When the value is set to true, the child Cl is dominant when the percentage rule
is used to calculate status for the parent Cl. If the Cl has low status, the parent
must take the child Cl status, overriding the percentage rule calculation if
necessary. This is useful to give emphasis to an important Cl. For example, you
might want to define Must for a database Cl, so that status is critical all the way
up the subtree if the database falls, regardless of the status of the other Cls in
the subtree.

The Must status defined for a relationship applies to that relationship only — it is
not used in any other relationships of the child CI.

The name of the ClI.

Defined only for route links. Indicates the destination network address to which
this route is configured.

Enables you to enter other information about the CI.

An ID for the source that automatically created the relationship, or the application
where the relationship was created.

Enables you to define the type of relationship that is created between the two
Cls.

The name of the Cl on the first side of the relationship. This is the Cl that you
selected in the view.

The name of the Cl on the second side of the relationship. This is the new CI that
you are creating.

The user name of the administrator who updated the relationship properties.
The date and time when the CI properties were last updated.
Enables you to define a display label for the relationship.

When a weight value is entered, the child Cl is given more weight in percentage
calculations, when the percentage rule is used to calculate status for the parent
Cl. Forexample, if a child Cl is given a weight of 3, then it has three times more
impact on the parent status calculation than its unweighted siblings.

The weight defined for a relationship applies to that relationship only — it is not
used in any other relationships of the child ClI.

Run Impact Analysis Dialog Box

This dialog box enables you to run the Impact rule you defined in Impact Analysis Manager for that

view.
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To access  Select Admin > RTSM Administration > Modeling > IT Universe
Manager. Right-click a trigger query node in the Topology Map and select Run

Impact Analysis or click the Run Impact Analysis Now button > inthe IT
Universe status bar.

Important You can:
information
o Display in a new window all the Cls that are impacted by the trigger CI. The
relationships in the map represent the Impact rules. The name of the
relationship is the name of the Impact rule you defined in the Impact Analysis
Manager. For details, see "Show Map" on the next page.

o Simulate how the statuses of the impacted Cls are impacted. For details, see
"Show in Views" on the next page.

o Generate a report that displays a list of Cls that are impacted in the system as
a result of the simulated changes. For details, see "Generate Report" below.

Note: This dialog only appears if an Impact rule is defined for that view. For
details, see "Impact Analysis Manager" on page 331.

Relevant "Retrieve Impact Analysis Results — Scenario" on page 189
tasks

User interface elements are described below:

Ul Element (A-Z) Description
All Impact rules Select to execute all impact rules in the impact analysis.
Generate Report Generates an Impact Analysis report, which displays information that is

divided as follows:

e Grouping by CIT. All the impacted Cls (the Cls that are impacted in
the system as a result of the simulated changes), sorted by CIT.

o Affected Application. All the impacted Cls that belong to a specific
business service.

o Triggered Cls. The Cls that represent the changes you want to
make to the system.

For details on the Impact Analysis report, see "Impact Analysis Report"
on page 324.

Impact rules bundle Select the bundle containing the required impact rules for the impact
analysis.
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Ul Element (A-2) Description

Only Impact rules Select to execute the impact rules from the specified bundle in the
located in specified | impact analysis.

bundle

Show in Views Simulates how the statuses of the impacted Cls are impacted for the

selected state. The Topology Map displays the statuses of the trigger
Cls as well as all statuses of the Cls that are impacted by it.

The Topology Map also displays the Impact Analysis indicators:

o Atrigger Cl is marked by this [ [indicator.

o ACl thatis both an impacted and a trigger Cl is marked by this
indicator.

¢ Animpacted Cl is marked by this | |indicator.

Note: The statuses that appear here and the colors that represent each
status are defined in the severity list for that state in the System Type
Manager. For details, see "Create/Update List/Enumeration Definition
Dialog Box" on page 376.

Show Map Enables you to select an Impact rule, and then display in a new window,
a simulation of all the Cls that are impacted by the trigger CI for the
selected state. If only one Impact rule is defined for this Cl, the Impact
Rules window is displayed directly. For more details, see "Show Impact
Pane" on page 225.

The relationships in the map represent the Impact rules and the name of
the relationship is the name of the Impact rule you defined in the Impact
Analysis Manager.

Note: Show Map enables you to view the results of multiple triggers.
Trigger Severity Select the required severity on the scale.

Note: The severity scale was defined for the state in the System Type
Manager. For details, see "System Type Manager" on page 351.

For example, you can create an Impact rule in the Impact Analysis
Manager that defines the severity of the trigger query node as other than
Warning (1). If you select a severity other than Warning (1), for
example, Minor (3), the condition is met and the simulated changes in
the system are triggered.

For details, see the "Impact Rules Definition Dialog Box" on page 342.

Save Snapshot Dialog Box

This dialog box enables you to take a snapshot of a view and save it.
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To access In IT Universe Manager, click the Snapshot button I in the Cl Selector and

select Save Snapshot.

Important You can compare snapshots of the same view taken at different times using the
information Compare Snapshots Report. For details, see "Compare Snapshots Report" on
page 319.

Relevant "Take a Snapshot of a View" on page 195
tasks

User interface elements are described below:

Ul Element (A-

Z) Description

Description A description of the snapshot (optional).

Note A note about the snapshot (optional).

View Name The name of the view as it appears in the Cl Selector. This field cannot be

edited.

Show Discovery Status and Changes Dialog Box

This dialog box enables you to find recent changes, for example, to an application, by rediscovering
the Cls and jobs in a view.

To access InIT Universe Manager:

o Torediscoverall Cls of a view, click the Show Discovery and Changes

ol | .
Summary button @ in the Cl Selector toolbar. The Show Discovery
Status and Changes dialog box is displayed.

o Torediscoverone Cl or several Cls in a view, select the Cl and display the
Discovery tab in the Advanced pane.
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Important By default, you can run the rediscovery procedure on views that include less than
information 10,000 Cls.

To increase the number of Cls that you can rediscover in a view:

1. Access the Infrastructure Settings Manager (Admin > Platform > Setup
and Maintenance > Infrastructure Settings).

2. Select the Max Cls in view supported to rediscover setting in the
infrastructure settings table.

3. Click the Value column and change the number.
4. Restart the server for the change to take effect.

For details on working with the Infrastructure Settings Manager, see
"Infrastructure Settings" in the BSM Platform Administration Guide.

Relevant "Check Status of Application Discovery (Rediscover a View)" on page 188
tasks
See also "Discovery Control Panel - Details Tab" in the Data Flow Management Guide

User interface elements are described below:

Ul Element (A-Z) Description

|§| Click to refresh the status of the selected Cls.

This button is disabled when there is no data to be reloaded.

|§| Click to rerun the discovery.

Discovery Progress For details, see "Discovery Control Panel - Details Tab" in the Data
Status on View Flow Management Guide.

History Changes on For details, see "Cl/Relationship History Dialog Box" on page 198.
View

Show Impact Pane

This page opens a window that displays the statuses of the trigger Cl as well as all statuses of the
Cls that are impacted by it.

To access  Inthe RunImpact Analysis Dialog box, click Show Map.

If Impact Analysis is already active, click on the Impact Analysis Is Active link
inthe IT Universe status bar.
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Important = The following tabs are available:
information
o Impact Results. Displays a map of all Cls impacted by the selected CI.

o Trigger Cls. Displays a table of information on the selected trigger Cls.

You can only see Impact Analysis results if you defined an Impact rule for that
view in Impact Analysis Manager. For details, see "Impact Analysis Manager" on
page 331.

To view information about specific Cls that are triggered or impacted by the
Impact rule, double-click the relationship connecting the Cls. A map is displayed.

The relationships in the map represent the Impact rules. The name of the
relationship is the name of the Impact rule you defined in the Impact Analysis
Manager.

Relevant "Retrieve Impact Analysis Results — Scenario" on page 189
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
<Legend> Indicates the icons displayed next to Cls with any of the following special

statuses:

o Added. When Change Timeframe is active, indicates that the Cl was
added.

o Candidate for Deletion. Indicates that the Cl is a candidate for deletion.

o Changed. When Change Timeframe is active, indicates that the Cl was
changed.

o External. Indicates that the Cl is a federated CI.
¢ Impacted. When Impact Analysis is active, indicates an impacted ClI.

« Impacted and Trigger. When Impact Analysis is active, indicates a
trigger Cl that is impacted.

¢ Note. Indicates that a note was added for the CI.

o Trigger. When Impact Analysis is active, indicates a trigger CI.

<Relationship> | The relationships represent the Impact rule you defined in the Impact
Analysis Manager. For details, see "Impact Rules Definition Dialog Box" on
page 342.
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Ul Element (A-
Z) Description

<The statuses The statuses that appear and the colors that represent each status are the
and the colors | ones that are defined in the severity list for that state in the System Type
that represent Manager. For details, see "Create/Update List/Enumeration Definition Dialog
each one> Box" on page 376.

<Toolbar> The Show Impact pane toolbar contains most of the buttons in the IT
Universe Manager toolbar.

<Topology Map @ Fordetails, see "Topology Map Sidebar" on page 164.
Sidebar>
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This chapter includes:

Modeling Studio Overview . 228
VieW FOrmMats .. 229
Building @ BUSINESS VW . . .. 229
Templates and Perspectives ... .. . 232
Predefined Folders and Views .. 234
Creating Template Based VIeWsS . ... ... 235
Business CIMOdElS ... ... o e 235
Building a Perspective Based VieW . ... . L 237
Revealed Cls and Watchpoints . ... 240
Create a Pattern View .. 244
Create a Template . ... ... 245
Create aPerspectiVe .. ... ... 246
Create a Template Based VieW ... 247
Create Multiple Template Based VieWs ... ... 248
Define Report Settings ... ... il 249
Build an Instance-based Model . ... .. .. . il 249
Build a New Pattern-based Model ... .. . ... 250
Build a Perspective-Based View BasedonaModel ... .. ... ... 251
Build a Perspective-Based View Based ona Collectionof Cls _._............................... 251
Build a Business Cl Model —Scenario ............ ... 252
Modeling Studio User Interface ... . 253

Tip: For more information about using Modeling Studio in BSM, see "Best Practices for
Modeling" on page 168.

Modeling Studio Overview

Modeling Studio is a tool for creating and managing views. You can create your own views, or work
with the out-of-the-box (factory) views provided with your BSM installation.
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The IT Universe model in the configuration management database can be very large, holding
thousands of configuration item (Cl)s. A view enables you to build a subset of the overall IT
universe model, containing only those Cls relating to a specific area of interest. You can define your
own views to display only the information that is relevant to your organization's business needs.

The views are used to display performance status in Service Health, and for setting up SLAs in
Service Level Management. BSM supports three view formats: pattemn views, template based
views, and perspective based views, which are populated through different processes. For details,
see "View Formats" below.

View Formats

BSM supports three view formats, by which to populate your view:

o Pattern views are built from a Topology Query Language (TQL) query that defines the structure
of the view. You can create a new TQL query as you build the view or base the view on an
existing query. The view displays only those Cls and relationships that satisfy the query
definition. When the view is displayed or refreshed, the Modeling Studio queries the RTSM for all
elements that fit the query, and automatically updates the view with those elements.

« Template based views are based on a TQL query, to which a template is then applied. The
template is a reusable view that includes parameters, which are saved as part of the template.
This enables you to build multiple views with the same settings without having to re-enter the
parameter information. The view displays only those Cls and relationships that satisfy the query
definition and the conditions of the template. For details on templates, see " Templates and
Perspectives" on page 232.

« Perspective based views are built by selecting a collection of individual Cls and applying a
special type of template, known as a perspective, to it. Instance views, which no longer exist,
are replaced by perspective based views. For details on perspectives, see " Templates and
Perspectives" on page 232.

When you select a view for editing from the view tree in the left pane, it opens on the editing pane in
the appropriate editor.

Local Impact Views

Within Service Health Administration, you can use the View Builder to create Local impact views,
which are independent of all other views. For example, suppose you have a global view which
contains a number of Cls representing business transactions, and you are only interested in the
data coming from two or three significant transactions. You can create a local impact view based on
the global view, remove the less important transactions from the local impact view, and the
calculations within the view are performed using only those transactions that are visible within the
view. For details, see "View Builder" in the BSM Application Administration Guide.

Building a Business View

In the Modeling Studio, you can define your own views to model your business environment.

This section includes the following topics:
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¢ "The Structure of a View" below
e "Setting the View Hierarchy" below

e "Making Views Available in BSM" on the next page

The Structure of a View

The views you create should provide the business users with logical representations of your
company's structure, processes, and goals. To meet these requirements, you generally build
multiple views representing different aspects of your business; for example, you could build
business views that revolve around any of the following:

o Company structure, so that data is organized by the geographical location of branches, or by
data centers.

o Business processes, so that data is organized by line of business, or by applications.

o Business goals, so that data is organized by sales, or by key customers.

The views depend on the particular demands of your organization and the actual hierarchical
structure of the views should reflect those demands.

The usual hierarchical format of a view is as follows:

o Top level. The highest levels of the view, consisting of the root Cl and the branches below it,

are normally built from logical Business Cl types such as Location, Line of Business,
Customer, Application, and so on.

o Intermediate level. The intermediate branches of the view normally consist of System Cl
types, representing actual hardware and software and/or monitoring group Cl types,
representing groups containing monitors.

« Bottom level. The lowest level of the view, consisting of leaf Cls at the ends of the subtrees, is
built from the Monitor Cl types. These Cls receive the actual data from the data sources, used
to determine KPI status all the way up the view subtrees, and so provide business context to the
view.

Note: The bottom level is only relevant when a monitoring solution such as BSM is
connected and modeled in the RTSM.

Setting the View Hierarchy

The Pattern View Editor enables you to set the view hierarchy using the Hierarchy pane on the right
side of the screen. There are two methods available for setting the hierarchy: Manual and Rule-
based. The manual method is selected by default.
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o Manual Hierarchy Method

In the manual hierarchy method, the query nodes of the view are displayed in a tree format. You
can create the hierarchy by manually dragging a selected query node under another query node
or by using the toolbar buttons. The system only allows you to move a query node under another
query node when the resulting hierarchy is valid. For details, see "Hierarchy Pane" on page 281.

It is possible to place a single query node from the view into the hierarchy multiple times. You
can then adjust the hierarchy so that the query node appears in different layers, according to the
required layout. The view results in such an instance would be the same as if you added another
query node to the TQL query. Using the same query node twice in the hierarchy enables you to
achieve the desired view results using a simpler TQL query.

¢ Query Node Grouping

When setting the view hierarchy manually, you can create subgroups to group Cls by different

criteria for the convenience of viewing the display. Click the Add Group By button = and
select one of the options. You can create a subgroup for Cls of the same type in the Topology
Map using the Add Group by CI Type option. You can create a subgroup for a specific query
node by selecting the Add Group by Query Node option. You can group Cls by a common
attribute using the Add Group by Attribute button and entering a regular expression as
described in "Query Node Grouping Dialog Box" on page 290. For details about regular
expressions, see "Regular Expression Examples" on page 415.

You can also create nested groups (a query node group inside another query node group) to help
fine-tune the TQL query results that are displayed in the Topology Map.

For example, after grouping query nodes of type node by their CIT, you can use their operation
state attribute to create more focused groups.

o Rule-Based Hierarchy Method

In the rule-based hierarchy method, you define hierarchy rules, using the Hierarchy Rules dialog
box. You select a source CIT, target CIT, relationship type, and relationship direction, which
define the conditions for a hierarchy rule. Any Cls in the view which satisfy the defined
conditions are subject to the rule, that is, the target Cl is placed on the layer below the source
ClI. For details on defining hierarchy rules, see "Hierarchy Rules Dialog Box" on page 262.

Making Views Available in BSM

When you create a view, you can associate it with one or more bundles to make the view visible in
relevant BSM applications. For example, only views associated with the SLM bundle appear in
Service Level Management. If a view is created from a template, the view inherits the bundles
settings of the template.

When you create a view or template, the Service_Health and SLM bundles are selected by default.
You can change the bundles with which a view is associated in the View Definition Properties
dialog box. For details, see "Query/View Definition Properties Dialog Box" on page 290.
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Note: It is possible to set up permissions that limit access to views, overriding bundle settings.
For more information about permissions, see the User Management section of the BSM
Platform Administration Guide.

The following table lists bundles that make views visible in BSM application and administration
pages:

Bundles Description

bam Views associated with the bam bundle appear in MyBSM,
Service Health, Service Level Management (SLM), and
Operations Management (Health Perspective and
Performance Perspective).

Note: This is alegacy bundle. Do not use the bam
bundle. Instead, use the Service Health bundle.

EUM Views associated with the EUM bundle appear:

e In End User Management (EUM) Application, in the
Browse Views tab in the Active Filters dialog box. For
details, see "Active Filters Dialog Box" in the BSM
User Guide.

¢ In EUM Administration, in the Monitoring tab.

Service Health Views associated with the Service_Health bundle appear
in MyBSM, Service Health, SLM, and Operations
Management (Health Perspective and Performance
Perspective).

SLM Views associated with the SLM bundle appear in SLM
Administration, in the Select Cls page of the New
SLA/Edit SLA Wizard. For details, see "Select Cls Page"
in the BSM Application Administration Guide.

soa Views associated with the soa bundle appear in
Application Management for SOA for SOA reports.

Note: All defined views are available in the View Builder tab in Service Health Administration,
regardless of their associated bundles.

Templates and Perspectives

A template is a reusable pattern view with defined parameters. You use templates to build template-
based views, setting the values of the parameters for each specific view. Any changes made to a
template affect all existing views based on that template.
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Template-based views can be opened in IT Universe Manager, like pattern views. You can also
open the template itself in IT Universe Manager to view the results for various parameter values. If
you want to save the results, you must save it as a template-based view. You define templates,
template-based views, and pattern views in the Pattern View Editor.

Perspectives are a type of template designed to be applied to a specific collection of Cls, similar to
the pattern in a pattern view. For example, a perspective could comprise a node containing an IP
Address. In that case, the resulting perspective-based view would include all the Cls from among
the Cls in the Cl selection, along with the IP Addresses contained in the node Cls.

The most basic perspective is known as the Content Only perspective and consists of only the
query node itself. If you apply the Content Only perspective to a Cl collection, the resulting view
contains only the selected Cls themselves.

Perspectives are also created and edited in the Pattern View Editor. You can have multiple views,
templates, and perspectives open in the Pattern View Editor simultaneously, each with its own tab.

Perspectives do not appear in the list of views in IT Universe Manager, however perspective-based
views can be opened in IT Universe Manager, like all other views. For details, see "Building a
Perspective Based View" on page 237.

In summary, the Views tree in the Resources tab of the Cl Selector in the Modeling Studio can
include five distinct entities:

e patternviews

templates

template based views

perspectives

perspective based views

You can filter the tree to select the types of views or templates to display.

The following table summarizes the types of views and where they are created and viewed:

Can be opened in IT Universe

Type of View Created in: Manager

Pattern View Pattern View Editor Yes

Template Pattern View Editor Yes, for the current session only
Template-based View Pattern View Editor Yes

Perspective Pattern View Editor No

Perspective-based Perspective-based View Yes

View Editor
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Predefined Folders and Views

The Views tree in the Resources tab of the Cl Selector in the Modeling Studio includes predefined
folders and views, as described in the following sections:

Predefined Folders

The hierarchical file folder system in the Cl Selector can help you organize your views. Predefined
folders are provided for the out-of-the-box views; you can modify these folders, or add additional
folders according to your organization's requirements.

Factory Views

Your BSM installation includes out-of-the-box pattern views, templates, and perspectives. These
views provide a quick start for working with the RTSM for setting up SLAs, and for viewing system
performance information in Service Health.

The out-of-the-box views are initially empty. As soon as Cls are added to the RTSM by one of the
Cl generators, the TQL query built into each pattern view is able to identify the Cls that meet the
pattern requirements, and add them to the view.

Views for Cls are created when a discovery process is run; the out-of-the-box views that are
provided correspond to the relevant Data Flow Management (DFM) packages. For example, the
Oracle view (Root > Database > Oracle > Oracle) is populated with Cls that are created when
Data Flow Management activates the Database - Oracle module. For details on running DFM, see
"Discovery Control Panel — Advanced Mode Workflow" in the Data Flow Management Guide.

For details on the cross-application processes for setting up the SAP views, see "Application
Management for SAP Reports and Views" in the BSM User Guide.

Some of the out-of-the-box views are set by default to display in specific BSM applications. There
are some out-of-the-box views that are hidden by default.

Some of the out-of-the-box views are considered basic to the system and cannot be deleted from
the folders.

Predefined Perspectives

BSM also provides out-of-the-box perspectives. One example is the Content Only perspective,
which includes only the elements of the view content itself, without any additional Cls.

The following out-of-the-box perspectives are intended to be used in Service Health:

o System Monitors only. This perspective enriches the model by adding child Cls down to the
level of monitors. Use this perspective to create a Service Health view that includes System
monitors only.

« End User Monitors. This perspective enriches the model by adding child Cls related to the end
user experience of the application, such as Business Transaction and Business Transaction
Flow. Use this perspective to create a Service Health view that includes monitoring statuses for
End User Management only.

o Impact. This perspective enriches the model with all child Cls related by impact links. Use this
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perspective to configure additional monitors using the Monitor Deployment Wizard.

 Model and Dependency Hierarchy. This perspective enriches the model with all dependent
Cls inthe RTSM. Use this perspective to create a view with the full model hierarchy.

o APM Perspective. This perspective enriches the model with Business Transactions Flow and
Business Transaction Cls. Use this perspective to add related infrastructure elements and
SiteScope monitors to create a view that includes all APM information.

Creating Template Based Views

Template-based views based on the same template contain the same query nodes and
relationships. They differ only in their parameter values. You create template-based views using the
Template-based View wizard. The wizard enables you to create multiple views at one time based
on the same template. When creating multiple views, you have the option of entering parameter
values manually or importing them from a CSV file. The CSV file must be formatted correctly for the
wizard to import the values. It must contain the name of at least one of the template parameters in
the first row and it must contain at least one record. The records should be in separate rows and the
parameter values for each record should be in the same row, separated by commas.

The wizard also provides an Advanced Naming feature, which enables you to define an expression
for the view names based on parameter values. For example, if your base template is called
Server_Template, and one of the template parameters is Serial Number, you could define the
view names to be Server <Serial Number>. In this way, the wizard automatically inserts the
respective value of the parameter Serial Number into the name of each view.

An alternate way to assign names to the views when importing values from a CSV file is to include
a column in the file called template_based_view_name. The file entries corresponding to this
column are automatically entered by the wizard as the view names. Note that this naming method
overrides the Advanced Naming feature; that is, view names are assigned the entries in the
template_based_view_name column of the file, even when the Advanced Naming feature is
selected.

For details on creating template-based views, see "Template-based View Wizard" on page 297.

You can also edit the parameters of a template-based view when the view is open in the Editor,
from the Template Parameter Values dialog box. For details, see "Template Parameter Values
Dialog Box" on page 301.

You cannot edit the report layout for a template-based view. To change the report layout, you need
to make changes in the base template of the view.

Business Cl Models

This section includes the following topics:

The collection of Cls which compose the view content of perspective-based views can be selected
in two ways. You can select Cls from the Cl Selector and drag them onto the editing pane. In this
case, you can build a view by applying a perspective to the collection and the collection cannot be
reused in another view without repeating the selection process. The other way to select the Cls to
appear in the view is by creating a model.
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A model is a reusable collection of Cl instances that define a business entity, such as a business
service or line of business. By creating a model, you are building a Cl collection that can be reused
with other perspectives to create different views. Any changes you subsequently make to the
model are reflected in all the views based on that model. There are two types of models: instance-
based models and pattern-based models.

Instance-based Models

You build an instance-based model by first selecting a business Cl to serve as its basis. The
available business Cls include group, application, business service, business unit, and line of
business. Then, you can add Cls to your model in the following ways:

« Manually, by dragging Cls from the CI Selector into the Model Editor
« Revealing related Cls using a reveal path and selecting the ones to add to the model
« Defining a watchpoint for a selected Cl and automatically adding Cls to the model

You can also begin building a model by dragging Cls onto the empty canvas and selecting Create a
new model.

The model you create is a Cl itself and the Cls in your model are related to the model by Contains
relationships. You must save your model before applying a perspective to it to build a view.

Caution: The changes you make in a model affect the entire universe, not just the views
based on that model. Thus, if you delete a Cl from a model, you are deleting the relationship
that existed between the Cls from the RTSM.

When working in IT Universe Manager, you can add selected Cls directly to a new model or an
existing model. For details, see "Add Cls to Model Dialog Box" on page 196.

Pattern-based Models

Another type of model you can build is a pattern-based model. In a pattemn-based model, you define
a TQL query to determine the Cls included, rather than selecting them manually. You can base your
pattern-based model on an existing TQL query or create a new TQL query.

You must designate at least one query node in the model's TQL query as output for the model. The
Cls of that type which match the pattern of the TQL query are the ones included in the model output.

The pattern-based model created is saved as a Cl like an ordinary model, and can be used to form
the content of a perspective-based view. The new TQL query created is saved as an ordinary query
and can be used as the basis for a pattern view.

Pattern-based models are not updated continuously. Each model is calculated at the time it is
saved and the TQL query runs at specific intervals to update the model. All existing pattern-based
models are updated at the same time. To set the starting time and repeat interval for the pattern-

based model updates, click the © button in the Resources tab of the left pane. The repeat interval
must be evenly divisible in a 24-hour period to ensure that the updates are performed at the same
hours each day. The settings you select also apply to all pattern-based models created
subsequently. The default settings are a starting time of 12 midnight and a repeat interval of 12-
hours.
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Note:

e When you export a pattern-based model in Package Manager, the underlying TQL query of
the model, as well as an enrichment used to update the model content, are added to the
package. When you view the package resource, or deploy or undeploy the package, only
those resources are displayed. The model name does not appear. A pattern-based model
exported from UCMDB 9.05 cannot be imported into an earlier UCMDB version.

o When you delete a pattern-based model (either from the Modeling Studio or from the IT

Universe), the Business Enrichment, Job Scheduler, and pattemn-based model Cl are also
deleted.

Defining a Pattern-based Model over an Instance-based Model

When defining a pattern-based model, it is possible build it on top of an existing instance-based
model. In this case, only the pattern of the model that you build is visible on the canvas, as in a new
pattern-based model. However, the Cls in the instance-based model also remain in the new model
and appear in the view results when the model is used to build a perspective-based view. Similarly,
when you access the model in IT Universe Manager, both the Cls in the instance-based model and
those retrieved by the pattern-based model are visible. The model is saved with the name of the
original instance-based model, in effect creating a hybrid model with both instance-based and
pattern-based components.

If you delete the model, only the additional pattem-based part of the model is deleted. The model
reverts to an instance-based model and the Cls included in it become visible in the Model Editor.

Building a Perspective Based View

A perspective based view is composed of perspectives applied to a model or a collection of Cls.

The perspective is a special type of template which is designed to be applied to a subset of the IT
Universe model.

The Content pane of the Perspective-based View Editor displays the models or Cls you have
selected to serve as the basis of your view. The Perspective pane displays the selected
perspectives. The Preview pane displays the resulting view based upon your content and
perspective selections. When you make a change in the content or perspective selections, the view
is updated accordingly in the Preview pane. For details, see "Perspective-based View Editor" on
page 285.

This section includes the following topics:

o "Content" on the next page

e "Perspectives" on the next page

o "Views Based on Multiple Perspectives" on page 239

¢ "Including and Excluding Child Cls" on page 239
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Content

The content in a perspective based view can be selected in two ways:

¢ You can add individual Cls to the view manually, using the Cl Selector. The Cls in the collection
are independent of each other. In this case, the collection of Cls is not defined as a model and
cannot be reused in another view.

¢ You can add one or more models to the view, using the Cl Selector. Alternatively, you can start
by working with a model in the Model Editor and select Generate View for Selected Model to
build a view based on that model. In this case, the identical content can be used to build another
view by selecting the same models.

You can select both individual Cls and models to form the content of a perspective based view,
however in that case, the models are treated as ordinary Cls. The models themselves are included
in the view without their hierarchy of child Cls.

When working in IT Universe Manager, you can add selected Cls directly to the content of a new or
an existing perspective based view. For details, see "Add Cls to View Dialog Box" on page 196.

Perspectives

The perspectives you select for your view determine which Cls are included in the view. A
perspective is a reusable pattern, similar to a template. The difference between a perspective and a
regular template is that the perspective includes one or more query nodes designated as contact
query nodes. A contact query node is a query node in the pattern which is used to apply the pattern
to specific content and it is indicated by a small icon that appears next to the query node =. .

For example, in the following perspective, a query node of type Windows is designated as the
contact query node and it has an IP Address related to it by a containment relationship.

=S
a2
indows

Contalnment

m

IpAddress

When this perspective is applied to a Cl collection, the resulting view contains all the Cls in the
original collection as well as the IP Addresses connected to the Windows Cls in the collection (the
Cls that were added by applying the perspective).

A perspective can have several contact query nodes, but every disconnected graph within a
perspective must have at least one contact query node.

If you make a change to a perspective, all views based on that perspective are affected.
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Views Based on Multiple Perspectives

You can select multiple perspectives to apply to the content of your view. There are two ways to
select multiple perspectives:

o Perspective groups
o Perspective chains

In a perspective group, you select two or more perspectives to apply simultaneously to the same
input content.

In a perspective chain, you select two or more perspectives at different levels of the view creation.
The perspective in the first level is applied to the original view content to generate results in the form
of a Cl collection that serves as input content for the next level. The perspective in the second level
is then applied to this content to generate the view results. You can build views based on multiple
levels of perspectives, each one generating input content for the following level.

It is possible to apply both of the above methods at the same time, that is, by selecting multiple
perspectives in each of the levels of a perspective selection.

For example, select a collection of IP Subnet Cls as your input content and select a perspective
that adds the node Cls related to the IP Subnets as the first level perspective. The results of this
stage consist of the original IP Subnets and their related nodes. Then add a second perspective
level and select two perspectives for it: one that adds CPU Cls related to nodes and one that adds
File System Cls related to nodes. The final results include the original IP Subnets, their related
nodes, and the CPUs and File Systems related to those nodes.

These options help to simplify the process of creating a perspective-based view, by breaking down
the functionality of a perspective into its component parts. Instead of building a separate large and

complex perspective for each required view, you can construct a custom perspective combination

to match the requirements of your specific case from smaller and more basic perspectives.

Including and Excluding Child Cls

When adding Cls that have children to a view, the Cl and its children are only included in the view if
the pattern of the perspective includes children for the selected Cl type. In that case, children are
included for all Cls of that type. After creating a view, you can hide specific Cls from the view by
selecting the Cl in the View Results pane and selecting Hide Cl from View from the shortcut
menu or clicking the Hide CI from View button in the toolbar. This option is only available for Cls
that were added to the view via the perspective and were not part of the original content on which
the view was based. Thus, if the view was based on a collection of Cls, the Cls in that collection
cannot be hidden from the view. If the view was based on a model, the model itself cannot be
hidden from the view, but the Cls contained in the model can be hidden.

When KPI status is calculated for a Cl and displayed in Service Health, the status is based on all
child Cls that exist in the RTSM for the parent Cl. The Business Logic Engine calculates status
from all child Cls attached to that parent Cl, across all views. The calculation is based on all the
relationships for the Cl in the RTSM, without connection to the child Cls displayed in any particular
view. To restrict the number of Cls displayed in the view, you can change the perspective to hide
child Cls. This has no effect on KPI status — status is still calculated based on all child Cls,
whether they are displayed in the view or hidden.
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Whether or not all child Cls are displayed in the view does not influence the status calculations
made for the parent Cl and the status displayed in Service Health.

For example, the following pictures show status in Service Health for the same ClI, Groupl, in two
views: In the first view, child Cls are included, and in the second, they are excluded. The same
status result is shown for the ClI in both views, regardless of the perspective in use.

Top View | Console | Filters Geographical Map Custom Map Reports

BPM_Profile1 ~ a5 5 1|

Performance @Ity  Availability @Dty  Ack B

Hierarchy KPIs Business Impact Alerts Changes & Incidents

Performance Availability Ack

[xEP Oty =]
Q4o O1o 8
Gse Q+g =
(VI (VI B8
Top View | Console | Filters Geographical Map Custom Map Reports
BPM_Profile1 - ol i

Performance Q*o Availability ‘:-—"*O Ack &

When a Cl has child Cls that are excluded from the view, the KPI tooltip in Service Health shows
the number of hidden child Cls with KPIs attached, to indicate that the KPI status of the parent is
based on Cls that are not in the view.

Details - Performance

CI name: fist_bpr_profile_1
Status: Critical

Calculation Rule: Warst Child Rule
Held status since: ef10/06 10:02:50 AM
Hidden child CIs

{with attached 5

KPIs):

You can use the Find Visible and Hidden Child Cls option to view information on hidden
children. For details, see "How to Find Visible and Hidden Child Cls" in the BSM User Guide.

Revealed Cls and Watchpoints

The Modeling Studio provides two advanced methods of adding Cls to an existing model: revealing
related Cls and defining watchpoints.

This section includes the following topics:
e "Revealing Cls" below

o "Watchpoints" on page 243

Revealing Cls

One approach to building a model is to add Cls related to the Cls in the model. The Modeling Studio
provides a tool to help you reveal those Cls. The process of revealing related Cls involves
constructing a reveal path, which is a chain of Cl types that are related to each other. The first item
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in your reveal path is the Cl type of the Cl from which you started to reveal Cls. The Modeling
Studio locates all of its related Cls and lists their Cl types. By selecting one of those types, you
build the next step of your path. All the related Cls of that type appear in the lower pane of the dialog
box. You can select the ones you want to include in your model. The process is repeated to build
the following step of the path.

For example, if you begin to reveal Cls from a Cl of type Windows, the Modeling Studio may reveal
related Cls of types Interface, Network, and IP. If you select Network, the related Cls of type
Network appear in the lower pane and can be added to the model by dragging them into the Cls
Basket or clicking the Cls Basket icon:

X
2} Revealing Related Cls... (2)
At each step of the reveal path, select revealed Cls to add to your model.
Feveal Path. 4 Windows = AvE RElD
Cl Type Conditions Cl count
) interface 1
=% Network 1
PP 1
Eind I P - e =
F
@ Drop Cls in order to add them to model... _“3
| Name | Cl Type

%% 16.50.60.0 Network
Find: I P - e El

Clz Basket

Click Next to build the next step of the path using Network as your selection. The Modeling Studio
reveals related Cls of type Windows, Unix, and IP. Unix is selected and the Unix Cls appear in the
lower pane and can be added to the model by dragging the selected ones into the Cls Basket pane:
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Reveal (Is X|

Revealing Related Cls... (3)

At each step ofthe reveal path, select revealed Cls to add to your model.

Reveal Path: [ Windows = 5% Metwork 3 g path
b4 ==
Cl Type Conditions Cl count
ﬁ Windows 35
e 43
| Einet @ @ |
T
6] Crop Cls in order to add them to model... &
Mame Cl Type
5 tabm1ss04 Unix
ﬁ notredame Lnix
ﬁ labm1sun0s Linix
5 tabm1itgo7 Unix
S tabmiitg10 Unix
5 tabm1 hp7 Unix
5 labmitg02 Unix
| Find: | @ @ |
Cls Basket
Rimish Cancel Help
Click Next to build the next step of the path using Unix as your selection:
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k.
I Revealing Related Cls... (4)
- L At each step of the reveal path, select revealed Cls to add to your model.
Reveal Path: ¢ Windows = 5% Network % 5 Unix &
Cl Type Conditions Cl count.
L SNMP 12 |58
|4 OS User 122
=/ Disk 12 |
2L ECcPU 8|
-“|- Interface 23
=% Network 2
&¥ S5H 13 |+
[ 1.9© 5 =
P
@ Crop Clz in order to add them to model...
MName | Cl Type
Cls Basket

In this case, a reveal path of Windows > Network > Unix was constructed. At each step, you
have the option of adding any of the revealed related Cls to your model. For details on revealing
Cls, see "Reveal Cls Dialog Box" on page 291.

It is also possible to construct a reveal path without revealing Cls. For details, see
"Create/Edit/Save Reveal Path Dialog Box" on page 259.

Watchpoints

Another method of locating related Cls to add to the model is by defining a watchpoint for a selected
Clin the model. A watchpoint is a mechanism which is triggered when a new related Cl of a
specified type is created. Every watchpoint is defined in connection with a reveal path. If a new
related Cl of any Cl type included in the path is created, the watchpoint is triggered and an indicator
appears next to the model. For details on defining a watchpoint, see "New Watchpoint Dialog Box"
on page 277.

Note: You must save a new model before defining watchpoints for its Cls.

All the related Cls detected by the watchpoint are displayed in the Watchpoints Updates dialog box.
The dialog box enables you to select the ones to add to your model and the ones to suppress, or
exclude from your model. For details, see "Watchpoints Updates Dialog Box" on page 307.

You also have the option to include the detected Cls in your model automatically by selecting the
check box in the New Watchpoint dialog box. In this case, all Cls detected by the watchpoint are
added to the model.
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A watchpoint can also be used to detect Cls included in the model which are no longer related to the
model. If such Cls are found along the reveal path connected to the watchpoint, they also appear in
the Watchpoints Updates dialog box. You can accept the suggestion to remove the Cls from your
model, or you can suppress the suggestion, thereby keeping the Cls in your model.

Note: Although a watchpoint is defined for an individual Cl, the watchpoint results display
related Cls of the ClI types included in the reveal path for all Cls in the model.

Create a Pattern View

This task describes how to create a pattern view and define its TQL query.

This task includes the following steps:

1. Open a New View in the Pattern View Editor

Click the New button ™ and select Pattern View. In the New Pattern View dialog box, select
the base TQL query on which your new view is based, or select Create new query to build a
new TQL query. The Pattern View Editor opens. For details, see "New Pattern
View/Template/Perspective Dialog Box" on page 276.

2. Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details on how to add query
nodes and relationships to a TQL query, see "Add Query Nodes and Relationships toa TQL
Query" on page 23.

Note: If you are starting with a blank view, you must add at least one query node in order
to save your view.

3. Setthe View Hierarchy

Set the hierarchy for the view by moving the required query nodes in the Hierarchy pane. For
details, see "Setting the View Hierarchy" on page 230.

When you are finished, click Save to save the view.

4. Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the
report for each query node of the view. You can also set the order of the report columns, set the
sort order of each column, and add a chart. For details, see "Define Report Settings" on page
249,

5. Set Permissions

Apply viewing and editing permissions to users and user groups for the new view. You set
permissions in Admin > Platform > Users and Permissions, select a user or a group and
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select Permissions. For details, see the Permissions section in the BSM Platform
Administration Guide.

Create a Template

This task describes how to define a new template.

This task includes the following steps:

1. Open a New Template in the Pattern View Editor

Click the New button " and select Template. In the New Template dialog box, select the
base TQL query on which your new template is based, or select Create new query to build a
new TQL query. For details, see "New Pattern View/Template/Perspective Dialog Box" on
page 276.

2. Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details on how to add query
nodes and relationships to a TQL query, see "Add Query Nodes and Relationships to a TQL
Query" on page 23.

Note: If you are starting with a blank template, you must add at least one query node in
order to save your template.

3. Set Parameter Values

Right-click a query node or relationship in the TQL query and select Query Node Properties. In
the Attributes tab, add an attribute with a parameterized value. For details, see "Query
Node/Relationship Properties Dialog Box" on page 68.

Note: If you do not set any parameters, when you try to save your template, you must
save it as a pattern view.

4. Setthe Template Hierarchy

Set the hierarchy for the template by moving the required query nodes in the Hierarchy pane.
For details, see "Setting the View Hierarchy" on page 230.

When you are finished, click Save to save the template.

5. Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the
report for each query node of the view. You can also set the order of the report columns, set the
sort order of each column, and add a chart. For details, see "Define Report Settings" on page
249.
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6.

Set Permissions

Apply viewing and editing permissions to users and user groups for the new template. You set
permissions in Admin > Platform > Users and Permissions, select a user or a group and
select Permissions. For details, see the Permissions section in the BSM Platform
Administration Guide.

Create a Perspective

This task describes how to define a new perspective.

This task includes the following steps:

1.

Open a New Perspective in the Pattern View Editor

Click the New button " and select Perspective. In the New Perspective dialog box, select
the base TQL query on which your new Perspective is based, or select Create new query to
build a new TQL query. For details, see "New Pattern View/Template/Perspective Dialog Box"
on page 276.

Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details on how to add query
nodes and relationships to a TQL query, see "Add Query Nodes and Relationships to a TQL
Query" on page 23.

Select a Contact Query Node

Select at least one query node in the TQL query to be a contact query node. Right-click the
query node and select Use As Contact Query Node.

Note: If you do not select a contact query node, when you try to save your perspective,
you must save it as a pattern view.

Set the Perspective Hierarchy

Set the hierarchy for the perspective by moving the required query nodes in the Hierarchy pane.
For details, see "Setting the View Hierarchy" on page 230.

When you are finished, click Save to save the perspective.

Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the
report for each query node of the view. You can also set the order of the report columns, set the
sort order of each column, and add a chart. For details, see "Define Report Settings" on page
249.

Set Permissions
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Apply viewing and editing permissions to users and user groups for the new perspective. You
set permissions in Admin > Platform > Users and Permissions, select a user or a group and
select Permissions. For details, see the Permissions section in the BSM Platform
Administration Guide.

Create a Template Based View

This task describes how to define a single template based view.

This task includes the following steps:

1.

Prerequisites

If you want to base your view on a new template, create the template first. For details, see
"Create a Template" on page 245.

Define a New Template Based View
You define a new template based view using the Template-based View wizard. Click the New

button ** and select Template Based View.

Select a Template

On the Select Template page of the wizard, select a template on which to base your view. For
details, see "Select Template Page" on page 297.

Select the Method for Adding Parameter Values

On the Import Parameter Values page of the wizard, select the method for adding the
parameter values. For details, see "Import Parameter Values Page" on page 298.

Set Parameters

On the Enter Parameters page, enter the parameter values for the view. For details, see "Enter
Parameters Page" on page 299.

Note: You can also edit the parameters from within the Editor after creating the view, by
selecting Show Parameters “F? from the toolbar or the shortcut menu.

When you are finished, click Finish to open the view in the Editor. Click Save to save the
view.

Set Permissions

Apply viewing and editing permissions to users and user groups for that view. You set
permissions in Admin > Platform > Users and Permissions, select a user or a group and
select Permissions. For details, see the Permissions section in the BSM Platform
Administration Guide.
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Create Multiple Template Based Views

This task describes how to define multiple template-based views.

This task includes the following steps:

1.

Prerequisites

If you want to base your views on a new template, create the template first. For details, see
"Create a Template" on page 245.

Define New Template Based Views
You define new template based views using the Template-based View wizard. Click the New

button ** and select Template Based View.

Select a Template

On the Select Template page of the wizard, select a template on which to base your views. For
details, see "Select Template Page" on page 297.

Select the Methods for Adding Parameter Values and Naming Views

On the Import Parameter Values page of the wizard, select the method for adding the
parameter values. Also, if you want to use the Advanced Naming feature, select the check box
on this page. For details, see "Import Parameter Values Page" on page 298.

Set Parameters

On the Enter Parameters page, enter the parameter values for the view. If you selected to
import the parameter values from a CSV file, they are automatically entered in the table. You
can edit the view names and parameter values manually on this page. You can also add new
views to the table or delete views from the table. For details, see "Enter Parameters Page" on
page 299.

Select the Location for Saving the Views

On the Select Location page, select the location in the view tree in which to save the new
views. For details, see "Select Location for Views Page" on page 299.

Save the Views

On the Summary page, review the details of the views you created. If there are no further
changes, click Save to save the views in the selected location.

Set Permissions

Apply viewing and editing permissions to users and user groups for each view created. You set
permissions in Admin > Platform > Users and Permissions, select a user or a group and
select Permissions. For details, see the Permissions section in the BSM Platform
Administration Guide.
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Define Report Settings

This task describes how to define report settings for a view, template, or perspective.

This task includes the following steps:

1.

Prerequisites

After defining the content and hierarchy of a view, template, or perspective, you can define the
report settings. Select the Report tab in the Pattern View Editor.

Select Attributes to Appear as Report Columns

For each query node in the view, select the query node in the Hierarchy pane and select the
attributes to appear as columns in the report for that query node. You select attributes in the
Query Node Definition pane by moving them from the Attributes list to the Report Layout list.
Set the order of the columns using the arrow buttons in the Report Layout list. For details, see
"Pattern View Editor" on page 280.

Add Function Columns to the Report - Optional

You have the option of adding a column for a selected query node consisting of data derived
from a function performed on one of its child query nodes. Click the Add Function button /% to
open the Add Function dialog box where you can select the relevant settings. For details, see "
Add/Edit Function Dialog Box" on page 255.

Set the Sort Order of the Column Content

Click the Set Sort Order button =1 to open the Sort Column Content dialog box. Determine
the columns by which to sort the report by moving columns from the Available Columns list to
the Sorted Columns list. Use the arrow buttons to set the sort order of the columns. Use the
Sort Ascending/Sort Descending buttons to set the sort direction for each column. For details,
see "Sort Column Content Dialog Box" on page 296.

Add a Chart to the Report - Optional

You have the option of adding a chart to your report, in place of a table, for a selected layer of
the view. When the necessary conditions for adding a chart are satisfied, the Define Chart link
in the Chart Properties section of the Query Node Definition pane is active. Click the link and
enter the chart settings. For details, see "Chart Properties" on page 284.

Build an Instance-based Model

This task describes how to build an instance-based business Cl| model which can serve as the
basis for a view.

This task includes the following steps:
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1. Create the New Model

In the Modeling Studio, click the New " button and select Instance Based Model to open
the New Model dialog box. Select a Cl type and enter the values for its properties. For details,
see "New Model Dialog Box" on page 276.

Note: You cannot create an instance-based model with an already existing name.

2. Add Cls to the Model Manually

In the CI Selector, search for the Cls you want to include in your model. Select them and drag
them into the model.

Tip: You can select more than one CI by holding the CTRL key while selecting Cls.

3. Reveal Cls

Select a Cl in the model and reveal its related Cls along a reveal path. Add selected Cls from
among the revealed Cls to your model. When you are done, save the model. For details, see
"Reveal Cls Dialog Box" on page 291.

4. Define Watchpoints for Cls in the Model

Right-click a Cl in the model and select Watchpoint > New Watchpoint. The New
Watchpoint dialog box opens. Select a reveal path and click OK. A small icon appears next to
the Cl indicating that a watchpoint is defined for it. For details, see "New Watchpoint Dialog
Box" on page 277.

Build a New Pattern-based Model

This task describes how to build a new pattern-based model which can serve as the basis for a
perspective-based view.

This task includes the following steps:

1. Define the New Model
You define a new pattern-based model using the Pattern-based Model wizard. Click the New

button *° and select Pattern Based Model.

Note: You cannot create an pattern-based model with an already existing name.

2. Enter the Model Details

On the first wizard page, select New Model. Then select a Cl type for the model and enter the
properties. For details, see "Select Cl Type Page" on page 279.
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3. Selecta TQL Query

On the next wizard page, select a TQL query for the model. You can create a new TQL query or
select an existing query from the tree. The TQL Query Editor opens with the selected query.
For details, see "Query Selection Page" on page 280.

4. Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details on how to add query
nodes and relationships to a TQL query, see "Add Query Nodes and Relationships toa TQL
Query" on page 23.

5. Set Output Query Nodes

Select one or more query nodes in the TQL query to serve as output for the model by right-
clicking them and selecting Add to Model Output. The query node is indicated by a small icon
next to it.

6. Save the Model

When you are finished, save the model with a unique name. If you created a new TQL query,
the query is also saved independently of the model and can be re-used as a regular TQL query.

Build a Perspective-Based View Based on a Model

This task describes how to build a view in the Modeling Studio based on a model and a perspective.

This task includes the following steps:

1. Open the Model
In the Modeling Studio, select Models as the Resource type in the left pane, select the

relevant model, and click Open Model 55 in the left pane toolbar.

2. Select a Perspective

In the Model Editor, right-click the model and select Generate View for selected model. The
Creating New View dialog box opens. Select perspectives to apply to the model. For details,
see "Creating New View Dialog Box" on page 260.

3. Save the View

The Perspective-based View Editor opens with your new view. Optionally, build a perspective
chain by selecting perspectives for additional levels of the view creation. Rename the view and
save it in the correct folder. For details, see "Perspective-based View Editor" on page 285.

Build a Perspective-Based View Based on a
Collection of Cls

This task describes how to build a view in the Modeling Studio based on a collection of Cls and a
perspective.
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This task includes the following steps:

1.

Create the New View

In the Modeling Studio, click the New “* button and select Perspective Based View to open
the Perspective-based View Editor. For details, see "Perspective-based View Editor" on page
285.

Add Cls to the View

In the CI Selector, search for the Cls you want to include in your view. Select them and drag
them into the view. For details on the Cl Selector, see "Cl| Selector" on page 126.

Tip: You can select more than one CI by holding the CTRL key while selecting Cls.

Select a Perspective and Save the View

In the Perspective pane, select perspectives to apply to your Cl collection. Optionally, you can
build a perspective chain by selecting perspectives for additional levels of the view creation.
Rename the view and save it in the correct folder. For details, see "Perspective-based View
Editor" on page 285.

Build a Business Cl Model - Scenario

This scenario describes how to build a business Cl model for use in a human resources application.

This task includes the following steps:

1.

Create a Model
To create a model, you need to select a Cl type and enter its key properties.
Select Admin > RTSM Administration > Modeling > Modeling Studio to open the

Modeling Studio. For details about how to create a model, see "New Model Dialog Box" on
page 276.

Example of a Business Cl Model:

In this example, a human resources application called Onboard Employee is to be created.
Select Business Process as the Cl type and enter Onboard Employee as the name
under the key properties.

2. Create Application Cl Models Within Your Model

You can create models within your model by clicking the New Model icon & in the Model
Editor. For details, see "Model Editor" on page 267
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Example of Application Cl Models:

Within the Onboard Employee model, create a model of type Application. Enter HR
Enterprise Resource Planning (ERP) as the name under the key properties. The
application Cl is created as a model within the Onboard Employee model. Repeat the
process to create the following applications: Active Directory (AD) and Customer
Relationship Management (CRM). The Onboard Employee model now includes three
application models.

3. Add System Cls to Your Model

Add to your model the Cls for the servers or other software elements on which the applications
are running.

Example of System Cl Models:

Under the HR ERPapplication, drag the System Cl SAP System. Under the AD
application, drag the System CI Node. The System Cls are included in the model and their

related Cls, such as Hosts and Monitors, are automatically added to the model as related
Cls.

4. Add Cls to Your Model as Related Cls

Add the Cls that are to be related to the Cls in the model but are not included in the model. For
details, see "Model Editor" on page 267.

Example of Related Cls:
Create an application CI of type Portal. Select the CRM application and click the Related

Cls tab in the Information pane. Drag the Portal Cl into the Information pane. The Cl is
added as arelated Cl to CRM.

Modeling Studio User Interface
This section includes (in alphabetical order):
o " Add/Edit Function Dialog Box" on page 255
o "Change Query Node/Relationship Type Dialog Box" on page 256
o "Choose Operation for Selected Items Dialog Box" on page 257
o "Conditions of Related Cls Dialog Box" on page 258

o "Create/Edit/Save Reveal Path Dialog Box" on page 259
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o "Creating New View Dialog Box" on page 260

¢ "Cycle Definition Dialog Box" on page 260

o "Hidden Cls Dialog Box" on page 261

o "Hierarchy Rules Dialog Box" on page 262

o "Left Pane" on page 262

e "Manage Cl Watchpoints Dialog Box" on page 267

o "Model Editor" on page 267

¢ "Modeling Studio Page" on page 274

¢ "Models Containing Selected Cl Dialog Box" on page 275

o "New Model Dialog Box" on page 276

o "New Pattern View/Template/Perspective Dialog Box" on page 276
o "New Watchpoint Dialog Box" on page 277

e "Open Reveal Path Dialog Box" on page 278

o "Pattern Based Model Wizard" on page 279

o "Pattern View Editor" on page 280

o "Perspective-based View Editor" on page 285

¢ "Query Node Grouping Dialog Box" on page 290

¢ "Query/View Definition Properties Dialog Box" on page 290
o "Reveal Cls Dialog Box" on page 291

¢ "Save Query Dialog Box" on page 293

o "Save View/Template/Perspective Dialog Box" on page 294
o "Select Integration Points Dialog Box" on page 295

e "Sort Column Content Dialog Box" on page 296

o "Template-based View Wizard" on page 297

o "Template Parameter Values Dialog Box" on page 301
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o "TQL Query Editor" on page 301
¢ "Views Containing Selected Cl Dialog Box" on page 306
o "Watchpoints Updates Dialog Box" on page 307

o "<Query/Template/Perspective Name> Dependencies Dialog Box" on page 308

Add/Edit Function Dialog Box

This dialog box enables you to define which of the query node's functions and parameters you want
toinclude in the report.

To access | Click the Add Function button under the Report Layout box in the Query Node
Definition pane of the Pattern View Editor.

Important When defining the report columns for a selected query node in a view, template, or

information = perspective, you can define a column consisting of data deriving from a function
defined for one of its child query nodes. Select the relevant child query node,
attribute, and function that you want to define.

First, select the required query node and function. The attribute list adjusts to
display the relevant attribute for the selected combination. Select the required
attribute.

Relevant "Define Report Settings" on page 249
tasks

User interface elements are described below:

Ul Element
(A-2) Description
Attribute Select an attribute from the list.
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Ul Element
(A-2) Description
Function From the Function list, select the function you want to use to calculate the
results on these columns.
The following are the available options:
o Average. The average value of the selected attribute for all the Cl instances
of the selected query node.
o Concatenated List. Lists the values of the selected attribute for all the ClI
instances of the selected query node.
e Count. Calculates the number of Cl instances of the selected query node.
o Distinct List. Lists the unique values of the selected attribute for all the ClI
instances of the selected query node.
¢ Max. The maximum value of the selected attribute for all the Cl instances of
the selected query node.
e Min. The minimum value of the selected attribute for all the Cl instances of
the selected query node.
e Sum. The sum of the selected attribute values for all the Cl instances of the
selected query node.
Related The child query node on which you want to perform the function.
Query Node
Title The name of the function attribute displayed in the report.

Change Query Node/Relationship Type Dialog Box

This dialog box enables you to change the ClI type of a TQL query node or relationship after you
have created a TQL query.

To access  Inthe TQL Query Editor or Pattern View Editor, right-click the required query node
and select Change Query Node Type. For relationships, right-click the required
relationship and select Change Relationship Type.

Important = You can change the Cl type of the selected query node to any other valid type
information based on the existing relationships and conditions of the selected query node.

Relevant o "Define a TQL Query" on page 22
tasks
¢ "Implement a Discovery Adapter" in the RTSM Developer Reference Guide

e "Create a Pattern View" on page 244
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

P Click Expand All to expand all the folders in the tree.
B Click Collapse All to collapse all the folders in the tree.
Tree View & Click Tree View to select the display format of the Cl type/Relationship

tree. The following options are available:
o Display label
¢ Class name

e Legacy class name

<ClI Select the required CI type or relationship.
type/Relationship
tree>
Relationship Select the direction of the relationship.
Direction , ,
Note: Only relevant for relationships.
Relationship The name of the relationship.
Name : .
Note: Only relevant for relationships.
Relationship Select an option to define how to handle relationships between identical
Restrictions query nodes or self relationships in the query results. A self relationship is a

relationship that leads from a query node to itself.
o Allow All Relationships. All relationships appear in the query results.

o Allow Self Relationships only. Only self-relationships (a relationship
that leads to itself) appear in the query results.

« Allow Non Self Relationships only. Self-relationships do not appear
in the query results.

Note: Only relevant for relationships.

Choose Operation for Selected Items Dialog Box

This dialog box enables you to create models and views from selected Cls.

To access  Inthe Modeling Studio, drag Cls from the C| Selector onto the empty canvas.
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Important | You can drag individual or multiple Cls onto the canvas. You can select ordinary
information = Cls and/or models to drag onto the canvas. Use the CTRL key while selecting Cls
to select multiple Cls.

See also "Best Practices for Modeling" on page 168

User interface elements are described below:

Ul Element
(A-Z) Description
Create a Select to build a model comprising the Cls in your selection. If the Cls you

new model | dragged onto the canvas include at least one Cl that has no valid links to any of
the model Cl types, this option is disabled.

Create a Select to build a view based on the CI collection formed by your selection.

hew view

Edit the Select to edit the selected model in the Model Editor.

model of , . . .

the selected Note: This option only appears when a single model is dragged onto the canvas.
Cl

Conditions of Related Cls Dialog Box

This dialog box enables you to define conditions for the Cl types in a reveal path.

To Click the Add Condition or Edit Condition buttons from the Conditions column of
access the Reveal Cls dialog box.

See "Best Practices for Modeling" on page 168

also

User interface elements are described below:

ul
Element
(A-2) Description

& Add the attribute condition you have defined.
% Delete an attribute condition.

1t Move a selected row up.

1L Move a selected row down.

View the condition definition.

And/Or  Click inside the And/Or field and select either And or Or to link multiple conditions.
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ul
Element
(A-Z) Description

Attribute Select an attribute from the list.
name

[ Click inside the Brackets box to display a list of brackets you can use to build more
Brackets complex, logical statements.

Criteria = Contains the attribute condition definition as defined in the Element Instances dialog
box.

Not Select NOT if you want the condition statement to do the opposite of what is defined.

Note: If you select NOT, query results do not include data from the Cl instances that
were not assigned a value. For example, your system contains three node Cls:
Node1 is assigned the value A, Node2 is assigned the value B and Node3 is not
assigned a value. You create a query to retrieve all nodes that are equal to A and
select NOT; the results of your query only include Node2 because Node3 is not
assigned a value.

Operator Select the required operator. For details, see "Attribute Operator Definitions" on page
34,

Value Enter or select the value of the attribute. The Value options vary according to the
attribute type you select.

Create/Edit/Save Reveal Path Dialog Box

This dialog box enables you to define a new reveal path or edit an existing path.

To

access To define a new reveal path, click the Reveal ““4 putton from the Model Editor, and

select Create Reveal Path.

To edit an existing reveal path, select a path from the Open Reveal Path dialog box
and click Edit.

To save areveal path, click Save Path from the Reveal Cls dialog box.

See also  "Best Practices for Modeling" on page 168
User interface elements are described below:

Ul Element
(A-Z) Description

Description Enter a description of the path.

Name Enter the name of the path.
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Ul Element
(A-Z)

Preview

Reveal
Path

Description
Opens the Reveal Cls dialog box displaying the related Cls in the path.

Note: This button does not appear in the Save Reveal Path dialog box.

Build the path by clicking the * jconto open a dialog box with a Cl type tree.
Select the Cl type for the next item in the path.

When you hold the pointer over a reveal path item, the following options are
available:

o Delete Selected Item(s). Deletes the selected item from the reveal path.

¢ Add condition. Opens the Conditions of Related Cls dialog box, which
enables you to set conditions for the reveal path item.

¢ Refine Query Node Type. Opens a Cl type tree, which enables you to
change the ClI type of the reveal path item.

Creating New View Dialog Box

This dialog box enables you to select a perspective to create a view from a model.

To access

Important
information

Relevant
tasks

See also

In the Modeling Studio, right-click a model in the Model Editor, Perspective-based
View Editor, or Cl Selector and select Generate view for selected Model or click

the Generate view for selected model icon ];;!* from the Model Editor.

You select perspectives in the left pane and move them to the right pane using the
arrow buttons.

"Build a Perspective-Based View Based on a Model " on page 251

"Best Practices for Modeling" on page 168

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description
Available Perspectives A list of the available perspectives to apply to your model.
Selected Perspectives The perspectives you selected to apply to your model.

Cycle Definition Dialog Box

This dialog box enables you to define a cyclical hierarchy in a view.
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To access | Inthe Modeling Studio, right-click a query node in the Hierarchy pane of the
Pattern View Editor and select Define Cycles.

Important | You can extend the TQL query definition of a view by defining a cycle in the view

information = hierarchy. Select a query node in the Hierarchy pane to be the source query node.
The Cycle Definition dialog box displays the valid target query nodes for that
source. The target query node in the cycle, along with its hierarchy, is treated as a
child or sibling of the source query node (depending on your folding rule selection).

See also "Best Practices for Modeling" on page 168
User interface elements are described below (unlabeled elements are shown in angle brackets):

ul

Element

(A-Z) Description

Folding Select one of the following options:
Rule

« Folded cycle under source. The target query node becomes a child of the source
query node.

« Flattened cycle under parent. The target query node becomes a sibling of the
source query node.

Target Displays the valid target query nodes for the selected source query node. A query
node is defined as a valid target query node if all of the following conditions are true:

o itis related to the source query node
o itis an ancestor of the source query node (or the source query node itself)

o itis a query based node (not a grouping node)

Hidden CIs Dialog Box

This dialog box enables you to restore hidden Cls to a view.

To From the Perspective-based View Editor, click the Show Hidden Cls icon from the
access | toolbar of the View Results pane.

See "Best Practices for Modeling" on page 168
also

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<check box> Select the check boxes for the Cls you want to restore.
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Ul Element (A-Z) Description

Cl Type The ClI type of the excluded CI.

Name The name of the excluded CI.

Restore Click Restore to include the selected Cls in the view.

Select All Click Select All to select all the Cls in the list for inclusion in the view.
Unselect All Click Unselect All to clear the check boxes of all the Cls in the list.

Hierarchy Rules Dialog Box
This dialog box enables you to set the hierarchy of a view by defining hierarchy rules.

To access From the Hierarchy pane of the Pattern View Editor, when Rule Based is

selected as the hierarchy method, click the Add Hierarchy Rule button * from
the toolbar.

Important For each hierarchy rule you define, select a source Cl type, target Cl type,
information  relationship, and direction.

See also "Best Practices for Modeling" on page 168
User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

gp Click to add a hierarchy rule.
% Click to delete the selected hierarchy rule.
Relationship Select a relationship from the drop-down list to edit the selected hierarchy
rule.
Relationship Select a direction from the drop-down list to edit the selected hierarchy rule.
Direction
Source Select a Cl type for the source Cl type from the drop-down tree to edit the

selected hierarchy rule.

Target Select a Cl type for the target Cl type from the drop-down tree to edit the
selected hierarchy rule.

Left Pane

This area enables you to browse views and TQL queries, search for Cls or models to open in the
Editor pane, and select Cl types to use in the TQL Query Editor or Pattern View Editor.
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To access Located to the left of the Editor pane in Modeling Studio.
Important The following tabs are available:
information

o CI Selector. See "Cl| Selector" on page 126.

¢ Resources. Enables you to select a model, view, or TQL query to open
in the Editor pane.

e CI Types. Enables you to select Cl types from the tree to add as a query
node to your TQL query.

See also "Best Practices for Modeling" on page 168

Resources Tab

Important = When Views or Queries is selected as the resource type, you can drag and drop
information = views, queries, or folders to move them from one folder to another.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

& Click New Folder to create a new folder in the resource tree.
Note: This button only appears when Queries or Views are selected as the
resource type.

% Click Delete to delete the selected resource from the RTSM.

|§| Click Refresh to refresh the resource tree.

P Click Expand All to expand all the folders in the resource tree.
Note: This button only appears when Queries or Views are selected as the
resource type.

B Click Collapse All to collapse all the folders in the resource tree.
Note: This button only appears when Queries or Views are selected as the
resource type.

| When Queries or Views are selected as the resource type, click Hide Empty

Folders to display only folders containing views or TQL queries.

When Models is selected as the resource type, click Show only models with
content to display only models containing Cls.
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Ul Element
(A-2) Description

r When Views is selected as the resource type, click Filter Tree to filter the
types of views and templates that appear in the tree.

When Queries is selected as the resource type, click Filter Tree to filter the
TQL queries that appear in the tree by query type.

When Models is selected as the resource type, click Filter Table to filter the
models in the table by Cl type.

M Click Open Query to open the selected TQL query in a new tab.

Note: This button only appears when Queries is selected as the resource type.
| Click Open View to open the selected view in a new tab.

Note: This button only appears when Views is selected as the resource type.
S Click CI Properties to view the properties of the selected model.

Note: This button only appears when Models is selected as the resource type.

e Click Show views containing selected Cl/model to display a list of views
including the selected Cl or model.

Note: This button only appears when Models is selected as the resource type.
B Click Open Model to open the selected model in the Model Editor.
Note: This button only appears when Models is selected as the resource type.

D Click Pattern Based Model Scheduler to modify the starting time and repeat
interval for all pattern-based models.

Note: This button only appears when Models is selected as the resource type.

Click Import From XML to import XML files that contain saved views or
queries to the Modeling Studio.

R

H

Note: This button only appears when Queries or Views are selected as the
resource type.

= Click Export To XML to export the view or query as an XML script. This option
— can be used to move a view or query from one workstation to another.

Note: This button only appears when Queries or Views are selected as the
resource type.
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Ul Element
(A-2) Description

<Resources> When Views or Queries is selected as the resource type, the available views or
TQL queries are displayed under their respective folders in tree format. When
Models is selected as the resource type, the available models are displayed in a
table.

For views, the following view types are included:
o Denotes a pattern view.

. O Denotes a template.

. L Denotes a template-based view.

o [ Denotes a perspective.

. LB Denotes a perspective-based view.

Resource Select the resource type to display in the pane. The available options are
Type Models, Views, and Queries.

Resources Tab Shortcut Menu

The Resources tab includes the following elements (listed alphabetically) available by right-clicking
a resource:

Menu Item Description

Create a new Create a new view, template, or perspective based on the
View/Template/Perspective selected view, template, or perspective.

Note: This option is only active for queries when a query of type
view, template, or perspective is selected.

Delete Delete the selected resource from the RTSM.

Export To XML Export the view or query as an XML script. This option can be
used to move a view or query from one workstation to another.

New Folder Create a new folder in the resource tree.

New Template Based View Edit the parameters of the selected template to define a new
template-based view.

Note: This option is only active when a template is selected in
the view tree.

Open Query/View/Model Open the selected view, TQL query, or model in a new tab.
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Menu Item Description

Properties Opens the Cl Properties dialog box for the selected model.
Note: This option is only relevant for models.

Refresh Refresh the resource tree.

Remove Remove the selected model.

Note: This option is only relevant for models.

Rename Folder Rename the selected folder.
Save As Save the selected TQL query with a new name.
Show containing views Opens the Views containing selected Cl dialog box for the

selected model.

Note: This option is only relevant for models.

ClTypes Tab
User interface elements are described below (unlabeled elements are shown in angle brackets):
Ul Element
(A-Z) Description
B Click Expand All to expand all the folders in the Cl Type tree.
B Click Collapse All to collapse all the folders in the Cl Type tree.
Tree View Click Tree View to select the display format of the Cl type tree. The following
= options are available:
o Display label
¢ Class name
¢ Legacy class name
> Click to add the selected Cl type to the TQL query which is open in the Editor
pane.
Note: This button is only active when a view or TQL query is open in the Editor
pane.
&3 Click Refresh to refresh the Cl Type tree.
<CI Type The available Cl types are displayed in tree format.
tree>

Cl Types Tab Shortcut Menu
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The CI Types tab includes the following elements (listed alphabetically) available by right-clicking a
Cl type:

Menu Item Description

Add Selected Select to add the selected Cl type to the TQL query open in the Editor pane.
CITs to Query

Go to Cl Type Takes you directly to the selected Cl type in CIT Manager.
Definition

Show Element Opens the Cl Instances window, which displays all instances of the selected
Instances CIT. For details, see "Element Instances Dialog Box" on page 61.

Manage CI Watchpoints Dialog Box
This dialog box enables you to add or remove watchpoints for a Cl in a model.

Toaccess £ within a model in the Model Editor, click the Watchpoint @ button and

select Manage Cl Watchpoints or right-click a Cl in the model and select
Watchpoint > Manage Cl Watchpoints.

User interface elements are described below:

Ul Element
(A-Z) Description
+ Add Click to open the New Watchpoint dialog box which enables you to add a new
watchpoint.
4 Remove Click to delete the selected watchpoint.

Automated A check mark indicates that the new Cls found by the watchpoint are to be
added to the view automatically.

Source CI Displays the CI forming the beginning of the reveal path.

Watchpoint = The name of the reveal path associated with the watchpoint.
Name

Watchpoint  Displays the reveal path for the watchpoint.
Path

Model Editor

This feature enables you to create and edit models.
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To access In the Modeling Studio, click the New button ** and select Instance Based

Model to create a new model or select Models as the Resource type and open an
existing model.

Important = The Model Editor contains the following panes:
information
o Content pane. Lists the Cls and models contained in the model.

¢ Information pane. Displays the properties, related Cls and watchpoints for
the selected CIl or model.

You can drag Cls from the Cl Selector into the Content pane of an existing model
to add them to the model. However, you cannot drag in a Cl that is already
included in the model.

You can drag Cls from the CI Selector into the Related Cls tab of the Information
pane provided that the selected source and target Cl can be related by a usage
relationship.

See also "Best Practices for Modeling" on page 168

Content Pane

User interface elements are described below:

Ul Element (A-2) Description
1% Map Select Map Mode to display the Cls as icons in a diagram.
B Text Select Text Mode to display the Cls in a list.
! Click CI Properties to open the Configuration Item Properties dialog

box for the selected CI.

B Click Show models containing selected Cl to display a list of the
models containing the selected Cl.

] Click Show views containing selected Cl/model to display a list of
the views containing the selected Cl or model.

oy Click Open selected model in a new tab to open the selected model
in a separate Model Editor tab.

Ll Click Generate view for selected model to create a view based on the
current model. The Creating New View dialog box opens, which enables
you to select a perspective to apply.

iy Click to remove a selected Cl from the model (it remains in the RTSM).
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Ul Element (A-Z) Description
=] Click Insert new model to open the New Model dialog box which
enables you to define a new model within the existing model.
P Click Expand All to expand the model hierarchy.
B Click Collapse All to collapse the model hierarchy.
Click Reveal for the following options:
el 9

o Start Revealing. Opens the Reveal Cls dialog box. For details, see
Reveal Cls dialog box.

o Create Reveal Path. Opens the Create Reveal Path dialog box. For
details, see Create Reveal Path dialog box.

e Open Reveal Path. Opens the Open Reveal Path dialog box. For
details, see Open Reveal Path dialog box.

e Click Watchpoint for the following options:

o Watchpoints Updates. Display the watchpoint results and select
Cls to add to the model. For details, see Watchpoints Updates dialog
box.

e New Watchpoint. Define a new watchpoint for the selected Cl. For
details, see New Watchpoint dialog box.

o Manage Cl Watchpoints. Add new watchpoints to the Cl or remove
existing ones. For details, see Manage Cl Watchpoints dialog box.

=) Click CI Collection to group Cls in a collection under a model. Select
one of the following options:

¢ Insert New CI Collection. Create a new empty Cl Collection. After
creating the collection, you can drag Cls into it from the Cl Selector,
the related Cls tab, or from the model itself.

e Join to Cl Collection. Select a Cl or several Cls in the model and
join them to an existing CI collection or form a new collection.

e Decompose CI Collection. Select a Cl collection and decompose
it. Its Cls remain directly under the main model.

Click Find to toggle between displaying and hiding the Find box and
arrow controls.

Note: This button only appears in Text mode.
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Ul Element (A-Z) Description

1 Click to refresh the map and optimize the map layout.

Note: This button only appears in Map mode.

Click Fit to Window to resize the map to fit the size of the pane.

Note: This button only appears in Map mode.

k Select - Select the functionality of the cursor from the Mode drop-down. The
following options are available:

e Select
e DragMap
e Zoomln

Note: This feature only appears in Map mode.

[ prirt.. Click the Print button to select Print, Print Preview or Print Setup.

ofl

Select a Cl and click Show External Relationships to display the
related Cls for that ClI.

Note: This button only appears in Map mode.

g Click Hide External Relationships to hide the related Cls.
Note: This button only appears in Map mode.
Indicates that watchpoints are defined for the current CI.
'D. Indicates that the watchpoints have detected new Cls related to the

current model. Click it to open the Watchpoints Updates dialog box.

Cl Type column Displays the type of each Cl in the model.

Find Enter a Cl name or a portion of a Cl name in the Find box to locate a Cl
in the model.

Find Next Click to go to the next occurrence of the selected search phrase in the
model.

Find Previous Click to go to the previous occurrence of the selected search phrase in
the model.

Highlight Click to highlight all occurrences of the search phrase in the model.

Name column Displays the name of each ClI in the model.
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Shortcut Menu Opftions

Menu Item

CI Collection

Fit to Window

Generate view
for selected
model

Hide External
Relationships

Insert New
Model

Open selected
model in a new
tab

Print

Properties

Refresh Layout

HP Business Service Management (9.24)

Description

Click CI Collection to group Cls in a collection under a model. Select one of
the following options:

¢ Insert New CI Collection. Create a new empty collection. After creating
the collection, you can drag Cls into it from the Cl Selector, the related
Cls tab, or from the model itself.

« Join to CI Collection. Select a Cl or several Cls in the model and join
them to an existing CI collection or form a new group.

o Decompose Cl Collection. Select a Cl collection and decompose it. Its
Cls remain directly under the main model.

Resizes the map to fit the size of the pane.
Note: This option only appears in Map mode.

Select to create a view based on the current model. The Creating New View
dialog box opens which enables you to select a perspective to apply.

Hides the related Cls from the map.

Note: This option only appears in Map mode.

Opens the New Model dialog box which enables you to create a new model
within the existing model.

Opens the selected model in a separate Model Editor tab.

Select one of the following options:
e Print
o Print Preview

e Print Setup
Opens the Configuration Item Properties dialog box for the selected Cl.

Refreshes the map and optimizes the map layout.

Note: This option only appears in Map mode.
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Menu Item

Reveal

Remove
Selected Cl(s)
from the Model

Select

Show
Containing
Models

Show
Containing
Views

Show External
Relationships

Watchpoint

Zoom
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Description

The following options are available:

« Start Revealing. Opens the Reveal Cls dialog box. For details, see
Reveal Cls dialog box.

o Open Reveal Path. Opens the Open Reveal Path dialog box. For details,
see Open Reveal Path dialog box.

Deletes the selected Cls from the model (it remains in the RTSM).

Select the functionality of the cursor. The following options are available:
o Select

e Drap Map

e ZoomlIn

Note: This option only appears in Map mode.

Click to display a list of the models containing the selected Cl.

Click to display a list of the views containing the selected Cl or model.

Displays the related Cls for the selected Cl.

Note: This option only appears in Map mode.

The following options are available:

« Watchpoints Updates. Display the watchpoint results and select Cls to
add to the model. For details, see Watchpoints Updates dialog box.

o New Watchpoint. Define a new watchpoint for the selected Cl. For
details, see New Watchpoint dialog box.

 Manage Cl Watchpoints. Add new watchpoints to the Cl or remove
existing ones. For details, see Manage Cl Watchpoints dialog box.

Select the size of the map from the list of percents.

Note: This option only appears in Map mode.
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Information Pane - Properties Tab
This area displays the properties of the selected Cl.
Important This pane is identical to the Properties tab of the Information pane in IT Universe

information = Manager. For details, see "Configuration Item Properties Dialog Box" on page
200.

Information Pane - Related Cls Tab

This area displays the Cls related to the model by one of the triplets that includes an Impacted By
(Potentially) relationship.

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul

Element

(A-2) Description

¢ Click to delete the relationship to the selected CI.

=2 Click Invert Direction to switch the direction of the relationship for the selected

Cl.

Note: This option is only active for Cls related by a usage relationship.

<Cl list> Lists the name and Cl type of the Cls related to the model by usage relationships,
as well as the direction of the relationship.

Filter by Select a field by which to filter the results and enter the value in the by box.

Information Pane - Watchpoints Tab

This area displays the watchpoints defined for the selected Cl.

User interface elements are described below:

Ul Element

(A-Z) Description

W Click to open the Manage C| Watchpoints dialog box, which enables you to
edit the watchpoint.

Automated Indicates whether the new Cls found by the watchpoint are automatically
added to the view.

Source CI Displays the Cl forming the beginning of the reveal path.

Watchpoint The name of the reveal path associated with the watchpoint.

Name

Watchpoint Displays the reveal path of the watchpoint.
Path
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Modeling Studio Page

This page enables you to create and edit models and views.

Tip: For more information about using Modeling Studio in BSM, see "Best Practices for
Modeling" on page 168.

To access | Select Admin > RTSM Administration > Modeling > Modeling Studio.

Important = The Modeling Studio page contains the following panes:
information
o Left pane. Enables you to search for Cls or select a view, model, or TQL
query to open. For details, see "Left Pane" on page 262.

o Editor pane. Displays the topology map of a selected view, model, or TQL
query.

The Editor pane is a blank canvas before any views or models are opened. When
you open a view, model, or TQL query, the relevant editor appears there. Multiple
views, models, and queries can be open at the same time in the Editor pane, each
within a separate tab.

See also "Model Editor" on page 267, "Perspective-based View Editor" on page 285,
"Pattern View Editor" on page 280, "TQL Query Editor" on page 301

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z) Description
" New Click the click the New buttonto select one of the following options:

¢ Instance Based Model. To create a new instance based model.

« Pattern Based Model. To create a new pattern based model.

o Pattern View. To create a new pattern view.

o Template Based View. To create a new template-based view.

o Perspective Based View. To create a new perspective-based view.
o Template. To create a new template.

o Perspective. To create a new perspective.

¢ Query. To create anew TQL query.
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Ul Element

(A-2) Description

= Click Save to save the changes to your view, model, or query.
For views, a dialog box opens which enables you to rename your view and save it
in the appropriate folder.

g Click Save As to save your view, model, or TQL query under a new name.
Click Undo to reverse the last change you made.

“A Click Redo to repeat the last action you took.

= Click Maximize Workspace to toggle between the regular display and a full-
screen display of the editor.

<Menu> For details, see "Main Menu" on page 154.

Models Containing Selected Cl Dialog Box

This dialog box enables you to display a list of the models containing the selected Cl.

To access Click the Show models containing selected Cl E2 button in the Model
Editor or select Show containing models from the shortcut menu.
See also "Best Practices for Modeling" on page 168

User interface elements are described below:

Ul Element

(A-Z) Description

S Click CI Properties to open the Configuration Item Properties dialog box for the
selected model.

i Click Show views containing selected Cl/model to display a list of views
containing the selected model.

3 Click Remove model to delete the selected model.

Cl Type Displays the Cl types of the models containing the selected ClI.

Find Enter a model name or a portion of a model name in the Find box to locate it in the

list.
Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find Click to go to the previous occurrence of the selected search phrase in the list.
Previous
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Ul Element
(A-2) Description
Name Displays the names of the models containing the selected Cl.
Note: The name of the current model appears in faded text.
New Model Dialog Box

This dialog box enables you to define a reusable model containing a collection of Cls.

To access Click the New = button and select Instance Based Model or drag a
CI from the tree in the Cl Selector onto the editing pane and select
Create a new model.

Relevant tasks "Build an Instance-based Model " on page 249

See also "Best Practices for Modeling" on page 168
User interface elements are described below:

Ul Element
(A-Z) Description

Define new Enter the values for the CI properties. You must enter values for required
Cl Properties  properties. The required properties are marked with an asterisk.

Select ClI Select a Cl type from the list to serve as the basis for your model.
Type

New Pattern View/Template/Perspective Dialog Box

This dialog box enables you to define a new pattern view, template, or perspective using the Pattern
View Editor.

To access In the Modeling Studio, click the New * button and select Pattern View,
Template, or Perspective from the drop-down menu.

Important After making your selection and clicking OK, you go directly to the Pattern View
information = Editor to begin building your view. For details, see "Pattern View Editor" on page

280.
Relevant "Create a Pattern View" on page 244, "Create a Template" on page 245, "Create a
tasks Perspective" on page 246
See also "Best Practices for Modeling" on page 168

User interface elements are described below (unlabeled elements are shown in angle brackets):
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ul
Element
(A-Z) Description

Click to go to the next occurrence of the selected search phrase in the list of TQL
queries.

&) Click to go to the previous occurrence of the selected search phrase in the list of TQL
queries.

=] Click to highlight all occurrences of the search phrase in the list of TQL queries.

<TQL Displays the existing TQL queries in tree format.

query
tree>

Choose | If you want to base your new view on an existing TQL query, select this option and
base select a TQL query from the tree. The Pattern View Editor opens with the selected
query TQL query on the canvas.

Create If you want to base your new view on a new TQL query, select this option. The

new Pattern View Editor opens with a blank canvas.
query
Find Enter a TQL query name or a portion of a query name in the Find box to locate a TQL

query in the list.

New Watchpoint Dialog Box

This dialog box enables you to define a watchpoint for a Cl in a model.

To access =
From within a model in the Model Editor, click the Watchpoint &4
button and select New Watchpoint or right-click a Cl in the model and
select Watchpoint > New Watchpoint.

Important If no reveal paths are found for the selected Cl, no watchpoints can be

information defined.
You cannot define watchpoints for Cls in a new model until you save the
model.

Relevant tasks "Build an Instance-based Model " on page 249

User interface elements are described below:

Ul Element (A-Z) Description

Automatically Select to automatically add all revealed Cls from the selected path to the
update model model.

HP Business Service Management (9.24) Page 277 of 416



Modeling Guide
Chapter 9: Modeling Studio

Ul Element (A-Z) Description

Control updates = Select to manually add revealed Cls from the selected path to the model.

manually

Select Select a reveal path from the drop-down list.

Watchpoint

reveal path

Show reveal Select a Cl type from the drop-down list. All reveal paths beginning with that

paths for Cl type CI type appear in the list in the lower drop-down box.

Open Reveal Path Dialog Box

This dialog box enables you to open an existing path.

To access

From within a model in the Model Editor, click the Reveal | ““* button and select

Open Reveal Path or right-click a Cl in the model and select Reveal > Open
Reveal Path.

Important  After selecting the reveal path you want to use, click Execute. If Cls are found on
information the selected path, the Reveal Cls dialog box opens for that path. If no Cls are
found, a message appears stating that no Cls were found on the path.

User interface elements are described below:

Ul Element (A-Z)
Description column

Edit

Execute

Find

Find Next

Find Previous

Highlight
Name column
Remove

Show reveal paths
for ClI type

Description
Displays the descriptions of the existing paths.

Opens the Edit Reveal Path dialog box which enables you to edit the
selected path.

Opens the Reveal Cls dialog box for the selected reveal path.

Enter a path name or a portion of a path name in the Find box to locate a
pathin the list.

Click to go to the next occurrence of the selected search phrase in the
list of paths.

Click to go to the previous occurrence of the selected search phrase in
the list of paths.

Click to highlight all occurrences of the search phrase in the list of paths.
Displays the names of the existing paths.
Deletes the selected path.

Select a Cl type from the drop-down list. All paths beginning with the
selected Cl appear in the table below.

HP Business Service Management (9.24) Page 278 of 416



Modeling Guide

Chapter 9: Modeling Studio

Pattern Based Model Wizard

This wizard enables you to build a pattern-based model.

To access

Important
information

Relevant
tasks

Wizard
map

See also

In the Modeling Studio, click the New * button and select Pattern Based
Model from the drop-down menu.

When you create a pattern-based model, the model is saved as a Cl, as with an
instance-based model. If you based your model on a new TQL query, the query is
also saved and appears in the TQL query tree.

When you build a pattern-based model over an existing instance-based model, the
model is saved with the name of the instance-based model.

If you create a new pattern-based model with the same name as a previously
deleted pattern-based model, you can select an old query on which to base the
new pattern-based model or you can create a new query.

"Build a New Pattern-based Model " on page 250

The Pattern Based Model Wizard contains:

"Select Cl Type Page" > "Query Selection Page"

"Pattern-based Models" on page 236

Select Cl Type Page

This wizard page enables you to select a Cl type for the model and define its details.

Wizard map

The Pattern Based Model Wizard contains:

"Select Cl Type Page" > "Query Selection Page"

User interface elements are described below:

Ul
Element

(A-Z) Description

Existing Select Existing Model to build a pattern-based model over an existing instance-

Model based model. Select an existing model from the tree.
New Select New Model to create a new pattern-based model (unrelated to any other
Model model). In the Select Cl Type section, select a Cl type from the list to serve as the

basis for your model. Then enter the values for the Cl properties in the Define New CI
Properties section.
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Query Selection Page

This wizard page enables you to select a TQL query upon which the model is based.

Wizard map The Pattern Based Model Wizard contains:

"Select Cl Type Page" > "Query Selection Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Element
(A-Z)

=

<TQL
Query
tree>

Choose
base

query

Create
new

query
Find

Description

Click to go to the next occurrence of the selected search phrase in the list of TQL
queries.

Click to go to the previous occurrence of the selected search phrase in the list of TQL
queries.

Click to highlight all occurrences of the search phrase in the list of TQL queries.

Displays the existing TQL queries in tree format.

If you want to base your model on an existing TQL query, select this option and select
a query from the tree. The TQL Query Editor opens with the selected query on the
canvas.

If you want to base your model on a new TQL query, select this option. The TQL
Query Editor opens with a blank canvas.

Enter a TQL query name or a portion of a query name in the Find box to locate a query
in the list.

Pattern View Editor

This feature enables you to build and edit pattern views, templates, and perspectives.

To access

To open a new view in the Pattern View Editor, go to the Modeling Studio, click
the New *° button and select the required type of view.

To open an existing view in the Pattern View Editor, go to the Resources tab of
the left pane in the Modeling Studio and select Views as the Resource type. Right
click a view in the tree and select Open View or double click a view or drag a view
onto the Editor pane. The topology map of the view opens in the Editor pane.
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Important | You can access the Editor in View mode or in Report mode.

information
¢ InView mode, the following panes are included:
= Query Definition pane. For details, see "TQL Query Editor" on page 301.
= Advanced pane. For details, see "Advanced Pane" on page 303.
= Hierarchy pane. Enables you to set the hierarchy of the view. (Located in
the right portion of the Editor page.)
¢ InReport mode, the following panes are included:
= Hierarchy pane. Enables you to set the hierarchy of the view. (Located in
the left portion of the Editor page.)
= Query Node Definition. Enables you to select the attributes to be included
in the report and to set their order.
Note: To save your view, template, or perspective, use the Save button in the
Modeling Studio main toolbar.
Relevant "Create a Pattern View" on page 244, "Create a Template" on page 245, "Create a
tasks Perspective" on page 246
See also "Best Practices for Modeling" on page 168

Hierarchy Pane

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Element
(A-2) Description
=] Click Add Group By to create a subgroup in the hierarchy. The following options
are available:
o Add Group By Attribute. Opens the Query Node Grouping dialog box, which
enables you to select an attribute for a subgroup in the hierarchy.
o Add Group By CI Type. Create a subgroup in the hierarchy for the Cl type of
the selected query node.
o Add Group by Query Node. Create a subgroup in the hierarchy for the
selected query node only.
OF Click Edit Group By Attribute to open the Query Node Grouping dialog box,

which enables you to edit the attribute for a subgroup in the hierarchy.
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ul

Element

(A-2) Description

Click Rename to rename the selected query node.

3 Click Delete Query Node to delete the selected query node from the hierarchy
tree.

'S Click Move Query Node Layer Up to place the selected query node one layer
higher in the hierarchy.

> Click Move Query Node Layer Down to place the selected query node under the
query node above it in the hierarchy.
Note: If the selected query node is located at the top of the hierarchy tree, clicking
Move Query Node Layer Down places it under the query node beneath it in the
hierarchy.

1t Click Move Query Node Up to move the selected query node up in the hierarchy
tree. The query node order in the hierarchy determines the query node order in the
report generated for the view in Reports.

1 Click Move Query Node Down to move the selected query node down in the
hierarchy tree. The query node order in the hierarchy determines the query node
order in the report generated for the view in Reports.

=% Click Preview to display a preview of the topology report.

Note: This option only appears in the Hierarchy pane when Report mode is
selected.

<Hierarchy The query nodes of the TQL query are arranged in a hierarchical tree reflecting the
tree> hierarchy defined for the view.

You can click and drag query nodes to change the hierarchy. When you click a
query node and begin to drag it, the query nodes under which it is possible to place
your query node are highlighted in green.

Hierarchy  Select the method of setting the hierarchy:
Method
o Manual. Set the hierarchy manually, by dragging query nodes and using the
toolbar buttons.

+ Rule Based. Open the Hierarchy Rules dialog box which enables you to set
rules for the hierarchy.

Shortcut Menu

The Hierarchy pane includes the following elements (listed alphabetically) available by right-clicking
a query node in the hierarchy tree:
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Menu Item

Add Group
By Attribute

Add Group
By CI Type

Add Group
By Query
Node

Define
Cycles

Delete Query
Node

Move Query
Node Down

Move Query
Node Layer
Down

Move Query
Node Layer
Up

Move Query
Node Up

Rename

Subgraph
Hierarchy

Description

Select Add Group By Attribute to open the Query Node Grouping dialog box,
which enables you to select an attribute for a subgroup in the hierarchy.

Select Add Group By CI Type to create a subgroup in the hierarchy for the CI
type of the selected query node.

Select Add Group By Query Node to create a subgroup in the hierarchy for
the selected query node only.

Select Define Cycles to define a cyclical hierarchy. For details, see "Cycle
Definition Dialog Box" on page 260.

Select to delete the selected query node from the hierarchy tree.

Select to move the selected query node down in the hierarchy tree.

Select Move Query Node Layer Down to place the selected query node under
the query node above it in the hierarchy.

Note: If the selected query node is located at the top of the hierarchy tree,
selecting Move Query Node Layer Down places it under the query node
beneath it in the hierarchy

Select Move Query Node Layer Up to place the selected query node one layer
higher in the hierarchy.

Select to move the selected query node up in the hierarchy tree.

Select to rename the selected query node.

Enables you to define whether the subgraph defined for the selected query node
is displayed as flat or as folded under the query node.

Note: This option is only relevant for query nodes that have a defined subgraph.

Query Node Definition Pane

Important
information

The Query Node Definition pane is disabled for template based views. To make
changes to the report layout, edit the based template of the view. When you open
atemplate based view in the Editor and select the Report tab, a warning message
appears containing a link to the base template of the view.

User interface elements are described below:
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ul

Element
(A-2) Description

1t Click Up to move a selected attribute up in the report layout order.

i Click Down to move a selected attribute down in the report layout order.

o3 Click Edit to edit the function for the selected attribute.

Y Click Delete to delete a selected attribute from the report layout.

> Click to move the selected attributes to the Report Layout list.

Add Click Add Function to open the Add Function dialog box, which enables you to

Function  define the functions to include in the report for the selected query node. Each
function that you add is treated as an attribute and becomes a column in the report.

Note: This button is only active if there is a query node below the selected query
node in the view hierarchy.

Attributes The list of available attributes for the selected query node.

Define Click Define Chart to display the data for the current layer of the view in a graphical
Chart chart format. The Chart Properties fields are displayed.

The Define Chart option is only active for a query node or a grouping node that:
o is the top layer of the view and has a layer below it in the view hierarchy
o is the only query node on its layer of the view

o has at least one numeric attribute selected for the report layout

Report Displays the list of attributes selected to appear in the report. Use the toolbar
Layout buttons to change the order of the attributes in the report and to add functions.

Set Sort | Click to open the Set Column Sort Order dialog box which enables you to set the
Order order of the report columns.

Chart Properties

The Chart Properties portion of the pane includes the following elements (listed alphabetically):

Ul Element
(A-2) Description
¢ Click Remove Chart to remove the chart from the report. The report is generated

in table format.

HP Business Service Management (9.24) Page 284 of 416



Modeling Guide
Chapter 9: Modeling Studio

Ul Element

(A-2) Description

Breakdown The chart is broken down by the CI or grouping node display label. This is fixed
by for all reports.

Chart Type Select Pie to create a pie chart or Bar to create a bar chart.

Value Select a value from the drop-down list.

Perspective-based View Editor

This feature enables you to create and edit perspective-based views.

To access In the Modeling Studio, click the New button *“ and select Perspective Based

View to create a new view or drag Cls from the Cl Selector onto the blank canvas
and select Create a new view.

To open an existing view in the Editor, select Views as the resource type in the
Resources pane, select the required perspective-based view from the tree, and

click Open View bl or double-click the view.

Important The Perspective-based View Editor contains the following panes:

information
e Content pane. Drag Cls and/or models onto this pane to include them in your
view.
o Perspective pane. Select perspectives to apply to the content to build a view.
e View Results pane. Displays a topology map with a preview of the current
view. This pane includes most of the IT Universe Manager functionality.
Relevant e "Build a Perspective-Based View Based on a Model " on page 251
tasks
o "Build a Perspective-Based View Based on a Collection of Cls" on page 251
See also "Best Practices for Modeling" on page 168

Content Pane

User interface elements are described below:

ul

Element

(A-Z) Description

D Go directly to IT Universe Manager for the current view.
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ul

Element

(A-2) Description

g Click Properties to open the Configuration Item Properties dialog box for the
selected Cl.

=3 Click Show models containing selected Cl to display a list of the models
containing the selected Cl.

] Click Show views containing selected Cl/model to display a list of the views
containing the selected CI or model.

oy Click Open selected model in a new tab to open the selected model in a separate
Model Editor tab.

Ll Click Generate view for selected model to create a view based on the selected
model. The Creating New View dialog box opens which enables you to select a
perspective to apply.

iy Click to remove a selected CI from the view content.

e Click View Definition Properties to open the View Definition Properties dialog box
which enables you to set properties for the view.

Click Find to toggle between displaying and hiding the Find box and arrow controls.

Cl Type  Displays the type of each Cl in the view.

column

Find Enter a Cl name or a portion of a Cl name in the Find box to locate a Cl in the view

Find Click to go to the next occurrence of the selected search phrase in the view.

Next

Find Click to go to the previous occurrence of the selected search phrase in the view.

Previous

Highlight Click to highlight all occurrences of the search phrase in the view.

Name Displays the name of each Cl in the view.
column

Shortcut Menu Options

Menu Item Description

Generate view Select to create a view based on the selected model. The Creating New
for selected View dialog box opens which enables you to select a perspective to apply.
model
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Menu Item Description

Open selected Opens the selected model in a separate Model Editor tab.

model in a new

tab

Properties Opens the Configuration Item Properties dialog box for the selected Cl.
Remove Base Deletes the selected Cl or model from the view content.

Cls

Show Click to display a list of the models containing the selected ClI.
Containing

Models

Show Click to display a list of the views containing the selected Cl or model.
Containing

Views

Perspective Pane

User interface elements are described below:

Ul Element
(A-Z) Description
% Delete the selected level of the perspective selection.
1t Shift the perspective selection from the current level to the previous one.
N Shift the perspective selection from the current level to the following one.
= Add a new level to the perspective selection. The results of the previous

perspective level serve as the input content for the new level.

Open a dialog box with the available perspectives. Move the required
perspectives from the available column to the selected column using the arrow
buttons.

To view a perspective definition, select a perspective in either column and click
the Open Definition link. The perspective definition opens in a separate tab.

Apply Over  Forviews based on models, select the Apply Over Model Hierarchy check

Model box to include the model hierarchy in the view and apply the perspectives to the

Hierarchy Cls included in the model as well as to the model itself. Clear the check box to
exclude the model hierarchy from the view and apply the perspectives to the
model itself only. In this case, the model is treated as an ordinary CI.

Note: This option is disabled for a view based on a collection of Cls oron a
model and a collection of Cls.
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Ul Element
(A-Z)

Perspectives

Description

Lists the selected perspectives.

A default perspective appears in the window before any selection is made. You
can set the value of the default perspective using the Selected perspectives for
new perspective based views infrastructure setting.

View Results Pane

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-

Z)

Map

Text
i

(=]
)
¥
¥
B

¥

Description
Click to display the view results in Map mode.
Click to display the view results in Text mode.

Create arelationship between two Cls in the view.
Toggle between hiding and displaying the topology map legend.

Move up one level in the topology map.
Move down one level in the topology map.
Delete the selected CI from the view.

Click Show CI Properties to open the Configuration Item Properties dialog
box for the selected Cl.

Click Refresh to refresh the view results.

Click Hide CI from View to hide the selected Cl from the view. This option
is only relevant for Cls that were added to the view via the perspective. You
cannot hide Cls from the original view content from the view.

Note: Hidden Cls can be restored from the Hidden Cls dialog box.

Click Show Hidden Cls to open the Hidden Cls dialog box which enables
you to restore Cls that were hidden from the view manually.

Click Create view based on selected Cl/s to create a new view based on
the Cls selected from the View Results pane.

Click Expand preview display to display the preview in a separate pane.
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Ul Element (A-

Z)

<Breadcrumbs>

<Legend>

<Topology
Map>

<Topology Map

Sidebar>

Description

At the top of the topology map, the breadcrumbs indicate the relevant query

nodes in each layer of the view for the path to the selected layer. The first
item in the path is the Top Layer. When you select a Cl from the layer below,
the parent Cl forms the next item in the breadcrumb path. You can click on
any item in the path to display that layer in the topology map.

Indicates the icons displayed next to Cls with any of the following special
statuses:

Added. When Change Timeframe is active, indicates that the Cl was
added.

Candidate for Deletion. Indicates that the Cl is a candidate for deletion.

Changed. When Change Timeframe is active, indicates that the Cl was
changed.

External. Indicates that the Cl is a federated CI.
Impacted. When Impact Analysis is active, indicates an impacted CI.

Impacted and Trigger. When Impact Analysis is active, indicates a
trigger Cl that is impacted.

Note. Indicates that a note was added for the CI.

Trigger. When Impact Analysis is active, indicates a trigger ClI.

The topology map in the View Results pane follows the layout of the topology
map in IT Universe Manager. For details, see "Topology Map" on page 209.

For details, see "Topology Map Sidebar" on page 164.

Shortcut Menu Options

Menu
Item

<IT
Universe
Shortcut
Menu
options>

Description

The IT Universe Manager shortcut menu options are available. For details, see "IT
Universe Manager Shortcut Menu" on page 211.
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Menu

Item Description

Create Select Create view based on selected Cl/s to create a new view based on the
view Cls selected from the View Results pane.

based on

selected

Cl/s

Hide CI Click to hide the selected CI from the view. This option is only relevant for Cls that

from View were added to the view via the perspective. You cannot hide Cls from the original
view content from the view. In the case of a view based on a model, the model
cannot be hidden but its Cls can.

Show Restore hidden Cls to the view.
Hidden
Cls

Query Node Grouping Dialog Box

This dialog box enables you to define a new grouping of Cls or to edit an existing grouping.

To Click the Add Group by button = in the Hierarchy pane of the Pattern View Editor
aceess  gnd select Add Group by Attribute or right click the required query node and select
Add Group by Attribute from the shortcut menu.

User interface elements are described below:

Ul Element (A-Z) Description

Expression capture  Enter the number of the relevant portion of the regular expression. Enter
group index 0 if the entire expression is relevant.

Group by Select an attribute from the drop-down list.

Mask to group by Enter a regular expression pattern representing the structure of the

selected attribute.

For details, see "Building a Business View" on page 229.

Query/View Definition Properties Dialog Box

This dialog box enables you to configure the properties of a TQL query or view.

To access In the Modeling Studio, click the Query/View Definition Properties = button
in the TQL Query Editor or Pattern View Editor.
See also "Best Practices for Modeling" on page 168
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User interface elements are described below:

Ul Element
(A-Z)

Base Query

Bundles

Description

Inter-Layer
Links

Persistent

Priority

Scope

Type

Description

Select an existing TQL query on which to base your new query.

Note:
o This field is only relevant for TQL queries.

e This field is optional.

A method of grouping TQL queries or views by category. Select the bundles
associated with the current query or view or create a new bundle for it.

Note: This field is optional.

For more information about bundles, see "Making Views Available in BSM" on
page 231.

A description of the TQL query or view.
Set the scope of inter-layer relationships displayed in the topology results.
Note: This field is only relevant for views.

Select to define the TQL query as persistent. A persistent query remains in the
memory permanently.

Note: This field is only relevant for TQL queries.

Select a priority level for the TQL query or view from the drop-down list (Low,
Medium, High, Express, Not Active). This setting determines how often the query
should be rerun automatically by the system to include updated information from
the RTSM.

Note: When you change the priority of a view, the priority of the TQL query on
which the view is based is also changed.

Select the scope of the TQL query from the drop-down list.
Note: This field is only relevant for Integration TQL queries.

Select the type of the TQL query from the drop-down list.

Note: This field is only relevant for TQL queries.

Reveal Cls Dialog Box

This dialog box enables you to search for Cls related to the Cls in a model and add them to the

model.

HP Business Service Management (9.24) Page 291 of 416



Modeling Guide
Chapter 9: Modeling Studio

T .
©8CC8S% " In the Model Editor of the Modeling Studio, select a Cl, click the Reveal | ‘3

button, and select Start Revealing or right-click a Cl in the model and select
Reveal > Start Revealing.

Important = The upper pane displays the Cl types of the Cls related to the selected Cl. The
information lower pane displays the Cls of the type selected in the upper pane.

The first step in the reveal path is the Cl type of the Cl you began with. When you
select a Cl type from the list in the upper pane, that Cl type becomes the second
step in the path. Click Next to display the Cl types available for the next step of
the path.

The number at the top of the box in parentheses indicates the length of the
constructed path thus far.

Relevant "Build an Instance-based Model " on page 249
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

% Click to delete a selected item from the Cls basket.
™ Click to add a selected CI from the lower pane to the Cls basket.

) Click to go to the next occurrence of the selected search phrase in the list of Cls.
C Click to go to the previous occurrence of the selected search phrase in the list of

Cls.

<Lower Displays a list of related Cls of the type selected in the upper pane.

pane>

Cl count Indicates how many related Cls of each type were found.

Cls Basket Displays the related Cls you selected to include in the model.
Cl Type Displays a list of Cl types of the Cls related to the selected Cl.

Conditions A check mark indicates that conditions were defined for the selected Cl type.
Click the Conditions column for the Cl type you want to select and click the Add
Condition or Edit Condition button to open the Conditions of Related Cls dialog
box. This enables you to define and edit conditions for the ClI type.

Find Enter a Cl name or a portion of a Cl name in the Find box to locate a Cl in the list of
Cls.
Finish Click Finish when you have finished adding Cls to the Cl basket.
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Ul Element

(A-2) Description

Next Click Next to display the Cl types available for the next step of the path.
Reveal Displays the reveal path being constructed.

path

Clicking the blue arrows in the path > displays a drop-down list of the Cl types
available for the next step of the path.

Clicking the Cl types in the path displays the following options:

« Jump to page. Refreshes the table with the available ClI types for the selected
step of the path.

« Edit Condition. Opens the Conditions of Related Cls dialog box.

o Delete Selected Item(s). Deletes the selected Cl type from the reveal path
(the path ends at the previous ClI type).

Save Path = Opens the Save Reveal Path dialog box which enables you to save the path. This
option is only active when a unique reveal path has been constructed.

Save Query Dialog Box

This dialog box enables you to save a new TQL query.

To access In the Modeling Studio, click the Save |@J| button when defining a new TQL
query.
See also "Best Practices for Modeling" on page 168

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description

E?] Click New Folder to create a new folder in the resource tree.

% Click Delete to delete the selected resource from the RTSM.
|§| Click Refresh to refresh the resource tree.

P Click Expand All to expand all the folders in the resource tree.
B Click Collapse All to collapse all the folders in the resource tree.

Click to go to the next occurrence of the selected search phrase in the tree.
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Ul Element (A-
Z) Description
@ Click to go to the previous occurrence of the selected search phrase in the

tree.

=] Click to highlight all occurrences of the search phrase in the tree.

<Resource Select a folder in the tree in which to save the query.

tree>

Find Enter a folder name or a portion of a name in the Find box to locate a folder in
the list.

Query Name Enter the name of the new TQL query.

Save View/Template/Perspective Dialog Box

This dialog box enables you to save a new pattern view, template-based view, perspective-based
view, template, or perspective.

To access In the Modeling Studio, click the Save |@J| button when defining a new
pattern view, template-based view, perspective-based view, template, or
perspective.

See also "Best Practices for Modeling" on page 168

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
& Click New Folder to create a new folder in the resource tree.
% Click Delete to delete the selected resource from the RTSM.
|§| Click Refresh to refresh the resource tree.
B Click Expand All to expand all the folders in the resource tree.
B Click Collapse All to collapse all the folders in the resource tree.
=) Click to go to the next occurrence of the selected search phrase in the tree.
) Click to go to the previous occurrence of the selected search phrase in the
tree.
B Click to highlight all occurrences of the search phrase in the tree.
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Ul Element (A-

Z) Description

<Resource Select a folder in the tree in which to save the view, template, or perspective.

tree>

Find Enter a folder name or a portion of a name in the Find box to locate a folder in
the list.

New query Select New query if the view is based on a new TQL query.
Note: This field is not relevant for template-based views and perspective-
based views.

View Name Enter the name of the new view, template, or perspective.

Select Integration Points Dialog Box

This dialog box enables you to select integration points to access the required data sources for a
TQL query node.

To access | Inthe Modeling Studio, right-click a TQL query node and select Select
Integration Points.

Important | You can select the data sources from which the TQL query generates the results
information = for each query node. For details on data sources, see Integration Studio Overview
in the Data Flow Management Guide.

See also "Best Practices for Modeling" on page 168

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

<Integration A list of integration points for available data sources.

Point list>

All Enables you to include Cls from all RTSM and external data sources for the
Integration selected query node in the TQL query results.

Points

Note: Only includes integration points where the CI type of the selected query
node is marked as federated.

Local Data Enables you to include Cls from the RTSM only for the selected query node in

Source the TQL query results.

Select Enables you to select integration points to include Cls from the required data
Integration sources only for the selected query node in the TQL query results.

Points
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Sort Column Content Dialog Box

This dialog box enables you to set the order of the column content in a report.

To access | Inthe Modeling Studio, click Set Sort Order in the Query Node Definition pane of
the Pattern View Editor (in Report mode).

Important | The report is sorted by columns following the order of the attributes in the Sorted
information Columns pane. Each selected column is sorted in ascending or descending order
according to your selection.

Relevant "Define Report Settings" on page 249
tasks

See also "Best Practices for Modeling" on page 168

User interface elements are described below:

Ul Element (A-
Z) Description
> Click Move to Sorted Columns to move the selected attribute to the Sorted
Columns pane.
&+ Click Move to Available Columns to move the selected attribute to the
Available Columns pane.
= Click to move all the attributes to the Sorted Columns pane.
P Click to move all the attributes to the Available Columns pane.
N Click to move the selected attribute down in the Sorted Columns list.
1+ Click to move the selected attribute up in the Sorted Columns list.
=t Click Sort Ascending to sort the selected column in ascending order.
=l Click Sort Descending to sort the selected column in descending order.
Available The attributes selected to appear as columns in the report.
Columns
Sorted The columns selected to be sorted.
Columns

HP Business Service Management (9.24) Page 296 of 416



Modeling Guide
Chapter 9: Modeling Studio

Template-based View Wizard

This wizard enables you to define template-based views manually or by importing parameter data
from a CSV file.

To access Click the New = button and select Template Based View.

Important The wizard enables you to create multiple template-based views based on the

information same template. When creating multiple views, the wizard includes the Save
Views page as the final page. When creating a single template-based view, the
wizard finishes with the Parameters page and opens the new view in the Editor.
You can save the new view from within the Editor.

Relevant e "Create a Template Based View" on page 247

tasks
e "Create Multiple Template Based Views" on page 248

Wizard The Template-based View Wizard contains:

ma
P "Select Template Page" > "Import Parameter Values Page" > "Enter Parameters

Page" > "Select Location for Views Page" > "Summary Page" > "Save Views
Page"

See also " Creating Template Based Views" on page 235

Select Template Page
This wizard page enables you to select a template on which to base your view.

Important If you don't want to use any of the templates in the tree, you can create a new
information template first and then build a view based on it. For details on creating a template,
see "Create a Template" on page 245.

Wizard The Template-based View Wizard contains:

ma
P "Select Template Page" > "Import Parameter Values Page" > "Enter Parameters

Page" >"Select Location for Views Page" > "Summary Page" > "Save Views
Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

|%| Click Refresh to refresh the template tree.

B Click Expand All to expand all the folders in the template tree.
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Ul Element

(A-2) Description

B Click Collapse All to collapse all the folders in the template tree.
Click to go to the next occurrence of the selected search phrase in the tree.
Click to go to the previous occurrence of the selected search phrase in the tree.

= Click to highlight all occurrences of the search phrase in the tree.

<Template Displays the existing templates in tree format.

tree>

Find Enter a template name or a portion of a name in the Find box to locate a

template in the list.

Import Parameter Values Page
This wizard page enables you to import parameter values from a CSV file.

Important If you are creating a large number of views based on the same template, you can
information = save the parameter values in a CSV file and import them directly into the wizard.

Note: If the CSV file contains any non-English characters, you must use UTF-8
encoding to ensure that the characters are displayed properly.

Wizard The Template-based View Wizard contains:

ma
P "Select Template Page" > "Import Parameter Values Page" > "Enter

Parameters Page" >"Select Location for Views Page" > "Summary Page" >
"Save Views Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

Add Select this option to enter the parameter values manually, whether for a single
parameter | view or for multiple views.

values

manually

Import Select this option to import the parameter values from a CSV file. Click the ellipsis
parameter

values button %! to browse your files for the required file.

from a

CSV file
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Ul Element

(A-2) Description

Use Select the Use Advanced Naming option to automatically name the created
Advanced views based on parameter values. In the box, enter an expression containing at
Naming least one parameter name in angle brackets. The views are named based on the

values of the selected parameter.

Enter Parameters Page

This wizard page enables you to set the values of the template's parameters for each new view
created.

Important If you are creating multiple views, click Next after you set the parameter values to
information = proceed to the Save Views page. If you are creating a single view, click Finish
after you set the parameter values to open the new view in the Editor.

Wizard The Template-based View Wizard contains:

ma
P "Select Template Page" > "Import Parameter Values Page" > "Enter Parameters

Page" > "Select Location for Views Page" > "Summary Page"> "Save Views
Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

4n Click to add a new view instance.

Y Click to delete the selected view instance.

<Parameter In each parameter column, enter or select the required parameter value for each
columns>  view.

Reset Click to reset the selected parameter to its original value.

Use Select the Use Advanced Naming option to automatically name the created
Advanced | views based on parameter values. In the box, enter an expression containing at
Naming least one parameter name in angle brackets. The views are named based on the

values of the selected parameter.
Note: All view names must be unique.

View Name Enter names for each of the new views, or use the default names assigned.

Select Location for Views Page

This wizard page enables you to select the location in which to save the created views.
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Important | All created views must be saved in the same location
information

Wizard The Template-based View Wizard contains:

ma
P "Select Template Page" > "Import Parameter Values Page" > "Enter Parameters

Page" > "Select Location for Views Page" > "Summary Page"> "Save Views
Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z) Description

& Click New Folder to create a new folder in the view tree.
|ﬁ| Click Refresh to refresh the view tree.

Py Click Expand All to expand all the folders in the view tree.

B Click Collapse All to collapse all the folders in the view tree.

© Click to go to the next occurrence of the selected search phrase in the tree.

(& Click to go to the previous occurrence of the selected search phrase in the tree.
= Click to highlight all occurrences of the search phrase in the tree.

<View tree> Select a folder (or the root) from the view tree.

Find Enter a template name or a portion of a name in the Find box to locate a
template in the tree.

Summary Page
This wizard page displays the details of the created views before saving.

Wizard map The Template-based View Wizard contains:

"Select Template Page" > "Import Parameter Values Page" > "Enter
Parameters Page" > "Select Location for Views Page" > "Summary
Page" > "Save Views Page"

User interface elements are described below:

Ul Element (A-Z) Description

Save view summary A summary of the views created including the name of the base
template, the number of views created, and the location selected for
saving the views.
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Save Views Page

This wizard page enables you to save the new views you created.

Important This wizard page is only relevant when you are creating multiple
Information template-based views.
Wizard map The Template-based View Wizard contains:

"Select Template Page" > "Import Parameter Values Page" > "Enter
Parameters Page" > "Select Location for Views Page" > "Summary
Page"> "Save Views Page"

Ul Element (A-Z) Description

Save Results A table displays the names of the new views and a message indicating
whether each view was saved successfully or not.

Template Parameter Values Dialog Box

This dialog box enables you to edit the parameters of a template-based view.

To access | From within a template-based view in the Modeling Studio, right-click a query
node with parameters defined and select Show Node Parameters, or click the

Show Parameters button *F* in the toolbar.

Important When you open the dialog box from the shortcut menu by right-clicking a query

information node with parameters defined, the dialog box only displays the parameters for the
selected query node. When you open the dialog box from the toolbar, it displays all
the parameters defined for any of the query nodes in the view.

See also "Best Practices for Modeling" on page 168
User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Parameters> Edit the values of the parameters.

TQL Query Editor

This feature enables you to build and edit TQL queries.
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To access

Important
information

Relevant
tasks

See also

To open anew TQL query in the TQL Query Editor, go to the Modeling Studio,

click the New "= button and select Query.

To open an existing TQL query in the TQL Query Editor, go to the Resources tab
of the left pane in the Modeling Studio and select Queries as the Resource type.
Right click a TQL query in the tree and select Open Query or double click a TQL
query or drag a TQL query onto the empty canvas. The TQL query opens in a new
tab.

To save your TQL query, use the Save button in the Modeling Studio main toolbar.

"Define a TQL Query" on page 22

"Best Practices for Modeling" on page 168

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z)

)

@

Em

o

b 4

Description

Click Show View Results in IT Universe to go directly to the selected view in
IT Universe Manager.

Note: This button only appears for views, templates, or perspectives.

Click Create Relationship to draw a relationship from one query node to
another.

Click Hide/Show Legend to toggle between hiding and displaying the topology
map legend.

Click Calculate Query Result Count to calculate the number of instances
found for each TQL query node or relationship.

Click Preview to display a preview of the TQL query results as they would
appearin IT Universe Manager.

Click Delete to delete the selected query node or relationship from the query.
For queries, opens the Query Definition Properties dialog box which enables
you to edit the type, scope, and priority of the TQL query.

For views, opens the View Definition Properties dialog box.

Report Properties. Opens the Report Properties dialog box, which enables
you to set the title and subtitle for the view's topology report.

Note: This button only appears for views, templates, or perspectives.
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Ul Element
(A-2) Description
<Py Opens the Template Parameter Values dialog box which enables you to edit
the parameters of a query node in a template-based view.
Note: This button only appears for template-based views.
<Legend> Indicates the icons displayed next to Cls with any of the following special

designations:

o lItis defined as a contact query node in a perspective

o lItis defined as the output query node of a pattern-based model
o |t has attributes defined

o |t has selected identities defined

e Itis hiddenin the query results

¢ It has a subgraph defined

o ltis afederated Cl

<Main menu> For details, see "Main Menu" on page 154.

<Shortcut For details, see "Shortcut Menu Options" on page 30.
menu
options>

<Topology For details, see "Topology Map Sidebar" on page 164.
Map Sidebar>

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected query node and
relationship.

Important The Advanced pane appears in the lower part of the window in the following
information managers and user interfaces: Modeling Studio, Impact Analysis Manager,
Enrichment Manager, the Input Query Editor and Trigger Query Editor in DFM.

A small green indicator # appears next to the tabs that contain data.
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Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
¢ "Define an Enrichment Rule — Scenario" on page 384

o "Define a TQL Query" on page 22
o "Create a Pattern View" on page 244
e "Create a Template" on page 245

e "Create a Perspective" on page 246

User interface elements are described below:

Ul Elements (A-Z) Description

Ak If the window is not wide enough to display all the tabs, use the
left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the
current module. You can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node or
the relationship. For details, see "Attribute Tab" on page 70.

Cardinality Cardinality defines how many query nodes you expect to have
at the other end of a relationship. For example, in a relationship
between a node and an IP Address, if the cardinality is 1:3, the
TQL query retrieves only those nodes that are connected to
between one and three IP Addresses. For details, see
"Cardinality Tab" on page 72.

Data Sources Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.
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Ul Elements (A-Z)

Details

Edit

Element Layout

Element Type

Enrichment Rules

Description

Displays the following information:

o CI Type/Element Type. The CIT of the selected query
node/relationship.

« Element Name. The name of the query node or relationship.
This appears only in the Modeling Studio.

« Show in query results. A green check indicates that the
selected query node/relationship is visible in the topology
map. A red mark indicates that it is not visible. In the
Modeling Studio, this is indicated by the word Yes or No.

¢ Include subtypes. A green check indicates that both the
selected Cl and its children are displayed in the topology
map. A red mark indicates that only the selected Cl appears.
This item does not appear in the Modeling Studio.

Click Edit to open the relevant dialog box for the selected tab.

Displays the attributes selection for the selected query node or
relationship. It lists the attributes selected to be included in the
query results (when Specific Attributes is selected as the
attributes condition). It also lists the excluded attributes and any
selected qualifiers for attributes. For details, see "Element
Layout Tab" on page 77.

Note: This tab appears only in the Modeling Studio.

Displays the subtype conditions defined for the query node or
relationship. For details, see "Element Type Tab" on page 75.

Note: This tab appears only in the Modeling Studio.

Displays the Enrichment rule defined for the selected query
node or relationship. If the Enrichment rule is used to update the
attributes of a Cl, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if
required. For details, see "Query Node/Relationship Definition
Dialog Box" on page 400.

Note: This tab appears only in Enrichment Manager.
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Ul Elements (A-Z) Description

Impacted Query Nodes Indicates which query node is impacted by the changes that
occur in the selected trigger query node. If required, you can
click Edit to open and modify the Impacted Query Nodes dialog
box. For details, see "Impacted Query Nodes Dialog Box" on
page 342.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node or
the relationship. For details, see "Qualifier Tab" on page 79.

Note: This tab appears only in Enrichment Manager and Impact
Analysis Manager.

Selected Identities Displays the element instances that are used to define what
should be included in the TQL query results. For details, see
"ldentity Tab" on page 82.

Views Containing Selected Cl Dialog Box

This dialog box enables you to display a list of the views containing the selected ClI.

To access Click the Show views containing selected Cl/model L button in the
Model Editor or select Show containing views from the shortcut menu.
See also "Best Practices for Modeling" on page 168

User interface elements are described below:

Ul Description

Element

(A-Z)

[+ Click Show View Results in IT Universe to go directly to the selected view in IT

Universe Manager.

3 Click Delete Selected Item(s) to delete the selected view.

e

Click Disconnect view from perspective to disconnect the selected view from its
perspective. The view becomes a pattern view.

,

Find Enter a view name or a portion of a view name in the Find box to locate it in the list.
Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find Click to go to the previous occurrence of the selected search phrase in the list.
Previous
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ul Description
Element
(A-Z)

Highlight = Click to highlight all occurrences of the search phrase in the list.

View Displays the list of views dependent on the selected template or perspective.

Name . .
Note: The name of the current view appears in faded text.

Watchpoints Updates Dialog Box
This dialog box displays the changes found in related Cls by a watchpoint defined for a model.

To access i
From within a model in the Model Editor, click the Watchpoint & button and

select Watchpoints Updates or right-click a Cl in the model and select
Watchpoint > Watchpoints Updates.

Important | The Watchpoints Updates dialog box indicates any changes found involving the

information Cls related to the model via the associated reveal path. If a new related Cl is
found which is not included in the model, the suggested update is an added ClI. If a
Clin the model is found to no longer be related via the path, the suggested update
is aremoved ClI.

This option is only enabled when watchpoints are defined for the model and Cls
have been found.

User interface elements are described below:

Ul Element (A- Description

Z)

Accept Select the check boxes for the Cls you want to add to your model or remove
from your model.

Accept All Click Accept All to apply all the suggested changes to your model.

Cl The names of the Cls found by the watchpoint.

Cl Type The types of the Cls found by the watchpoint.

Clear All Click Clear All to clear the check boxes for all the found Cls.

Restore Select the check boxes for the Cls in the Suppressed Cls pane that you
want to consider for inclusion in your model.

Show/Hide Toggle between hiding and displaying the Suppressed Cls pane of the dialog

Suppressions box.
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Ul Element (A- Description

Z)

Suggested Indicates whether the suggested change is an added Cl or a removed ClI.

Update

Suppress Select the check boxes for the Cls you want to exclude from your model or
leave in your model.

Suppress All Click Suppress All to decline all the suggested changes to your model.

<Query/Template/Perspective Name> Dependencies
Dialog Box

This dialog box enables you to clarify the status of dependent views when saving changes to a
query, template, or perspective.

To access | Inthe Modeling Studio, make a change to a query, template, or perspective with
dependent views. When you click Save, the dialog box opens.

Important = Any change made to a resource affects the views based on that resource. Before

information = the changes are saved, you need to specify the desired result on the dependent
views. For each dependent view, select one of the available options: Delete, Re-
Apply, or Detach.

User interface elements are described below:

]| Description

Element

(A-Z)

Delete Select this option to delete the selected dependent view.

Detach Select this option to detach the selected dependent view from the template or

perspective. The view becomes a pattern view.
Note: This option is not relevant for queries.

Re-Apply @ Select this option to apply the revised query, template, or perspective to the
selected dependent view. The view type remains the same as it was previously
(pattern view, template-based view, or perspective-based view).

Resource The dependent views are displayed in a tree format.

HP Business Service Management (9.24) Page 308 of 416



Chapter 10: Reports

This chapter includes:

Topology Reports OVerview ... .. 309
ComMPare ClS oL 309
Compare SNaPShO S ... L 310
CrON EXPreSSIONS oo 311
Reports User Interface ... . 312

Topology Reports Overview

Topology reports provide a method of displaying the data from views in a report format. Every view
defined in the Modeling Studio has a corresponding topology report. The report settings are defined
in the view definition in Report mode in the Pattern View Editor. For details, see "Pattern View
Editor" on page 280.

For details on selecting the Cls to be displayed in a view, see "Working with the CI Selector" on
page 122.

Perspectives, perspective-based views and template-based views also have topology reports. The
reports settings for such views are based on the settings defined in the base template or
perspective.

Several additional reports are available in IT Universe Manager, including Asset Report, Compare
Cls Report, Compare Snapshots Report, and Impact Analysis Report.

Compare Cls

This task explains how to compare the hierarchies of two compound Cls, view a Cl's configuration
document, and show the difference between two configuration documents.

This task includes the following steps:

1. Select the Required Cls

In IT Universe Manager, select the two Cls you want to compare. The hierarchies of the two
compound Cls are compared in the Compare Cls report (for details, see "Compare Cls Report"
on page 314). You can choose to compare two Cls that appear in a selected view, or in the
RTSM. For details, see "Cl Selector" on page 126.

Example of Nonmatching Cls:

In this example, the No Matching Cl icon is displayed next to the Cl
LABM3QCRNDDBO03 because it has no corresponding Cl on the other side.
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The Show Different Attribute Values icon is displayed next to the MemorySize
properties for the Cls LABM3QCRNDDB02 and LABM3ASTDBO01 since they have
different MemorySize values.

® (& 10.00.0 =@ [&E] 192 168.226.0
i p&ddress Ip&ddress
=& 8] Windows 4 Zj—@ 192.168.226 1
«+ [EZ] LABM3QCRNDDBOZ | ¥ Windows
= [E] | ABM3QCRNDDBO3 L [E] LABM3ASTDBO1
4 I} 3
Eind: | |@ @ | | Eind:] |2 B
P
Mame | Value Name | Value
Dizcoveradien... Dizcoveredien...
DizcoveredDzN...  Windows 2003 DizcoveredDs...  Windows 2003
DiscoveredOsV... | Microsoft DizcoveredOs... | Microsoft
Host Operating ... 3780 Host Operating ... 3790
! MemorySize 2,045 fi ! Memaory Size |4,093

2. View a ClI's Configuration Document

Select a Cl of the CIT Configuration Document and view the configuration document. For
details, see "Compare Cls Report" on page 314.

3. Show the Difference Between Two Configuration Documents

Select two Cls of the CIT Configuration Document and view the difference between the two
configuration documents. For details, see "Compare Cls Report" on page 314.

Compare Snapshots

This task describes how to take a snapshot of a view, and to compare two snapshots of a specific
view taken at different times.

This task includes the following steps:

1. Take a Snapshot of a View

a. Selectaview inIT Universe Manager.

b. Click the Snapshot I button and select Save Snapshot to take a snapshot of the view
and save it. For details, see the "Save Snapshot Dialog Box" on page 223.

2. Save Snapshots on a Periodic Basis

Optionally, you can schedule snapshots to be taken of a certain view at specific times by
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defining a task. For details, see "Schedule Snapshot Dialog Box" on page 327.

3. Compare Snapshots

Compare the snapshots of a view taken at different times. Select Modeling > Reports and
create a Compare Snapshots Report. For details, see "Compare Snapshots Report" on page
319

Example of Snapshots of a View Taken at Different Times:

In the following example, the Deleted Item icon next to the vmamqa278 Cl in the left
pane, indicates that the Cl has been deleted in the newer view.

Legend: @ Containz An Updated ttem ¥ Deleted tem - New tem < Updated tem

Current Before deleting

@ (8] 1655244 0/22 - (&) 1655 244 0/22

B jabm3amz254
B labm3am288
B labm3rdeiot
B mydymoo1
Be ymamaazea
H @ Vmamgaz 7 s
24 ymamaazza

@ vmrtsmpos02

Cron Expressions

] jabm3amz54
] labm3amzss
=] labm3rdeio
E=] mydvmoo11
g ymamaazsa
* @ vmamgaz2ya
B¢ ymamaazra

@ vmrtsmpos02

A Cron Expression is a string composed of six or seven fields separated by white space. Six of the
fields are mandatory, and one is optional.

The following table contains the fields used in a Cron Expression.

Field Name Allowed Values Allowed Special Characters
Seconds 0-59 ,=x
Minutes 0-59 =
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Field Name Allowed Values
Hours 0-23

Day of month 1-31

Month 1-12 or JAN-DEC
Day of week 1-7 or SUN-SAT
Year (optional) empty, 1970-2099

The following table contains examples of how to use Cron expressions.

Cron

Expression Meaning

0012**? The task runs every day at 12:00 PM.

01510 ? ** The task runs at 10:15 AM every day.

01510**? The task runs at 10:15 AM every day during the year 2011.
2011

Allowed Special Characters

=*
,-*?2/LWC
,=*
,-*?/LC#
=r

00/514**7? The task runs every 5 minutes starting at 2 PM and ending at 2:55 PM, every

day.

0151015*? The task runs at 10:15 AM on the 15th day of every month.
01510 ? * 6L The task runs at 10:15 AM on the last Friday of every month.

01510 ? *6#3  Thetask run at 10:15 AM on the third Friday of every month.

Reports User Interface

This section includes (in alphabetical order):

o "Asset Report" on the next page

e "Compare Cls Report" on page 314

o "Compare Snapshots Report" on page 319

o "Impact Analysis Report" on page 324

o "Job List Dialog Box" on page 325

e "Schedule Snapshot Dialog Box" on page 327

e "Toolbar Options" on page 328
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Asset Report

This report displays a list of all the Cls in a specified view, their attribute values, as well as their
child Cls in the RTSM. You use Asset reports to view and analyze the contents of the view and
focus on the data that is of interest to you. For example, an Asset report can display a list of all the
servers that are part of a specific application contained in the view.

Wiew: | SAN Topology

wss | Include information based on ® CMODE ) iew

Display Label

|||||| FrimaryDns Name |||||

= [ 000E7FFDISF LABM3MAM11 devlab.ad
L[] 16.59.56.213

To access  Select Admin > RTSM Administration > Modeling > IT Universe Manager

and click the Asset Report 2 button.

Important  The report only includes attributes that are marked with the Asset Data qualifier in
information the Attributes tab in the Cl Type Manager. For more details, see "Add/Edit
Attribute Dialog Box" on page 357.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

<Shortcut For details, see "IT Universe Manager Shortcut Menu" on page 211.

menu>

<Toolbar>  For details, see "Toolbar Options" on page 328.

Include Select one of the following:
information
based on o CMDB. Includes information from the selected view as well as information

HP Business Service Management (9.24)

about the child Cls and their attribute values in the RTSM.

In this option, the report includes Cls that are connected to the Cls in selected
view by relationships with the Container qualifier. For example, the report
includes the CPU and memory of a server that is contained in the view.

View. Includes only information about the Cls and their attributes that are
contained in the selected view.
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Ul Element
(A-2) Description
View Enables you to select a view by opening the View Selector. For details, see "Cl

Selector" on page 126.

Note: When you generate an Asset report from a specific view, the report retains
the same hierarchical structure as the relevant view in the Topology Map.

Compare Cls Report

This report enables you to compare the hierarchies of two compound Cls. A compound Cl is a Cl
that is linked to another CI by a relationship with the CONTAINER qualifier. You can display the
compared Cls and their child Cls that appear in a selected view, orin the RTSM.
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Compared Cl | 000129F42265 El
Compared C| 1859 5088 Default Domain B
Mutual View:  unix_\View_1
Compare on: i view ® cMODB
o Cenerate
Legend: @ Cortaing An Updated tem == Mo Matching C1 ¢ Updated tem
000129F42269 16.59.50.88 DefaultDomain
B @ 0001 28F42269 B @ 16.59 50.88 Defautt Domain
- Irterface IpAddress

D (@) Ipsddress L« () 1559 50 88

L () 15.44.49 38 SHMP

D[] SHMP L ) SNMP 16.59.50.88 Default

- {:} SHNMP {0001 29F42269)

1
f
BN I | k|
Find: L& 8 Find: L& 8
Pt
MHame | Value MHame | Value

DizcoveredPradu... | snmp = DizcoveredProdu... | snmp =
Application Categ... Application Categ...
Application Versio... 3 g Application Versio... A
Product Mame T Product Mame 1
! Candidate For ... | Sat May 1 20100, ! Candidate For ... Sun May 220100,

To access

Select Admin > RTSM Administration > Modeling > IT Universe Manager.

Right-click a Cl in the Topology Map and select Compare Cls Report.
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Important e The Compare Cls page is divided into two panes. Each side displays a

information hierarchical tree structure of the Cls you selected. When you select a Cl on
one side, the corresponding Cl on the other side is automatically selected,
provided Synchronize Selection is pressed.

e You can compare only two Cls of the same CI type or one of the Cl type's
children in the hierarchy.

e The only format available for previewing and exporting the Compare Cls report
is the Excel format.

Relevant
tasks

"Compare Cls" on page 309

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z) Description

A Finds the previous occurrence of an item marked as changed.

A Finds the next occurrence of an item marked as changed.

) Show Configuration Files Differences. Shows the difference between the
content of the two configuration files. Configuration files use the .xml, .txt or .ini
extensions.

Select a Cl of the CIT Configuration File in both panes and click the Show
Differences button. A window opens displaying the differences (marked in blue) in
the configuration files.

&y Show Only Different Cls in Tree. In the <Properties panes>, displays only the
part of the tree structure containing Cls that do not match.

=l Show Only Different Attribute Values. In the <Properties panes>, toggles

between displaying all the comparable attribute values of the selected ClI or only
the attribute values that are different.

Enables you to select a Cl on one side and have its corresponding Cl
automatically selected on the other side.

aa”

Inn"

The default state for the Synchronize Selection button is selected. Deselecting
this button allows you to select different Cls from each of the two trees. This
enables you to compare two different Cls and see their different properties.
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Ul Element
(A-Z)

)

Description

Contains An Updated Item. Indicates that a Cl's attribute value has changed.
For example, a Contains an Updated Item icon is displayed next to the
IpAddress Cl in the figure below since the attribute of its child Cl 10.168.100.2

icon has changed.

e [E 10000

—Hel@| lpsddress
10002
10.168.100.2
<[] 10188100 3

+ @] Net Device

= Mew MNode

LE 10000
= Windows

No Matching CI. Indicates that a Cl in one pane does not match any

corresponding Cl in the other pane.

The following example displays the No Matching Cl icon next to the Windows
icon because it does not have a corresponding Cl in the other pane.

= (& 10000
= Ipaddress
10002
10.168.100.2
<[] 10.168.100.3
EH—' Met Device

EI— Mew Mode
[+—== @ | Windows

irnl
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.Y

E-2 [E] 16.59.124.0

Ipiddress
16591241
16581242

Mew Mode
L El1g59124.0

= (@] switch
I::(E m3-cnb-01
< [22] m3-cnb-02
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Ul Element
(A-2) Description
o Updated Item. Indicates that the attribute value of a Cl has changed.
For example, the figure below shows that the Cls 10.0.0.2 and 16.59.124.1
display the Updated Item icon because they was updated with a new IP Network
Mask value, as indicated by the Show Only Different Attribute Values El
icons (see the Name and Value columns in the bottom panes undermeath the tree
structure).
10.0.0.0 16.59.124.0
=& [@ 10000 e [@ 16591240
[l]—GJ Ipaddress Ip&ddress
10002 1659124 1
101681002 16591242
<[] 101681003 Mew MNode
G @] Net Device L-E 1559.1240
EEI— Mew Mode 4 = Switch
= [@] Windows I = [22] m3—cnb-
= m3-cnkb402
Find: | & B Find: | & B
Pt
Name | Value MName | Value
Routing Dormain Default Dormain Raouting Dormain Default Dormain
|_!| IP Metwork Mask 255255 2550 |!_|P Metwaork Mazk | 25525525210
&) () Enables you to move to the next or previous result of the search for the string

entered in the Find field.
<Toolbar>  For details, see "Toolbar Options" on page 328.

<Shortcut  Fordetails, see "IT Universe Manager Shortcut Menu" on page 211.
menu>

<Properties Displays the attributes of the selected CI.

pane> . . o
The Properties pane contains the following fields:

o Name. Displays the attribute name for the selected Cl, which was marked as
Comparable in the Cl Type Manager.

o Value. Displays the attribute value for the currently selected ClI.

<Left and Displays a tree of the compared Cls and their child Cls that appear in the selected
right view orin the RTSM, depending on whether you selected the View or the CMDB
panes> options.
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Ul Element
(A-2) Description

Compare Select one of the following:

in
e CMDB. Includes the selected Cls and their child Cls that appear in the entire

RTSM.

e View. Includes the selected Cls and their child Cls that appear only ina
specific view.

Compared  Epaples you to select the two Cls you want to compare. Click =to open the Cls

Cl Selector dialog box. For details, see "Cl Selector" on page 126. The Cl you select
in the top box is displayed in the left pane and the Cl you select in the bottom box
is displayed in the right pane.

Find Find. Enter a search name or a portion of a search name in the Find field to locate
it in the list.

Mutual If both of the Cls you are comparing exist within the same view, the name of the

View view is displayed in this field. Otherwise, the field displays the words No mutual
view.

Compare Snapshots Report

This report enables you to compare two snapshots of a specific view taken at different times. It
enables you to visualize the differences between the views by comparing the statuses of the view
at the times the snapshots were taken.
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Compare Snapshots Report1* =|
- =j = ﬁ"a':u":u";:fh-ﬁ th}}

\iew with snapshots | Metwaork Topology |'|
Auailable Snapshots | Time | Descrip... | Owner | Size | Mote |
Current current 3,861
Mon Apr... | snapshot2 3,861
[ | Mon Apr... | snapshaot! 3,861

Legend: @ Cortainzs An Updated tem # Deleted tem = Mew tem o Updsted tem

NetworkT opology Mon Apr 12 14:34:56 IDT ...

10000
101010
101681000
10.168.252 4
10.8.0192

3

| 100,00
| 101010
| 10.168.100.0
| 10,168,252 4

3

To access  Select Admin > RTSM Administration > Modeling > IT Universe Manager.

Click the Snapshot e button and select Compare snapshots

Important e You can compare a current snapshot to a previous snapshot or two snapshots
information taken in the past.

¢ You can define a schedule that takes snapshots of a specific view on a
periodic basis and saves them. For details, see "Schedule Snapshot Dialog
Box" on page 327.

¢ The only format available for previewing and exporting the Compare Snapshots
report is the Excel format.

Relevant e "Compare Snapshots" on page 310
tasks
See also e "Save Snapshot Dialog Box" on page 223

e "Schedule Snapshot Dialog Box" on page 327

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element
(A-2) Description

P Expands the entire hierarchical tree structure of the Cls you selected.
B Collapses the hierarchical tree structure of the Cls you selected.

A Finds the previous occurrence of an item marked as changed.

A Finds the next occurrence of an item marked as changed.

B Show Configuration Files Differences. Shows the difference between the
content of the two configuration files. Configuration files use the .xml, .txt or .ini
extensions.

Select a Cl of the CIT Configuration File in both panes and click the Show
Differences button. A window opens displaying the differences (marked in blue) in
the configuration files.

Ay Show Only Different Cls in Tree. In the <Properties panes>, displays only the
part of the tree structure containing Cls that do not match.

= Show Only Different Attribute Values. In the <Properties panes>, toggles
between displaying all the attribute values of the selected ClI or only the attribute
values that have changed.

ad”

Enables you to select a Cl on one side and have its corresponding Cl
automatically selected on the other side.

Inn"

The default state for the Synchronize Selection button is selected. Deselecting
this button allows you to select different Cls from each of the two trees. This
enables you to compare two different Cls and see their different properties.
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Ul Element
(A-Z)

)

Description

Contains An Updated Item. Indicates that a Cl's attribute value has changed.
For example, a Contains an Updated Item icon is displayed next to the 10.0.0.0
Cl in the figure below since the attribute of its child C1 10.168.100.3 icon has

changed.

10.0.0.0

= 10.0.0.0

S Ipfddress
10.168.100.2
10.168.100.3
Windows

oy

,—
kel
3

|

y
A

Find:|

Mame | Value
Routing Domain DefaultDom...
2 )P Network Mask  255.0.0.0

Deleted Item. Indicates that a Cl has been deleted from the view.

New Item. Indicates that a new Cl has been added to the view.

B4 (8] 10000
E-4 IpAddress
10.168.100.2
[ 10.188.100.3
iJ, Windows
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Ul Element
(A-2) Description
© Updated Item. Indicates that the attribute value of a Cl has changed.

For example, the figure below shows that the Cls LABM3MAM16 displays the
Updated Item icon because it was updated with a new Version value, as

indicated by the Show Only Different Attribute Values El icons (seethe
Name and Value columns in the bottom panes undermeath the tree structure).

sanity rep Sun Apr 11 10:55:08 IDT...
4 LALIvRAL 1D H LTLITIS L T LTS L T
0 L AEM3LTDEOT — 0 LABM3LTDEO (LABM3LTDBEO)
4 LAEM3LTDEDZ = Y LABM3LTDBOZ (LABM3LTDEOZY | =
p Y LABM3ILTDDE g @ 4 | ABM3LTDDEO (LABM3LTDDEO
0 | ABM3LTDDEDZ @ 4 LABM3LTDDEOZ (LABM3LTDDED
4 LABM3MAM1E - o 4 LABM3MAMIG (LABM3MANIG) -
4 I} 4 4 1} 4
Find: | | & & Find: | | & &
Pt
Mame | Value Mame | Value
DiscoveredProduc... | M35QL OB DiscoveredProduc... | M35QL OB
Application Category Database Application Category Database
Application Versio... Application Versio...
Procduct Mame =ql_server_datab. .. Procduct Mame =ql_server_databa...
! ersion ! ersion 2005

<Left and Displays a hierarchical tree structure of all the Cls in the view for that snapshot
right version. The left side always represents the older of the two versions.
panes>

<Properties Displays the attributes of the selected CI.

pane> . . .
The Properties pane contains the following fields:

o Name. Displays the name of the selected Cl as defined in the Cl's label.

o Value. Displays the attribute value for the currently selected ClI.
<Toolbar>  For details, see "Toolbar Options" on page 328.

Available Displays the current status and previously saved snapshots of the view selected
Snapshots | inthe View with Snapshots field. Select the two snapshots you want to
compare.

Note: Visible when the Show Report Parameters button is pressed.

View with Displays the name of the view whose snapshots you want to compare. Only
shapshots  views for which snapshots have been taken are displayed.

Note: Visible when the Show Report Parameters button is pressed.
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Impact Analysis Report

This report displays a list of Cls that are impacted in the system as a result of simulated changes.
For details, see "Run Impact Analysis Dialog Box" on page 221.

‘_F;;‘F,"Flepurt Parameters | B E= - ‘F_EI L

Sever'rty: Fule Bundle: u

S

Triggered Clz: CZ2

b'—il erate |

Trggered CI5| Grouping by CIT [| Affected Application

Show Clinstances of: | structureElement (3) "| @ N =t Q
Display Label
=] labmzami1
{_} 1112222
=] labm2ami4
To In IT Universe Manager, click Generate Report from the Run Impact Analysis

access dialog box.

See also ¢ "Impact Analysis Manager" on page 331

e "RunImpact Analysis Dialog Box" on page 221

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description
<Toolbar> For details, see "Toolbar Options" on page 328.

Rule Bundle @ Enables you to select the rule group with which the Impact Analysis rule works.

Severity Sets the severity level that we want to simulate for the triggered Cls.
Triggered Select the Cls that represent the changes you want to make to the system.
Cls Opens the Cl Selector.

Affected Application Tab

This tab displays all the Cls that belong to a specific business application, which were affected by
the triggered Cl severity change.

User interface elements are described below:
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Ul Element (A-Z) Description
Display Label The name of the ClI or relationship as it appears in the topology map.
Trigger Severity The severity selected in the Severity box.

Grouping by CIT Tab

This tab displays all the Cls related to the triggered Cls that are impacted in the system as aresult
of the simulated changes, sorted by Cl type.

User interface elements are described below:
Ul Element (A-Z) Description
Display Label The name of the ClI or relationship as it appears in the topology map.
Trigger Severity The severity selected in the Severity box.

Triggered Cls Tab

This tab displays all the Cls that represent the changes you want to make to the system. The Cls in
this tab are the Cls selected in the Triggered Cls box.

User interface elements are described below:

Ul Element (A-Z) Description

Display Label The name of the ClI or relationship as it appears in the topology map.

Job List Dialog Box

This dialog box displays a list of the reports/snapshots that were scheduled to run in the "Schedule
Snapshot Dialog Box" on page 327.

To Select Admin > RTSM Administration > Modeling > IT Universe Manager. Click

access the Snapshots i) button, and select Show Scheduled Snapshot Jobs.

User interface elements are described below:

Ul Element

(A-Z) Description
Insert New Scheduled Report. Define a new job using the Schedule Report
dialog box.

2 Edit Job. Edit the selected job using the Schedule Report dialog box.

By Create Copy. Enables you to create a copy of the selected job. Opens a new job

in the Schedule Report dialog box that uses the details of the selected job.
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Ul Element

(A-2) Description

Y Remove Job. Deletes the selected job from the list of scheduled jobs.

=3 Run Job Immediate. Runs the selected job.

Wi Pause Job. Pauses the selected job. Enabled only if the job has a Pending
status.

L Resume Job. Resumes the selected job.
Note: The Resume button is enabled only for jobs that have a Paused status.

& Refreshes the list of scheduled jobs.

T Clears the current filter.

i Change visible columns. Enables you to select the columns to be displayed.

Current The current status of each scheduled job:

Status

Running. The job is currently executing.

Pending. The job is waiting for the scheduling requirements to be fulfilled.
o Completed. The job has finished executing.
e Paused. The job has been paused.

Note. If a job has a Completed status, and you want to resume running the job,
you can either click Run Job Immediate or change the Next Execution Time to
the current time. If you change it to a future time, the status changes to Pending.

Description A description of the scheduled job as defined in the Schedule Report dialog box.

Execution | Thejob's current execution status:

Status )
e Success. The job completed successfully (denoted by the & icon).
o Failure. The job failed to execute (denoted by the & icon).
e None. The job has not yet been executed.
Last The last time the report ran.
Execution
Time
Name The name of the scheduled job as defined in the Schedule Report dialog box.
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Ul Element

(A-2) Description

Next The next time the report is scheduled to run.
Execution

Time

Time Zone  The time zone in which the job is scheduled to run.

Schedule Snapshot Dialog Box

This dialog box enables you to define a schedule for taking snapshots of a specific view. You can
see the list of snapshots that have been scheduled to runin the "Job List Dialog Box" on page 325.

To access = Select Admin > RTSM Administration > Modeling > IT Universe Manager.

Click the Snapshots [esi button in the Cl Selector, and select Schedule
Snapshot.

Relevant e "Compare Cls" on page 309

tasks
e "Compare Snapshots" on page 310

The following elements are included:

Ul Element (A-Z) Description

Click to validate the Cron expression you entered in the Cron
Expression box.

(Appears only when you select Day of Month.) Clears the selected

i dates in the calendar.

Cron Expression Enter a Cron expression to schedule a job. For a description of the fields
used in Cron expressions and examples of how to use them, see " Cron
Expressions" on page 311.

Description A description of the scheduled job.

Ends Select one of the following options:
¢ Never. Do not specify an end date.
¢ Until. Choose the date and time by which you want the action to

stop running.

Note: This element is not relevant if you define a report to run only once.

Locale Select the language for the report.

Name The name of the scheduled job.
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Ul Element (A-2) Description

Repeat Select one of the following actions:
e Once. Activates a job only once.

¢ Interval. Runs ajob on the basis of a fixed interval. You can select
an interval of minutes, hours, days, or weeks.

o Day of Month. Runs a job every month on the selected dates.

o Weekly. Runs ajob on a weekly basis. Select the day or days on
which you want the action to run.

¢ Monthly. Runs ajob on a monthly basis. Select the month or months
in which you want the job to run.

e Yearly. Runs ajob on ayearly basis.

e Cron. Use a Cron expression to schedule a job. For a description of
the fields used in Cron expressions and examples of how to use
them, see, " Cron Expressions" on page 311.

Repeat every (Appears only when you select Interval or Yearly.) Select a value for
the interval between successive runs.

For example, if you select Yearly and then 2, the job runs every second
year.

Repeat on (Appears only when you select Day of Month, Weekly, or Monthly.)
Select the days or dates on which to run the job.

For example, if you select Monthly and then January and July, the job
runs on the specified date and time in January and July.

Server Time The exact server time according to the client's time zone.
Starts Choose the time and date when you want the job to begin running.
Time Zone Set the required time zone.
Toolbar Options
This section describes the toolbar options for reports.
Ul Element (A-
Z) Description

Displays the parameters that are defined for the report.
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Ul Element (A-
Z)

|

=)

Description

Send Mail. Opens the Send Mail dialog box. You can send an email
containing the generated report in various formats, or as a direct link. For
details on the various formats, see "Toolbar Options" on the previous page.

Select one or more of the available formats for the generated report to be sent
as attachments to an email recipient.

Note: Required fields are marked with an asterisk.

Generate Direct Link. Creates a direct link to the specific location on the
server of the selected report, or to the data that you have exported as a
specific format.

Export Report.

Enables you to select the format for previewing and exporting the report. The
available options are:

e CSV. The report data is formatted as a comma-separated values (CSV)
text file that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the comma (,)
must be defined as the list separator. In Windows, to verify or modify the
list separator value, open Regional Options from the Control Panel, and on
the Numbers tab ensure that the comma is defined as the List Separator
value. In Linux, you can specify the list separator in the application that
opens the CSV file.

o PDF. The report data is exported in PDF format.

Note: When exporting to PDF, select a reasonable number of columns to
display to ensure that the report is legible.

o XLS. The report data is formatted as an .xls (Excel) file that can be
displayed in a spreadsheet.

e XML. The report data is formatted as an XML file that can be opened in a
text or XML editor.

Tip: To extract HTML code from the report:
= Open the file in an HTML editor

= Copy the relevant table into the target file

Show Short Labels. Toggles between displaying the chart labels
minimal/maximum information.

Note: This option is available only for pie charts.
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Ul Element (A-
Z) Description
H Show Legend. Toggles between hiding and displaying the chart's legend.
Note: This option is available only for pie charts.
P Expand All. Expands the tree structure.
B Collapse All. Collapses the tree structure.
% Delete from CMDB. Deletes the selected Cl from the CMDB.
EE! Opens the Configuration Item Properties dialog box for the selected Cl.
|§| Refresh. Refreshes the report tree.
m Select Columns. Select the columns you want to display in the report. For
details, see "Select Columns Dialog Box" on page 412.
=t Sort Column Content. Enables you to set the sort order of the selected
column's content.
Q Find. Toggles between displaying and hiding the Find utility.
| Generate | Generate Report. Enables you to generate the selected report.
0 Note: This button appears disabled prior to defining the report parameters.

<breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Generated Displays the active generated report.

report>

Find Enter a search name or a portion of a search name in the Find field to locate it
in the list.

HP Business Service Management (9.24) Page 330 of 416



Chapter 11: Impact Analysis Manager

This chapter includes:

Impact Analysis Manager Overview ... 331
Define an Impact Rule —Workflow ... 331
Impact Analysis Manager User Interface ... ... 334

Impact Analysis Manager Overview

Impact Analysis Manager enables you to define the interdependencies between components in
your IT infrastructure to simulate how infrastructure changes (for example, a new software
installation or upgrade) can impact your system.

By creating Impact rules based on TQL queries, you can determine the true origin of a problem and
its business impact. Each Impact rule you define is attached to a specific Impact Analysis TQL
query. For more information about TQL queries, see "Topology Query Language" on page 15.

You define Impact rules to specify a causal relationship between two or more Impact Analysis
query nodes. Define one query node as the trigger, or the query node that represents the changes
you want to make to the system, and another query node as the one that is impacted. After the
causal relationship is established, Impact Analysis Manager enables you to determine the effect of
the changes occurring in root cause query nodes.

You then run the Impact rules in IT Universe Manager to simulate how the changes impact your
system and discover the root causes of the changes (for details, see "Run Impact Analysis Dialog
Box" on page 221). This enables you to evaluate and handle accordingly, the possible implications
of any action, update, new deployment, or a failure of the service delivery.

A simulated change in an impacted Cl can alter the Cl's map status, which is manifested through
an addition of a status icon to the Cl's symbol. The Topology Map displays the statuses of the
trigger Cls as well as all statuses of the Cls that are impacted by it. Each color represents a
different status.

For details about the status icons and the colors that represent them, see "Show Impact Pane" on
page 225.

You can then generate a report displaying the following:
o Clsinthe system that are impacted by the changes.
o Trigger Cls (the Cls that represent the changes you want to make to the system).

o Cls that belong to a specific business service.

Define an Impact Rule - Workflow

This section describes how to define an Impact rule whereby a change in CPU operation impacts
the node to which it is connected.
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This task includes the following steps:

1.

Create an Impact Analysis TQL Query

To create an Impact Analysis TQL query, you need to create an Impact Analysis TQL and then
add the TQL query nodes and relationships that define the query.

Select Admin > RTSM Administration > Modeling > Impact Analysis Manager to open
the Impact Analysis Manager. For details about how to create an Impact Analysis TQL query,
see "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard" on page 344. For
details about how to add query nodes and relationships to a query, see "Add Query Nodes and
Relationships to a TQL Query" on page 23.

Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a Composition
relationship. The TQL query results must comply with the direction of the arrows.

(

=
=
=
m

Composition

*--—-—-

Cpu

Note: An Impact Analysis TQL query is subject to certain validation restrictions. For
details, see "Troubleshooting and Limitations" on page 89.

2. Define an Impact Rule

When you define an Impact rule, you must specify the required causal relationship between the
query nodes. Define one query node as the trigger, or the query node that represents the
changes you want to make to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger query node and select Define
Impacted to open the Impacted Query Nodes dialog box. Select the query node you want the
trigger query node to impact. Then click the Add button to open the Impact Rules Definition
dialog box to set conditions for defining impacted query nodes. For details about how to define
an Impact rule, see "Impact Rules Definition Dialog Box" on page 342.

Note: The change state option in the Impact rule definition is no longer relevant for Impact
Analysis. The only supported state is operation.
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Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the conditions under
which the simulated change in the system is triggered. The Severity area defines the
severity of the impact on the impacted query node.

The Impact rule in this example states that when the CPU operation is not in the normal
state, the node is impacted. Since the severity is set to 100% of the trigger's severity, the
severity of the node is the same as the severity of the CPU, which is determined when
Impact Analysis is run.

Impact Rules Definition

Cescription: | |

[ Conditicns

State: | operation | hd |

Operator: | Mt equsal |" |

Value comparizon: | Marmal |"’ |

() Pange % = 4

() Fixed severity:

(®) Severtty relative to trigger severity (%):

In the resulting TQL query, an upward arrow appears next to the query node defined as the
trigger query node and a downward arrow appears next to the query node defined as the
impacted query node.
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— +

—

Mode

Composition

i

Cpu

+*

Note: To retrieve the Impact Analysis results, you must run the Impact rule in IT Universe
Manager. For details, see "Retrieve Impact Analysis Results — Scenario" on page 189.

Impact Analysis Manager User Interface

This section includes (in alphabetical order):

¢ "Details Dialog Box" below

o "Impact Analysis Manager Page" on the next page

o "Impacted Query Nodes Dialog Box" on page 342

o "Impact Rules Definition Dialog Box" on page 342

o "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard" on page 344
o "Impact Rule General Attributes Page" on page 345

o "Impact Rule Base Query Page" on page 345

o "Impact Rule Groups Page" on page 346

Details Dialog Box
This dialog box displays the new Impact rule you created in the Impact Rules Definition dialog box.

To access In the Impact Analysis Manager, click Next in the Impacted Query Nodes dialog
box.

Relevant "Define an Impact Rule — Workflow" on page 331
tasks

User interface elements are described below:
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Ul Element (A-

Z) Description

Description The description of the new Impact rule.

State The category you chose from the State list in the Impact Rules Definition

dialog box.

Impact Analysis Manager Page

This page enables you to define Impact rules.

To access  Select Admin > RTSM Administration > Modeling > Impact Analysis
Manager.

Important | When selecting query nodes to function as Impact Analysis triggers, they must
information comply with certain restrictions. For details, see "Troubleshooting and
Limitations" on page 89.

Relevant "Define an Impact Rule — Workflow" on page 331
tasks
See also " Impact Analysis Manager Overview" on page 331

Impact Rules Pane

This area displays a hierarchical tree structure of predefined folders and Impact rules. Each Impact
rule is associated with a TQL query.

Important You can create your own Impact rules, or work with the default rules provided with
information = your BSM installation.

The predefined folders are provided for the default Impact rules; you can modify
these folders, or add additional folders according to your organization's
requirements.

You can drag and drop Impact rules or folders to move them from one folder to
another.

User interface elements are described below:

Ul Element
(A-2) Description
F=| Create a new folder.
Creates an Impact rule. Opens the New Impact Rule Wizard.
Y Deletes the selected folder or Impact rule.
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Ul Element

(A-2) Description

3 Refreshes the data content of the hierarchical tree structure that may have been
modified by other users.

=i (Enabled only when a new Impact rule is created or when changes are made to an
existing one.) Saves the Impact rule to the RTSM.

5 Opens the Impact Rule Properties Wizard. Enables you to change the description

of the rule.

Generates a preview of the results of the selected Impact rule.

Exports an Impact rule to an XML file.

pall

ol Imports XML files that contain saved Impact rules to the Impact Analysis
Manager.

Ea Represents a folder.

(=] Represents an Impact rule.

<Impact Displays the existing Impact rules in tree format.

Rules tree>

Note: Only Impact rules appear in the tree. TQL queries of type Impact Analysis
(created in the Modeling Studio) do not appear.

The following elements are available by right-clicking a folder or Impact rule:

ul

Element

(A-2) Description

Delete Delete the selected folder or Impact rule.

Export To Displays a standard Save As dialog box, enabling you to save the Impact rule as an
XML XML script. This option can be used to move an Impact rule from one workstation to
another, provided the related TQL query is also relocated.

Import Imports XML files that contain saved Impact rules to Impact Analysis Manager.
From

XML

New Creates an Impact rule. Opens the New Impact Rule Wizard.

New Creates a new folder.

Folder

Preview Generates a preview of the results of the selected Impact rule.
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ul
Element
(A-2) Description

Properties Opens the Impact Rule Properties Wizard. Enables you to change the description
of the rule.

Rename Rename the folder.
Folder

Save (Enabled only when a new Impact rule is created or when changes are made to an
existing one.) Saves the Impact rule to the RTSM.

Save As Displays the Save As Impact Rule Wizard, enabling you to create new Impact rules
based on an existing query.

Editing Pane

This area displays the selected Impact rule, which consists of query nodes that are defined in the
TQL query and the relationships between them.

Important o When you select a folder in the Impact Rules pane, the editing pane is empty.

information
e When you select an Impact rule in the Impact Rules pane, the editing pane

displays the selected rule, which consists of TQL query nodes that are defined
in the TQL query and the relationships between them.

Relevant "Add Query Nodes and Relationships to a TQL Query" on page 23
tasks

See also When selecting query nodes to function as Impact Analysis triggers, they must
comply with certain restrictions. For details, see "Troubleshooting and
Limitations" on page 89.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-

Z) Description

Indicates a trigger query node. Located to the right of the trigger query node's
icon.

Indicates an impacted query node. Located to the right of the impacted query
node's icon.

|I| Indicates query nodes that are both impacted and trigger query nodes.

<Main Menu> For details, see "Main Menu" on page 154.

<Query Node> = A component from which TQL queries are built.
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Ul Element (A-
Z) Description

<Relationship> The entity that defines the relationship between two query nodes.

<Shortcut For details, see "Shortcut Menu Options" on page 30.

menu options>

<Toolbar> For details, see "Toolbar Options" on page 157.

<Tooltip> Hold the cursor over a query node or relationship to view its tooltip.

The tooltips contain the following information:
o Element name. The name of the query node.

e CI Type. The CIT of the query node as defined in the Cl Type Manager.
For details, see "Cl| Type Manager" on page 348.

o Definitions of the selected query nodes and relationships. The
attribute conditions, as described in "Query Node/Relationship Properties
Dialog Box" on page 68.

o Names of the trigger and the impacted query nodes. This is only
relevant if the query node over which the cursor is hovering is the trigger
query node.

Cl Type Selector

This area displays a hierarchical tree structure of the Cl Types found in the RTSM.

Important The CI Type Selector is part of Enrichment Manager, Impact Analysis Manager,
information and Trigger TQL Editor.

To create or modify a TQL query, click and drag query nodes to the Editing pane
and define the relationship between them. Your changes are saved to the RTSM.
For details, see "Add Query Nodes and Relationships to a TQL Query" on page
23.

Note: The number of instances of each CIT in the RTSM is displayed to the right
of each CIT.

Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
¢ "Define an Enrichment Rule — Scenario" on page 384
¢ "Define a TQL Query" on page 22

e "Create a Pattern View" on page 244

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Elements (A-

Z) Description
& Click Add CI Type to Map to move the selected Cl type to the Editing
pane.
|§| Click Refresh to refresh the Cl type tree.
Q Click Search to search for the CI type entered.
B Click Expand All to expand all subtrees within the Cl type tree.
B Click Collapse All to collapse the subtrees within the CI type tree.
<Search Enter the name or part of a name of a Cl type for which to search.
window>

Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically) available by right-
clickinga Cl Type:

Menu Item Description

Add CI Type Select to add the selected Cl type to the Editing pane.

to Map

Go to CI Takes you directly to the selected Cl type in CIT Manager.

Type

Definition

Show CIT Opens the CIT Instances window, which displays all instances of the selected
Instances CIT. For details, see "Element Instances Dialog Box" on page 61.

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected query node and
relationship.

Important The Advanced pane appears in the lower part of the window in the following
information managers and user interfaces: Modeling Studio, Impact Analysis Manager,
Enrichment Manager, the Input Query Editor and Trigger Query Editor in DFM.

A small green indicator #* appears next to the tabs that contain data.
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Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
¢ "Define an Enrichment Rule — Scenario" on page 384

o "Define a TQL Query" on page 22
o "Create a Pattern View" on page 244
e "Create a Template" on page 245

e "Create a Perspective" on page 246

User interface elements are described below:

Ul Elements (A-Z) Description

Ak If the window is not wide enough to display all the tabs, use the
left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the
current module. You can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node or
the relationship. For details, see "Attribute Tab" on page 70.

Cardinality Cardinality defines how many query nodes you expect to have
at the other end of a relationship. For example, in a relationship
between a node and an IP Address, if the cardinality is 1:3, the
TQL query retrieves only those nodes that are connected to
between one and three IP Addresses. For details, see
"Cardinality Tab" on page 72.

Data Sources Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.
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Ul Elements (A-Z)

Details

Edit

Element Layout

Element Type

Enrichment Rules

Description

Displays the following information:

o CI Type/Element Type. The CIT of the selected query
node/relationship.

« Element Name. The name of the query node or relationship.
This appears only in the Modeling Studio.

« Show in query results. A green check indicates that the
selected query node/relationship is visible in the topology
map. A red mark indicates that it is not visible. In the
Modeling Studio, this is indicated by the word Yes or No.

¢ Include subtypes. A green check indicates that both the
selected Cl and its children are displayed in the topology
map. A red mark indicates that only the selected Cl appears.
This item does not appear in the Modeling Studio.

Click Edit to open the relevant dialog box for the selected tab.

Displays the attributes selection for the selected query node or
relationship. It lists the attributes selected to be included in the
query results (when Specific Attributes is selected as the
attributes condition). It also lists the excluded attributes and any
selected qualifiers for attributes. For details, see "Element
Layout Tab" on page 77.

Note: This tab appears only in the Modeling Studio.

Displays the subtype conditions defined for the query node or
relationship. For details, see "Element Type Tab" on page 75.

Note: This tab appears only in the Modeling Studio.

Displays the Enrichment rule defined for the selected query
node or relationship. If the Enrichment rule is used to update the
attributes of a Cl, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if
required. For details, see "Query Node/Relationship Definition
Dialog Box" on page 400.

Note: This tab appears only in Enrichment Manager.
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Ul Elements (A-Z) Description

Impacted Query Nodes Indicates which query node is impacted by the changes that
occur in the selected trigger query node. If required, you can
click Edit to open and modify the Impacted Query Nodes dialog
box. For details, see "Impacted Query Nodes Dialog Box"
below.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node or
the relationship. For details, see "Qualifier Tab" on page 79.

Note: This tab appears only in Enrichment Manager and Impact
Analysis Manager.

Selected Identities Displays the element instances that are used to define what
should be included in the TQL query results. For details, see
"ldentity Tab" on page 82.

Impacted Query Nodes Dialog Box

This dialog box enables you to define which query node in the TQL query is the trigger Impact
Analysis query node and which query nodes are impacted by the changes that occurred in the
system.

To access  Right-click the query node or relationship that functions as a trigger and select
Define Impacted. The Impacted Query Nodes dialog box opens to display the
query nodes in the TQL query.

Important Before creating the TQL query, you must know which query node in the query is
information the trigger Impact Analysis query node and which are impacted by the changes
beforehand. The definition is performed here.

Relevant "Define an Impact Rule — Workflow" on page 331
tasks

User interface elements are described below :

Ul Element (A-
Z) Description

Impacted Query Contains a list of the Impact Analysis query nodes in the Impact rule. Select
Nodes pane the query nodes to be impacted by the trigger query node.

Impact Rules Definition Dialog Box

This dialog box enables you to set conditions for defining impacted query nodes, define the scope of
the trigger conditions, and define the severity of the impact.
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To access

Important
information

Relevant
tasks

In the Impact Analysis Manager, click Add in the Details dialog box.

¢ Inthe Conditions area, set conditions for defining impacted query nodes. When
this condition is met, the simulated change in the system is triggered.

For example, you can define an Impact Analysis condition that states that the
operational state of the query node is other than Normal. When the operational
state of the query node instance changes and is no longer Normal, the
condition is met and the simulated changes in the system are triggered.

o Inthe Scope area, define how many instances of the trigger query node should
fulfill the conditions for triggering the changes in the system.

You can apply the trigger conditions to a single instance of a trigger query
node, to a certain percentage of the trigger instances, or to all of them.

For example, you can define that impact is calculated when at least 10% of the
system’s nodes are down.

o Inthe Severity area, define the severity of the Impact Analysis impact.

"Define an Impact Rule — Workflow" on page 331.

User interface elements are described below :

Ul Element
(A-Z)

All
Any
Description

Fixed
severity

Function

Operator

Range

Description

All instances should fulfill the conditions.

One instance or more should fulfill the conditions.
A description of the Impact rule you are defining.

Define afixed severity level for every system change generated. Then, select the
required severity level from the list.

Select Function (displayed when you selected the All and Range options in the
Scope area) to define a severity level for the system changes, as a function of the
severity levels of all the trigger query node instances that are included in the
range. From the list, select either Average or Max.

For example, if you select Average, the severity level of the system changes is
the average severity of all the trigger instances.

Select the required operator. For a list of the operators you can use for defining an
attribute condition, see "Attribute Operator Definitions" on page 34

A certain percentage of all instances should fulfill the conditions. For example, if
you enter a range of 50% to 100%, the changes are triggered when 50% or more
of the instances meet the conditions.
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Ul Element
(A-Z)

Severity
relative to
trigger
severity (%)

State

Value
comparison

Description

Select Severity relative to trigger severity (%) (displayed when you selected
the Any option in the Scope area) to define a severity level for each system
change that is relative (as a percentage) to the severity of the trigger event.

Enter the percentage in the box provided.

Choose the required state. The states that appear in the list are the states that are
defined in the State Manager. For details, see "State Manager" in the RTSM
Administration Guide.

Select the required attribute.

New Impact Rule/Impact Rule Properties/Save As Impact
Rule Wizard

This wizard enables you to create or modify an Impact rule.

To access

Important
information

Relevant
tasks

Wizard
Map

e Tocreate an Impact rule, right-click anywhere in the Impact Rules pane and

click New or click the New " button.

e To modify an Impact rule, right-click an Impact rule in the Impact Rules pane
and select Properties.

e Tocreate a new Impact rule based on an existing query, right-click an Impact
rule in the Impact Rules pane and select Save As.

Any major change made to the TQL query after creating an Impact rule causes
the system to delete the rule. These changes include deleting a root cause or
impacted query node or changing the Min and Max relationship definitions. For
details, see "Cardinality Tab" on page 72.

¢ Minor changes, such as adding a query node to the TQL query, do not cause
the deletion of the rule.

o The Impact Analysis TQL query that serves as the basis of the Impact rule, is
subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 89. If the TQL query is not valid, it cannot be used for the
creation of an Impact rule.

"Define an Impact Rule — Workflow" on page 331.

The "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard"
contains:

"Impact Rule General Attributes Page" on the next page > "Impact Rule Base
Query Page" on the next page > "Impact Rule Groups Page" on page 346
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Impact Rule General Attributes Page
This wizard page enables you to enter a unique name and description for the Impact rule.

Important e The Impact Analysis TQL query that serves as the basis of the Impact rule, is

information subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 89. If the TQL query is not valid, it cannot be used for the
creation of an Impact rule.

¢ Forimportant information on the effects of making changes to the TQL query
after creating it, see "New Impact Rule/Impact Rule Properties/Save As
Impact Rule Wizard" on the previous page.

o By default, this wizard is set to display a Welcome page. You can choose not
to display the Welcome page by changing the user preferences. For details,
see "User Preferences Dialog Box" on page 88.

Wizard The "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard" on
map the previous page contains:

"Impact Rule General Attributes Page" > "Impact Rule Base Query Page"
>"Impact Rule Groups Page"

See also "IT Universe Manager" on page 176

User interface elements are described below:

Ul Element

(A-2) Description

Rule (Optional) Enter a description of the Impact rule.
Description

Rule Name @ Enter a unique name for the Impact rule.

The rule name cannot contain any of the following characters: \/: " <>|% ?. The
final character cannot be a blank space.

Note: If the Impact rule name is either empty, contains a name used by another
Impact rule, or uses invalid characters, the Next and Finish buttons are disabled.

Impact Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on which the Impact rule is
based. You can use an existing query or create a new query.
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Important
information

e The Impact Analysis TQL query that serves as the basis of the Impact rule is
subject to certain validation restrictions. For details, see "Troubleshooting and

Limitations" on page 89. If the TQL query is not valid, it cannot be used for the
creation of an Impact rule.

o Forimportant information on the effects of making changes to the TQL query
after creating it, see "New Impact Rule/Impact Rule Properties/Save As
Impact Rule Wizard" on page 344.

Wizard
map

The "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard"
contains:

"Impact Rule General Attributes Page" > "Impact Rule Base Query Page™ >
"Impact Rule Groups Page"

See also

"IT Universe Manager" on page 176

User interface elements are described below :

Ul Element (A-2)

Base the Impact rule
on a new query

Base the Impact rule
on an existing query

Base Query
Description

Base Query Name

Base Query Priority

Save a new query
based on the current
definition

Description

Select this check box if you want to base the Impact rule on a new TQL
query. The query results are based on the attributes defined for the new
TQL query.

Select this check box if you want to base the Impact rule on an existing
TQL query. Select the required Impact Analysis TQL query from the
drop-down list.

(Optional) Enter a description of the TQL query.

Enter a unique name for the Impact Analysis TQL query.

If you selected the Base the Impact rule on an existing TQL option,
select the Impact Analysis TQL query on which you want to base the
rule.

There is no need to make a selection here since all TQL queries of the
type Impact Analysis are automatically set to inactive.

Select to save a new TQL query based on your Impact rule definition.

Note: This field only appears in the Save As Impact Rule wizard.

Impact Rule Groups Page

This wizard page enables you to define where you can run Impact rules.
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Important e The Impact Analysis TQL query that serves as the basis of the Impact rule, is

information subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 89. If the TQL query is not valid, it cannot be used for the
creation of an Impact rule.

o Forimportant information on the effects of making changes to the TQL query
after creating it, see "New Impact Rule/Impact Rule Properties/Save As
Impact Rule Wizard" on page 344.

o By default, this wizard is set to display a Completion page after clicking Next
in this page. You can choose not to display the Completion page by changing
the user preferences. For details, see "User Preferences Dialog Box" on page

88.
Wizard The "Impact Rule Groups Page" contains:
map "Impact Rule General Attributes Page" > "Impact Rule Base Query Page" >
"Impact Rule Groups Page"
See also "IT Universe Manager" on page 176

User interface elements are described below :

Ul Element
(A-2) Description
UcMDB Enables you to run an Impact rule in IT Universe Manager. For details, see "IT

Universe Manager Overview" on page 176.
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Note to HP Software-as-a-Service customers: The data in Cl Type Manager can be
viewed but not edited.

Cl Types Overview

HP Business Service Management (9.24)

A configuration item (Cl) can represent hardware, software, services, business processes, or any
component of your IT infrastructure. Cls with similar properties are grouped under a Cl type (CIT).
Each CIT provides a template for creating a Cl and its associated properties.

Every Cl must belong to a Cl type. The following are the main categories of CITs:

« Business Element. CITs that correspond to the logical elements of your business, such as
processes and organizational groups.

o IT Process Record. CITs that correspond to changes that occur in your IT infrastructure.
« Monitor. CITs that handle incoming metrics collected from your business universe.

o Location. CITs that correspond to the location of devices and business organizations or people
supporting a function.

o Party. CITs that correspond to an active entity such as a person or organization.
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o CI Collection. Alogical collection of Cls.

o Infrastructure Element. CITs that correspond to the physical elements (hardware and
software) installed in your business environment.

The CITs are arranged in a tree structure under these categories in the Cl Types pane. You can
browse the Cl Type model by expanding the tree in the Cl Types pane. The CIT selected in the left
pane is displayed in the topology map along with all the potential valid relationships to other CITs.

You can also define new CITs to match your business needs. For details on defining new ClITs, see
"Create Configuration Item Type/Relationship/Calculated Relationship Wizard" on page 363.

Cl Type Attributes

Every Cl type has attributes which define it such as name, description, and default value. The CITs
grouped under other CITs in the CI Type tree inherit attributes from the higher-level CITs.

When you define a new ClI type, you first select a Base Configuration Item Type from a list of
existing CITs. Your new CIT inherits the attributes of the existing CIT. You can then set the
attributes for the new CIT. You edit the attributes of an existing CIT by selecting a CIT from the tree
in the Cl Types pane and selecting the Attributes tab of the topology map. For details on CIT
attributes, see "Attributes Page" on page 365.

This section includes the following topics:
o "CI Type ldentification Methods" below

¢ "CIl Type Naming" on the next page

Cl Type Identification Methods

Every Cl created is given an automatically generated global ID, which is used to identify different
instances of the same Cl type. You can also select additional identification methods as described
in "Details Page" on page 364.

If you select the Simple identification option, you can designate one or more of the CIT's
attributes as key attributes, which are used as identifiers of the CIT. When you define an instance
of a CIT, the CIT's key attributes are mandatory fields for Cls of that type. You can assign as many
key attributes as you want to a given CIT. If you do not assign a key attribute when defining a new
CIT or changing the identification method of an existing CIT to Simple Identification, you must
select the ABSTRACT_CLASS qualifier on the Qualifier page of the wizard.

You can change or remove the key attributes of an existing CIT if the key attribute values for all
instances of that CIT are unique. Similarly, you can change the identification method to

Simple Identification only if the key attribute values for all instances of that CIT are unique. If the
selected changes result in multiple instances of a CIT with identical key attribute values, an error
message indicates that the action is not permitted, as the CIT instances would be merged.

If you select other identification methods, you cannot define key attributes for the CIT, but it retains
the key attributes of its parent CIT. These key attributes are mandatory fields for Cls of that type
and they cannot be removed. For those identification methods, there are no restrictions on the
qualifiers selected.
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Cl Type Naming

Entity names in BSM for RTSM-based applications follow the conventions described below:
o CIT attributes values. All primitive types are supported: long, double, float, string, and so on.

o CIT attributes values-type string. All special characters are supported. The maximum length
is 4000 characters.

« CIT name. Only the following characters are permitted: a-z, A-Z, 0-9 and underscore (_). Note
also:

= The first character must not be a number.

= The name field is case sensitive, but you cannot use the same name with different cases for
different ClITs.

= The maximum length is 200 characters.

o CIT attribute name. Only the following characters are permitted: a-z, A-Z, 0-9 and underscore
(). Note also:

= The first character may be a number.
= The attribute name field is not case sensitive.
= The maximum length is 200 characters.

o CIT attribute length. The total length of all the attribute values in one CIT cannot exceed 8K
bytes due to a Microsoft SQL Server limitation.

Cl Type Relationships

The same attributes defined for CITs are also defined for relationships. You can also assign key
attributes for relationships but it is not required. For details on defining new relationship types, see
"Create Configuration Item Type/Relationship/Calculated Relationship Wizard" on page 363.

Deprecated Cl Types

CITs and relationships that are scheduled to be removed in a subsequent product version are
known as deprecated CITs. Such CITs appear in the user interface in strikethrough font. You can
hold the pointer over a deprecated CIT to display a tooltip with information about it, including which
CIT replaces it.

Note: The strikethrough font is only visible when a font size of 14 points or higher is selected
for the topology map.

Deprecated CITs appear in the CIT tree in Modeling Studio, however it is not recommended to use
them in building new TQL queries and views. In place of a deprecated CIT, use the CIT indicated in
the tooltip as its replacement. Deprecated CITs do not appear in out-of-the-box queries and views.
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CIT attributes which are scheduled to be removed are deprecated attributes. They also appear in
strikethrough font in the user interface.

The following image displays a TQL query containing a deprecated CIT:
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System Type Manager
System Type Manager enables you to create a predefined list whose values define an attribute

type. For more details on System Type Manager, see "System Type Manager Dialog Box" on page
381.

You can create the following attribute types:

o List. Enables you to create a predefined list of values, for example, Location.

« Enumeration. Enables you to create a predefined list of values, as well as assign each value a
color. Enumerations are designed to be used as severity value lists by states. For details, see

"State Manager" in the RTSM Administration Guide.

Severity lists are used for:

o Retrieving Impact Analysis results in IT Universe Manager. For details, see "IT Universe
Manager" on page 176.

o Creating an Impact rule. For details, see "Impact Analysis Manager" on page 331.
You can use both List and Enumeration values for:
o Editing the attributes of a CIT. For details, see "Create a Cl Type" below.

o Defining an attribute condition for a TQL query node or relationship. For details, see "Query
Node/Relationship Properties Dialog Box" on page 68.

Create a Cl Type

This task describes the process you follow to create a CIT using the Create Cl Type wizard.

This task includes the following steps:
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1. Prerequisites
From the CI Type Manager, select Cl Types from the list box in the Cl Types pane. Then
select New ™ to start the Create Cl Type Wizard.

2. Define the Cl Type

Enter the name, description, and base configuration item type for the new CI type and select an
identification method for it. For details, see "Details Page" on page 364.

3. Setthe Cl Type Attributes
Edit the attributes of the new CI type. For details, see "Attributes Page" on page 365.

Note: List and Enumeration definitions are created in the System Type Manager. If
required, you can create additional List and Enumeration definitions. For details, see
"Create List and Enumeration Definitions" on page 354.

4. Assign Qualifiers to the Cl Type

Assign qualifiers to the definition of the new ClI type. For details, see "Qualifiers Page" on page
368.

5. Assign an Icon to the Cl Type

Select anicon to assign to the new Cl type. For details, see "lcon Page" on page 370.

6. Customize the Cl Type Menu

Select the menu items and commands to appear in the shortcut menu for the new Cl type. For
details, see "Attached Menu Page" on page 371.

7. Define the Cl Type Default Label

Define the attributes to appear in the Cl type label. For details, see "Default Label Page" on
page 373.

8. Define the Matching Rules

If necessary, define the matching rules for the new CI type. For details, see "Matching Rules
Page" on page 375.

Note: This step is only relevant for customers running HP Universal CMDB Configuration
Manager.

Create a Relationship Type

This task describes the process you follow to create a relationship type using the Create
Relationship wizard.

This task includes the following steps:
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Prerequisites
From the CI Type Manager, select Relationships from the list box in the Cl Types pane. Then

select New " to start the Create Relationship Wizard.

Define the Relationship

Enter the name, description and base CI type for the new relationship. For details, see "Details
Page" on page 364.

Set the Relationship Attributes

Edit the attributes of the new relationship. For details, see "Attributes Page" on page 365.

Note: List and Enumeration definitions are created in the System Type Manager. If
required, you can create additional List and Enumeration definitions. For details, see
"Create List and Enumeration Definitions" on the next page.

Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see "Qualifiers Page" on
page 368.

Customize the Relationship Menu
Select the menu items and commands to appear in the shortcut menu for the new relationship.

For details, see "Attached Menu Page" on page 371.

Define the Relationship Default Label

Define the attributes to appear in the relationship label. For details, see "Default Label Page" on
page 373.

Create a Calculated Relationship Type

This task describes the process you follow to create a calculated relationship type using the Create
Calculated Relationship wizard.

This task includes the following steps:

1.

Prerequisites
From the CI Type Manager, select Calculated Relationships from the list box in the CI Types

pane. Then select New  to start the Create Calculated Relationship Wizard.

Define the Calculated Relationship

Enter the name, description and base CI type for the new calculated relationship. For details,
see "Details Page" on page 364.
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3. Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see "Qualifiers Page" on
page 368.

4. Add Required Triplets
Add the required triplets. For details, see "Triplets Page" on page 369.

Create List and Enumeration Definitions

This section describes the tasks for creating List and Enumeration definitions.

This task includes the following steps:

1. Create a List Definition

You can create a List definition of predefined values. For example, a List definition called
Location might contain:

= New York
= Boston
= Baltimore

For details, see "Create/Update List/Enumeration Definition Dialog Box" on page 376.

2. Create an Enumeration Definition

You can create an Enumeration definition, which enables you to assign a color for each value
on the list. For details, see "Create/Update List/Enumeration Definition Dialog Box" on page
376. For an example of an Enumeration definition, see "Create an Enumeration Definition —
Workflow" below.

Create an Enumeration Definition - Workflow

The following steps describe how to create an Enumeration definition.
Note: To retrieve the required results, you must follow each step in this task.

To create an Enumeration definition:
1. Select Admin > RTSM Administration > Modeling > Cl Type Manager.

2. From the Main Menu, select Cl Types > System Type Manager to open the System Type
Manager dialog box.

3. Click the Add button
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* to open the Create List Definition dialog box.

Note: Alternatively, you can select Admin > RTSM Administration > Administration
> State Manager and then click the New Enumeration button to open the Create
Enumeration Definition dialog box.

4. Select Enumeration.
5. Inthe Name box, enter the required name.
6. (Optional) Inthe Display Name box, enter the required display name.

This example describes how to create the following severity list:

Key Value Severity Represented
0 Green Normal

1 Orange Major

2 Red Critical

7. Clickthe Add ¥ button to create a new row.

8. Inthe Value box, enter Normal, in the Key box, enter @, and in the Color section, select
Green.

9. Click the Add * button to create another row.

10. Inthe Value box, enter Major, in the Key box, enter 1, and in the Color section, select
Orange.

11. Click the Add ¥ button to create another row.

12. Inthe Value box, enter Critical, in the Key box, enter 2, and in the Color section, select
Red.

The following image shows the Enumeration Definition section after the changes:
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13. Click OK to save your changes.

View Descriptions for Cl Types and Relationships

You can view a complete list of available Cl types in tree format in the left pane of Cl Type
Manager. You can search incrementally for a specific Cl type as described in "C| Type Manager" on
page 360. To see a description for a particular Cl type, select it from the tree and hold the pointer
over the icon which corresponds to it in the Topology Map. A tooltip containing a description of the
Cl type is displayed.

For relationships, select Relationships in the left pane and search incrementally by the first letter
of the relationship. Select the relationship you want and hold the pointer over its icon in the
Topology Map to display a tooltip containing a description of the relationship.

For detailed information on CI types and relationships, you can generate the UCMDB CI Types and
Relationships Information PDF. For details, see "Export Selected CITs to PDF Dialog Box" on
page 380.

Cl Type Manager User Interface

This section includes (in alphabetical order):
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o "Add/Edit Attribute Dialog Box" below

+ "Add/Remove Relationship Dialog Box" on page 360

o "CI Type Manager" on page 360

¢ "Create Configuration Item Type/Relationship/Calculated Relationship Wizard" on page 363
o "Details Page" on page 364

o "Attributes Page" on page 365

o "Qualifiers Page" on page 368

o "Triplets Page" on page 369

o "lcon Page" on page 370

o "Attached Menu Page" on page 371

o "Default Label Page" on page 373

o "Matching Rules Page" on page 375

o "Create/Update List/Enumeration Definition Dialog Box" on page 376
o "Export Selected CITs to Excel Dialog Box" on page 378

o "Export Selected CITs to PDF Dialog Box" on page 380

o "System Type Manager Dialog Box" on page 381

Add/Edit Attribute Dialog Box

This dialog box enables you to define a new attribute to add to a CIT or to edit an existing attribute of
aCIT.

To access Inthe CI Type Manager, select the Attributes tab, then click the Add

+ button, or select an attribute and click the Edit button or double-
click the attribute.

Important information  In Edit mode, fields that cannot be changed are disabled.

Details Tab

User interface elements are described below:
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Ul Element
(A-2) Description
Attribute Enter a unique name for the new attribute. Only the following characters are
Name permitted: a-z, A-Z, 0-9 and underscore (_). Note also:
e The first character may be a number.
o The attribute name field is not case sensitive.
e The maximum length is 200 characters.
Attribute Select one of the following options:
Type
¢ Primitive. Choose from one of the following field types: boolean, bytes, date
number, double number, float number, integer, list of integers, long
number, string, 1list of strings, xml.
e Enumeration/List. Contains a list of Enumerations and Lists defined in the
System Type Manager. For details, see "System Type Manager" on page 351.
This option enables you to define an attribute with a predefined value. For
example, a location attribute might be defined by a location list containing the
following values: Singapore, Paris, New York.
Default Enter or select a default value for the attribute. The options for the Default Value
Value field vary depending on the attribute type you selected.

Note: If you select the Primitive attribute types 1ist of integersorlist of
strings, you can enter multiple values.

Description Enter a description for the new attribute.

Note: This field is optional.
Display Enter a name for the new attribute to identify it in BSM.
Name e .

Note: This field is optional.

Scope Select the scope of the new attribute (the class model to which it belongs).

Value Size Enter a value for the maximum physical size of the new attribute. (Enabled for
bytes and string only).

Advanced Tab

User interface elements are described below:

Ul Element
(A-2) Description
Asset Data Select to display the attribute value in the Asset Report.
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Ul Element
(A-Z)

Change
Monitored

CMS Browser
Searchable

CMS Browser
Visible

Comparable

Discovery
Auto Trim

Editable

Enable Auto
Truncate by
DFM

Index

Lower Case

Password

Probe-side ID

Required

Static

Description

Select to define attributes whose values are being marked as Change
Monitored in Cl Type Manager. The changes in the values of such attributes are
saved in the CMDB History database.

Note:

o When this qualifier is selected for a given attribute, the attribute appears as a
visible column in the Element Instances dialog box. For details, see
"Element Instances Dialog Box" on page 61.

o Change Monitored is not relevant for attributes of the type list of integers or
list of strings.

Select to enable this attribute to be searchable in the UCMDB Browser.

Select to enable this attribute to be viewed in the UCMDB Browser.

Select to enable this attribute to be used for comparing compound Cls.

When selected, results sent from the Probe are trimmed. That is, leading and
trailing spaces and tabs are trimmed, so that there are no white spaces at the
beginning or at the end of the result.

Select to enable future editing of the attribute. Only attributes that are marked
as Editable (or ones that have values) are displayed in the Properties tab in IT
Universe Manager.

If selected, when attributes of type STRING exceed the size limit, Discovery
truncates the value. For details, see "Data Validation on the Data Flow Probe"
in the Data Flow Management Guide.

Select to accelerate the attribute retrieval performance. This option is
recommended for attributes that are used frequently in search conditions. For
example, IP address is usually an index attribute of a node.

When this option is selected, the attribute value appears in lower case.

When this option is selected, the attribute value appears as asterisks (a hidden
value).

If selected, this attribute is used by the probe to identify a Cl.

Select to define this attribute as a required one, if its value is required for the
creation of the CIT.

Select to define this attribute as static.
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Ul Element
(A-2) Description
Unique When this option is selected, different instances of this Cl type must have

unique values.
Upper Case When this option is selected, the attribute value appears in upper case.

Use Update Select this option to add the ALLOW_VOLATILITY qualifier. For details on this
Value Policy | qualifier, see " The ALLOW_VOLATILITY Qualifier" on page 22.

Visible Select to display this attribute in the Properties tab in IT Universe Manager.

Add/Remove Relationship Dialog Box

This dialog box enables you to add or remove default or new relationships between CITs, which
define their physical or logical connections.

To access  Inthe Cl Type Manager, right-click a CIT or two CITs and select Add/Remove
Relationship.

Important When adding a relationship between two CITs, select the two CITs to be linked by
information = holding down CTRL and clicking the CIT names. Then right-click one of them and
select Add/Remove Relationship.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2) Description

<query node1 to query Select the relationships to add in the direction of the first query node
node2> to the second.

<query node2 to query Select the relationships to add in the direction of the second query
node1> node to the first.

Relationship Name A list of the possible relationships.

Cl Type Manager
This page enables you to view the information in the Cl Type model, which contains the definitions
of all configuration item types (CITs) defined in the system and the relationships that define the

connections between them. Each CIT has its own attributes, as well as the attributes inherited from
its parent CIT.

To access  Select Admin > RTSM Administration > Modeling > Cl Type Manager.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-Z) Description

Click the New button to open the Create Configuration Item Type Wizard
which enables you to define a new Cl type. For details, see "Create
Configuration Item Type/Relationship/Calculated Relationship Wizard" on

page 363.
iy Click Delete to delete the selected Cl type or relationship.
|§| Click to refresh the data content of the hierarchical tree structure that may
- have been modified by other users.
= Click the Save button to save changes made to a Cl type.
Y Enables you to import CITs from an external file.
= Enables you to export a CIT as an XML file. Use this option to move CITs

from one server to another.

# Enables you to export a CIT. Choose the export format. The available
options are:

e PDF. The table data is exported in PDF format.

e XLS. The table data is formatted as an .xls (Excel) file that can be
displayed in a spreadsheet.

<ClI Select one of the following options:
Type/Relationship
Box> e CI Types. Display the Cl types in the CIT model.

¢ Relationships. Display the relationships in the CIT model.

o Calculated Relationships. Display the calculated relationships in the
CIT model.
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Ul Element (A-Z) Description

<Editing Pane> The following tabs are available:

o Dependencies. Displays the Cl Type model in a topology map,
including the CITs and the relationships between them. The name of
the selected Cl type or relationship appears in the border at the top of
the pane. When you point to a CIT, a tooltip displays the display name
of the CIT and its description.

o Details. Enables you to edit the basic information about the Cl type
selected in the left pane. For details, see "Details Page" on page 364.

o Attributes. Enables you to edit the attributes of the selected CIT. For
details, see "Attributes Page" on page 365.

¢ Qualifiers. Enables you to assign qualifiers to the selected CIT. For
details, see "Qualifiers Page" on page 368.

o Triplets. Enables you to create a calculated relationship. For details,
see "Triplets Page" on page 369. This tab appears only for calculated
relationships.

¢ lcon. Enables you to assign an icon to the selected CIT. For details,
see "lcon Page" on page 370. This tab does not appear for
relationships.

o Attached Menu. Enables you to customize the shortcut menu of a Cl
by adding menu items and commands (for example, ping, run a
program, open a URL). The customized menu is displayed when you
right-click a Cl instance in IT Universe Manager. For details, see
"Attached Menu Page" on page 371.

o Default Label. Enables you to define attributes that appearin the CIT
label. You can include more than one attribute by using the function
buttons. For details, see "Default Label Page" on page 373.

e Matching Rules. Enables you to define matching rules for use in HP
Universal CMDB Configuration Manager. For details, consult the
Configuration Manager documentation. This tab does not appear for
relationships and only appears when UCMDB is running with
Configuration Manager.

<Main Menu> For details, see "Main Menu" on page 154.

<Toolbar> For details, see "Toolbar Options" on page 157.
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Ul Element (A-Z) Description

Cl Types Pane

A hierarchical tree structure of the Cl Type model containing the
inheritance relationships among CITs, and displaying the number of
instances of each CIT in the RTSM. All CITs included in the CI Type
model are classified as either a CIT or a relationship. You can drill down
and view the relationships and neighbors of the selected CIT in the
topology map. You can search in the list of CITs or relationships using the
Incremental Search by entering the first letter of the CIT or relationship
repeatedly until you reach the required selection. You can also search for a
CIT or relationship by entering its full name.

Shortcut Menu

CIl Type Manager includes the following options available by right clicking a Cl type in the CI Types
pane or the Dependencies map:

Ul Element
(A-Z)

Add/Remove
Relationship

Delete
Selected
Item

Export To
XML

New

Show CIT
Instances

Description

Opens the Add/Remove Relationship dialog box, which enables you to add or
remove relationships from CITs. For details, see "Add/Remove Relationship
Dialog Box" on page 360.

Deletes the selected Cl type. This option is only available for Cl types that have
no children and no instances.

Enables you to export a CIT as an XML file. Use this option to move CITs from
one server to another.

Opens the Create Configuration Item Type Wizard which enables you to define a
new CI type. For details, see "Create Configuration ltem
Type/Relationship/Calculated Relationship Wizard" below.

Opens the Show All Instances dialog box, which displays all instances of the
selected CIT. For details, see "Element Instances Dialog Box" on page 61.

Create Configuration Item Type/Relationship/Calculated
Relationship Wizard

This wizard enables you to define a new configuration item type or relationship.

To Click a Cl type or relationship in the topology map or CI Types pane of the Cl Type

access

Manager and select New or click the New button = in the Cl types pane.

Wizard | The "Create Configuration Item Type/Relationship/Calculated Relationship Wizard"
map contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon Page"
> "Attached Menu Page" > "Default Label Page" > "Matching Rules Page"
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The Create Configuration Iltem Type wizard includes the following pages:
o "Details Page" below

o "Attributes Page" on the next page

o "Qualifiers Page" on page 368

o "Triplets Page" on page 369

o "lcon Page" on page 370

o "Attached Menu Page" on page 371

o "Default Label Page" on page 373

o "Matching Rules Page" on page 375

Details Page
This wizard page enables you to enter basic information about the new CI type you are defining.

Important For general information about the Create Configuration Iltem Type Wizard, see
information | "Create Configuration Item Type/Relationship/Calculated Relationship Wizard"
on the previous page.

Wizard The "Create Configuration Item Type/Relationship/Calculated Relationship
map Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "lcon
Page" > "Attached Menu Page" > "Default Label Page" > "Matching Rules Page"

User interface elements are described below:

Ul Element

(A-Z) Description

Base ClI Select a base CIT for the CIT you are creating. The new CIT inherits the base
Type CIT's attributes.

Note: This field only appears in the Create Cl Type Wizard. It is not relevant
when editing an existing CIT in the Details tab of Cl Type Manager.

Created By | The userwho created the new CIT.
Note: This field is optional.
Description = A description for the new CIT.

Note: This field is optional.
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Ul Element

(A-2) Description

Display The name of the CIT as it appears in the BSM interface.
Name

Note: This field is optional.

Identification Every new CI defined has an identification based on its CMDB ID and global_id
properties. You can set an additional identification method for instances of the
selected CIT. The following options are available:

« Simple identification. Select attributes from the Available Attributes pane
and move them to the Selected Attributes pane. These attributes are defined
as the CIT's key attributes. CIT instances with matching values for all of the
key attributes are merged into a single instance.

¢ Advanced identification. Click the Edit button to define an XML
identification rule. For an example of an XML identification rule, see "Create
an ldentification Rule Document" in the Data Flow Management Guide.

¢ Inherited from parent. The CIT uses the same identification method as its
parent CIT.

¢ No identification. No additional identification method.

Note: For relationships, only the Simple identification option is available.

Name The unique name of the new CIT. Only the following characters are permitted: a-
z, A-Z, 0-9 and underscore (_). Note also:

e The first character must not be a number.

o The name field is case sensitive, but you cannot use the same name with
different cases for different CITs.

e The maximum length is 200 characters.

Scope Select the scope of the new CIT (the class model to which it belongs).

Attributes Page
This wizard page enables you to edit the attributes of the Cl type.

Wizard | The "Create Configuration Item Type/Relationship/Calculated Relationship Wizard"
map contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page"> "Attached Menu Page" >"Default Label Page" > "Matching Rules Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element
(A-2) Description
EH Click the Add button to define a new attribute. For details, see "Add/Edit
Attribute Dialog Box" on page 357.
i Select a row and click the Edit button to open the Edit Attribute dialog box. For
details, see "Add/Edit Attribute Dialog Box" on page 357.
Note: If you modify an attribute belonging to a CIT's parent, the text turns light
blue. If you modify an attribute belonging to the CIT itself, the text remains dark
blue.
3 Click the Delete button to delete a selected attribute. This option is only active
for newly defined attributes.
|5| Click the Reset button to reset the attribute settings after editing a pre-existing
= attribute.
|@| Click Select Columns to select the columns to appear using the Select

Columns dialog box. For details, see "Select Columns Dialog Box" on page 412.

<Attributes> Displays all attributes associated with the new CIT. Attributes appearing in black
are ones that the new CIT inherits from the base CIT. Attributes appearing in dark
blue are ones that are private to this CIT and its descendants. Attributes
appearing in light blue are inherited ones that have been modified for the new CIT.

Asset Data  Indicates whether the attribute value is displayed in the Asset Report. For details
see "Asset Report" on page 313.

Note: When this qualifier is selected for a given attribute, the attribute appears as
a visible column in the Element Instances dialog box. For details, see "Element
Instances Dialog Box" on page 61.

Change Select to define attributes whose values are being marked as Change Monitored
Monitored in Cl Type Manager. The changes in the values of such attributes are saved in
the CMDB History database.

Note: When this qualifier is selected for a given attribute, the attribute appears as
avisible column in the Element Instances dialog box. For details, see "Element
Instances Dialog Box" on page 61.

CMS Indicates whether this attribute is searchable in the UCMDB Browser.
Browser
Searchable

CMS Indicates whether this attribute is visible in the UCMDB Browser.
Browser
Visible
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Ul Element
(A-2) Description

Comparable Indicates whether this attribute is to be used for comparing compound Cls. For
details, see "Compare Cls Report" on page 314. The changes in the value of
such an attribute are saved in the CMDB History database.

Note: When this qualifier is selected for a given attribute, the attribute appears as
a visible column in the Element Instances dialog box. For details, see "Element
Instances Dialog Box" on page 61.

Default The default value for the attribute. This value appears when the new CIT is
Value defined and there is no runtime value for the attribute.

Description = A description of the attribute.

Discovery Indicates whether the results sent from the Probe are trimmed.
Auto Trim

Display The attribute name that appears in the BSM interface.

Name

Editable Indicates whether the attribute can be edited.

Only attributes that are marked as Editable (or ones that have values) are
displayed in the Properties tab in IT Universe Manager.

Enable Auto Indicates whether the auto-truncate feature for attributes of type STRING is
Truncate by  enabled.

DFM

Index Indicates whether the attribute has been defined as an index attribute, which
enables you to accelerate the attribute retrieval performance.
This option is recommended for attributes that are used frequently in search
conditions. For example, IP address is usually an index attribute of a node.

Key Indicates whether the attribute is defined as a key attribute.

Note: This column is only relevant when Simple identification is selected as the
identification method.

Lower Case Indicates whether to keep the attribute value in lower case.

Name The actual name of the attribute (compare to Display Name). The name must be
in English.

Probe-side Indicates whether this attribute is used by the probe to identify a ClI.

ID

Required Indicates whether this attribute is defined as a required one, whose value is
required for the creation of the CIT.

Static Indicates whether this attribute is defined as static.
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Ul Element
(A-2) Description
Type The type of the attribute.

UDM Scope Indicates whether the attribute is included in the UDM class model.

Unique Indicates whether this attribute is defined as unique, for which different instances
of this CI type must have unique values

Upper Case Indicates whether to keep the attribute value in upper case.

Visible Indicates whether this attribute is displayed in the Properties tab in IT Universe
Manager.

Qualifiers Page

This wizard page enables you to assign qualifiers to a Cl type definition.

Important Qualifiers enable you to define added attribute definitions to the CIT. In the

information = Qualifiers list, select the required qualifiers using the Add buttons to move your
selections to the Configuration Item Type Qualifiers list. You can make
multiple selections by holding down the CTRL key.

Wizard The "Create Configuration Item Type/Relationship/Calculated Relationship
map Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "lcon
Page"> "Attached Menu Page" > "Default Label Page" > "Matching Rules Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description

Click this button to move all qualifiers to the Configuration Item Type
Qualifiers list.

1A

> Select the qualifier and click this button to add the qualifier to the
Configuration Item Type Qualifiers list. Select multiple qualifiers by
holding down the CTRL key.

'S To remove a qualifier from the CIT definition, select the qualifier from the
Configuration Item Type Qualifiers list and click this button.

Click this button to remove all qualifiers from the Configuration Item Type
Qualifiers list.

Tify

To define a new, custom qualifier, enter the qualifier name in the text box and
click Insert. The qualifier appears in the Configuration Item Type
Qualifiers list.
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Ul Element (A-

Z) Description

<Configuration ' The list of qualifiers that define attributes of the new CIT. For example, you
Item Type can use a qualifier to define a CIT as abstract, which means that you cannot
Qualifiers> create instances fromiit.

<Qualifiers> For a list of the available qualifier options, see "Qualifier Tab" on page 79.

Triplets Page

This wizard page enables you to create a calculated relationship. Each row on the Triplets page
represents one of the allowed steps in the path leading from the source Cl to the target Cl in the
topology map.

Note: This step of the wizard is only relevant for calculated relationships.

Important e This page is displayed if you select Calculated Relationships in the drop-
information down box in the CI Types pane.

o For details about calculated relationships, see "Impact Modeling" on page 94.

o Forgeneral information about the Create Configuration Item Type Wizard, see
"Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" on page 363.

Wizard The "Create Configuration Item Type/Relationship/Calculated Relationship
map Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "lcon
Page"> "Attached Menu Page" > "Default Label Page" > "Matching Rules Page"

See also "Impact Modeling" on page 94

User interface elements are described below:

Ul Element
(A-Z) Description
i Click to define the allowed steps in a path in the topology graph leading from the
source Cl to the target Cl in the calculated relationship. Opens the Add Triplet
dialog box. For details, see "Add Triplet Dialog Box" on page 58.
2 Select a row and click the Edit button to edit the triplet. Opens the Edit Triplet
dialog box. For details, see "Add Triplet Dialog Box" on page 58.
3 Click the Delete button to delete a selected triplet.

Relationship The required relationship connecting the two query nodes.
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Ul Element

(A-2) Description

Relationship The source and target of a relationship.

Direction
e = Thedirectionis from source to target.
e = Thedirectionis from target to source.

Source The required source query node.

Target The required target query node.

Icon Page

This wizard page enables you to select an icon to assign to the new CI Type.

Note: This step of the wizard is not relevant for relationships.

Important Each CIT is displayed with a default icon. However, you can attach different icons
information to the same CIT when certain conditions apply. For example, you can associate
different icons with the same CIT when one of its attribute values changes.

Wizard The "Create Configuration Item Type/Relationship/Calculated Relationship
map Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page"> "Triplets Page" > "lcon
Page" > "Attached Menu Page" > "Default Label Page" > "Matching Rules Page"

User interface elements are described below:

Ul Element (A-Z) Description
g Click to add a row.

Note: Only active if Change the Configuration Item Type icon
according to its attribute value is selected.

b 4 Click to remove a row.

Note: Only active if Change the Configuration Item Type icon
according to its attribute value is selected.

Attributes Select an attribute to determine the icon assigned to the CIT.
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Ul Element (A-2) Description
Change the Enables you to assign an icon for each attribute value. For example,
Configuration Item you could define two values for the City attribute: if City=London,

Type icon according to | oneicon s displayed. If City=Beijing, anothericon is displayed.

its attribute value . : .
Note: If you change the icon of a CIT that appears in an existing

view, the CIT's icon is not updated in the view.

Configuration Item Select the group to which the CIT belongs.
Type Main Icon

Icon Select anicon to associate with the value you entered in the Value
column.
Value Enter a value corresponding to the attribute you selected. You can

add a new line for each value you enter.

Attached Menu Page

This wizard page enables you to customize the shortcut menu of a Cl by adding menu items and
commands (for example, ping, run a program, open a URL). The customized menu is displayed
when you right-click a Cl instance in IT Universe Manager.

Important If a CIT does not have a method defined specifically for it, the CIT inherits all the
information menus from its parent CIT or the nearest ancestor that does have a method
defined for it.

If you create or modify a menu, the change occurs only in the specific CIT that is

being edited.
Wizard The "Create Configuration Item Type/Relationship/Calculated Relationship
map Wizard"contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page" > "Attached Menu Page" > "Default Label Page" > "Matching Rules
Page"

User interface elements are described below:

Ul Element
(A-Z) Description
= Select a menu item from the tree and click the button. A new entry appears under
the selected item.
Click to remove a menu item.
i+ Click to move a selected menu item up in the menu.
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Ul Element
(A-Z)

W

<Tree>

Command

Description

Existing
Method

Icon

Menu Item
Name

Method

Method
Name

New Method

Parameters

Require
user
confirmation

HP Business Service Management (9.24)

Description

Click to move a selected menu item down in the menu.

Hierarchical tree containing the default menu items.

Caution: It is not recommended to edit the definitions of the default menu items.

To connect to a specific location on the World Wide Web, select URL, and enter
the exact Internet address, for example, http://www.hp.com/go/software.
(Available only if you select the URL command type option.)

Note: If you use a variable in the Command field, use the format command

name %1 and define the CIT attributes as described in "Parameters” below. The
parameter values replace %1 according to their order in the list. For example, %1
is replaced by the first parameter in the list, %2 is replaced by the second
parameter in the list, and so on.

Enter a description for the method. (This is for internal use only and does not
appear in the menu.)

Select to choose a command from a list of defined methods inherited from the IT
Universe CIT and all its ancestors.

Select the icon to appear next to the menu option in the shortcut menu.
Note: This field is optional.

Enter a name for the new menu item as it should appear in the menu.

Enables you to add a command to the menu.

Note: To create a method and not override the existing method, it is
recommended to create a new menu item and place the new method there.

Enter a name for the command.

Select to add an action (for example, ping) to the menu item.

To add attributes to the command or URL, click the Add Parameter button and
select the attribute from the list.

To delete an existing entry, select it and click the Remove Parameter button.

Note: Parameters are not relevant when Inner Process is selected.

Select the check box for users to confirm access to a menu item before the item
is displayed.
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Ul Element
(A-2) Description
Separator To place a separator between two menu items:
Click OK to place a separator undermneath the selected menu option.
Shortcut Press any key combination to create a shortcut for the menu item, for example,

CTRL+H.

Note: This field is optional.

Sub-Menu Select to create a sub-menu under the selected menu option.

EJ I Hiskary
| Note L\\\*ﬂ ] AddMote
X Delete Subj‘menu
B, MNew RelatedCI < MenL
Actions ¥
Type Choose a command type:

e URL. Opens a web page to the specified URL. Enter the URL of a Web page
for the command to open in the URL box.

o Inner Process. Triggers an internal BSM action. Select an action from the
drop-down list of actions.

o Execute. Triggers an executable action. Enter an executable command in the
Executable box.

Note: In the Executable box, enter only the name of the executable file (for

example, notepad. exe). Do not enter a path to the executable file. A path
cannot execute a program.

Default Label Page

This wizard page enables you to define attributes that appear in the Cl type label. You can include
more than one attribute by using the function buttons. This is the final step of the Create
Configuration Item Type Wizard.
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Important
information

Wizard
map

You build a label by selecting attributes in the Cl Type Attributes pane and adding
them to the Format pane, using the operators in the Format pane to connect them.

The label appears as the title under a Cl of the new CI Type. The label definition
can be customized to include different attribute values. For example, if the
function label of the node CIT is composed of hostname and network, the
displayed label is: serverl 10.0.65.0.

Labels can also be created using regular expressions.

The "Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page" > "Attached Menu Page" > "Default Label Page" > "Matching Rules
Page" on the next page

User interface elements are described below:

Ul
Element
(A-Z)

=
QO

&

Description

Click to add the selected attribute to the Format pane.

Adds parentheses to the formatted text (use in conjunction with the other functions).

Places an AND operator between two attributes in the formatted text. For example,
network_netaddr&network_domain displays the network address and the domain
of a query node.

Places an OR operator between two attributes in the formatted text.

Adds a regular expression (using regular expression syntax) to the label definition.
The structure of the entry is (v1, v2, v3), where v1 represents the selected attribute,
v2 represents the regular expression itself (which divides the value into groups), and
v3 represents the number of the selected group.

For example, if the selected attribute is a name, consisting of a first name, a space,
and a surname, the regular expression would be (name, (\S*)(\s*)(\S*), 3),
which indicates that the surname can be used for the name attribute in the default
label.

For examples of how to use regular expression syntax, see "Regular Expression
Examples" on page 415.

Click to undo the last change in the Format pane.

Click to revert the last change in the Format pane that was made using the Undo
button.
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ul
Element
(A-Z) Description
= Click to clear the Format pane.
() Click to restore the default settings.
Cl Type Displays the available options of attributes to be included in the CIT label.
Attributes
Cl Type Displays the attributes that you select to appear in the CIT label.
Label
Definition For example, to label a node by its host name and operating system, choose the
F host_hostname and host_os attributes. The CIT label is host1l UNIX.
ormat
You can define conditions using AND and OR combinations.
Note: To delete an attribute from the Format pane, highlight it and press the DELETE
key.
Matching Rules Page

This wizard page enables you to define matching rules for comparable attributes for use in HP
Universal CMDB Configuration Manager.

Important
information

Wizard
map

This page is only relevant when Configuration Manager is installed. For details on
matching rules, refer to the Configuration Manager documentation.

Note: You can activate the Matching Rules page manually by setting the Enable
Configuration Manager Matching Rules setting to true in the Infrastructure
Settings Manager.

The "Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page" > "Attached Menu Page" > "Default Label Page" > "Matching Rules
Page"

User interface elements are described below:

Ul Element
(A-Z)

]

Description

Click to move the selected comparable attributes to the Matching Rule Priorities
pane or the Required Matching Attributes pane. Select multiple attributes by
holding down the CTRL key.
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Ul Element
(A-Z)

o

qu

it

1|+

Comparable
Attributes

Matching
Rule
Priorities

Required
Matching
Attributes

Description

Click to remove an attribute from the Matching Rule Priorities pane or the
Required Matching Attributes pane.

Click to move all attributes to the Matching Rule Priorities pane or the Required
Matching Attributes pane.

Click this button to remove all attributes from the Matching Rule Priorities pane or
the Required Matching Attributes pane.

Set the order of the matching rules using the up and down buttons.
A list of all the attributes of the selected CI type with the comparable qualifier
selected.

The attributes selected are used by Configuration Manager, according to the
priority defined, to determine if the matching rule is satisfied.

The values of the selected attributes must match to satisfy the Configuration
Manager matching rule.

Create/Update List/Enumeration Definition Dialog Box

This dialog box enables you to define a new List or Enumeration definition. The List or Enumeration
definition you have created appears in the System Type Manager dialog box, where you can edit it if
required (for details, see "System Type Manager Dialog Box" on page 381).

To access

Important
information

Relevant
tasks

Click the Add button in the System Type Manager dialog box.

You can access the Create/Update Enumeration Definition dialog box from the
State Manager as well. For details, see "State Manager" in the RTSM
Administration Guide.

"Create List and Enumeration Definitions" on page 354

User interface elements are described below:

Ul Element
(A-Z)

Display
Name

Enumeration

Description

Enter the name you want to appear in the list of System Type Definitions. If you
leave this field empty, the entry in the Name field is used.

Enables you to create a predefined list of values, as well as assign each value a
color. For details, see "Enumeration Definition Area" on the next page.
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Ul Element

(A-2) Description

List Enables you to create a predefined list of values. For details, see "List Definition
Area" below.

Name Enter a unique name for the definition.

List Definition Area

This area enables you to create a predefined list of values.

To access Select List in the Create List/Enumeration Definition dialog box.
Important For example, a Location attribute might be defined by a location list
information containing the following values:

o New York

o Boston

o Baltimore

The following elements are included (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description
EH Add a List definition. Double-click inside the row and either select a

date from the calendar that appears (if you chose the type Date) or
type the required value.

¢ Delete a List definition.
=M Sorts the list in alphabetical order.

Type Choose one of following field types:
e Date

e Double

Integer

Long

String
Enumeration Definition Area

This area enables you to create a list from a predefined list of values (similar to List), with
capabilities such as assigning a color for every value.
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To access

Important
information

See also

Select Enumeration in the Create List/Enumeration Definition dialog box.

Enumerations are designed to be used as severity value lists by states. You can
use Enumerations for lists that require key values.

"Create an Enumeration Definition — Workflow" on page 354

User interface elements are described below:

Ul Element (A-Z)

+
x

Color

Key

Value

Description

Add an Enumeration definition.

Remove an Enumeration definition.

Select a color that indicates the severity level.

Note: Gray is only enabled when you create an Enumeration of the
type Admin.

Type a number to create an enumeration that describes a severity
list for a category.

Assign key values according to the following rules:

o Thelist of key values must always begin with zero (0). (Zero
represents the Normal state.) Otherwise, it does not appear in
the State Manager (for details, see "State Manager" in the RTSM
Administration Guide).

e The list must always be numbered consecutively.

For an example of an Enumeration definition, see "Create an
Enumeration Definition — Workflow" on page 354.

Type a value, either a string or a number, for example, Red or my
value. The value appears in the tooltip for the Cl in IT Universe
Manager.

Export Selected CITs to Excel Dialog Box

This dialog box enables you export selected Cl types to an Excel report.

To access

In the CI Type Manager, click the Export Class Model button a and select
Export Selected CITs to Excel.
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Important  You can select a CIT and a relationship to serve as the root Cl type and root
information  relationship for the report. If you do not select a CIT or relationship, the default
values are used. The root CIT and root relationship are independent of each other.

The report displays the root CIT and all its descendant CITs. The report contains
the following pages:

e CIT Hierarchy. Displays the CITs under the root CIT in tree format with links
to their attributes.

¢ Relationship Hierarchy. Displays the relationships under the root relationship
in tree format with links to their attributes.

o CIT Attributes. Displays the name, type, description and display level for the
CIT attributes of each CIT under the root CIT.

« Relationship Attributes. Displays the name, type, description and display
level for the relationship attributes of each relationship under the root

relationship.

o Valid Relationships. Displays all the valid relationships for each CIT under
the root CIT.

o Enumerations. Displays all the enumeration definitions from the System Type
Manager. (Not dependent on the root CIT or root relationship.)

o Lists. Displays all the list definitions from the System Type Manager. (Not
dependent on the root CIT or root relationship.)

You can select the pages you want to display in the report.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

Root Cl Type
Click the ellipsis button =% to select a CIT to serve as the root Cl type. If you
do not select a CIT, the default root Cl type used . To change the default value,
edit the Object root setting in Infrastructure Settings Manager.

Root

CIT

Relationship  Click the ellipsis button to select a relationship to serve as the root
relationship. If you do not select a relationship, the default root relationship
used. To change the default value, edit the Link root setting in Infrastructure
Settings Manager.
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Ul Element
(A-2) Description

Select pages = Select the pages to display in the report (select the check boxes for all the
to display required pages). The following options are available:

e CIT Worksheets. Includes the CIT Hierarchy and the CIT Attributes
worksheets.

¢ Relationship Worksheets. Includes the Relationship Hierarchy and
Relationship Attributes worksheets.

o Valid Relationships Worksheet. Includes the Valid Relationships
worksheet.

o Type Definition Worksheets. Includes the Enumerations and Lists
worksheets.

Export Selected CITs to PDF Dialog Box

This dialog box enables you export selected Cl types to a PDF report.

To access In the Cl Type Manager, click the Export Class Model button 8 and select

Export Selected CITs to PDF.

Important The output of this dialog box is the UCMDB CI Types and Relationships
information | Information PDF, describing the Universal Data Model.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description
All Data Select to display all the information on the selected CITs.
Changes Select to display only the changes in the selected CITs from the previous data
Only model.
CiTs

Click the ellipsis button %% to select CITs to export.
Filter Select tofilter the attributes in the report by qualifiers. Enter the required
attributes by  qualifiers in the box. The report displays only the attributes with the selected
qualifiers qualifiers.

Relationships
Click the ellipsis button

CIT

to select relationships to export.
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Ul Element
(A-2) Description
Show Select the scope of the selected CITs and relationships:
Properties

e UDM. Includes CITs and relationships from the UDM.

e CMS. Includes only CITs and relationships used in the CMS
Show Select to include qualifier information in the exported report.
Qualifiers
Show Select to include relationship information in the exported report.

Relationships

Show Valid Select to include valid link information in the exported report. The valid link
Links section displays all the valid relationships for the selected CITs.

System Type Manager Dialog Box

This dialog box enables you to display the attribute types you defined in the Create
List/Enumeration Definition dialog box.

To access From the Cl Type Manager, select Cl Types > System Type Manager.
Relevant tasks @ "Create List and Enumeration Definitions" on page 354

See also "Create an Enumeration Definition — Workflow" on page 354

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
i Create a predefined list whose values define an attribute type. You can create
a definition for the following attribute types:
o List definition.
o Enumeration definition.
For a description of these attribute types, see "Create/Update
List/Enumeration Definition Dialog Box" on page 376.
2 Enables you to edit an existing definition. For details, see "Create/Update
List/Enumeration Definition Dialog Box" on page 376.
3 Delete an existing definition. Select the system type definition you want to

delete and click the Delete button.

<System Type  The list of Enumeration and List definitions created in the System Type
Definitions> Manager.
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Enrichment Manager — Overview ... 382
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Add Enrichment Query Nodes and Relationships to an Enrichment TQL Query ............... 388
Enrichment Manager User Interface .. ... .. .. 389

Enrichment Manager - Overview

Enrichment rules can be used for several purposes:

o Adding new Cls and relationships to the RTSM.

o Deleting specific Cl instances from the RTSM.

o Updating the attribute values of specific Cl instances in the RTSM.

Enrichment query nodes and relationships differ from other query nodes and relationships in that
they are conceptual deductions that represent real relationships and Cls that cannot be discovered
automatically by the discovery process.

Enrichment query nodes and relationships are created as part of a TQL query, whose other TQL
query nodes are regular ones, meaning TQL query nodes that already exist in the RTSM. For more
information about TQL queries, see "Topology Query Language" on page 15.

The following example displays a regular query node of type Node linked to a Websphere AS
Enrichment query node by an Enrichment Composition relationship.
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Enrichment E: i A:J -
query node
Yiebsphere AS

) *
Enrichment + Composition
relationship .
Existing query node —

MNode
Containment

_1_
I

IpAddress

By placing an Enrichment query node within a TQL query context, the query receives data from its
attributes, and uses it to insert new information into the RTSM.

When you create Enrichment rules, the following results can occur:

o The RTSM is enlarged. Add Enrichment query nodes and relationships that are currently not
included in the RTSM.

The following Enrichment rule example displays a regular Windows query node (that already

exists in the RTSM) connected to a Log File Enrichment query node by an Enrichment
Composition relationship.

Enrichment .
query node

Log File

+ Camposition
AN

Existing query node 3

—

Wilindows
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This Enrichment rule states that for every Windows Cl instance that is found in the RTSM, a new
Log File Cl instance is created, and linked to the Windows CI with a Composition relationship.

« Specific Cl instances are deleted from the RTSM. For an example, see "Define an
Enrichment Rule — Scenario" below.

o The values of Cl attributes are updated. Use an Enrichment rule to update the attributes of a
Cl that already exists in the RTSM.

The following Enrichment rule example illustrates that a regular Windows query node (that
already exists in the RTSM) has been updated with an Enrichment rule.

%J

Windows

This Enrichment rule states that every Windows CI found in the RTSM is updated with the
attribute value defined in the Enrichment rule.

Define an Enrichment Rule - Scenario

This task describes how to create the following Enrichment rule:

AnIP Address Cl is connected to two identical Node Cls: one Node Cl is identified by its IP
address and the other is identified by its lowest MAC address. For every such instance, delete the
Node Cl that is identified by its IP address from the RTSM.

Note: To reach the required result, you must implement each one of the following steps.

This task includes the following steps:
o "Create an Enrichment TQL Query" below

o "Define the Query Node of Type Node that Is Identified by its Lowest MAC Address" on page
386

o "Define the Query Node of Type Node that is Identified by its IP Address" on page 386

o "Define the Enrichment Rule" on page 387

1. Create an Enrichment TQL Query

To create an Enrichment TQL query, you need to define an Enrichment rule and then add the
regular TQL query nodes and relationships that define the query.

Note: You can add Enrichment query nodes and relationships only after at least one
regular query node has been added to the query.
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Select Admin > RTSM Administration >Modeling > Enrichment Manager. For details
about how to create an Enrichment TQL query, see "New Enrichment Rule/Enrichment Rule
Properties/Save As Enrichment Rule Wizard" on page 397. For details about how to add query
nodes and relationships to a query, see "Add Query Nodes and Relationships to a TQL Query"
on page 23.

Example of an Enrichment TQL Query:

A new Enrichment TQL query called doubleHosts1 (located under the Network folder) is
created in Enrichment Manager.

Fule Mame: | double Hosts1 |

Fule Description: Delete incomplete host

Fule iz Active

The doubleHosts1 Enrichment rule is displayed in the Enrichment Rules pane.

— Application
Cluster
Correlation
Database
| Discovery
= Enrichment
- IBM WebSphere M

—
[l
—
[l
—
[l
—

Eﬁ] double Hosts

Eﬁ] cdouble Hosts1

[ Update_Broadcast_|P

In this Enrichment TQL query, an IP Address query node is linked to two query nodes of
type Node by a Containment relationship. The TQL results must comply with the
direction of the arrows.
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Mode_2 Mode
Containgment_2

Cantainment

il

[pAddress

Note: A TQL query is subject to certain validation restrictions. For details, see
"Troubleshooting and Limitations" on page 89.

2. Define the Query Node of Type Node that Is Identified by its Lowest
MAC Address
At the top of the Enrichment Manager page, select Query mode. In the editing pane, right-click
the required query node of type Node, select QueryNode Properties to open the Query Node
Properties dialog box. Then define an attribute condition in the Attribute tab. For details on how
to define an attribute condition, see "Query Node/Relationship Properties Dialog Box" on page
68.

Example of an Attribute Condition Definition that Identifies the Node by its Lowest
Mac Address:

In the Attribute tab, this attribute condition definition identifies the required Node by its
lowest MAC address.

» Attribute name — Node is Complete
= Operator — Equal

= Value — True

3. Define the Query Node of Type Node that is Identified by its IP Address

At the top of the Enrichment Manager page, select Query mode. In the editing pane, right-click
the required query node of type Node, and select Query Node Properties to open the Query
Node Properties dialog box. Then define two attribute conditions in the Attribute tab. For details
on how to define an attribute condition, see "Query Node/Relationship Properties Dialog Box"
on page 68.
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Example of an Attribute Condition that Enables a Node to Be Identified by its IP
Address:

This attribute condition is the first attribute condition you need to define in the Attribute tab
to enable the query node of type node to be identified by its IP Address.

Attribute name — Node is Complete
Operator — Equal
Value — False

This is the second attribute condition you need to define in the Attribute tab to enable the
query node of type node to be identified by its IP address.

Attribute name — Node is Complete
Operator — Is null

Value — Value cannot be changed

4. Define the Enrichment Rule

Define the Enrichment rule that deletes all instances of the query node of type Node that are
identified by their IP addresses. From the toolbar, select Enrichment mode. In the Enrichment
Rules pane, select the doubleHosts1 Enrichment rule. Then right-click the query node of type
Node that is identified by its IP address and select Delete Relationship/Query Node Item.

Example of a Query Node of Type Node Containing a Removed Indicator:

The query node of type Node now has a removed indicator to denote that all node
instances that have identical attribute and cardinality settings are removed from the
RTSM. The Enrichment query now looks like this.

== g

Mode Mode_2

CDntainment\q /Ccmtainment_?

il

IpAddress
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Add Enrichment Query Nodes and Relationships to
an Enrichment TQL Query

This section describes how to add Enrichment query nodes and relationships to an Enrichment TQL
query in Enrichment Manager.

To add Enrichment query nodes and relationships to a TQL query:

1.

From the tree in the Enrichment Rules pane, select the Enrichment rule to which you want to
add Enrichment query nodes and relationships or create a new one. For details, see "New
Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule Wizard" on page 397.

From the Query/Enrichment drop-down at the top of the page, select Enrichment Mode.

Enrichment Mocle | b
Cuery Mode
Enrichment Mode

From the tree displayed in the Cl Type Selector, click and drag the query nodes you want to
function as an Enrichment query node on to the editing pane. These are the TQL query nodes

that are included in the query. Added Enrichment query nodes are displayed by an added EI
indicator.

Note: You can add more than one Enrichment query node to a rule.

Link the Enrichment query node to an existing TQL query node or query nodes, to provide the
Enrichment query node with the needed context for its operation.

The following are the Enrichment rule validations:

= You must link the new Enrichment query node to at least one of the existing TQL query
nodes in the rule.

= Enrichment query nodes can only be linked to one another with an Enrichment relationship.

= If the new Enrichment query node must be contained (according to its CIT definition) in
another query node, you must use the Composition relationship to connect this
Enrichment query node to an existing TQL query node.

= You cannot link an Enrichment query node to a TQL query node that is hidden.
To add a relationship between two query nodes, do one of the following:

= Select the required query nodes by holding down CTRL and clicking the TQL query nodes,
right-click and select Add Relationship.
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= Click the Create Relationship I icon and draw a line between the required query nodes.

Added Enrichment relationships are displayed by an added EI indicator.

The Add Relationship dialog box opens. For details, see "Add/Edit Relationship Dialog Box"
on page 50.

6. Click OK. The selected query nodes are linked by the relationship you have selected.

Enrichment Manager User Interface

This section includes (in alphabetical order):
« "Enrichment Manager Page" below

o "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule Wizard" on page
397

o "Rule General Attributes Page" on page 398
¢ "Rule Base Query Page" on page 399
¢ "Query Node/Relationship Definition Dialog Box" on page 400

o "Query Node Definition - Advanced Attribute Dialog Box" on page 402

Enrichment Manager Page

This page enables you to define Enrichment rules. These rules, which are based on a specific TQL
query, can be used for several purposes, including:

¢ Adding new Cls and relationships to the RTSM.
o Deleting specific Cl instances from the RTSM.

o Updating the attribute values of specific Cl instances in the RTSM.

To access  Select Admin > RTSM Administration > Modeling > Enrichment Manager.

Important Enrichment Manager has two modes in which you can work. Always check the
information = Enrichment/Query mode list in the toolbar to verify the currently selected
mode.

Relevant "Define an Enrichment Rule — Scenario" on page 384
tasks

Enrichment Rules Pane

This area displays a hierarchical tree structure of predefined folders and Enrichment rules. Each
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Enrichment rule is associated with a TQL query.

Important = You can create your own Enrichment rule, or work with the out-of-the-box (factory)
information = Enrichment rules provided with your BSM installation.

The default folders are provided for the out-of-the-box queries. You can modify
these folders, or add additional folders according to your organization's
requirements.

You can drag and drop Enrichment rules or folders to move them from one folder to
another.

User interface elements are described below:

Ul Element

(A-2) Description

F=| Creates a new folder.
Creates an Enrichment rule. Opens the New Enrichment Rule/Properties
wizard.

iy Deletes the selected folder or Enrichment rule.

|§| Refreshes the data content of the hierarchical tree structure that may have been

B modified by other users.

= (Enabled only when an Enrichment rule is created or when changes are made to
an existing one.) Saves the Enrichment rule to the RTSM.

EE! Opens the New Enrichment Rule/Properties wizard. Enables you to change the

description and the activation state of the Enrichment rule.

Generates a preview of the results of the selected Enrichment rule.

Represents a folder.

B O E

Represents an Enrichment rule.

<Enrichment Displays the existing Enrichment rules in tree format.

Rule tree> . . . .
Note: Only Enrichment rules appear in the tree. TQL queries of type Enrichment

(created in the Modeling Studio) do not appear in the tree.
The following elements are available by right-clicking a folder or Enrichment rule:

Ul Element (A-Z) Description

Delete Deletes the selected folder or Enrichment rule.
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Ul Element (A-Z) Description

Export To XML Displays a standard Save As dialog box, enabling you to save the
Enrichment rule as an XML script. This option can be used to move
an Enrichment rule from one workstation to another, provided the
related TQL query is also relocated.

Import From XML Imports XML files that contain saved Enrichment queries to the
Enrichment Manager.

New Creates an Enrichment rule. Opens the New Enrichment Rule
wizard.

New Folder Creates a new folder.

Preview Generates a preview of the results of the selected Enrichment rule.

Properties Opens the New Enrichment Rule/Properties wizard. Enables you

to change the description and the activation state of the rule.

Rename Folder Renames the folder.

Save (Enabled only when a new Enrichment query is created or when
changes are made to an existing one.) Saves the Enrichment rule
tothe RTSM.

Save As Displays the Save As Enrichment Rule wizard, enabling you to

define a new name and description for a query. This option can be
used for creating a new Enrichment rule based on an existing one.

Editing Pane

This area enables you to create and define Enrichment query nodes and relationships.
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Important e When you select a folder in the Enrichment Rules pane, the editing pane is
information empty.

e When you select an Enrichment rule in the Enrichment Rules pane, the editing
pane displays the selected rule, which consists of TQL query nodes that are
defined in the TQL query and the relationships between them, and the
Enrichment query nodes and relationships that are created and added to the
rule.

¢ The Enrichment Manager has two modes in which you can work: Enrichment
mode and Query mode.

The mode in which you are working determines the options that appear in the
shortcut menu. For details, see the editing pane description below.

¢ You can calculate the number of instances that were created as a result of an
Enrichment rule and remove the instances created from an Enrichment rule
from the RTSM. For details, see "Additions Count" on page 157 and "Remove
Enrichment Results" on page 163.

Relevant "Define an Enrichment Rule — Scenario" on page 384
tasks
See also For details on how to create a TQL query, see "Add Query Nodes and

Relationships to a TQL Query" on page 23.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

E| Indicates an added Enrichment query node or relationship.

E| Indicates a query node or relationship that has been deleted from the

RTSM.

Indicates an updated query node or relationship.
Enrichment Mode | * The Enrichment Manager has two modes in which you can work:
Query Mode Enrichment mode and Query mode.
Enrichment Made Working in:

Query and

¢ Query mode enables you to define regular (non-Enrichment)
relationships and query nodes and add them to the TQL query you
defined.

Enrichment mode

¢ Enrichment mode enables you to define Enrichment relationships
and query nodes and add them to the TQL query you defined.

<Main Menu> For details, see "Main Menu" on page 154.
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Ul Element (A-Z) Description

<Query Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between two query nodes.
<Shortcut menu> For details, see "Shortcut Menu Options" on page 30.

options

<Toolbar> For details, see "Toolbar Options" on page 157.

<Tooltips> Hold the cursor over a query node or relationship to view its tooltip.

The tooltips contain the following information:
o Element name. The name of the query node.

e CI Type. The CIT of the query node as defined in the Cl Type
Manager. For details, see "C| Type Manager" on page 348.

o Definitions of the selected query nodes and relationships. The
attribute conditions, as described in "Query Node/Relationship
Properties Dialog Box" on page 68.

Cl Type Selector

This area displays a hierarchical tree structure of the Cl Types found in the RTSM.

Important | The CI Type Selector is part of Enrichment Manager, Impact Analysis Manager,
information = and Trigger TQL Editor.

To create or modify a TQL query, click and drag query nodes to the Editing pane
and define the relationship between them. Your changes are saved to the RTSM.
For details, see "Add Query Nodes and Relationships to a TQL Query" on page
23.

Note: The number of instances of each CIT in the RTSM is displayed to the right
of each CIT.

Relevant e "Define an Impact Rule — Workflow" on page 331
tasks
e "Define an Enrichment Rule — Scenario" on page 384
o "Define a TQL Query" on page 22

e "Create a Pattern View" on page 244

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Elements (A-

Z) Description
& Click Add CI Type to Map to move the selected Cl type to the Editing
pane.
|§| Click Refresh to refresh the Cl type tree.
Q Click Search to search for the CI type entered.
B Click Expand All to expand all subtrees within the Cl type tree.
B Click Collapse All to collapse the subtrees within the CI type tree.
<Search Enter the name or part of a name of a Cl type for which to search.
window>

Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically) available by right-
clickinga Cl Type:

Menu Item Description

Add CI Type Select to add the selected Cl type to the Editing pane.

to Map

Go to CI Takes you directly to the selected Cl type in CIT Manager.

Type

Definition

Show CIT Opens the CIT Instances window, which displays all instances of the selected
Instances CIT. For details, see "Element Instances Dialog Box" on page 61.

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected query node and
relationship.

Important The Advanced pane appears in the lower part of the window in the following
information managers and user interfaces: Modeling Studio, Impact Analysis Manager,
Enrichment Manager, the Input Query Editor and Trigger Query Editor in DFM.

A small green indicator #* appears next to the tabs that contain data.
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Relevant ¢ "Define an Impact Rule — Workflow" on page 331
tasks
¢ "Define an Enrichment Rule — Scenario" on page 384

o "Define a TQL Query" on page 22
o "Create a Pattern View" on page 244
e "Create a Template" on page 245

e "Create a Perspective" on page 246

User interface elements are described below:

Ul Elements (A-Z) Description

Ak If the window is not wide enough to display all the tabs, use the
left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the
current module. You can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node or
the relationship. For details, see "Attribute Tab" on page 70.

Cardinality Cardinality defines how many query nodes you expect to have
at the other end of a relationship. For example, in a relationship
between a node and an IP Address, if the cardinality is 1:3, the
TQL query retrieves only those nodes that are connected to
between one and three IP Addresses. For details, see
"Cardinality Tab" on page 72.

Data Sources Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.
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Ul Elements (A-Z)

Details

Edit

Element Layout

Element Type

Enrichment Rules

Description

Displays the following information:

o CI Type/Element Type. The CIT of the selected query
node/relationship.

« Element Name. The name of the query node or relationship.
This appears only in the Modeling Studio.

« Show in query results. A green check indicates that the
selected query node/relationship is visible in the topology
map. A red mark indicates that it is not visible. In the
Modeling Studio, this is indicated by the word Yes or No.

¢ Include subtypes. A green check indicates that both the
selected Cl and its children are displayed in the topology
map. A red mark indicates that only the selected Cl appears.
This item does not appear in the Modeling Studio.

Click Edit to open the relevant dialog box for the selected tab.

Displays the attributes selection for the selected query node or
relationship. It lists the attributes selected to be included in the
query results (when Specific Attributes is selected as the
attributes condition). It also lists the excluded attributes and any
selected qualifiers for attributes. For details, see "Element
Layout Tab" on page 77.

Note: This tab appears only in the Modeling Studio.

Displays the subtype conditions defined for the query node or
relationship. For details, see "Element Type Tab" on page 75.

Note: This tab appears only in the Modeling Studio.

Displays the Enrichment rule defined for the selected query
node or relationship. If the Enrichment rule is used to update the
attributes of a Cl, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if
required. For details, see "Query Node/Relationship Definition
Dialog Box" on page 400.

Note: This tab appears only in Enrichment Manager.
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Ul Elements (A-Z) Description

Impacted Query Nodes Indicates which query node is impacted by the changes that
occur in the selected trigger query node. If required, you can
click Edit to open and modify the Impacted Query Nodes dialog
box. For details, see "Impacted Query Nodes Dialog Box" on
page 342.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node or
the relationship. For details, see "Qualifier Tab" on page 79.

Note: This tab appears only in Enrichment Manager and Impact
Analysis Manager.

Selected Identities Displays the element instances that are used to define what
should be included in the TQL query results. For details, see
"ldentity Tab" on page 82.

New Enrichment Rule/Enrichment Rule Properties/Save
As Enrichment Rule Wizard

This wizard enables you to create or modify an Enrichment rule.

To access ¢ Tocreate a new Enrichment rule, right-click anywhere in the Enrichment Rules

pane and click New or click the New " button.

o To modify an existing Enrichment rule, right-click an Enrichment rule in the
Enrichment Rules pane and select Properties.

¢ To create a new Enrichment rule based on an existing query, right-click an
Enrichment rule in the Enrichment Rules pane and select Save As.
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Important ¢ When creating a new Enrichment rule, bear in mind that the application does
information not allow you to make any changes in the TQL query that are necessary for the
rule. These changes include the following:

= Deleting, from the Enrichment TQL query, the query nodes or relationships
connected to the Enrichment query node, causing a query node to become
unattached to any relationship.

= You cannot change the cardinality definition to O (not required) of a query
node or relationship that is used in an Enrichment rule. For details on
relationship cardinality, see "Query Node/Relationship Properties Dialog
Box" on page 68.

o An Enrichment TQL query that serves as the basis for Enrichment rules, is
subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 89. If the TQL query is not valid, you cannot save it.

Relevant "Define an Enrichment Rule — Scenario" on page 384

tasks

Wizard The "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment
map Rule Wizard" contains:

"Rule General Attributes Page" > "Rule Base Query Page"

See also "Topology Query Language" on page 15

Rule General Attributes Page
This wizard page enables you to enter a unique name and description for the Enrichment rule.

Important o An Enrichment TQL query that serves as the basis for Enrichment rules is
information subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 89. If the TQL query is not valid, you cannot save it.

o Forimportant information on the effects of making changes to the TQL query
after creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save
As Enrichment Rule Wizard" on the previous page.

o By default, this wizard is set to display a Welcome page. You can choose not
to display this page by changing the user preferences. For details, see "User
Preferences Dialog Box" on page 88.

Wizard The "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment
map Rule Wizard" contains:

"Rule General Attributes Page" > "Rule Base Query Page"

See also "Topology Query Language" on page 15

User interface elements are described below:
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Ul Element

(A-2) Description

Rule (Optional) Enter a description of the rule.

Description

Rule is (Optional) Select this option to activate the rule in the system as soon as it is
Active saved.

Default: Not selected.

Note:

o If an active Enrichment rule is deactivated (by clearing the Rule is Active
check box), all changes that occur in the RTSM relating to the rule are deleted
from the system. When you deactivate an Enrichment rule, a red X appears
next to the Enrichment rule in the Enrichment Rules pane.

o Toreactivate the rule, right-click the rule in the Enrichment Rules pane and
select Properties. In the General Attributes page, select Rule is Active.

Rule Name Enter a unique name for the Enrichment rule. The rule name cannot contain any of
the following characters: \/: " < >| % ?. The final character cannot be a blank
space.

Note: If the rule name is either empty, contains a name used by another
Enrichment rule, or uses invalid characters, the Next and Finish buttons are
disabled.

Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on which the Enrichment
rule is based.

Important e An Enrichment TQL query that serves as the basis for Enrichment rules, is
information subject to certain validation restrictions. For details, "Troubleshooting and
Limitations" on page 89. If the TQL query is not valid, you cannot save it.

o Forimportant information on the effects of making changes to the TQL query
after creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save
As Enrichment Rule Wizard" on page 397.

o By default, this wizard is set to display a Completion page after clicking Next
in this page. You can choose not to display the Completion page by changing
the user preferences. For details, see "User Preferences Dialog Box" on page

88.
Wizard The "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment
map Rule Wizard" contains:

"Rule General Attributes Page" > "Rule Base Query Page™

See also "Topology Query Language" on page 15
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User interface elements are described below:

Ul Element (A-Z)

Base the
Enrichment rule
on a new query

Base the
Enrichment rule
on an existing

Description

Select this check box if you want to base the Enrichment rule on a new TQL
query. The TQL results are based on the attributes defined for the new TQL

query.

Select this check box if you want to base the Enrichment rule on an existing
TQL query. Select the required Enrichment TQL query from the drop-down
list.

query

Base Query
Description

Base Query
Name

Base Query
Priority

Save a new

(Optional) Enter a description of the TQL query.

Enter a unique name for the Enrichment TQL query.

If you selected the Base the Enrichment rule on an existing TQL option,
select the Enrichment TQL query on which you want to base the rule.

Select a priority level for the new TQL query (Low, Medium, High, or
Express). This setting determines how often the query is rerun
automatically by the system to include updated information from the RTSM.

Select to save a new TQL query based on your Enrichment rule definition.

query based on

the current
definition

Note: This field only appears in the Save As Enrichment Rule wizard.

Query Node/Relationship Definition Dialog Box

This dialog box displays the attributes of the selected query node/relationship. The key attributes
and the required attributes of the selected query node appear in bold.

To access

Important
information

Relevant
tasks

HP Business Service Management (9.24)

Right-click a query node or relationship when in Enrichment mode (select
Enrichment from the Query/Enrichment drop-down at the top of the Enrichment
Manager page) and select Update Relationship/Query Node.

Use an Enrichment rule to update the value of Cl attributes in the RTSM, or to add
data to attributes that currently do not have values. You can use this option, for
example, for simultaneously adding a note to all Cl instances.

You must fill in the value of the key attributes and the required attributes of the
Enrichment query node. The method you use to define these values determines
the number of instances created.

If you enter a dynamic value, you can create numerous instances. For example,
entering the dynamic value of a host_key for the CIT Node or an IP address
attribute for the CIT IpAddress.

"Define an Enrichment Rule — Scenario" on page 384
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Attributes Area

User interface elements are described below :

Ul Element (A-Z) Description

Name The attribute name.

Type The field type of the selected attribute.
Value The value as defined in one of the following:

e The Value box in the Set Attributes area.

e The combination of the values in the By Attribute boxes in the
Set Attributes area.

o The Value column if you selected Simple in the Type column
in the Query Node Definition - Advanced Attribute dialog box.

e The combination of the values in the Value column and the
column to the right of the Value column if you selected By
Attribute in the Type column in the Query Node Definition -
Advanced Attribute dialog box.

Set Attributes Area

User interface elements are described below :

Ul Element
(A-Z) Description

(Appears only if you selected an attribute of the field type string.) Opens the
Query Node Definition - Advanced Attribute dialog box.

Define query node and relationship attributes of the type string using simple or
complex expressions. You can also create complex expressions using regular
expression format..

Advanced  (Appears only if you selected an attribute of the field type string.) Displays the
attribute value you defined in the Query Node Definition - Advanced Attribute
dialog box.

By Define an attribute using attributes from other query nodes in the TQL query.
Attribute

o Inthe box to the left, select the required query node.

¢ Inthe box to the right, select the query node’s required attribute.

The attribute definition appears in the Value column in the Attributes area.
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Ul Element
(A-Z)

RegExp
Group

Regular
Expression

Value (in
the Set
Attributes
area)

Description

(Appears only when you select an attribute of the field type string.) Enter the
group number only if you are adding a regular expression using regular expression
syntax. This is the part of the regular expression pattern to focus on when creating
the attribute. A set of parentheses () constitutes a group.

(Appears only when you select an attribute of the field type string.) Add a regular
expression using regular expression syntax. Enter the regular expression pattern.

Define a constant value. Enter the required value in the Value box or select a
value from the Value list.

Note: The value definition appears in the Value column in the Attributes area.

Query Node Definition - Advanced Attribute Dialog Box

This dialog box enables you to define query node and relationship attributes of the type String using
simple or complex expressions. You can also create complex expressions using regular expression

format.

To Select an attribute of the type string in the Query Node Definition dialog box. Select
access  Advanced and then click the Advanced button.

Relevant | "Define an Enrichment Rule — Scenario" on page 384

tasks

User interface elements are described below :

Ul Element
(A-Z)

=0

1t

L

Advanced
Value

Description

Define an attribute value using simple or complex expressions. Creates a new
entry in the Type column. Click the new entry and select either Simple or By
Attribute. For details, see the description for the Type column below.

Delete an attribute value.
Move a selected row up.

Move a selected row down.

(This list is only available if you select By Attribute in the Type column.) Click
the entry inside the box and select the required attribute.

Concatenate Use all the attribute values listed in this dialog box.
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Ul Element
(A-Z)

RegExp
Group

Regular
Expression

Type

Use first
attribute
with value

Value

HP Business Service Management (9.24)

Description

(This list is available only if you select By Attribute in the Type column.) Click

inside the RegExp Group column, click the —_— button, and enter the group
number in the Value for RegExp Group dialog box that opens. This is the part of
the regular expression pattern to focus on when creating the attribute. A set of
parentheses () constitutes a group.

(This list is only available if you select By Attribute in the Type column.) Click

inside the Regular Expression column, click the N button, and enter the
regular expression pattern in the Value for Regular Expression dialog box that
opens.

Click the entry inside the Type column and select one of the following options:
o Simple. Define a constant value using a simple expression.

o By Attribute. Define an attribute using attributes from other query nodes in
the TQL.

Default: Simple

Use the first attribute value listed in this dialog box that is not empty.

o If you select Simple in the Type column, click inside the Value column, click

the — button, and enter the required value in the Value for Simple dialog
box.

Note: If you define an attribute value using only one Simple expression, the
Value column cannot be empty.

o If you select By Attribute in the Type column, click inside the Value column
and select the required value from the list.
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This chapter includes:

Universal Data Model (UDM) Overview ... . 405

Universal Data Model (UDM) Overview

The Universal Data model (UDM), provides the information model that enables HP Software
products to integrate using a common language. The UDM provides the vocabulary in the form of
Cl types and the relationships between them, and their attributes. This vocabulary and the artifacts
derived from it are used to enable integrations in an enterprise environment, to enable faster design
and deployment, and to facilitate ease of maintenance and integration evolution. The UDM is
applied to many management products and solutions, including BSM and its integrations.

You can generate the UCMDB CI Types and Relationships Information PDF, which provides
information on specific Cl Types and Relationships in the UDM. For details, see "Export Selected
CITs to PDF Dialog Box" on page 380.
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a UML Tool

This chapter includes:

Export the Class Model ... .
Export to UML Tool — OVerVIeW . ...
Convert XML of Selected Part of Class Model ........ ... ...
Export to UML Tool User Interface ... .. .

Tool PIUG-IN INPUL

Note: Currently, Altova UModel versions 2008 and 2009 are supported.

Export the Class Model

This task describes how to use the Export Class Model to UML tool wizard.

This task includes the following steps:

1. Prerequisites

Set up the tool by extracting the following zip file to any location:

<HP BSM root directory>:\odb\tools\ExportClassModel.zip

2. Run the UML Tool

You use the Export Class Model to UML wizard to choose the CIT and its attributes to be
exported to the UML tool.

For details on working with the Export to UML wizard, see "Export Class Model to UML
Wizard" on page 408.

3. View the Exported File in Altova

a. InAltova, select File > Import From XMI File.
b. Select the XMl file. The class model entry appears in the Model Tree pane.

c. Right-click the entry and select Show in new diagram > Content. Click OK.

Export to UML Tool - Overview

The Export to UML tool enables you to export selected sections of the RTSM class model to a
format compatible with UML tools, and to view the model as a UML diagram.
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The input for the tool is the RTSM class model XML file retrieved by the JMX service
UCMDB:service=Class Model Services/
exportClassModelToXmil().

Note: To access the JMX console, enter the following address in your browser:
http://<server_name>:21212/jmx-console, where <server_name> is the name of the
machine on which BSM is installed.

Convert XML of Selected Part of Class Model

This task describes how to use the custom plug-in to convert the XML of a selected part of the
class model to the UML tool format.

The plug-in can be either a Java class oran XSLT text file. If you use a Java class, it must
implement the ITransformToUML(ExportToUML.jar) interface; the transformToUML() method
receives an XML string as a parameter and returns a byte array that is written to the output file.

For details on the custom plug-in input, see " Tool Plug-in Input" on page 409.

This task includes the following steps:
o "Activate the Plug-in Using a Java Class" below

o "Activate the Plug-in Using an XSLT Text File" below

Activate the Plug-in Using a Java Class

Add the display name and fully-qualified class name to the config.xml file in the ExportToUML
directory, as follows:

<ConverterToUML>

<Name><display name></Name>

<Class><fully qualified class name></Class>
</ConverterToUML>

Continue with the procedure for exporting the class model. For details, see "Export the Class
Model" on the previous page.

Activate the Plug-in Using an XSLT Text File

In this case, XSLT from the specified file is applied to the class model XML and is written to the
output file.

Add the display name and full path of the XSLT file to the config.xml file in the ExportToUML
directory, as follows:

<ConverterToUML>
<Name><display name></Name>
<XsltFile><Full_path_of_the_XSLT_file></XsltFile>
</ConverterToUML>

Continue with the procedure for exporting the class model. For details, see "Export the Class
Model" on the previous page.

HP Business Service Management (9.24) Page 407 of 416



Modeling Guide
Chapter 15: Exporting the RTSM Data Model to a UML Tool

Export to UML Tool User Interface

This section includes:
o "Export Class Model to UML Wizard" below
o "Select Valid Links" on the next page

o "Export Selected Iltems" on the next page

Export Class Model to UML Wizard

This wizard enables you to choose the CIT and its attributes to be exported to the UML tool.

To access  Browse to the location where you extracted the tool. Right-click
ExportClassModel.jar in the ExportClassModel directory. Select Open With >
Java 2 Platform SE binary.

Important By default the tool opens the ClassModel.xml file in the ExportClassModel
information = directory. You open other files through the File > Open Class Model File menu.

Relevant "Export the Class Model" on page 406

tasks

Wizard The Export Class Model to UML wizard contains:

map "Export Class Model to UML Wizard" above > "Select Valid Links" on the next
page > "Export Selected Items" on the next page

See also " Tool Plug-in Input" on the next page

User interface elements are described below:

Ul Element (A-Z) Description
File Displays alist of XML files. Open the file that contains the class model.

Select Attributes = Select the attributes to be displayed in the UML tool.

Pane
The attributes of the selected CIT are displayed in this pane. The attributes

are colored as follows:
o Attributes inherited from the parent CIT are black.

o Attributes specific to this CIT are dark blue.

Select Cl Types  The CITs displayed here are retrieved from the ClassModel.xml file.
Pane
Select the CIT and its sub nodes to be exported to the UML tool.

Use the buttons to select or clear all subindex.
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Select Valid Links

This wizard page enables you to select links that can be used between two CITs.

Important General information about the wizard is available in "Export Class Model to
information UML Wizard" on the previous page.

Wizard map The Export Class Model to UML wizard contains:

"Select Valid Links" > "Export Selected ltems"
User interface elements are described below:

Ul Element
(A-2) Description

Click to remove the filter from the list of CITs.

Filter by Enables you tofilter the list of valid links. You can filter the list of CITs and you can
sort the list by CIT or relationship.

Export Selected Items
This wizard page enables you to export the selected CITs and their attributes to the UML tool.

Important General information about the wizard is available in "Export Class Model to
information UML Wizard" on the previous page.

Wizard map The Export Class Model to UML wizard contains:
"Select Valid Links" > "Export Selected Items"

User interface elements are described below:

Ul Element
(A-2) Description
Export Click to browse to the UML file, in XMI format, to which you want to add the

UCMDB CITs and their attributes.

If there are no valid links for a pair of CITs, a no valid links message is displayed
in the Select Valid Links page.

Tool Plug-in Input

The input for the plug-in is an XML string (selected classes/attributes/valid links) in the following
form:
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<?xml version="1.0" encoding="IS0-8859-1"?>
<Class-Model>
<Class class-name="hostresource" display-name="Host Resource" visibi
lity="public">
<Attribute name="isvirtual" display-name="Is Virtual" visibility
="public"/>
<Attribute name="city" display-name="City" visibility="public"/>
</Class>
<Class class-name="host_node" display-name="Computer" visibility="pu
blic">
<Derived-From class-name="host"/>
</Class>
<Class class-name="vax" display-name="VAX" visibility="public">
<Attribute name="root_actualdeletionperiod" display-name="Actual
Deletion Period" visibility="public"/>
<Attribute name="data_allow_auto_discovery" display-name="Allow
CI Update" visibility="public"/>
<Derived-From class-name="host_node"/>
</Class>
<Class class-name="host" display-name="Host" visibility="public">
<Attribute name="host_iscomplete" display-name="Host Is Complete"
visibility="public"/>
<Attribute name="host_isroute" display-name="Host Is Route" visi
bility="public"/>
<Attribute name="host_hostname" display-name="Host Name" visibil
ity="public"/>
<Attribute name="host_os" display-name="Host Operating System" v
isibility="public"/>
</Class>
<Class class-name="unix" display-name="Unix" visibility="public">
<Derived-From class-name="host_node"/>
</Class>
<Valid-Link ID="host_member_host" display-name="Member" visibility="
public">
<Endl class-name="host"/>
<End2 class-name="host"/>
</Valid-Link>
<Valid-Link ID="host_container_f_hostresource" display-name="Contain
er link" visibility="public">
<Endl class-name="host"/>
<End2 class-name="hostresource"/>
</Valid-Link>
</Class-Model>
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This chapter includes:

Columns UserInterface .. ... . 412

Columns User Interface

This section includes (in alphabetical order):
e "Select Columns Dialog Box" below

e "Sort Column Content Dialog Box" on the next page

Select Columns Dialog Box

This dialog box enables you to choose the information you are interested in displaying. You can hide
a column or display a hidden column.

D ipti
escription Click the Select Columns X button. This button appears above every table in

areport.

Important  The order of the columns in the list in the Visible Columns pane determines the

Information = order of the columns displayed in the table. To change the order of table columns,
move them to the required position using the up and down arrow buttons or by
dragging a column to a new location.

The following elements are included:

Ul Element
(A-Z) Description
> Displays a column. Moves the selected column from the Available Columns
pane to the Visible Columns pane.
4 Hides a selected column. Moves the selected column from the Visible
Columns pane to the Available Columns pane.
> Displays all hidden columns. Moves all the columns from the Available
- Columns pane to the Visible Columns pane.
= Hides all columns. Moves all the columns from the Visible Columns pane to the
- Available Columns pane.
1t Move a selected column up in the list in the Visible Columns pane.
4 Move a selected column down in the list in the Visible Columns pane.
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Ul Element

(A-2) Description

Available The columns in this pane do not appear in the table.
Columns

Visible The columns in this pane are visible in the table.
Columns

Sort Column Content Dialog Box
This dialog box enables you to set or change the sort order for the entries displayed in a table.

Description Click the Sort Column Content button "‘—T.

Important = To sort a table by one column:

Information )
Move the column name from the Available Columns to the Sorted Columns

list. Select the name and decide whether to sort in ascending (upward triangle) or
descending (downward triangle) order by clicking the relevant button.

To sort a table by more than one column:

Move the column names from the Available Columns to the Sorted Columns
list. For each column, decide whether to sort in ascending or descending order.

To change the order in which columns are sorted:

In the Sorted Columns list, select an entry, and click the Up or Down arrow to
change the order. (Entries higher in the list are sorted before entries lower in the
list.) A number is displayed in the table's column headers.

Note: Only columns that are displayed can be sorted. For details on how to define
which columns are displayed in the table and in which order, see "Select Columns
Dialog Box" on the previous page.

The following elements are included:

ul

Element

(A-2) Description

> Moves the selected column from the Available Columns pane to the Sorted

Columns pane. You can double-click the selection to perform the same procedure.

'S Moves the selected column from the Sorted Columns pane to the Available
Columns pane.
Moves all the columns from the Available Columns pane to the Sorted Columns

AT

pane.
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ul
Element
(A-2) Description
p= Moves all the columns from the Sorted Columns pane to the Available Columns
= pane.
¥ f Moves the selected column up or down in the list to increase or decrease its priority
in establishing the sort order.
== Enables you to sort the column content in ascending or descending order.

In the Sorted Columns pane, select a column name and click the ascending or
descending button.

Available The columns whose content is not sorted.

Columns ;

Note: You can select multiple columns.
Sorted The columns whose content is sorted in either ascending or descending order.
Columns
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This chapter includes:

Examples of Regular Expressions ... ... 415

Examples of Regular Expressions

o Enter aregular expression to define an IP address (aa.yy.zz.mm):

To: In the First Field Enter: In the Second Field Enter:
Create label by aa (YT 1
Create label by yy DD 2
Create label by zz CLIXIDEINTS 2
Create label by mm LI LDE™ 2

o Enteraregular expression to create the label by the first or last letters of the selected attribute:

To: In the First Field Enter: In the Second Field Enter:
Create label by the first letter () 1
Create label by the last letter (M) 2
Create label by the first two letters | (..)(.*) 1
Create label by the last two letters  (.*)(..) 2
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We appreciate your feedback!

If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on Modeling Guide (Business Service Management 9.24)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client,
and send your feedback to SW-Doc@hp.com.
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